
前言 
 

 
目的 

本手册详细阐述了STEP 7进行编程，为安装和调试软件提供支持。本手册解释了如何生成
程序，并对用户程序组件作了说明。  

本手册的使用对象是那些使用STEP 7和SIMATIC S7自控系统实现控制任务的人员。 

我们建议你通过手册《STEP 7 V5.2使用入门》中的例子，来了解STEP 7。这些例子对“使
用STEP 7编程”的主题作了简单的介绍。 

 
所需基本知识 

为了很好理解本手册，需要具有自动化技术的一般知识。 

另外，还应熟悉安装有Windows 95/98/2000，MS Windows Millenium，MS Windows NT 
4.0工作站，MS Windows 2000专业板或MS Windows XP专业板操作系统的计算机或PC
一类的工具的使用（例如编程器等）。 

 
手册的应用范围 

本手册适用于STEP 7编程软件包V5.2版。在服务包中可以得到最新信息： 

• 在“readme.wir”文件中 

• 在更新的STEP 7在线帮助中 

在在线帮助中的“What’s new?”主题中可以得到详细介绍，以及新板STEP 7的变化情况。 

 
在线帮助 

集成在软件中的在线帮助是本手册的补充。在线帮助的目的是为你提供详细的软件使用帮
助。 

帮助系统通过多个界面集成在软件中： 

• 在Help菜单中有多个菜单命令可以选择：使用“Contents（内容）”命令，可以打开
Step 7的帮助索引。 

• Using Help（使用帮助）提供有详细的在线帮助使用说明。 

• 上下文相关帮助可以提供关于当前的文本信息，例如，一个打开的对话框或一个激活
的窗口。你可以通过点击“Help”按钮或按动F1，打开文本相关的帮助。 

• 状态栏提供有其它形式的上下文相关帮助。当鼠标放在某个菜单命令上时，它为每个
菜单命令显示一个简短的解释。 

• 当鼠标短时放在一个工具栏的图标上时，也能为每个图标显示一个简短的解释。 

如果你更愿意阅读打印出来的在线帮助，你可以打印每个帮助主题、工作簿或整个在线帮
助。 

本手册是从基于HTML的STEP 7帮助中摘取出来的。详细过程请参阅STEP 7帮助。由于手
册和在线帮助的结构几乎一样，所以能够很容易地在手册和在线帮助之间进行转换。 
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其它帮助 

如果您有任何技术问题，情与当地Siemens代表处联系。 

http://www.siemens.com/automation/partner 

 
SIMATIC培训中心 

西门子公司还提供有许多培训课程，介绍SIMATIC S7自动化系统。详情请与您所在地区的
培训中心联系，或与德国纽伦堡（邮编D-90327）的总部培训中心联系： 

电话：  +8610  64721888 

电话：  +49 (911) 895-3200 

或与当地西门子培训中心联系： 

北京：010 – 64392860 

上海：021 – 32200899 – 306 

广州：020 – 87320088 – 2279 

武汉：027 – 85486688 – 6601 

沈阳：0451 – 2393128 

重庆：023 – 63828919 – 3002 

http://www.ad.siemens.com.cn/training 

http://www.sitrain.com 
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SIMATIC客户支持热线 

昼夜值班，遍布全球： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

面向全球（纽伦堡） 技术支持 

提供24小时服务 

电话：+49(0) 180 5050-222 

传真：+49(0) 180 5050-223 

E-Mail：adsupport@siemens.com 

GMT：+1:00 

  

欧洲/非洲（纽伦堡）  

授权 

当地时间：星期一—星期五 

8:00 至17:00 

电话：+49(0) 180 5050-222 

传真：+49(0) 180 5050-223 

E-Mail：adsupport@siemens.com 

GMT：+1:00 

美国（约翰逊市） 

技术支持和授权   

当地时间：星期一—星期五 

8:00 至17:00 

电话：+1(0) 770 740 3505 

传真：+1(0) 770 740 3699 

E-Mail：
isd-callcenter@sea.siemens.com 

GMT：-5:00 

亚洲/澳在利亚（北京） 

技术支持和授权 

当地时间：星期一—星期五 

8:30 至17:30 

电话：+86 10 6475 7575 

传真：+86 10 6474 7474 

E-Mail：
adsupport.asia@siemens.com 

GMT：+8:00 

SIMATIC热线和授权热线使用的语言是德语和英语。 

      

        

 

约翰逊市 

 纽伦堡  北京 
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SIMATIC客户支持在线服务 

SIMATIC客户服务支持部门，通过其在线服务，还可为您提供与更丰富的有关SIMATIC产
品的其它信息： 

http://www.siemens.com/automation/service&support 

在此，您可以得到： 

• 通过新闻向您提供最新的产品信息 

• 通过Search功能在Service&Support内查找相应的资料 

• 全世界的拥护和专家可以通过论坛交流经验 

• 通过数据库可以得到当地自动化与驱动集团的代表处信息 

• 在“Services”下得到有关现场服务、维修、备品备件以及更多的信息。 
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1 产品介绍和软件安装 
 

1.1 STEP 7概述 

 

何谓STEP 7 

STEP 7是用于SIMATIC可编程逻辑控制器组态和编程的标准软件包。它是SIMATIC工业软

件的组成部分。有下列版本的STEP 7标准软件包： 

• 用于SIMATIC S7-200上简单单站应用的STEP 7 Micro/DOS和STEP 7 Micro/WIN。 

• 用于使用带有各种功能的SIMATIC S7-300/ST-400、SIMATIC M7-300/M7-400和

SIMATIC C 7的STEP 7： 

- 可通过选择SIMATIC工业软件中的软件产品进行扩展（见“STEP 7标准软件包的

扩展应用”一节） 

- 为功能模板和通讯处理器赋值参数 

- 强制和多处理器模式 

- 全局数据通讯 

- 使用通讯功能块的事件驱动数据传送 

- 组态连接 

STEP 7是本用户手册讨论的主题，STEP 7 Micro在《STEP 7 Micro/DOS用户手册》中描

述。 

 

基本任务 

当你用STEP 7创建一个自动化解决方案时，有一系列的基本任务。下图所示为大多数项目

需要执行的任务，并把这些任务分配到基本程序中。它会提示你与之相关的章节，因此你

可以很方便地在整个手册中查找与任务相关的信息。 
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安装STEP 7 

设计控制器组态和程序结构 

启动STEP 7并创建一个项目 

现在组态硬件码？ 

组态硬件和连接 
• 组态模板 
• 连网各个站 
• 组态与对方站的连接 

用符号编程替代绝对地址编程吗？ 

定义符号 

生成用户程序 
• 编程块 
• 在程序中调用块 
• 定义局域符号 

现在生成参考数据吗？（例如，为调试） 

生成参考数据 

选项 
• 编程报文 
• 为“操作员控制和监视”组态变量 

组态硬件和连接 

你是否已组态了硬件？ 

下载程序 

打印和存档 

测试程序并诊断错误 
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可选步骤 

如上图所示，你有两个可选步骤： 

• 先组态硬件然后编程块。 

• 也可以先编程块而不组态硬件。这种方法建议用于维修和维护工作，例如，集成编程

的块到一个已有的项目中。 

 

各个步骤的简要说明 

• 安装及授权 

第一次使用STEP 7时，要进行安装并将授权从磁盘传至硬盘（见“安装STEP 7”和“授

权”一节）。 

• 设计你的控制器 

在使用STEP 7之前，设计你的自动化解决方案。将过程分割为单个的任务以生成一个

组态图表（见“设计一个自动化项目的基本步骤”一节）。 

• 设计程序结构 

使用STEP 7中可用的块将你的控制器设计草案中所描述的任务转化为程序结构（见“用

户程序中的块”一节）。 

• 启动STEP 7 

从Windows用户界面启动STEP 7（见“启动STEP 7”一节）。 

• 创建一个项目结构 

项目就像一个文件夹，所有数据都以分层的结构存于其中，任何时候你都可以使用。

在创建了一个项目之后，所有其它任务都在这个项目下执行（见“项目结构”一节）。 

• 组态一个站 

组态一个站就是指定你要使用的可编程控制器；例如，SIMATIC 300、SIMATIC 400、

SIMATIC S5（见“插入站”一节）。 

• 组态硬件 

组态硬件就是在组态表中指定你的自动化解决方案所要使用的模板以及在用户程序中

以什么样的地址来访问这些模板。模板的特性也可以用参数进行赋值（见“组态硬件的

基本步骤”一节）。 

• 组态网络和通讯连接 

通讯的基础是预先组态网络。为此，要创建一个你的自动化网络所需要的子网，设置网

络特性，设置网络的连接特性以及任何连网的站所需要的通讯连接（见“组态子网的步

骤”一节）。 
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• 定义符号 

可以在符号表中定义局域或共享符号，在你的用户程序中用这些更具描述性的符号名

替代绝对地址。（见“生成一个符号表”一节）。 

• 创建程序 

用一种可供使用的编程语言创建一个与模板相连接或与模板无关的程序并以块、源文

件或图表的形式存储（见“生成逻辑块的基本步骤”和“编写STL源文件的基本信息”

两节）。 

• 只适于S7：生成并评估参考数据 

利用这些参考数据可以使用户程序的调试和修改更容易（见“可用参考数据概述”一

章）。 

• 组态报文 

你可以生成与块相关的报文，比如包括它们文本和属性。使用传送程序，可以将生成

的报文组态数据送至操作员接口系统数据库（例如SIMATIC WinCC。SIMATIC 

ProTool），（见“组态报文”一章）。 

• 组态操作员控制和监视变量 

在STEP 7中可以生成操作员控制和监视变量并赋予它们所需的属性。使用传送程序，

可以将生成的操作员控制和监视变量传至操作员接口系统WinCC的数据库（见“组态

操作员控制和监视变量”一节）。 

• 下载程序到可编程控制器 

只适于S7：完成所有的组态、参数赋值和编程任务之后，可以下载整个用户程序或其

中的单个块到可编程控制器（你的硬件解决方案的可编程模板）。（见“下载条件”

一节）。CPU已包含操作系统。  

只适于M7：从众多不同的操作系统中为你的自动化解决方案选择一个合适的操作系

统，将该操作系统单独地或与用户程序一起传至M7可编程控制系统所需要的数据存储

介质中。 

• 测试程序 

只适于S7：进行测试，可以显示来自你的用户程序的变量数值，也可以是来自CPU的。

对变量可以作赋值，为要显示或修改的变量生成一个变量表（见“用变量表进行测试

的介绍”一节）。  

只适于M7：使用高级语言测试工具，测试用户程序。 

• 监视操作，诊断硬件 

通过显示一个模板的在线信息，可以断定模板故障的原因。在诊断缓存区和堆栈内容

的帮助下，可以判定用户程序处理中错误的原因。还可以检查一个用户程序是否可以

在一个特定的CPU上运行（见“诊断硬件”和“显示模板信息”两节）。 
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• 制作设备文档 

在创建一个项目/设备后，为项目数据生成清楚的文档资料是非常有意义的，它使该项

目的进一步编辑以及维护操作更容易（见“打印项目文档”一节）。DOCPRO是用来

创建和管理设备文档的可选工具，使用该工具，你可以设计项目数据结构，译成接线

手册的形式，并以通用格式打印出来。 
 

特殊主题 

当你创建一个自动化解决方案时，有些特殊主题可能会令你感兴趣。  

• 多处理方式—多CPU的同步操作（见“多处理方式—多CPU的同步操作”一节） 

• 多用户工作在一个项目中（见“多用户编辑项目”一节） 

• 工作在M7系统（见“M7系统程序的方法”一节） 

 

1.2 STEP 7标准软件包 

 

使用标准 

STEP 7中集成的SIMATIC编程语言和语言表达方式，符合EN 61131-3或IEC 1131-3标准。

标准软件包运行在操作系统Windows 95/98/NT 4.0/2000/Me/XP下，并与Windows的图形

和面向对象的操作原理相匹配。 

 

标准软件包的功能 

标准软件支持自动任务创建过程的各个阶段，如： 

• 建立和管理项目 

• 对硬件和通讯作组态和参数赋值 

• 管理符号 

• 创建程序，例如为S7可编程控制器创建程序 

• 下载程序到可编程控制器 

• 测试自动化系统 

• 诊断设备故障 

STEP 7软件的用户接口，基于当前最新水平的人机控制工程设计，轻松使用。 

STEP 7软件产品手册在在线帮助和PDF格式电子手册中提供有所有在线信息。 
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STEP 7中的应用程序 

STEP 7标准软件包提供一系列的应用程序（工具）： 

 

      标准软件包 

 

 

 

 

 

无需分别打开各个工具；当选择相应功能或打开一个对象时，它们会自动启动。 

 

SIMATIC 管理器 

SIMATIC Manager（SIMATIC管理器）可以管理一个自动化项目的所有数据，无论是为哪

个可编程控制系统（S7/M7/C7）设计的。编辑所选数据所需要的工具由SIMATIC Manager

自行启动。 

 

符号编辑器 

硬件组态 

SIMATIC管理器 

      编程语言 
 LAD    FBD    STL 

NETPRO 
通讯组态 

硬件诊断 
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符号编辑器 

使用Symbol Editor（符号编辑器），可以管理所有的共享符号。具有以下功能： 

• 为过程信号（输入/输出）、位存储和块设定符号名和注释 

• 分类功能 

• 从/向其它的Windows程序导入/导出 

使用这个工具生成的符号表可供其它所有工具使用。因而，对一个符号特性的任何变化都

能自动被其它工具识别。 

 

诊断硬件 

这些功能可以向你提供可编程控制器的状态概况。这个概况中可以显示符号，指示每个模

板是否正常或有故障。双击故障模板，可以显示有关故障的详细信息。信息的范围视各个

模板而定： 

• 显示关于模板的一般信息（例如，定货号、版本、名称）以及模板状态（例如，故障） 

• 显示中央I/O和分布式从站的模板信息（例如，通道故障） 

• 显示来自诊断缓存区的报文 

对于CPU，还可显示以下附加信息： 

• 用户程序处理过程中的故障原因 

• 显示循环时间（最长的、最短的和最近一次的） 

• MPI的通讯可能性及负载 

• 显示性能数据（可能的输入/输出、位存储、计数器、定时器和块的数量） 

 

编程语言 

用于S7-300和S7-400的编程语言梯形逻辑图（Ladder Logic）、语句表（Statement List）

和功能块图（Function Block Diagram）都集成在一个标准软件包中。 

• 梯形逻辑图（或LAD）是STEP 7编程语言的图形表达方式。它的指令语法与一个继电

器的梯形逻辑图相似：当电信号通过各个触点、复合元件以及输出线圈时，使用梯形

图，可以追踪电信号在电源示意线之间的流动。 

• 语句表（或STL）是STEP 7编程语言的文本表达方式，与机器码相似。如果一个程序是

用语句表编写的，CPU执行程序时则按每一条指令一步一步地执行。为使编程更容易，

语句表已进行扩展，还包括一些高层语言结构（例如，结构数据的访问和块参数）。 

• 功能块图（FBD）是STEP 7编程语言的图形表达方式，使用与布尔代数相类似的逻辑

框来表达逻辑。复合功能（如数学功能）可用逻辑框相连直接表达。 

其它编程语言作为可选软件包使用。 
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硬件组态 

使用这个功能，可以为自动化项目的硬件进行组态和参数赋值。具有以下功能：  

• 组态可编程控制器时，可以从电子目录中选择一个机架，并在机架中将选中的模板，

安排在所需要的槽上。 

• 组态分布式I/O与组态中央I/O一致，也支持以通道为单位的I/O。 

• 在给CPU赋值参数的过程中，可以通过菜单的指导设置属性，比如，启动特性和循环

扫描时间监控。支持多处理方式。输入的数据保存在系统数据块中。 

• 在向模板作参数赋值过程中，所有可以设置的参数都是用对话框来设置的。没有任何

设置使用DIP开关。参数赋值向模板的传送是在CPU启动过程中自动完成的。这意味着，

例如，模板可以相互交换而无需赋值新的参数。 

• 功能模板（FM）和通讯处理器（CP）的参数赋值，与其它模板的赋值方法一样，也是

在硬件组态工具中完成的。对于每一个FM和CP，都有模板指定对话框和规则（包括在

FM/CP功能软件包范围内）。通过只在对话框中提供有效的选项，系统可以防止不正

确的输入。 

 

NetPro（网络组态） 

通过MPI，可以实现使用NetPro时间驱动的循环数据传送，只要你在这里： 

• 选择通讯的站 

• 在表中输入数据源和数据目标；自动生成要下载的所有块（SDB），并且自动完整地

下载到所有的CPU中。 

事件驱动的数据传送也是可以实现的，只要你在这里：  

• 设置通讯连接。 

• 从集成的块库中选择通讯或功能块。 

• 以你选择的编程语言为所选的通讯或功能块赋值参数。 
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1.3  STEP 7版本5.2中的新内容 

 

在线帮助 

点击STEP7在线帮助中的“Start page”图标以打开帮助信息。通过它可以打开以下主题： 

• STEP 7入门 

• 组态和编程 

• 测试和调试 

• Internet上的SIMATIC 

 

SIMATIC 管理器 

• 在SIMATIC管理器中，可以分布式地读/写各个项目的用户数据。 

• 通过菜单命令PLC > Compile and Download Objects可以很方便地将组态数据下载

到PLC中。它将对所选择的对象进行检查、编译并下载到CPU。 

• 所有项目数据都可输入到CPU的存储卡中（菜单命令PLC > Save to Memory Card和

PLC > Get from Memory Card）。 

• 用菜单命令Options > Manage Multilingual Texts > Settings for Handling 

Comments和Options > Manage Multilingual Texts > Rearrange可以根据需要设

定程序块的文本翻译，也可以在单个项目中改写多语言文本管理的数据库。 

• 当打开用STEP 7 V5.2编写的多重项目、项目或库时，如果你的系统没有安装创建它们

所使用的选项软件包时，系统会向您提示。当在SIMATIC管理器中选择了一个项目后，

通过Edit > Object Properties可以获得编写该项目所需选项软件包的概述。

“Required optional packages”表将显示所有所需的选项软件包的安装状态。 

• 在SIMATIC管理器中，“PLC”菜单按照主题分组更加清晰。 

• 在项目的对象属性页中，可以规定STEP 7或PCS 7的使用(在SIMATIC管理器中，首先

选择项目，然后通过Edit > Object Properties进入“General”表)。该项设定将特别为

STEP 7或PCS 7选择SIMATIC管理器中适用的功能。 

• 块比较功能得到了极大的改善。 
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编写LAD/STL/FBD块 

• 重新设计的LAD/STL/FBD程序编辑器用户界面分为概述窗口、块窗口和详细信息窗口。 

• 由于重新设计了变量声明表，变量声明的步骤有所变化。 

• 可通过按钮在程序段中直接修改和监视输入和存储位的变化和状态 (参见用程序编辑器

修改和监视变量)。 

• 当从一个块生成一个源文件时，将包含所有的报文数据和过程诊断组态数据以便重新

编译。 

• 通过Options > Customize > Source Text可以定义STL源文件的格式、字体和打印机

设定。 

• Options > Compare Online/Offline Partner可以显示块比较的结果，该块可以实在线

的或离线的。 

• 可直接在程序编辑器内修改和监视变量。 

• 块编辑器中很好地集成了过程诊断功能。 

• 绝对值或符号的地址优先级得到了极大的提高。 

• 数组编辑更加容易。 

• “Insert Symbols”命令现在可以选择数据块的局部变量和参数或单元。 

• 通过详细信息窗口可以快速访问交叉参考。 

• “Call Structure”可以显示STEP 7程序的块调用结构。 

 

数据块参数赋值 

“Parameter Assignment for Data Blocks”可以让您在LAD/STL/FBD程序编辑器外实现下

面功能： 

• 编辑和向PLC下在背景数据块的实际值，而不用装载整个数据块。 

• 在线监视背景数据块。 

• 使用S7_techparam系统特性可以方便地向背景数据块和多重背景进行参数赋值并进行

在线监视。 

参考数据 

• 程序结构也可作为独立结构显示。 

• 可以将参考数据导出到不同的文件中。 
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符号表 

• 调用菜单命令Edit > Special Object Properties > Direct Operator Control可以设置

输入和存储位的属性，以便可以方便、快捷地在程序编辑器中监视和修改这些地址。 

• 新的“Status”状态栏可以显示错误ID符号。 

• 以前对符号的最大限制为16380，而现在没有限制。 

 

监视和修改变量 

• 当打开变量表时应考虑地址优先。 

- 当“Symbol Comment”符号注释栏隐藏时，符号栏以短文形式显示符号注释。 

- 可以显示以红线表示的短文。 

- 变量表可以放大和缩小。 

- 可以显示强制值及其结果。 

 

组态和诊断硬件 

• 新型31xC CPU带有其它辅助功能，例如： 

- 读/写访问分布式数据(>4字节) 

- 在“DP Slave”模式中可以设置“Commissioning/Debug mode”选项来编辑PG

功能的性能。 

• 新版本的DP/PA Link支持DPV1模式。当插入DP/PA Link后，高层了DP主站自动使用该

模式。注意：当用一个新的DP/PA Link (157-0AA82) 替换现有的时，将改变从站的插

槽ID。 

• 在线调整识别数据： 

对于新的DP/PA Link(157-0AA82)以及用于其它S7-300信号模板的新型ET 200M接口

(153-2AA03)，可以使用菜单命令PLC > Upload Module Identification Data / .. 

Upload To PG命令来调整可改变的识别数据，例如工厂ID(变量)以及创建日期。可以

在块属性对话框的“Identification”表中组态这些识别数据。可以用PLC > Module 

Status显示组态数据。 

• 变量插槽的可视化： 

当从硬件目录选择一个模板后，在所有配置的机架中可插入该模板的插槽以彩色高亮

显示。该特性使您编制配置结构时更加快捷、方便。 

• 可插入模板的选择帮助： 

当选择完插槽后，点击右键，通过文本菜单打开一个可插入模板的清单Insert Object

或Replace Object。该特性可以保存通过硬件目录的搜寻结果。 
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• 在硬件配置中可以直接通过Internet地址察看模板的产品支持信息。可以得到有关模板

的常见问题回答或相关手册的产品信息。在硬件目录中或模板机架中选择所需的模板，

点击右键打开文本菜单Product Support Information即可得到。 

• 模板的安装顺序： 

在V5.2中，你可以有顺序地安装诸如新型S7-300 CPU或分布式I/O部件。通过Internet

下载以及安装可以得到更新的硬件信息(参见安装硬件更新)。  

• 在RUN模式下可以修改标准S7-400 CPU的系统操作，也就是说CPU将保持RUN模式，

保存最小间隔。 

• 可以使用模板时间或本地时间来指定诊断缓冲内的事件时间。 

• 通过新的诊断中继器(6ES7 972-0AB01)图形化显示PROFIBUS网络拓扑结构。 

• 在 SIMATIC 管 理 器 或 硬 件 配 置 中 ， 通 过 PLC > PROFIBUS > Diagnose, 

Monitor/Modify Node可以分布式模板，这样可以监视和修改输入/输入。 

• 通过PLC > Module Status可以调用所显示的硬件通道故障的帮助信息。对于通过GSD

文件集成的DP从站，可以调用设备诊断的帮助信息。 

• 可通过“Accessible Nodes”调用从站的模板状态。 

 

组态网络和连接?  

• 当工作在多项目时，你可以建立项目间的网络连接以及组态连接。 

• 在NetPro下可以导入和导出连接以及站数据，该特性适用于S7连接、冗余S7连接和PtP

连接。 

• NetPro在上传到PG后和自动合并连接。如果两个端点都存在，并且相应的通讯方可以

单独赋值，则在上传后，S7连接、PtP连接以及冗余S7连接可以定义或识别。 

• 当用OPC服务器操作时，可以在一个SIMATIC PC站和一个全局网络中的S7站建立S7

连接。 

 

组态报文 

• 你可以决定是否对项目或CPU分配报文号(在SIMATIC管理器中，选择Options > 

Customize并进入“Message Number”表)。对CPU分配报文号可以使其不会改变或

不用重新编译。如果要在HMI设备上显示报文，则需要对CPU分配报文号，以及使用

WinCC V6.0和/或ProTool V6.0应用软件。 

• 报文属性是统一的，而不需要规定使用设备。 

• 不再提供“Translate Text”功能，现在通过“Manage Multilingual Text”功能翻译用

户定义的文本。 
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• 可以建立用户定义的文本库。 

 

CPU报文 

• 在新的中断窗口中可以察看来自ALARM_S块的队列报文。  

• 在新的信息文本窗口中可以察看来自ALARM_S块的报文文本。 

• 你可以向调用模板状态诊断报文那样调用系统诊断报文。 

 

报告系统错误 

• “Report System Error（报告系统错误）”功能只适用于F系统。 

• 可以对用户块和诊断块定义绝对名以及符号名。 

• 当输入块名后，将返回现有块的接口参数。 

 

标准库 

• STEP 7 V5.2提供新的标准库“Miscellaneous Blocks”，该库包含从时间标签到TOD

同步功能的块。 

 

 

1.4  STEP 7标准软件包的扩展应用 

 

标准软件包可通过可选软件包进行扩展，这些可选软件包被分组为以下三个软件类别：  

• 工程工具（Engineering Tool）；这些是较高层次的编程语言和面向工艺的软件。 

• 运行版软件（Run-Time Software）； 这是用于生产过程的而无需架框的运行版软件。 

• 人机接口（Human Machine Interface，HMI）；这是特别用于操作员控制和监视的软

件。 

下表是可选软件，你可以根据你的可编程控制系统来选用： 
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  STEP 7  

 S7-300 
S7-400 

M7-300 
M7-400 

C7-620 

Engineering Tool    

·Borland C/C++  o  

·CFC +1） + +2） 

·DOCPRO + +3） + 

·HARDPRO +   

·M7 ProC/C++  o  

·S7 GRAPH +1）  +2） 

·S7 HiGraph +  + 

·S7 PDIAG +   

·S7 PLCSIM +  + 

·S7 SCL +  + 

·Teleservice + + + 

Run-Time Software    

·Fuzzy Control +  + 

·M7-DDE Server  +  

·M7-SYS RT  o  

·Modular PID Control +  + 

·PC-DDE Server +   

·PRODAVE MPI +   

·Standard PID Control +  + 

  Human Machine Interface    

·ProAgent    

·SIMATIC ProTool    

·SIMATIC ProTool/Lite   o 

·SIMATIC WinCC    

O = 必须的  

+ = 可选的 

1）=从S7-400以上建议使用 

2）= 对于C7-620不推荐 

3）= 不用于C程序 
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1.4.1 工程工具（Engineering Tool） 

工程工具（Engineering Tool）是面向任务的工具，可被用于扩展标准软件包。工程工具

（Engineering Tool）包括： 

• 供编程人员使用的高级语言。 

• 供技术人员使用的图形语言。 

• 用于诊断、模拟、远程维护、设备文档制作等的扩展软件。 

      工程工具 

 

 

 

 

 

 

 

 

 

 

高级语言 

下列语言作为可选软件包，用于SIMATIC S7-300/S7-400可编程控制器的编程： 

• S7 GRAPH是用于编程顺序控制（步和转换）的编程语言。在这种语言中，过程顺序被

分割为步。步中包含控制输出的动作。从一步到另一步的转换由转换条件控制。 

• S7 HiGraph是以状态图的形式描述异步、非顺序过程的编程语言。为此，系统要被分

解为几个功能单元，每个单元呈现不同的状态。各功能单元可通过在图形之间交换报

文来同步。 

• S7 SCL是符合EN 61131-3（IEC 1131-3）标准的高级文本语言。它包含的语言结构与

编程语言Pascal和C相类似。所以S7 SCL特别适合于习惯于使用高级编程语言的人使

用。例如，S7 SCL可以用于编程复杂或经常重复使用的功能。 

 

图形语言 

CFC是用于S7和M7的编程语言，用来以图形方式连接已有的功能。这些功能涵盖了从简

单的逻辑操作到复杂的闭环和开环控制等极为广泛的功能范围。大量的此种类型的功能在

库中以块的形式提供。编程时将这些块拷贝到图表中并用线连接。 

         高级语言 图形语言 

扩展软件 

  S7 SCL S7 GRAPH 

S7 HiGraph 
CFC 

M7 ProC/C++ 

TeleService 

S7 PDIAG 

DOCPRO  

S7 PLCSIM 

HARDPRO 
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扩展软件 

• Borland C++（只用于M7）包含Borland开发环境。 

• 使用DOCPRO，可以将你用STEP 7生成的全部组态数据构造为接线手册。这使得组态

数据的管理更为容易，并且可以为按照指定标准的打印准备好信息。 

• HARDPRO是S7-300硬件组态系统，它支持用户对复杂的自动化任务的大范围的组态。 

• M7-ProC/C++（只用于M7），允许将编程语言C和C++的Borland开发环境集成到STEP 

7的开发环境中。 

• 你可以使用S7 PLCSIM（只用于S7）模拟将S7可编程控制器连接到编程设备或PC，以

便进行测试。 

• 使用S7 PDIAG（只用于S7），可以标准化组态SIMATIC S7-300/S7-400过程诊断。使

用过程诊断，可以检测可编程控制器之外的故障和故障状态（例如，未到达限位开关）。 

• 使用TeleService，就可以使用编程设备或PC，通过电话网对S7和M7可编程控制器作

远程编程和服务。 

 

1.4.2  运行版软件 

运行版软件包括可以由用户程序调用的预编程的解决方案。运行版软件直接集成在自动化

解决方案中。它包括：  

• SIMATIC S7控制器，例如，标准模板，以及模糊控制。 

• 用于连接可编程控制器和Windows应用程序的工具。 

• SIMATIC M7的一个实时操作系统。 

 

     

 

 

 

 

 

 

 

 

控制器 

与Windows连接的工具  实时操作系统 

标准PID控制 模块化PID控制 模糊控制 

PRODAVE 

MPI 

M7-DDE  

server 
M7-SYS RT 

运行版软件 
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SIMATIC S7控制器 

• 使用标准PID控制，可以将连续控制器、脉冲控制器以及步进控制器集成到用户程序中。

使用带有集成控制器设置的参数赋值工具，可以让你在一个很短的时间内将控制器设

为最优使用。 

• 如果简单的PID控制器不足以解决你的自动化任务，则可以使用模块化PID控制。通过

在提供的标准功能块中作连接，几乎可以设计和建立任何控制结构。 

• 使用模糊控制可以生成模糊逻辑系统。当过程很难或无法用数学模型来描述；过程特

性不可预知；或者出现非线性；但具有过程运行的经验时，可以使用这种模糊系统。 

 

用于连接Windows的工具 

• PRODAVE MPI是用于SIMATIC S7、SIMATIC M7和SIMATIC C7之间过程数据通信的

工具箱。它通过多点接口（MPI）自行管理数据通信。 

• 使用M7-DDE服务器（动态数据交换），无需另外编程就可将Windows应用程序连接

到SIMATIC M7的过程变量。 

 

实时操作系统 

• M7-SYS RT包含M7 RMOS 32操作系统和系统程序。它是SIMATIC M7软件包使用 

M7-ProC/C++和CFC的前提条件。 

 

 

1.4.3 人机接口 

人机接口（HMI）是专门用于SIMATIC中操作员控制和监视的软件。 

• 开放的过程监视系统SIMATIC WinCC，是一个基本的操作员接口系统，它包括所有重

要的操作员控制和监视功能，这些功能可以用于任何工业系统和使用任何工艺。 

• SIMATIC Pro Tool和SIMATIC ProTool/Lite是用于组态SIMATIC操作员面板（OP）和

SIMATIC C7紧凑型设备的现代工具。 

• ProAgent通过建立有关故障原因和位置的信息可实现对系统和设备的有目的快速过程

诊断。 
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                    人机接口 

SIMATIC WinCC SIMATIC ProTool ProAgent 

SIMATIC ProTool/Lite 
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2  安装与授权 
 

2.1 授权 

你需要产品特别授权（用户权）以使用STEP 7编程软件。因此，本软件为拷贝保护设计，

并且仅当在相应的编程器或PC的硬盘上程序或软件包的相关授权被找到才能使用。 

例如，STEP 7与可选软件包，需要不同的授权。 

 

 

2.1.1 安装与取出授权 

 

授权磁盘 

在软件供货范围中，包括一张只读的授权磁盘。它含有实际授权。含有STEP 7 V5.2的

CD-ROM上的程序“AuthorsW”，用于显示、安装和取出授权。 

授权的数量由授权磁盘上的授权记数器决定。你每次安装一个授权，该记数器减“1”。当

记数器值到达“0”时，你不可能用这张磁盘再安装任何授权。 

 

提示 

你收到的黄色授权磁盘带有STEP 7标准软件的相应授权。  

对于可选软件包，你将收到一张带有为此的一个授权的红色授权磁盘。 

 

注意 

阅读授权磁盘上README.WRI文件中的提示和“Guidelines for Handling Authorizations”

中的准则。如果你不坚持这些准则，可能会不可补地丢失授权。 

 

没有授权，你也可以使用标准软件以便熟悉用户接口和功能。然而只有安装了授权才允许

有效地使用STEP 7工作。如果你还未安装授权，你将每隔一段时间被敦促安装它。 
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如果你丢失授权 

授权可能丢失，例如，如果硬盘出现故障并且你没有机会从故障的硬盘取出授权。 

如果你丢失授权，你可以使用紧急授权。它也包含在授权磁盘上。该紧急授权允许你继续

运行该软件一段有限时间。在这种情况下，在有效的时间超出之前，当你起动时屏幕上显

示出所剩的时间。在此期间你应获得丢失授权的替换授权。为此，与你当地西门子代表处

联系。 

 

提示 

当你安装紧急授权的同时，有效期即开始生效，即使你不起动STEP 7。即使你把授权写回

磁盘，紧急授权也不停止运行。 

 

安装AuthorsW 

用于显示、安装和取出授权的“AuthorsW”程序，也在含有STEP 7 V5.2的CD-ROM上。

你使用安装（Setup）程序把该程序安装在你的硬盘上，从这里你就可以用它进行授权操

作。 

 

提示 

AuthorsW程序的默认位置是START > SIMATIC > AuthorsW > AuthorsW。 

 

在你第一次安装时安装授权 

当第一次安装STEP 7软件时，当信息提示你安装授权时，你应按如下进行： 

1. 当提示时，把授权磁盘插入驱动器。 

2. 应答提示。 

3. 授权被传送到一个物理驱动器。 

 

安装授权的顺序 

在没有授权的情况下使用STEP 7软件，系统会给您一个警告提示。你可以稍候通过

AuthorsW安装授权。在线帮助中介绍了安装的详细信息。 

 

注意： 

在Windows NT/2000/XP下，只有安装在本机硬盘上并具有写访问状态时，才能运行授权。 
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2.1.2 管理授权的原则 

注意 

阅读本章中和授权盘上的“README.WRI”文件中的提示。如果你不坚持这些准则，可能

会不可补地丢失授权。 

 

什么时候需要取出授权? 

当你格式化、压缩或恢复你的硬盘之前，或当你安装新的操作系统之前，你必须取出任何

已有的授权。 

 

备份 

如果你备份含有授权拷贝的硬盘，当你把你备份的数据恢复到你的硬盘时，这些拷贝可能

会覆盖掉有效的授权，结果破坏了授权。 

为避免有效的授权被备份的拷贝覆盖，你必须如下去做：  

• 在你做备份拷贝之前取出所有授权。 

• 从备份中去掉授权。 

 

优化你的硬盘 

如果你使用能够提供移动固定数据块的优化程序，仅当你把所有的授权都从硬盘传送到授

权磁盘后才能使用。 

 

故障扇区 

当你安装授权时，目标盘上某磁道有时被标为“故障”。不要试图修理该磁道。否则你可

能会破坏授权。 

 

写保护和拷贝保护 

授权磁盘必须不是写保护的。 

可以拷贝授权磁盘上的文件到另一驱动器（例如，硬盘），并在那里使用。然而，不能使

用这些拷贝的文件授权，你需要原始的授权磁盘来授权。 

 

允许的驱动器 

只能把授权安装在硬盘上。对压缩的驱动器（例如，DBLSPACE），你可以把授权安装在

相应的主驱动器上。授权工具可以防止授权被安装在非法的驱动器上。 
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存贮位置 

当你安装授权时，授权文件存贮在带有“（System）系统”和“（Hidden）隐藏”属性

的保护子目录“AX NF ZZ”中。  

• 这些属性禁止改变。 

• 禁止修改或删除文件。 

• 禁止移动该子目录。从该子目录（授权）拷贝的文件，会被识别为故障，并且使授权

失效。 

否则，授权将不可恢复地丢失。 

保护的子目录“AX NF ZZ”在每个驱动器被生成一次，并包含安装在该驱动器上的所有授

权，当第一个授权被安装时，它就被生成，并当最后一个授权被取出时，被删除。 

对每个授权，将在该保护的子目录中，生成两个名字相同但扩展名不同的文件。这些文件

被给予同授权相同的名字。 

 

授权的数目 

只要存贮空间足够，用户可以在驱动器上安装任意多个自己所需要的授权，但是相同的版

本只能有一个授权（例如：STEP 7 V 4.x只能有一个、 STEP 7 V5.x只能有一个）。这些

授权彼此不会发生冲突。 

 

破坏的授权 

在硬盘驱动器上损坏的授权，不能被Authorsw程序删除。这些损坏的授权甚至有可能妨碍

用户安装新的及有效的授权。在这种情况下，请与当地西门子代表处联系。 

 

授权工具 

当前所用的授权工具AuthorsW版，比任何旧版本功能更强。 

 

提示 

如果使用V2.0版，不能识别所有旧的授权，在这种情况下，用户应使用更老的AUTHORS

版（DOS版）<V3.x以下的授权工具来工作。 
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2.2  安装STEP 7 

在STEP 7中，安装有Setup程序，使用该程序，可自动地进行安装。用户可按照屏幕弹出

的指南信息的引导，一步一步地完成整个安装步骤。用户可用标准的Windosw 95/98/NT

或Windows 2000/XP/Me软件安装功能，调用Setup程序。 

主要安装步骤：  

• 将数据拷贝到你的编程器上 

• 设置EPROM和通讯的驱动器 

• 输入ID号 

• 授权（如果需要） 

 

提示 

西门子编程器（如PG 740）已将STEP 7软件装在硬盘上，只需释放安装即可。 

 

安装要求 

• 操作系统：  

Microsoft Windosw 95，Windows98，Windows 2000，Windows NT，Windows XP或

Windows Me。 

• 基本硬件：  

编程器或PC： 

-  80486处理器以上（Windosw NT/2000/XP/Me要求奔腾处理器）和 

-  RAM：至少32 Mbyles，建议64 Mbytes 

-  Microsoft Windows 支持的彩色显示器、键盘和鼠标 

编程器（PG）是专门为在工业环境中使用而设计的个人计算机。它安装了用于SIMATIC可

编程序逻辑控制器编程时所需的一切。 

• 硬盘空间：  

请参考readme文件中提供的所需硬盘空间的要求。 

• MPI多点接口（可选）：  

如果用户需要在STEP 7中用多点接口（MPI）方式与可编程序逻辑控制器进行通讯，则在

编程器或PC与可编程序控制器之间只需要多点接口（MPI）。 
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因此，用户需要： 

-  在计算机的通讯口上连接PC/MPI电缆，或 

-  在计算机中安装MPI卡 

编程器中已经装有多点接口。 

• 外部接口（可选） 

如果用户希望在PC上为EPROM编程，则还需要一个外部接口。 

 

提示 

见README.WRI文件中的“安装STEP 7”的注意事项和“与STEP 7基本软件包兼容的 

SIMATIC软件包清单”。  

使用命令Start > Simatic > Product Notes，在“Start（开始）”菜单中，可以找到Readme

文件。  

使用命令Start > Simatic > Documentation，在“Start（开始）”菜单中，可以找到兼容

性列表。 

 

2.2.1 安装步骤 

安装准备 

在用户开始安装软件之前，必须先启动Windows 95/98/NT/2000/XP/Me。  

• 如果在用户编程器的硬盘上已装有STEP 7软件，则用户不再需要任何外部数据媒介。 

• 从磁盘上安装STEP 7时，应先将第1张盘插入到用户编程器或PC的软驱中。 

• 从光盘上安装时，要将光盘放入用户PC机的光驱中。 

 

开始安装程序 

按如下步骤安装软件： 

1. 插入磁盘（磁盘1）或光盘，双击文件“SETUP.EXE”，起动安装程序。 

2. 一步一步地按照安装程序所显示的指令进行。 

在整个安装过程中，安装程序一步一步地指导用户如何进行。在安装的任何阶段，用户都

可以切换到下一步或上一步。 

在安装过程中，在对话框中显示一些询问需要用户回答，还有一些选项需要用户选择。请

阅读下列提示，可帮助你既快又容易地回答一些安装访问。 
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如果已经安装了STEP 7的某一种版本... 

如果安装程序发现，在编程器上已有另一版本的STEP 7，它将报告该情况，并提示用户如

何进行：  

• 中断安装，以便用户可以将旧的STEP 7版本在Windows下卸载，然后，再开始安装。 

• 或者，继续安装，用新版本覆盖旧版本。 

如果用户在安装新版本之前，卸载旧版本，则用户软件能够较好地组织。使用新版本覆盖

旧版本有一个缺点，就是，如果以后做卸载时，旧版本中保留的部分，不能被删除。 

 

选择安装选项 

在用户选择安装范围时，有三种选项：  

• 标准组态：用于用户接口的所有语言、所有应用以及所有的举例。请参考最新产品信

息中对这种组态所要求的存储空间。 

• 最小组态：只有一种语言，没有举例。请参考最新产品信息中对这种组态所要求的存

储空间。 

• 用户定义组态：用户可定义安装范围，选择用户希望安装的程序、数据库、举例和通

讯功能。 

 

ID号码 

在安装的过程中，将提醒用户输入一个ID号码。要求输入的ID号码，可在软件产品证书中

或授权盘中找到。 

 

使用授权 

在安装过程中，安装程序将检查硬盘上是否有授权。如果没有发现授权，会出现一条信息，

指出该软件只能在有授权的情况下使用。如果用户愿意，可立即运行授权程序，或者继续

安装，稍后再执行授权程序。在前一种情况中，应插入授权盘。 

 

PG/PC接口设置 

在安装过程中，会出现一个对话框，在这个对话框中，用户可以设置PG/PC接口的参数。

用户可在“设置PG/PC接口（Setting the PG/PC Interface）”中找到更多信息。 

 

设置存储卡参数 

在安装过程中，会出现一个对话框，在这个对话框中，用户可以为存储卡分配参数。  

• 如果用户不用存储卡，则不需要EPROM驱动器.选择“NO ERROM Driver”选项。 
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• 否则，选择应用到你的编程器上的输入路径。 

• 如果用户使用的是PC，则可选择用于外部编程口的驱动器。这里，用户必须定义哪个

接口用于连接编程口（例如，LPT1）。 

在安装完成之后，用户可通过STEP 7程序组或控制面板中的“Memory Card Parameter 

Assignment（存储卡参数赋值）”，修改这些设置参数。 

 

闪存文件系统 

在为存储卡赋参数的对话框中，用户可以定义是否应安装闪存文件系统。 

例如，当用户需要在SIMATIC M7中向EPROM存贮卡中写入某些文件，或从EPROM存贮

卡中删除某些文件，同时，不改变存储卡中保留的内容时，就需要有闪存文件系统。 

如果用户使用某个适合的编程器（PG720/PG740/PG760）或用外部编程口，并且，希望使

用此功能，则选择闪存文件系统的安装。 

 

如果在安装过程中出现错误 

下列错误可能导致安装失败：  

• 如果在起动后，立即出现一个初始化错误，该程序很可能不能在Windows下起动。 

• 没有足够的存储空间：对于标准软件，不考虑用户安装的范围，在硬盘上至少需要

100Mbytes的空间。 

• 坏盘或坏光盘：如果盘是坏的，请与当地西门子代表处联系。 

• 操作员错误：重新安装，并仔细阅读各项指令。 

 

完成安装 

如果安装成功，会在屏幕上出条信息告知用户。 

如果在安装的过程中，改变了系统文件，将建议你重新起动Windows。当用户完成这些以

后，可以开始基本的STEP 7应用，SIMATIC管理器。 

一旦安装成功完成，会为STEP 7生成一个程序组。 

 
2.2.2 设置PG/PC接口 

通过这里所做的设置，用户可以设置编程器/PC与可编程序控制器之间的通讯连接。在安装

过程中，会出现一个对话框，在这个对话框中，用户可以设置PG/PC接口的参数。在安装

之后，用户可在STEP 7程序组中调用“Setting PG/PC接口”程序，显示该对话框。这将使

你在安装之后，可以改变接口参数。 
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基本程序 

为了对接口进行操作，用户需要如下步骤：  

• 在操作系统中设置 

• 适合的接口参数 

如果用户使用编程器并通过多点接口（MPI）进行连接，则不再需要其它的操作系统特别

适配方法。 

如果用户使用PC机和MPI卡或通讯处理器（CP），则应检查在Windows 中“Control Panel

（控制面板）”里的中断和地址设置，以确保没有中断冲突和地址区重叠。 

为了使向编程器/PC接口分配参数容易进行，在显示的对话框中提供一套预先定义的基本参

数（接口参数）供用户选择。 

 

为PG/PG接口分配参数 

为了设置模板参数，请按照下列步骤要点进行（可在在线帮助中找到详细描述）： 

双击“Control Panel（控制面板）”中的“Setting PG/PC Interface（设置PG/PC接口）”。 

将“Access Point of Application（应用访问点）”设置为“S7ONLINE。” 

在“Interface Parameter set used（所用接口参数集）”的表中，选择所需接口参数赋值。

如果没有显示你所需要的接口参数，用户必须用“Select（选择）”按钮先安装模板或协

议。然后，接口参数会自动生成。 

-  如果用户所选的接口能自动识别总线参数（例如：CP 5611），则用户可以直接将编程

器或PC至MPI或PROFIBUS上，而不需要设置总线参数。如果传输率小于187.5Kbps，在

读总线参数时，有可能有将近1分钟的延迟。自动识别条件：主站分配循环总线参数并连接

到总线上。所有与此有关的新MPI组件，必须使能总线参数的循环分配（缺省PROFIBUS

网络设置）。 

如果用户选择接口为不自动识别总线参数，则用户可以显示该属性，并将这些总线参数与

子网适配。 

如果与其它设置发生冲突，需要做必要的修改（例如，修改中断或地址的设置）。在这种

情况下，在Windows 的硬件组态和控制面板中做相应的修改（见下面）。 

 

注意 

禁止删除模板参数设置“TCP/IP”（如果“TCP/IP”参数出现的话）。它将防止其它应用

功能不会被修改。 
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检查中断和地址设置 

如果用户使用的是PC带有MPI卡，则应检查缺省设置的中断和地址区是否被占用，如果需

要，选择一个没被占用的中断和地址区。 

用户可在Windows95/98/Me下显示当前的设置，步骤如下： 

在“Contral Panel（控制面板）”中打开“ System（系统）”对话框，并选择“Device Manager

（设备管理器）”选项卡。 

在所显示的表中选中“Computer（计算机）”，并点击“Properties（属性）”按钮。 

在另一个对话框中，用户通过选择相应的选择按钮，可以显示所占用的中断列表（IRQ）

或所占用的地址区（I/O）。 

在Windows 95/98/Me下，可以按下述方法修改资源： 

在Device Manager内，从SIMATIC NET组中选择CP。 

在“Resources”中的“Properties”下更改资源。 

 

在Windows NT下，用户可以：  

• 在 Start > Programs > Administrative Tools(Common) > Windows NT 

Diagnostics > Resources下，显示资源设置。 

• 在PG/PC Interface > Install > Resources下，修改资源。 

在Windows 2000下，用户可以：  

• 在Control Panel > Administrative Tools > Computer Management > System 

Tools > System Information > Hardware Resources下，显示资源设置。 

• 在Control Panel > Administrative Tools > Computer Management > System 

Tools > Device Manager > SIMATIC NET > CP-Name > Properties > Resources

下，修改资源。 

在Windows XP下，用户可以：  

• 在Start > All Programs > Accessories > System > System programs > System 

Information > Hardware Resources，显示资源设置。 

• 在Control Panel > Desktop > Properties > Device Manager > SIMATIC NET > CP 

Name > Properties > Resources修改资源。 
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2.3 卸载STEP 7 

使用通常的Windows步骤来卸载STEP 7： 

在“Control Panel”中，双击“Add/Remove Programs”图标，启动Windows下用于安装

软件的对话框。 

在安装软件显示的项目表中，选择STEP 7。点击“Add/Remove（加入/删除软件）”按键。 

如果“Remove Enabled File（删除使能的文件）”对话框出现，如果用户不知如何回答，

则可点击“No”按键。 

 



安装与授权 

 

 

 
2-12 



设计自动化解决方案 

 3-1 

3  设计自动化解决方案 
 

3.1 设计一个自动化项目的基本步骤 

本章概述了为一个可编程控制器（PLC）设计一个自动化项目所涉及的基本任务。基于一

个自动工业搅拌过程示例的指导，将一步一步贯穿整个过程。 

设计一个自动化项目的方法有很多。可用于任何项目的基本步骤的说明如下图所示。 

 

 

 

3.2  将过程分割为任务和区域 

一个自动化过程包括许多单个的任务。通过识别一个过程内的相关任务组，然后将这些组

再分解为更小的任务，即使最复杂的过程也能够被定义。 

下面这个工业搅拌过程的例子可以用来说明如何将一个过程构造为功能区域和单个的任

务： 

 

 

 

 

 

将过程分割为各个任务 

说明每个区域 

定义安全要求 

说明所需要的操作员显示和控制 

生成你的可编程控制器的组态图 
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决定过程的区域 

在定义了要控制的过程之后，将项目分割成相关的组或区域： 

 

 

 

 

 

 

 

 

 

 

 

 

 

区域：配料A 

区域：配料B 

入口阀   进料泵   进料阀 区域：排料 

罐液位测量开关 

  搅拌电机 

区域：混合罐 

入口阀   进料泵   进料阀   流量传感器 

   入口阀   进料泵   进料阀   流量传感器

入口阀   进料泵   进料阀 

罐液位测量开关 

配料B 

配料A 

  搅拌电机 

示例：工业搅拌过程 
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由于每组被分为小任务，所以控制过程在这一部分所要求的任务就不那么复杂了。 

在我们的工业搅拌过程示例中，你可以看到四个不同的区域（见下表）。在这个例子中，

配料A的区域中包含的设备与配料B的区域相同。 

 

功能区域 使用的设备 

配料A 配料A的进料泵，配料A的入口阀，配料A的进料阀，配料A的流量传感器 

配料B 配料B的进料泵，配料B的入口阀，配料B的进料阀，配料B的流量传感器 

混合罐 搅拌电机，罐液位测量开关 

排料 排料阀 

 

3.3  说明各个功能区域 

当你说明过程中的各个区域和任务时，不仅要定义每个区域的操作，而且要定义控制该区

域的各种组件。这包括： 

• 每个任务的电的、机械的和逻辑的输入和输出 

• 各个任务的互锁和相关性 

本示例工业搅拌过程使用泵、电机和阀门。必须对这些设备作精确描述，以识别其操作特

性和操作过程所要求的互锁类型。下表提供的示例是对工业搅拌过程中使用的设备的描述。

完成说明后，还可以用它来订购所需要的设备。 

 

配料A/B：进料泵电机 

进料泵电机传送配料A和B到混合罐 

   - 流速：400升（100 加仑） /分钟 

   - 速率：1200 转/分时，100千瓦（134马力） 

泵由混合罐附近的操作员站控制（启动/停止）。启动的次数被计数以便进行维护。计数器和
显示都可以由一个按钮复位。 

对泵进行操作必须满足以下条件： 

   - 混合罐不满 

   - 混合罐的排料阀关闭 

   - 紧急关断未动作。 

如果满足下列条件，则泵被关断： 

   - 在泵电机启动7秒后流量传感器仍指示没有流量 

   - 流量传感器指示流动已停止 
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配料A/B：入口阀和进料阀 

配料A和B的入口阀和进料阀可以允许或防止配料进入混合槽。 

阀门是带有弹簧的螺线管 

   - 如果螺线管动作则送出阀打开。 

   - 如果螺线管不动作则送出阀关闭。 

入口阀和进料阀都由用户程序控制。 

满足以下条件，排料阀可以打开： 

   - 进料泵电机至少运行1秒。 

如果满足下列条件，则泵被关断： 

   - 流量传感器指示没有流量 

 
 

搅拌电机 

搅拌电机在混合罐中混合配料A和配料B 

   - 速率：1200 转/分时100千瓦（134马力） 

搅拌电机由混合罐附近的操作员站控制（启动/停止）。启动的次数被计数以便进行维护。计
数器和显示都可以由一个按钮复位。 

对泵进行操作必须满足以下条件： 

   - 罐液位传感器没有指示“罐液位低于最低限” 

   - 混合罐的排料阀是关闭的 

   - 紧急关断未动作： 

如果满足下列条件，则泵被关断： 

   - 在电机启动后的10秒内转速计未指示已达到额定速度 

 

 

排料阀 

排料阀让混合物排出（靠重力排出）到过程的下一阶段。阀门是带有弹簧的螺线管 

   - 如果螺线管动作则送出阀打开 

   - 如果螺线管不动作则送出阀关闭 

送出阀由一个操作员站控制（打开/关闭）。 

以下条件满足排料阀可以打开： 

   - 搅拌电机关断 

   - 罐液位传感器未指示“罐空” 

   - 紧急关断未动作： 

如果满足下列条件，则泵被关断： 

   - 罐液位传感器指示“罐空”。 

 
 

罐液位测量开关 

混合罐中的开关指示罐的液位高度关用来联锁进料泵和搅拌电机 
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3.4  列表输入，输出和入/出 

为每个要控制的设备写出物理说明后，为每个设备或任务区域画出输入和输出图。 

 

 

 

 

 

 

 

这个图相应于要编程的逻辑块。 

 

3.5  为电机生成一个 I/O 图 

在我们这个工业搅拌过程的例子中使用了两个进料泵和一个搅拌电机。每个电机由它自己

的“电机块”控制，而这个“电机块”对三个设备都是一样的。该块需要六个输入：两个

用于启动或停止电机，一个用于复位维护显示，一个用于电机的响应信号（电机运行/未运

行），一个用于运行期间必须接收的响应信号，一个用于流量时间的定时器的号码。 

逻辑块还需要4个输出：两个指示电机的操作状态，一个指示故障，一个指示电机应维护了。 

还需要一个入/出参数启动电机。它被用作控制电机但同时也在“电机块”的程序中被编辑

并修改。 

 

 

 

 

搅拌电机的“电机块”的I/O图 

输入/输出图            

设备

电机 
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3.6  为阀门创建一个 I/O 图 

每个阀由它自己的“阀门块”控制，该块对所有的阀都是一样的。该逻辑块有两个输入：

一个用来打开阀，一个用来关闭阀。它还有两个输出：一个用于指示阀是打开的，另一个

用于指示阀是关闭的。 

该块有一个入/出参数用于启动该阀。它被用作控制阀门但同时也在“阀门块”的程序中被

编辑和修改。 

 

 

 

 

 

 

 

 

 

3.7  建立安全要求 

根据法定的要求及公共健康和安全政策，决定为确保过程安全还需要哪些附加组件。在你

的描述中还应包括那些安全组件对你的过程区域的任何影响。 

 

定义安全要求 

确定哪些设备需要硬件接线电路以达到安全要求。通过定义，这些安全电路的操作独立于

可编程控制器之外（虽然安全电路通常提供一个I/O接口以便与用户程序相配合）。通常你

要组态一个矩阵来连接每一个执行器，这些执行器都有它自己的紧急断开范围。这个矩阵

是安全电路的电路图的基础。 

要设计安全机制可按如下进行：  

• 决定每个自动化任务之间逻辑的和机械的/电的互锁。 

• 设计电路使得属于过程的设备可以在紧急情况下手动操作。 

• 为过程的安全操作建立更进一步的安全要求。 

 

搅拌电机的阀门块的I/O图 

阀门 
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建立安全电路 

在工业搅拌过程示例中使用了以下逻辑作为它的安全电路：  

• 一个紧急断开开关可独立于可编程控制器（PLC）之外关掉以下设备： 

-  配料A的进料泵 

   -  配料B的进料泵 

   -  搅拌电机 

   -  阀门 

• 位于操作员站的紧急断开开关。 

• 一个用于指示紧急断开开关状态的控制器的输入。 

 

3.8  描述所需要的操作员显示和控制 

每个过程需要一个操作接口，使得操作人员能够对过程进行干预。设计技术规范的部分包

括操作员控制站的设计。 

 

定义操作员控制站 

在我们示例中所描述的工业搅拌过程，每个设备都可以由操作员控制站上的按钮来启动或

停止。这个操作员控制站包括用以指示操作状态的指示灯（见下图）。 
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操作站上还包括指示设备在经过一定次数的启动后需要维护的指示灯以及可以使过程立即

停止的紧急断开开关。操作站上还有用来复位三个电机的维护显示灯的按钮。用这个按钮

可以关断用于指示电机应进行维护的维护指示灯并将相应的计数器清零。 

 

 

 

 

 

 

复位 

   维护   维护   维

     紧急停机 
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3.9  生在一个组态图 

在制作了设计要求的文档后，还必须决定项目所需的控制设备的类型。 

通过决定使用什么样的模板也就指定了可编程控制器的结构。生成一个组态图指定以下方

面： 

• CPU类型 

• I/O模板的类型及数量 

• 物理输入和输出的组态 

下图所示为工业搅拌过程的S7组态的示例。 

 

操作员站 

工业搅拌过程 

急停电路 

数字输入
模板 

数字输出
模板 

数字输出
模板 
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4  设计程序结构基础 
 

4.1  CPU中的程序 

在一个CPU中，有两种不同的程序总会被执行：  

• 操作系统 

• 用户程序 

 

操作系统 

每个CPU都有一个操作系统，用以组织与特定的控制任务无关的CPU的功能和顺序。操作

系统的任务包括以下各项： 

• 处理暖起动和热起动 

• 刷新输入的过程映象表和输出的过程映象表 

• 调用用户程序 

• 检测中断并调用中断OB 

• 检测并处理错误 

• 管理存储区域 

• 与编程设备和其它通讯伙伴之间的通讯。 

如果修改了操作系统的参数（操作系统的缺省设置），则会影响CPU在某些区域的操作。 

 

用户程序 

你必须自己生成用户程序并下载到CPU。这个程序中包含处理你的特定的自动化任务所需

要的所有功能。用户程序的任务包括以下各项：  

• 指定在CPU上暖起动和热起动的条件（例如，带有某个特定值的初始化信号） 

• 处理过程数据（例如，二进制信号的逻辑组合、读入并处理模拟信号、为输出指定二

进制信号、输出模拟值） 

• 指定对中断的响应 

• 处理程序的正常运行中的干扰 
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4.2  用户程序中的块 

STEP 7编程软件允许结构化你的用户程序，也就是说可以将程序分解为单个的、自成体系

的程序部分。这样做有以下优势：  

• 大规模的程序更容易理解 

• 可以对单个的程序部分进行标准化 

• 程序组织简化 

• 程序修改更容易 

• 由于可以分别测试各个部分，查错更为简单 

• 系统的调试更容易 

工业搅拌过程的示例说明了将一个自动化过程分解为单个的任务的优越性。结构化的用户

程序的各个部分相应于这些单个的任务，就是大家所知的程序块。 

 

块类型 

在S7用户程序中有几种不同类型的块可以使用： 

 

块 功能的简要描述 还可参考 

组织块（O B） OB决定用户程序的结构 组织块和程序结构 

系统功能块（SFB）
系统功能（SFC） 

SFB和SFC集成在S7 CPU中可以让你访
问一些重要的系统功能 

系统功能块（SFB）和 系
统功能（SFC） 

功能块（FB） 
FB是带有“存储区域”的块，你可以自
己编程这个存储区域 

功能块（FB） 

功能（FC） FC中包含经常使用的功能的例行程序 功能（FC） 

背景数据块 

（背景DB） 
当一个FB/SFB被调用时，背景DB与该块
相关联，它们可在编译过程中自动生成 

背景数据块 

数据块（DB） 
DB是用于存储用户数据的数据区域，除
了指定给一个功能块的数据，还可以定义

可以被任何块使用的共享数据 
共享数据块（DB） 

OB、FB、SFB、FC和SFC都包含部分程序，因此也称作逻辑块。每种块类型所允许的块

的数量以及块的长度视CPU而定。 
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4.2.1  组织块和程序结构 

组织块（OB）是操作系统和用户程序之间的接口。它们由操作系统调用并控制循环和中断

驱动的程序的执行以及可编程控制器如何启动。它们还处理对错误的响应。通过编程组织

块，你可以指定CPU的反应。 

 

组织块的优先级 

组织块决定各个程序部分执行的顺序。一个OB的执行可以被另一个OB的调用而中断。哪

个OB可以中断其它OB，由它的优先级决定。高优先级的OB可以中断低优先级的OB。背

景OB的优先级最低。 

 

中断的类型和优先级 

导致OB被调用的事件就是所知的中断。下表显示了STEP 7中的中断类型以及分配给它们

的组织块的优先级。并非所有列出的组织块和它们的优先级适用于所有的S7 CPU（见

《S7-300可编程控制器、硬件和安装手册》以及《S7-400、M7-400可编程控制器模板技

术规范参考手册》）。 

中断类型 组织块 优先级（缺省） 参见 

主程序循环 OB1 1 用于循环程序处理的组织块（OB1） 

日时钟中断 OB10 至 OB17 2 日时钟中断组织块（OB10-OB17） 

时间延迟中断 OB20 
OB21 
OB22 
OB23 

3 
4 
5 
6 

时间延迟中断组织块（OB20-OB23） 

循环中断 OB30 
OB31 
OB32 
OB33 
OB34 
OB35 
OB36 
OB37 
OB38 

7 
8 
9 
10 
11 
12 
13 
14 
15 

循环中断组织块（OB30-OB38） 

硬件中断 OB40 
OB41 
OB42 
OB43 
OB44 
OB45 
OB46 
OB47 

16 
17 
18 
19 
20 
21 
22 
23 

硬件中断组织块（OB40-OB47） 
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中断类型 组织块 优先级（缺省） 参见 

DPV1中断 OB55 
OB56 
OB57 

2 
2 
2 

编程DPV1设备 

多处理器中断 OB60多处理器 25 多处理器 -多CPU的同步操作 

时钟中断 OB61 
OB62 
OB63 
OB64 

25  

冗余错误 OB70 I/O冗余错误
（只适用于H系统） 

OB72 CPU冗余错误
（只适用于H系统） 

25 
 
 
28 

故障处理级织块（OB70-OB87/ 
OB121-OB122） 

异步的故障 OB80时间错误 

OB81电源故障 

OB82诊断中断 

OB83插入/移走模板
中断 

OB84 CPU硬件故障 

OB85 程序循环错误 

OB86 机架故障 

OB87 通讯错误 

26 
（或者如果异
步错误OB存
在于启动程序

中则为28） 

故障处理组织块 

块（OB70-OB87/OB121-OB122） 

背景循环 OB90 291） 背景组织块（OB90） 

启动 OB100暖启动 

OB101热启动 

OB102冷启动 

27 
27 
27 

启动组织块 

（OB100/OB101/OB102） 

同步错误 OB121编程错误 

OB122访问错误 

引起错误的
OB的优先级 

故障处理组织块 

（OB70-OB87/OB121-OB122） 

1）优先级别29相应于优先级0.29。背景循环的优先级低于自由循环。 
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改变优先级 

用STEP 7可以对中断进行赋值参数，用参数赋值你可以，比如在参数块中不选中中断OB

或优先级：日时钟中断，时间延迟中断，循环中断和硬件中断。 

S7-300 CPU中组织块的优先级是固定的。 

对S7-400 CPU（以及CPU318），你可以用STEP 7修改以下组织块的优先级： 

• OB10至OB47 

• OB70至OB72（只适用于H CPU）以及OB81至OB87在RUN模式下。 

下列为允许的优先级： 

• 优先级2至23相应于OB10至OB47 

• 优先级25或28相应于OB70至OB72 

• 优先级26或28相应于OB81至OB87 

可以将同一个优先级分配给几个OB。具有相同优先级的OB的处理顺序是它们的启动事件

出现的顺序。 

由同步错误启动的故障OB被处理的优先级与错误出现时正在执行的块的优先级一样。 

 

局域数据 

生成逻辑块（OB、FC、FB）时可以声明临时局域数据。CPU上的局域数据区域按优先级

划分。 

在S7-400上，可以使用STEP 7在“优先级”参数块中改变每个优先级的局域数据的数量。 

 

OB的启动信息 

每个组织块都有20个字节局域数据的启动信息，这些信息是一个OB被启动时由操作系统提

供的。这些启动信息指定了OB的启动事件，OB启动的日期和时间，出现的错误及诊断事

件。 

例如，OB40是一个硬件中断OB，在它的启动信息中包含产生中断的模板地址。 

 

取消选定中断OB 

如果将优先级赋值为0，或分配少于20个字节的局域数据给某个优先级，则相应的中断OB

就被取消选定。对于取消选定的中断OB的处理有以下限定：  

• 在RUN模式下，它们可以被拷贝或连接到你的用户程序。 

• 在STOP模式下，它们可以被拷贝或连接到你的用户程序，但是当CPU进行暖启动时，

它们停止这个启动并在诊断缓存区中存入一个输入项。 
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通过取消选定你不需要的中断OB，可以增加可供使用的局域数据量，这可以被用来在其它

优先级中节省临时数据。 

 

循环程序处理 

循环程序处理是可编程控制器上程序执行的“普通”类型，这意味着操作系统在程序环（循

环）中运行，并且在主程序的每一个环中调用一次组织块OB1。OB1中的用户程序因此也

被循环执行。  

 

 
操作系统 

电源上电 

循环 

用户程序 

主程序 
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事件驱动的程序处理 

循环程序处理可以被某些事件中断。如果一个事件出现，当前正在执行的块在语句边界被

中断，并且另一个被分配给特定事件的组织块被调用。一旦该组织块执行结束，循环程序

将从断点处继续执行。 

 

 

 

 

 

 

 

 

 

 

 

 

这意味着部分用户程序可以不必循环处理，只在需要时处理。用户程序可以分割为“子程

序”，分布在不同的组织块中。如果用户程序是对一个重要信号的响应，这个信号出现的

次数相对较少（例如，用于测量罐中液位的一个限位传感器报警达到了最大上限），当这

个信号出现时，要处理的子程序就可以放在一个事件驱动处理的OB中。 

 

线性编程与结构化编程 

可以将整个用户程序写在OB1中（线性化编程）。只有在为S7-300编写简单程序并且需要

较少存储区域时，才建议使用这种方法。 

将复杂的自动化任务分解为能够反映过程的工艺、功能或可以反复使用的小任务时，控制

会更加容易。这些任务由相应的程序部分表示，即为所知的块（结构化编程）。 

 

 

 

 

 

 

启动程序 

操作系统 用户程序 

电源上电 

循环 
主程序 

中断 

错误 

中断 

中断 

中断程序 

错误处理 
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4.2.2  用户程序中调用的分层结构 

为使用户程序工作，组成用户程序的块必须被调用。使用特殊的STEP 7指令可以实现块调

用，块调用的指令只能在逻辑块中编写和启动。 

 

顺序和嵌套深度 

块调用的顺序和嵌套深度即是所谓的调用分层结构。可以嵌套调用的块的数量（嵌套深度）

依据特定的CPU而定。下图所示为一个循环周期内块调用的顺序和嵌套深度。 

 

线性化编程 结构化编程 

  
  

  
操

 作
 系

 统
 

循环开始 

背景DB1 

背景DB2 背景DB1 

嵌套深度 
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创建块的一套顺序：  

• 创建块应从上到下，所以你应从最上行的块开始。 

• 每个被调用的块应已经存在，即在块的一行中应按从右向左的顺序创建它们。 

• 最后创建的块是OB1。 

将这些规则用于上图示例的练习，就产生以下块创建的顺序： 

FC1>FB1+背景DB1>DB1>SFC1>FB2+背景DB2>OB1 

提示 

如果嵌套太深（层次太多），局域数据堆栈会溢出（又见局域数据堆栈）。 

 

块调用 

下图所示是在一个用户程序中块调用的顺序。程序调用第二个块，这个块的指令则完全被

执行。一旦第二个块或者说这个被调用的块执行结束，由于执行调用指令而被中断的块的

执行，将从块调用指令后面继续。 

 

 

 

 

 

 

 

 

在编程一个块之前，必须指定你的程序将使用哪些数据，也就是说，必须声明块的变量。 

提示 

必须为每个块调用说明OUT参数。 

 

提示 

当执行冷启动时，操作系统复位SFB3“TP”的背景。如果你想在一个冷启动之后，初始

化这个SFB的背景，必须通过OB100用PT=0调用该SFB的相关背景。例如，你可以通过在

一个包含该SFB背景的块中执行一个初始化例行程序来实现这一步。 

调用块 (OB, FB, FC) 被调用块 (FB,FC,SFB,或SFC) 

程序执行 

调用其它块的指令 

块结束 
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4.2.3  块类型 

4.2.3.1 用于循环程序处理的组织块（OB1） 

在可编程控制器上循环程序处理是程序执行的“普通”类型。操作系统循环调用OB1并用

这个调用启动用户程序的循环执行。  

 

循环程序执行的顺序 

下表所示为循环程序处理的各个阶段： 

步骤 10/98以前的CPU中的顺序 在新CPU中的顺序（10/98以后） 

1． 操作系统启动循环监控时间 操作系统启动循环监控时间 

2． CPU读输入模板的输入状态并刷新输入
的过程映象表 

CPU从输出的过程映象表写数值到输出
模板 

3． CPU处理用户程序并执行程序中所包含
的指令 

CPU读输入模板的输入状态并刷新输入
的过程映象表 

4． CPU从输出的过程映象表写数值到输出
模板 

CPU处理用户程序并执行程序中所包含
的指令 

5． 在循环结束处，操作系统执行所有挂起的
任务，例如，下载和删除块，接收和发送
全局数据 

在循环结束处，操作系统执行所有挂起的
任务，如下载和删除块，接收和发送全局
数据 

6． 最后，CPU回到循环开始处并重新启动循
环监控时间 

最后，CPU回到循环开始处并重新启动循
环监控时间 

 

过程映象 

所以在循环程序处理过程中，CPU的过程信号映象是一致的。CPU并不直接访问I/O模板上

的输入（I）和输出（Q）地址区域，而是访问一个CPU内部的存储区域，该区域中包含输

入和输出的映象。 

 

编程循环程序处理 

你可以通过使用STEP 7在OB1中编写你的用户程序以及在OB1调用的块中编写程序来编

程循环程序处理。 

启动程序无错执行一结束，循环程序处理就立即开始。 
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中断 

循环程序处理可以被以下事件中断：  

• 一个中断 

• STOP命令（模式选择开关，编程器上的菜单选项，SFC46 STP，SFB20 STOP） 

• 电源掉电 

• 出现故障或编程错误 

 

扫描循环时间 

扫描循环时间是操作系统运行循环程序和中断循环的所有程序部分（例如，执行其它组织

块）以及系统操作（如，刷新过程映象）所需要的时间。这个时间被监控。 

每个循环的循环扫描时间（TC）并不相同。下图所示为已有的CPU和新CPU之间不同的扫

描循环时间（TC1≠TC2）： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

新CPU(10/98以后)的不同扫描

当前循环 下一个循环 下一个循环 

更新过程映相 
输入表 

更新过程映相 
输入表 

更新过程映相 
输出表 

更新过程映相 
输出表 

更新过程映相 
输出表 

到10/98的CPU的不同扫描循环时间 

当前循环 下一个循环 下一个循环 

更新过程映相 
输入表 

更新过程映相 
输入表 

更新过程映相 
输出表 

更新过程映相 
输出表 

更新过程映相 
输入表 
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循环监视时间 

使用STEP 7，可以修改缺省的最大循环监视时间。如果这个时间超出，CPU转为STOP模

式或调用OB80，在OB80中你可以指定CPU如何响应这个故障。 

 

最小循环时间 

使用STEP 7，可以为S7-400 CPU和CPU318设置最小循环时间。在以下情形下这个功能是

有用的： 

• 当OB1（主程序扫描）程序执行的启动时间间隔必须一致时，或者 

• 如果循环时间太短，过程映象表的刷新没必要过于频繁。 

下图所示为已有的CPU和新CPU中程序处理过程中的循环监控时间的功能。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

             

 

 

到10/98的CPU的循环监控时间 

当前循环 下一循环 

更新过程映
相输出表 

更新过程映
相输入表 

更新过程映
相输入表 

可以设置的最大循环时间 
可以设置的最小循环时间 
实际扫描循环时间 
Tmin与实际扫描时间的差 
优先级 
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刷新过程映象 

在CPU的循环程序处理过程中，过程映象被自动刷新。对于S7 400 CPU以及CPU 318，你

可以刷新过程映象，如果你要：  

• 直接访问I/O或者 

• 用系统功能SFC26 UPDAT_PI和SFC27 UPDAT_PO在程序的不同点刷新一个或多个过

程映象的输入或输出部分。 

 

通讯负载 

你可以使用CPU参数“Scan Cycle Load from Communication（通讯扫描循环负载）”，

在给定框架内控制通讯过程的持续时间，一般总为增加扫描循环时间。通讯过程举例包括

以MPI方式将数据传送至其它CPU，或使用编程器加载块。 

该参数很少影响编程器测试功能。但是，你可以显著增加描述时间。在过程模式中，你可

以限制测试功能的时间（只适用于S7-300）。 

 

 

 

10/98后的CPU的循环监控时间 

当前循环 下一循环 

更新过程映
相输出表 

更新过程映
相输入表 

更新过程映
相输出表 

可以设置的最大循环时间 
可以设置的最小循环时间 
实际扫描循环时间 
Tmin与实际扫描时间的差 
 
优先级 
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参数的工作原理 

CPU操作系统可连续提供整个CPU处理能力的通讯组态百分比（时间段技术）。如果通讯

时不需要处理功能，可用于其它处理。 

 

设置扫描循环时间 

无需其它异步事件，OB1扫描循环时间可以根据以下公式乘以一个系数进行计算： 

 

 

 

举例1（无其它异步事件）： 

如果你设定通讯循环加载50％，OB1循环时间将加倍。 

同时，OB1扫描循环时间还会受到异步事件的影响（例如硬件中断或循环中断）。据统计，

由于扫描循环时间通讯部分的扩展，在OB1扫描循环时间内将有更多异步事件发生。这会

导致OB2扫描循环的额外增加。这种增加取决于每个OB1扫描循环时间发生的事件数量以

及事件处理时间。 

举例2（考虑其它异步事件）： 

对于一个执行时间为500ms的OB1来说，50％的通讯负载将会导致实际扫描循环时间为

1000ms（CPU总是有足够的通讯作业要处理）。除此之外，每100ms将执行一次处理时

间为20ms的循环中断，这种循环中断会增加扫描循环 5*20 ms = 100 ms，无通讯负载。

即，实际扫描循环时间将为 600 ms。由于一个循环中断也会中断通讯，因此50％的通讯

负载会增加扫描循环时间10 * 20 ms，即，在这种情况下，实际扫描循环时间为1200 ms，

而不是1000 ms。 

 

提示 

• 检查系统运行时“通讯循环负载”参数的改变效果。 

• 在设置最小扫描循环时间时要考虑通讯负载，否则会出现时间错误。 

 

建议 

• 如果可能的话，使用缺省值。  

• 只有将CPU用于通讯目的，并且用户程序没有时间限制，才能增加该数值。 

• 否则，应降低该数值。 

• 设定过程模式（只适用于S7-300），限制测试功能所需时间。 

100 

100 – 通讯扫描循环负载 (％) 
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4.2.3.2 功能（FC） 

功能（FC）属于你自己编程的块。功能是“无存储区”的逻辑块。FC的临时变量存储在局

域数据堆栈中。当FC执行结束后，这些数据就丢失了。要将这些数据永久存储，功能也可

以使用共享数据块。 

由于FC没有它自己的存储区，所以你必须为它指定实际参数。不能够为一个FC的局域数据

分配初始值。 

 

应用程序 

一个FC包含一个程序部分，当FC被不同的逻辑块调用时，这些程序总会被执行。可为以下

目的使用功能：  

• 为调用块返回一个功能值（例如：数学功能） 

• 要执行一个工艺功能（例如：使用位逻辑操作的单控制功能）。 

 

将实际参数赋值给形式参数 

形式参数是“实际”参数的虚名称。当该功能调用时，用实际参数替代形式参数。对于FC

来说，形式参数总是必须赋给实际参数（例如：将实参“I 3.6”赋值给形参“Start”）。

在FC中使用的参数类型：输入、输出和输入/输出参数存做指针，指向调用FC的逻辑块的

实际参数。 

 

FC和FB输出参数的主要区别 

在功能块中，当访问参数时使用背景数据块中的实际参数的拷贝参数。当调用FB时，如果

没有传送输入参数或没有写输出参数，则背景数据块中将始终使用以前的值。 

功能没有存储器，与FB对比，不可以选择对FC的形参赋值。通过寻址来访问FC的参数。

当数据块的一个地址或调用块的局部变量作为实际参数时，则将一个复制的实际参数存储

到调用块的局部数据区，用它来传送数据。 

 

注意： 

在这种情况下，如果没有向FC的输出参数写入一个数据，则将输出一个随机值。 

由于作为复制数据所保留的调用块的局部数据区没有赋值到输出参数，所有该区没有写入

任何数据。因此将输出存储在该区域的随机值，因为局部数据不能自动地设置为0。 
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因此，请遵守下列准则： 

• 如果可能，对输出参数初始化。 

• 根据RLO执行置位和复位指令。当这些指令用来决定输出参数的值时，如果前一次的

逻辑运算RLO=0，则不会生成数值。 

• 确保写到输出参数中的数据与块中的任何程序路径无关。要特别注意跳转指令、LAD

和FBD中的ENO输出指令、BEC指令以及影响MCR指令。 

注意： 

尽管一个FB的OUTPUT参数或FC和FB的INPUT参数不输出随机值(即使向参数写入数据，

将保持旧值或输入值作为输出值)，也应该遵守上述规则，以避免无意中对“旧”值进行处

理。 

 

4.2.3.3 功能块（FB） 

功能块（FB）属于用户自己编程的块。。功能块是具有“存储功能”的块。用数据块作为

功能块的存储器（背景数据块）。传递给FB的参数和静态变量存在背景数据块中。临时变

量存在本地数据堆栈中。  

当FB执行结束时，存在背景DB中的数据不会丢失。可是，当FB的执行结束时、存在本地

数据堆栈中的数据将丢失。 

 

提示 

为避免工作在FB时出现错误，当在附录中选择参数时，去读允许的数据类型。 

 

应用程序 

FB中所含的程序总是当不同的逻辑块调用该FB时执行。功能块使得对于经常使用的功能、

复杂功能的编程变得容易。 

 

功能块和背景数据块 

每次功能块的调用都将赋给一个背景数据块，用于传递参数。 

多次调用某一FB，可以有多个背景，用户可以用一个FB控制多台设备。例如，一个用于电

机控制的FB，可以通过对每个不同的电机，使用不用的背景数据集，来控制多台电机。每

台电机的数据（例如：转速、爬升、累积运行时间等），可存在一个或多个背景DB中。 
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下图所示为FB的形参用实参赋值后并存在背景DB中的情况。 

 

 

 

 

 

 

 

 

 

数据类型FB的变量 

如果用户程序是结构化的，则在FB中又调用了另一个已经存在的功能块，用户可在调用FB

的变量定义表中将被调FB作为数据类型FB的静态变量。该项技巧允许用户嵌套变量，并将

背景数据压缩在一个背景数据块（多重背景）中。 

 

将实际参数赋值给形式参数 

在STEP 7中，对于FB通常不是必须将实际参数赋值给形参。可是，下列情况除外，对以下

形参必须赋实参： 

• 对于复杂数据类型（如：字符串（STRING），数组（ARRAY）或日期与时间

（DATE__AND__TIME）的输入/输出类型参数。 

• 对于所有的参数类型（例如，定时器（TIMER）、计数器（COUNTER）或指针（POINTER）。 

对于下列情况，STEP 7会将实际参数赋值给FB的形式参数：  

• 当用户在调用语句中定义了实际参数时：FB的指令用所提供的实参。 

• 当用户在调用语句中没有定义实际参数：FB的指令用存在背景DB中的值。 

下表所示为哪些FB的变量必须赋实参。 

 

变  量  数据类型  

 基本数据类型 复杂数据类型 参数类型 

输入 无实参要求 无实参要求 有实参要求 

输出 无实参要求 无实参要求 有实参要求 

输入/输出 无实参要求 有实参要求 -- 

 

形式参数 实际参数 
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给形式参数赋初值 

在FB的定义表中，用户可给形式参数赋初值。这些值将写入与FB相关的背景DB中。 

如果用户在调用语句中，没有给形参赋实参，则STEP 7将使用存在背景DB中的值。这些

值也可作为初值输入到FB的变量定义表中。 

下表所示为哪些变量可以赋初值。由于临时数据在该块执行完后将丢失，所以用户不能给

它们赋任何值。 

 

变  量  数据类型  

 基本数据类型 复杂数据类型 参数类型 

输入 允许有初值 允许有初值 -- 

输出 允许有初值 允许有初值 -- 

输入/输出 允许有初值 -- -- 

静态 允许有初值 允许有初值 -- 

临时 -- -- -- 

 

4.2.3.4  背景数据块 

每次功能块的调用都将赋给一个背景数据块，用于传递参数。FB的实际参数和静态数据存

在背景DB中。在FB中定义的变量，决定背景数据块的结构。背景意味着一次功能块调用。

例如，如果在S7用户程序中某个功能块被调用了五次，则该块有五个背景。 

 

生成一个背景DB 

在用户生成一个背景数据块之前，相应的FB必须已经存在。当用户生成背景数据块时，必

须指定所属FB的序号。 

 

每次不同的背景用一个背景DB 

如果用户将多个背景数据块分配给某个控制电机的功能块（FB），则用户可用该FB去控制

多个不同的电机。 

描述电机的各项数据（例如：转速、升速时间、整个操作时间），存在不同的数据块中，

当FB调用时，相应的DB决定哪个电机被控制。根据该项技巧，控制多台电机只需一个功

能块（参看下图）。 
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一个背景DB用于某个FB的多次背景（多重背景） 

用户也可以将多个电机的背景数据同时传递到一个背景DB。为此，用户必须增加一个FB

来管理电机控制器的多次调用，并且，在调用FB的定义表中用数据类型FB的静态变量定义

每个背景。 

如果用户只用一个背景DB存放某个FB的多次背景，则节约了存储空间，并能最优地使用

数据块。 

在下图中，调用FB是FB21“电机控制”，变量为数据类型FB22，不同的背景用“Motor-1”、

“Motor-2”和“Motor-3”标识。 

在这个例子中，FB22不需要自己的背景数据块，因为它的背景数据存在调用FB的背景数

据块中。 

 

一个背景DB用于不同FB的多次背景（多重背景） 

在一个功能块中，用户可以调用其它已经存在的FB的背景。为此，用户可以将所需的背景

数据赋值到调用FB的背景数据块中，这就意味着，在这种情况中，用户不需要为被调FB

增加任何数据块。 

DB201: Motor_1

DB202: Motor_2

DB203: Motor_3

FB22: Motors 

用电机1的数据调用
FB22，DB201 

用电机2的数据调用
FB22，DB202 

用电机3的数据调用
FB22，DB203 
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为了将这些多重背景在一个背景数据块中实现，用户必须在调用功能块的定义表部分，为

每次独立的背景定义一个被调功能块数据类型的静态变量。在功能块内部的调用，则不再

需要背景数据块，只需要变量的符号名。 

下图示例中，赋值的背景数据存在一个共同的背景DB中。 

 

4.2.3.5 共享数据块（DB） 

与逻辑块不同，在数据块中没有STEP 7的指令。它们用于存放用户数据，换句话说，数据

块中存放用户程序工作时所需的变量数据。共享数据块用于存放所有其它块都可以访问的

用户数据。 

DB的大小可以不同。关于所允许的最大尺寸，请参考用户所用CPU的描述。 

用户可以用任意方式来建立数据块的结构，以适合其不同的需求。 

 

在用户程序中的共享数据块 

如果某个逻辑块（FC，FB或OB）被调用，则它可以临时占用局域数据区的空间（L堆栈）。

除了这个局域数据区，逻辑块还可以打开一个DB形式的存储区。与局域数据区中的数据不

同，在DB中的数据当DB关闭时，换句话说，当相应的逻辑块结束时，不会不删除。 

每个FB、FC或OB可从共享DB中读取数据，或将数据写入共享DB。当该DB退出时，这些

数据保持在DB中。 
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一个共享DB和一个背景DB可同时打开。下图所示为访问数据块的不同方法。 

 

 

 

 

 

 

 

 

4.2.3.6 系统功能块（SFB）和系统功能（SFC） 

已经编好程序的块 

用户不需要每个功能都自己编程。S7 CPU为用户提供了一些已经编好程序的块，这些块可

在用户程序中进行调用。 

在系统功能块和系统功能中的参考帮助中可找到进一步的信息（跳转到语言描述，和有关

块的在线帮助以及系统属性）。 

 

系统功能块 

系统功能块（SFB）是集成在S7 CPU中的功能块。SFB作为操作系统的一部分，不占用户

程序空间。与FB相同，SFB也是“具有存储能力”的块。用户也必须为SFB生成背景数据

块，并将其下载到CPU中作为用户程序的一部分。 

S7 CPU提供下列SFB： 

• 通过组态连接用于通讯目的。 

• 集成的特殊功能（例如：CPU 312 IFM 和CPU 314I FM上的 SFB 29“HS_COUNT”）。 

 

系统功能 

系统功能是集成在S7 CPU中预先编好程序并通过测试的功能。可在用户程序中调用SFC。

SFC属于操作系统的一部分，而不算做用户程序的一部分。与FC相同，SFC是“不具有存

储能力”的块。 

 

共享DB 
（DB 20） 

背景DB 
（DB 122） 

 
所有的块都能访问 

 
只允许FB 12访问 
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S7 CPU提供以下功能：  

• 复制及块功能 

• 检查程序 

• 处理时钟和在线运行仪表 

• 传递数据集 

• 在多CPU状态中将事件从一个CPU传到所有其它的CPU中 

• 处理日期时间中断和延时中断 

• 处理同步错误、中断错误和异步错误 

• 有关静态和动态系统数据的信息，例如：诊断 

• 过程映象刷新和位域处理 

• 寻址模板 

• 分布式I/O 

• 全局数据通讯 

• 非组态连接的通讯 

• 生成块相关信息 

 

其它信息 

有关SFB和SFC更详细的信息，请参考《S7-300和S7-400系统软件，系统和标准功能》参

考手册，《S7-300可编程序控制器，硬件和安装手册》以及《S7-400，M7-400可编程序

控制器模板特性参考手册》中关于SFB和SFC的解答。 

 

 

4.2.4 用于中断程序处理的组织块 

根据所提供的中断OB，S7 CPU允许如下中断： 

• 可按照一定的时间或间隔来执行某一部分程序（时间中断）。 

• 用户程序可对过程中的外部信号进行响应。 

循环执行的用户程序不需要查询是否有中断事件发生。如果有中断请求，操作系统确保执

行在相应的中断OB中的程序，这就使得可编程序逻辑控制器对于中断，可以编程进行响应。 
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中断类型与应用 

下表所示为如何使用不同类型的中断。 

中断类型 中断OB 应用举例 

日期时间中断 OB10到OB17 在一个班结束时，计算一下混合流量控制的整个流量。 

延时中断 OB20到O B23 控制风扇：当电机关掉之后20秒时，风扇必须运行。 

循环中断 OB30到OB38 对于闭环控制系统，信号的定时采样。 

硬件中断 OB40到OB47 当罐的最高上限达到时、产生报警信号 

 

4.2.4.1 日时钟中断组织块（OB10-OB17） 

S7 CPU提供日期时间中断OB，这些OB在特定的日期和时间或以一定间隔由操作系统调用

执行。 

日期时间中断可按如下方式触发： 

• 在某特定时间（用绝对形式定义日期时间）执行一次。 

• 从特定的时间开始并按中断应重复的间隔（例如：每分钟、每小时、每天）周期地执

行。 

 

日期时间中断规则 

日期时间中断只有当该中断设置了参数，并且在相应的组织块中有用户程序存在时才能被

执行。如果与上述情况不符，则操作系统会诊断缓存器中输入一个错误信息，并执行异步

错误处理（OB80，请参看错误处理组织块（OB70到OB87/OB121到OB122））。 

周期的日期时间中断必须对应一个实际日期。从一月三十一日开始每月重复OB10是不可能

的。在这种情况下，该OB将只在有31天的那个月起动。 

日期时间中断在PLC起动时（暖起动或热起动）激活，而且，只能在PLC起动过程结束之

后，才能执行。 

在参数设置时，没有选中的日期时间中断不能起动。CPU认为这是一个编程错误，将进入

到停机状态。 

暖起动之后，日期时间中断必须重新设置（例如，在PLC起动程序中用SFC30 ACT_TINT）。 

 

起动日期时间中断 

为了让CPU起动日期时间中断，用户必须首先设置日期时间中断，然后再激活它。起动该

中断有以下三种方法：  
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• 通过STEP 7中设置相应的参数（“日期时间中断”参数块），实现日期时间中断的自

动起动。 

• 在用户程序中用SFC28 SET_TINT和SFC 30 ACT_TINT，设置并激活日期时间中断。 

• 用STEP 7的参数设置日期时间中断，在用户程序中用SFC 30 ACT_TINT激活日期时间

中断。 

 

查询日期时间中断 

要想查询设置了哪些日期时间中断，以及这些中断什么时间发生，用户可选用下列方法之

一：  

• 调用SFC 31 QRY_TINT。 

• 请求系统状态表的“中断状态”表。 

 

终止日期时间中断 

用SFC 29 CAN_TINT，用户可以取消那些还没有执行的日期时间中断。用SFC 28 SET_TINT

可以重新设置那些被终止的日期时间中断，并可用SF以30 ACT_TINT重新激活它们。 

 

日期时间中断OB 

所有八个日期时间中断OB具有相同的预置优先级（2），因此，它们的优先级是按起动事

件发生的顺序进行处理的。可是，用户可以通过选择适当的参数来改变优先级。 

 

改变设置时间 

用户可以用如下方法改变中断的日期时间设置：  

• 用主时钟同步主站和从站的时间。 

• 在用户程序中可以调用SFC0 SET_CLK设置一个新的时间。 

 

改变时间的响应 

下表所示为日期时间中断在时间已经改变之后，是如何反应的。 

如果⋯ 则⋯ 

如果时间向前挪动，并且有一个或多个日期时
间中断已经跳过 

起动OB80，那些跳过的日期时间中断输入到
OB80的起动信息中 

用户没有终止在OB80中跳过的日期时间中断 跳过的那些日期时间中断，将不再执行 

用户还没有终止在OB80中跳过的日期时间中
断 

第一个跳过的日期时间中断执行。其它的跳
过的日期时间中断将忽略 

将时间设置向后挪动，日期时间中断的起动事
件会再次发生 

日期时间中断的执行不再重复 
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4.2.4.2 时间延迟中断组织块（OB20-OB23） 

S7 CPU提供延时OB用于在用户程序中编写延时执行的程序。 

 

延时中断规则 

延时中断只有当相应的组织块在CPU程序中存在时，才能执行。如果与上述情况不符，则

操作系统会诊断缓存器中输入一个错误信息，并执行异步错误处理（OB80，请参看错误处

理组织块（OB70到OB87/OB121到OB122））。 

在参数设置时，如果没选延时中断OB，则该OB不能起动。CPU认为这是一个编程错误，

将进入到停机状态。 

当在SFC 32 SRT_DINT中设定的延时时间达到时，触发延时中断。 

 

起动延时中断 

为了起动延时中断，用户必须在SFC 32中设定延时时间，当相应的时间延迟达到时，该中

断OB被调用。请参考《S7-300可编程序控制器，硬件及安装手册》和《S7-400，M7-400

可编程序控制器模板规范参考手册》中有关最大允许的延迟时间长度。 

 

延时中断OB的优先级 

延时中断OB优先级的缺省设置值为3至6级。用户可以设置参数改变优先级。 

 

4.2.4.3 循环中断组织块（OB30-OB38） 

S7 CPU提供循环中断OB，可用于按一定间隔中断循环程序的执行。 

循环中断按间隔触发。间隔的时间是从STOP状态到RUN时开始计算。 

 

循环中断的规则 

当用户定义时间间隔时，必须确保在两次循环中断之间的时间隔中，有足够的时间处理循

环中断自己的服务程序。 

如果用户在设置参数时，没有选循环中断OB，它们将不再起动。CPU认为这是一个编程错

误，将进入到停机状态。 
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起动循环中断 

为了起动循环中断、用户必须在STEP 7中的循环中断参数块里定义时间间隔。时间间隔必

须是1ms基本时钟率的整数倍。 

时间间隔=n×基本时钟率1ms 

一共有九个循环中断OB，每个OB都有其缺省的时间间隔（请参看下表）。为相应的循环

中断OB装载后，其对应的缺省时间间隔变为有效。然而，用户可以设置参数改变缺省值。

请参阅《S7-300可编程序控制器，硬件和安装手册》及《S7-400，M7-400可编程序控制

器模板规范参考手册》中有关上限的内容。 

 

循环中断中的相位偏移 

为避免不同的循环中断OB在同时开始请求中断，可能造成时间错误（循环时间超过），用

户可以定义一个相位偏移。相位偏移确保当循环中断的时间间隔达到时，再做一定的延时。 

相移=m×基本时钟率（0=m<n） 

下图所示为与无相移循环中断（OB38）相比，相移循环中断OB（OB37）的执行情况。 

 

循环中断OB的优先级 

下表所示为循环中断OB缺省的时间间隔和优先级。用户可以设置参数来改变时间间隔和优

先级。 

循环中断 时间间隔（ms） 优先级 

OB30 5000 7 

OB31 2000 8 

OB32 1000 9 
OB33 500 10 
OB34 200 11 

OB35 100 12 
OB36 50 13 

OB37 20 14 
OB38 10 15 
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4.2.4.4 硬件中断组织块（OB40-OB47） 

S7 CPU提供有硬件中断OB，用于对模板（例如，信号模板（SM），通讯处理器（CP），

功能模板（FM））上的信号变化进行响应。通过STEP 7，用户可以决定从可组态的数字

量或模拟量模板来的哪些信号可以起动OB。对于CP和FM，可能使用在对话框中设置相应

的参数来起动OB。 

当具有中断能力的信号模板上，有一个允许进行中断的信号从过程传到CPU时，或者当CPU

的功能模板产生一个中断信号时，将触发硬件中断。 

 

硬件中断的规则 

硬件中断只有当CPU的程序中存在相应的组织块时，才能执行。如果与上述情况不符，则

操作系统会诊断缓存器中输入一个错误信息，并执行异步错误处理（OB80，请参看错误处

理组织块（OB70到OB87/OB121到OB122））。 

如果用户在参数设置中没有选中硬件中断OB，则它们不能起动。CPU认为这是一个编程错

误，将进入到停机状态。 

 

具有硬件中断能力的信号模板的参数设置 

具有硬件中断能力信号模板的每个通道都可以触发一个硬件中断。为此，用户通过STEP 7

必须给具有硬件中断能力的信号模板设置如下参数集：  

• 用什么触发一个硬件中断 

• 哪种硬件中断OB将被执行缺省设置（OB40用于执行所有的硬件中断） 

用户通过STEP 7，可以使用功能块激活硬件中断的生成。在这些功能模块的参数设置对话

框中，设置保持的参数。 

 

硬件中断OB的优先级 

硬件中断OB的缺省优先级为16到23。用户可以设置参数改变优先级。 
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4.2.4.5 启动组织块（OB100/OB101/OB102） 

起动类型 

起动特性有三种不同的类型：  

• 热起动（在S7-300和S7-400H中没有） 

• 暖起动 

• 冷起动 

下表所示为：对应各种起动类型，操作系统调用不同的OB。 

起动类型 相关OB 

热 起 动 OB101 

暖 起 动 OB100 

冷 起 动 OB102 

 

起动OB的起动事件 

CPU当下列事件发生后，执行起动功能：  

• 电源上电后 

• 用户将CPU的状态选择开关从“STOP”拔到“RUN/RUN-P”后 

• 从通讯功能来的请求后 

• 多CPU方式同步之后 

• H系统中连接后（只适用于备用CPU上） 

根据起动事件、所使用的CPU及其设置参数，调用相应的起动OB（OB100、OB101或

OB102）。 

 

启动程序 

用户可以通过在暖起动的组织块OB100、热起动的组织块OB101或冷起动的组织块OB102

中编写程序，来设定其CPU起动的起动条件（运行时的初值，I/O模板的起动值）。 

起动程序没有长度限制，也没有时间限制，因为循环监视还没激活。在起动程序中，不能

执行时间中断或硬件中断程序。在起动过程中，所有数字量输出的信号状态都为“0”。 

 

手动起动后的起动类型 

S7-300 CPU只允许手动暖起动或冷起动（只有CPU 318-2）。 

对于某些S7-400 CPU，如果用户通过STEP 7的参数设置允许手动起动，则用户可以使用
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状态选择开关和起动类型开关（CRST/WRST），进行手动起动。手动暖起动可以不用设

定参数。 

 

自动起动后的起动类型 

对于S7-300 CPU，电源上电后，只允许暖起动。 

对于S7-400 CPU，用户可定义电源上电后，是自动暖起动还是自动热起动。 

 

过程映象清零 

当S7-400 CPU起动时，将执行保留的循环，并作为缺省设置，清零输出过程映象表。如果

用户希望在起动之后，继续在用户程序中使用旧值，也可以不将过程映象清零。 

 

模板存在/类型监视 

当用户进行组态表的参数设置时，可以决定是否需要在组态表中检查模板是否存在，以及

模板类型与起动前是否匹配。 

如果模板检查激活，CPU发现组态表与实际组态不相符时，CPU将不起动。 

 

监视时间 

为确保可编程序控制器起动时没有错误，用户可以选择以下监视时间： 

• 模板传递参数的最大允许时间 

• 上电后，模板准备好用于操作的信号所允许的最大时间 

• 对于S7-400 CPU，热起动期间中断所允许的最大时间 

一旦监视时间达到，CPU将进入到停机状态或只能做暖起动。 

 

4.2.4.6 背景组织块（OB90） 

如果用户用STEP 7定义最小的扫描循环时间，且该时间比实际的扫描循环时间长，则CPU

在循环程序结束时，还有处理时间。该时间用于执行背景OB。如果用户的CPU中没有OB90，

则CPU等待，直到定义的最小扫描循环时间达到为止。因此，对于那些对运行时间要求不

高的过程，用户可以用OB90，而避免等待时间。 
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背景OB的优先级 

背景OB的优先级为29，对应的优先级0.29。因此，该OB的优先级最低。其优先级不能通

过参数设置进行修改。 

下图所示为，在CPU中处理的背景循环、主程序循环和OB10。 

 
 

OB90的编程 

由于OB90的运行时间不受CPU操作系统的监视，因此，用户可以在OB90中编写程序的长

度不受限制。为确保在背景程序中的数据具有一致性，在编程时注意以下问题： 

• OB90的清零事件（参看《S7-300和S7-400的系统软件、系统和标准功能》参考手册） 

• 过程映象的刷新与OB90不同步 

 

优先级 下一循环 

输入过程映 
像表刷新 

输出过程映 
像表刷新 

Tc = 主程序循环所需的实际循环时间 
Tmin = 用STEP 7设定的最小循环时间 
Twait = 下一个循环开始之前所剩的循环时间 



设计程序结构基础 

 4-31 

4.2.4.7 故障处理组织块（OB70-OB87/OB121-OB122） 

错误类型 

可被S7 CPU检测到，并且，用户可以通过组织块对其进行响应的错误，可分为两个基本类

型：  

• 同步错误：这些错误可能出现在用户程序的某一部分中。该类错误发生在执行某特定

指令过程中。如果没有装载相应的同步错误OB，当错误发生时，CPU进入到STOP。 

• 异步错误：这些错误不会出现在用户程序的执行过程中。该类错误是优先级错误、可

编程序控制器故障（例如：模板损坏）或冗余错误。如果没有相应异步错误OB，当错

误发生时，CPU进入到“STOP”状态。 

• （例外：OB70，OB72，OB81）。 

下表所示为可能出现的错误类型，按错误处理OB进行分类。 

 

异步错误 /冗余错误 同步错误 

OB70 I/O冗余错误（只适用于H CPU） OB121编程错误（例如没有装入DB） 

OB72 CPU冗余错误（只适用于H CPU，例如，一
个CPU发生故障） 

OB122 I/O存取错误（例如，存取一个并
不存在的信号模块） 

OB73通讯冗余错误（只适用于H CPU， 

例如，一个冗余S7连接冗余损失） 

 

OB80计时错误（例如，超过扫描循环时间）  

OB81 电源故障（例如，电池故障）  

OB82诊断中断（例如，输入模块短路）  

OB83拆除/插入中断（例如，拆除一个输入模块）  

OB84 CPU 硬件故障（ MPI网络接口故障）  

OB85 优先级错误（例如没有装入OB）  

OB86 机架故障  

OB87通讯错误（例如，一个不正确的全局数据通
讯信息框ID） 

 

 

同步错误OB 

同步错误发生在执行某一特定指令的过程中。当这些错误出现时，操作系统在I堆栈做一个

输入记录，并调用同步错误OB。 

该类型错误OB的调用，是由于在程序中执行了一个同步错误的结果，其优先级与检测到错

误的块一致。因此，OB121和OB122可以访问中断发生时的累加器与其它寄存器中的内容。

用户可利用这些值，对错误条件进行响应，然后，返回处理用户程序（例如，如果访问某
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个模拟输入模板时，有个访问错误，则用户可以在OB122中用SFC44 RPL_VAL定义一个替

代值）。可是，该错误OB的本地数据，在L堆栈中的这个优先级中，额外占用一个空间。

对于S7-400 CPU，一个同步错误OB可以起动另一个同步错误OB。对S7-300 CPU，这个

功能不可能。 

 

异步错误OB 

如果CPU的操作系统检测到一个异步错误时，将起动相应的错误OB（OB70到OB73和

OB80到OB87）。该类异步错误OB具有最高等级的优先级，如果所有的异步错误OB的优

先级相同，则它们不能被其它OB中断。如果同时有多个相同优先级的异步错误OB出现，

它们将按其出现的顺序进行处理。 

 

屏蔽起动事件 

利用系统功能（SFC），用户可以屏蔽、延迟或禁止各种OB的起动事件。有关这些SFC和

组织块的详细信息，请参考《S7-300和S7-400系统软件，系统和标准功能》参考手册。 

 

 

 

 

 

 

 

 

 

提示 

如果用户希望忽略中断，更有效的方法不是禁止它们，而是下载一个空的OB（内容只有

BE）。 

 

 

 

错误OB的类型 SFC SFC的功能 

同步错误O B SFC 36 MSK_FLT 屏蔽某个同步错误。屏蔽的错误不再起动错误
OB，也不会触发编程响应 

 SFC 37 DMSK_FLT 取消屏蔽同步错误 

异步错误O B SFC 39 DIS_IRT 禁止所有的中断和异步错误。被禁止的错误，在
CPU的任何循环中不再起动错误OB， 

  也不触发编程响应。 

 SFC40 EN_IRT 便能中断和异步错误 

 SFC 41 DIS_AIRT 延迟优先级高的中断，以及异步错误，确保该类
OB执行结束 

 SFC 42 EN_AIRT 使能优先级高的中断和异步错误。 
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5 启动和操作 
 

5.1 启动STEP 7 

   启动Windows以后，你就会发现一个SIMATIC Manager（SIMATIC管理器）的

图标，这个图标就是启动STEP 7的接口。 

快速启动STEP 7的方法：将光标选中SIMATIC Manager这个图标，并双击。打开SIMATIC

管理器窗口。从这里，你可以访问你所安装的标准模块和选择模块的所有功能。 

启动STEP 7的另一方式：在操作系统的任务栏中选中“Start”键，而后进入“Simatic”。 

注意 

你可以从STEP 7窗口的用户引导Windows打开程序在线提示，得到更多的有关标准窗口的

操作及选项的信息。 

 

SIMATIC 管理器 

SIMATIC管理器用于基本的组态和编程。SIMATIC管理器具有下列功能： 

• 建立项目 

• 硬件组态及参数设定 

• 组态硬件网络 

• 编写程序 

• 编辑、调试程序 

对各种功能的访问都设计成直观、易学的方式。 

可以使用SIMATIC管理器在下列方式工作： 

• 离线方式，不与可编程控制器相联 

• 在线方式，与可编程控制器相联 

注意相应的安全提示。  

 

 

 

 

 

下步如何进行呢? 
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以“Projects”形式建立自动化作业标题。在操作之前，如果先理解下列内容，你就会感

到这个操作变得非常简单： 

• 用户接口 

• 基本操作步骤 

• 在线帮助 

 

5.2  启动STEP 7并带有预置启动参数 

使用STEP 7 V5.0以上版本，你可以在SIMATIC管理器中生成几个符号，并在调用顺序上指

定启动参数。为此，SIMATIC管理器选中这些参数描述的对象，快速双击，立即进入相应

的Project。 

执行文件S7tgtopx.exe，可以指定下列起动参数： 

/e <完整的物理Project路经> 

/o <对象的逻辑路径> 

/h <对象ID> /on或/off 

下列描述为建立相应参数最简捷的方法。 

 

用复制和粘贴方式建立参数 

按如下进行： 

1. 建立访问文件S7tgtopx.exe的路径。 

2. 打开属性对话框。 

3. 选择“Link”选项卡。如下扩展“Target”下的输入。 

4. 在SIMATIC管理器选择相应的对象。 

5. 用“CTRL+C”复合键，复制这个对象到文件夹。 

6. 将光标移“Link”选项卡中“Target”的末端。 

7. 用“CTRL+V”复合键，粘贴文件夹中的内容。 

8. 用“OK”关闭对话框。 

 

 

 

参数举例： 
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/e F:\SIEMENS\STEP7\S7proj\MyConfig\MyConfig.s7p 

/o “1,8:MyConfig\SIMATIC 400（1）\CPU416-1\S7-Program（1）\Blocks\FB1“ 

/h T00112001;129;T00116001;1;T00116101;16e 

 

注意Project路径的结构 

在 文 件 系 统 中 Project 路 径 是 一 个 物 理 路 径 。 不 支 持 UNC Notation ， 如 ：

F:\SIEMENS\STEP7\S7proj\MyConfig\MyConfig.s7p 

完整的逻辑路径如下： 

[View ID, online ID]:project name\{object name\}*\ 对象名 

例如：/o 1.8:MyConfig\SIMATIC 400（1）\CPU416-1\S7-Program（1）\Blocks\FB1 

 

注意逻辑路径的结构 

只能用复制和粘贴功能，建立完整的逻辑路径和对象ID。 

但是，用户也可以访问这些路径。如前例所述： 

/o "MyConfig\SIMATIC 400（1）\CPU416-1\S7-Program（1）\Blocks\FB1”。通过增加\on

或\off，用户可以指明路径是否在在线窗口或离线窗口有效。如果仅做复制和粘贴则无需做

上述工作。 

重要：如果路径中有空格，应用引号代替这些空格。 

 

 

5.3 访问帮助功能 

 

在线帮助 

在线帮助系统提供给用户有效快速的信息，无需查阅手册，在线帮助具有如下信息方式： 

• Contents：显示帮助信息的号码 

• Context-Sensitive Help（F1 key）：首先用鼠标选中或在对话框或窗口选择某一对象，

而后用F1键得到相应帮助信息。 

• Introduction：对某种功能的使用、主要特性及功能范围做一个简要说明。 

• Getting Started：概述启动某功能的基本步骤。 

• Using Help：在在线帮助下，对查找特殊信息的方法提供描述。 
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• About：提供有关当前版本的信息。 

通过帮助菜单可访问任何窗口的实时对话框。 

 

访问在线帮助功能 

你可以用下列方法之一访问在线帮助： 

• 在菜单栏选中帮助菜单，再从中选择相应指令。 

• 在某对话框单击“Help”键，则可以显示这个对话框的帮助。 

• 将光标移到某个你希望得到帮助的窗口或对话框，而后按下F1键或选择菜单命令Help 

> Context-Sensitive Help。 

• 在窗口内使用问号键。 

在线帮助功能访问的后三种方式即所熟悉的上下文相关帮助。 

 

访问快速帮助功能 

你只要将光标移到需要帮助的工具栏的某个键上，保持片刻，则显示出快速帮助信息。 

 

 

5.4 对象和对象等级 

与Windows Explorer的文件夹和文件的结构相同，SIMATIC管理器可以在STEP 7的项目和

库中显示对象等级。 

下图是一个对象等级的例子。 

 

• 项目对象 
• 站对象 

• 编程模块对象 

• S7/M7程序对象 
• 源文件文件夹对象 

• 块文件夹对象 

对象有下列功能： 

• 对象属性的载体 

• 文件夹 

• 功能的载体（如：启动某特殊应用） 

对象作为属性的载体 
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对象同时携带功能和属性（如设定）。当选择某一对象，则能够执行下列功能： 

• 用菜单命令Edit > Open Object，编辑对象 

• 用菜单命令Edit > Object Properties，打开对话框，设定对象的特定选择。 

文件夹也可以做为属性的载体。 

 

对象做为一个文件夹的形式 

文件夹（子目录）可能含有其它的文件夹或对象。当你把它打开后，则可以显示这些内容。 

 

对象作为功能的载体 

当你打开一个对象以后，则显示一个可编辑的窗口。 

一个对象，或是一个文件夹，或是一个功能的载体。除非是这样一个站：它即是文件夹（编

程模式），也是功能载体（用于硬件组态）。 

• 当你双击某个站的图标，其中的对象就显示出来：编程模式和站的组态（站作为一个

文件夹）。 

• 当你用菜单命令Edit > Open Object打开一个站时，你就能对其进行组态和参数设定

（站作为一个功能载体）。当你双击“Hardware”对象时，与菜单命令有着相同的效

果。 

 

 

5.4.1  项目对象 

项目位于对象等级最高层，它包括一个自动化解决方案中的所有的数据及程序。 
 

在项目视窗中的位置 

 

• 项目对象 

• 站对象 
• 编程模块对象 

• S7/M7程序对象 

• 源文件文件夹对象 
• 块文件夹对象 

 

图  标 对象文件夹 重要功能选择 
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项目 • 建立项目 

• 项目和库的归档 

• 管理多语言文本 

• 检查可使用的软件包 

• 打印项目文献 

• 再排列 

• 翻译并编辑操作文本 

• 插入操作站对象 

• 多个用户编辑项目 

• 转换版1 项目 

• 转换版2 项目 

• 设置PG/PC接口 

 

站 

SIMATIC 300 
SIMATIC 400 

• 插入一个站点 

• 这个图标即表示一个站也表示一个文件夹（站的等  

     级），其它功能可以在站对象下找到 

 

 

S7程序 

 
M7程序 

• 插入S7/M7程序 

• S7/M7程序图标即是对象（项目级），也是对象文 

件夹（程序级）。其它功能可以在S7/M7程序对象 

中找到 

 

网络 

用于网络组态和设
定属性的启动工具 

• 通讯站点和分支网络的属性 

• 总览：整体数据通讯 

• 组态整体数据通讯过程 

 

 

5.4.2  库对象 

库由S7/M7程序组成，用于存贮软件块。库位于对象等级的上层。 

 

• 库对象 

• S7/M7程序对象 

• 源文件文件夹对象 
• 块文件夹对象 

 

图标 对象文件夹 重要功能选择 

 

库 • 标准库总览 

• 有关程序库 

• 项目和库的归档 

图标 库级中的对象 重要功能选择 
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S7 程序 

 
 
M7 程序 

• 插入S7/M7程序 

• S7/M7程序图标即是对象（项目级），也是对
象文件夹（程序级）。其它功能可以在S7/M7程序
对象中找到 

 

 

5.4.3 站对象 

SIMATIC 300/400站用一个或多个程序模式表示S7的硬件组件。 

 

在项目视窗中的位置 

 

• 项目对象 

• 站对象 

• 编程模块对象 

• S7/M7程序对象 

• 源文件文件夹对象 

• 块文件夹对象 

 

图标 对象文件夹 重要功能选择 

 站 •   插入一个站点 

•   上载站参数 

•   下载组态参数到可编程控制器 

•   从一个站点上载组态参数 

•   显示CPU报文和用户定义的诊断报文 

•   组态“系统错误报告”  

•   诊断硬件，显示模板信息 

•   显示和改变操作模式 

•   显示并设置时间和日期 

•   清除装载存储器和工作存储器，初始化CPU 

 SIMATIC PC站 

(没分配) 

•   生成并设定SIMATIC PC 站点参数 

•   组态SIMATIC PC站间的通讯结构 
•   更新SIMATIC PC站 

 SIMATIC PC站 
(已分配) 

•   选中要在网络中组态的SIMATIC PC站 
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图标 站点级中的对象 重要功能选择 

 

 

硬件 •  硬件组态基本步骤 

•  站点组态基本步骤 

•  总览：组态设定本机配置的参数 

•  组态DP主站系统基本步骤 

•  组态多计算操作 

 

编程模块 •  编程模块既是对象（站点级）又是对象文件夹
（“Programmable Modules”级）。其它功能可以在
编程模块对象中找到 

 

5.4.4 编程模块对象 

编程模块可以再现设定的参数（CPUxxx，FMxxx，CPxxx。无记忆的系统数据（例如CP441

通过站点CPU装入。因此，没有“系统数据”的对象在项目等级中不能显示。 

 

在项目视窗中的位置 

 

• 项目对象 

• 站对象 

• 编程模块对象 

• S7/M7程序对象 

• 源文件文件夹对象 

• 块文件夹对象 

图标 站点级中的对象 重要功能选择 

 
 

编程模块 •   总览：组态设定本机配置的参数 

•   显示CPU报文和用户定义的诊断报文 

•   组态“系统错误报告” 

•   诊断硬件，显示模板信息 

•   通过EPROM存储卡下载 

•   设定访问可编程控制器的口令 

•   显示强制数值窗口 

•   显示和改变操作模式 

•   显示并设置时间和日期 

•   设定操作属性 

•   清除装载存贮区和工作暂存区，初始化CPU 

•   在线视窗中的诊断符号 

•   内存分区 

•   将下载软件块存入集成EPROM 

•   升级可编辑控制器中的操作系统 
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图标 编程模块级对象 重要功能选择 

 程序： 

S7程序 

 
M7程序 

 
程序 

•  插入S7/M7程序 

•  S7/M7程序图标即是对象(Project级 )，也是对象 

   文件夹（Program级）。其它功能可以在S7/M7 

   程序对象中找到。 

 设定网络 •   项目中的网上站点 

•   联接类型及站点 

•   明确联接的不同类型 

•   输入新的联接 

•   组态用于SIMATIC站中的模板联接 

 

 

5.4.5  S7/M7程序对象 

S7/M7程序是一个文件夹，它包括 S7/M7 CPU软件或非CPU的软件（如：CP或FM模板）。 

 

在项目视窗中的位置 

 

• 项目对象 

• 站对象 

• 编程模块对象 
• S7/M7程序对象 

• 源文件文件夹对象 

• 块文件夹对象 

图标 对象文件夹 重要功能选择 

 S7程序 •   插入S7-/M7-程序 

•   建立地址优先权 

•   建立逻辑块的基本步骤 

•   如何为项目分配和编辑用户定义的诊断 

•   如何为CPU分配和编辑用户定义的诊断 

•   翻译并编辑操作文本 

•   显示CPU报文和用户定义的诊断报文 

•   程序测试 

 M7程序 •   M7系统程序 

 程序 •   在项目中生成软件（一般） 

图标 程序级中的对象 重要功能选择 
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 对单一或多个变量设定符号
的符号表 

•   绝对地址和符号地址 

•   符号表的结构及元素 

•   输入共享符号 

•   输入符号时的提示 

•   如何设定和编辑与符号相关的信息 

•   翻译并编辑用户文本 

•   通过符号表组态控制与监测属性 

•   编辑通讯属性 

•   符号表输入/输出接口 

 源文件 •   其它功能可以在源文件夹对象中找到 

 软件块文件夹 •   其它功能在软件块文件夹对象中寻找 

 

5.4.6 块文件夹对象 

离线方式软件块文件夹包括：逻辑软件块（OB，FB，FC，SFB，SFC），数据块（DB），

用户定义数据类型（UDT）和变量。系统数据对象表示系统数据块。 

在线方式的软件块文件夹包括可下载到可编程控制器并可执行的程序。 

 

在项目视窗中的位置 

 

• 项目对象 

• 站对象 

• 编程模块对象 

• S7/M7程序对象 

• 源文件文件夹对象 

• 块文件夹对象 

 

图标 对象文件夹 重要功能选择 

 软件块 •   用Project Management（项目管理）下载 

•   不用Project Management（项目管理）下载 

•   可用参考数据概述 

•   再接线 

•   软件块的比较 

•   翻译并编辑操作文本 

•   转换软件块的系统属性、语言描述及提示 

 

符号 块文件夹对象 重要功能选择 
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 软件块概要 •   建立逻辑软件块 

•   生成软件块 

•   编写STL源文件的基本信息 

•   软件块的比较 

 

组织块（O B） 附加功能：  

•   引入数据及参数类型 

•   下载条件 

•   用程序状态功能进行测试 

•   你应了解的关于在单步模式/断点下进行测试的信息 

•   再接线 

•   软件块的注释 

 
功能（FC） 附加功能：  

•  引入数据及参数类型 

•  下载条件 

•  用程序状态功能进行测试 

•  你应了解的关于在单步模式/断点下进行测试的信息 

•  再接线 

•  软件块及参数属性 

 
功能块（FB） 附加功能：  

•  引入数据及参数类型 

•  使用多重背景 

•  下载条件 

•  用程序状态功能进行测试 

•  你应了解的关于在单步模式/断点下进行测试的信息 

•  再接线 

•  软件块及参数属性 

•  设定和编辑与软件块相关的信息 

•  PCS 7 报文组态 

•  翻译并编辑用户文本 

•  设定FB参数的系统属性 

 

用户定义的数据
类型（UDT） 

•  生成软件块 

•  编写STL源文件的基本信息 

•  引入数据及参数类型 

•  使用用户定义的数据类型访问数据 

•  软件块及参数属性 

 

DB（全局数据块） •  数据块中的数据总览 

•  数据块的声明表显示状态 

•  下载条件 

•  编写数据块状态 

•  引入数据及参数类型 

•  使用多重背景 

•  软件块及参数属性 

•  设定和编辑软件块的相关信息（只限于背景数据块） 
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•  PCS7报文组态（仅限于背景数据块） 

•  翻译和编辑用户文本（仅限于背景数据块） 

 

系统功能 (SFC) •  下载条件 

•  软件块及参数属性 

•  软件块的注释 

 
系统功能块 

（SFB） 

•  下载条件 

•  软件块及参数属性 

•  设定和编辑与软件块相关的信息 

•  为CPU创建与块相关的报文 

•  PCS 7 报文组态 

•  翻译并编辑用户文本 

•  软件块的注释 

 
变量表（VAT） •  用变量表进行监视和修改的基本程序 

•  测试变量表 

•  监测变量 

•  修正变量 

•  强制变量 

 

系统数据块 

（SDB） 

系统数据块（SDB）仅能用下列功能编辑：  

•  硬件组态 

•  通讯站点和分支网络的属性 

•  总览：整体数据通讯 

•  设定和编辑与符号相关的信息 

•  下载条件 

 

 

5.4.7  源文件文件夹对象 

源文件文件夹含有文本方式的源程序。 

 

在项目视窗中的位置 

 

•  项目对象 

•  站对象 
•  编程模块对象 

•  S7/M7程序对象 

•  源文件文件夹对象 
•  块文件夹对象 

 

图标 对象文件夹 重要功能选择 
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 源文件夹 •  编写STL源文件的基本信息 

•  导出源文件 

•  导入源文件 

 

图标 源文件夹对象 重要功能选择 

 

 

源文件 

(如：STL源文件) 

•  编写STL源文件的基本信息 

•  生成STL源文件 

•  将软件块模式插入STL源文件 

•  将源代码插入STL源文件 

•  检查STL源文件的一致性 

•  编译STL源文件 

•  从软件块生成STL源文件 

•  导出源文件 

•  导入源文件 

 

网络模板 •  生成网络模板 

•  在程序中插入一个段模板 

 

 

5.4.8  没有站点或CPU的S7/M7编程 

在没有组态SIMATIC站之前，你可以编写程序。这也就意味着初始工作与你要编程的站点

无关。 

 

生成S7/M7程序 

1.  用菜单命令File > Open或项目窗口，打开相应的项目。 

2.  选择离线方式项目窗口中的项目。 

3.  根据在可编程控制器上生成的程序，选择下列菜单命令： 

Insert > Program > S7 Program，如果你的程序要运行在SIMATIC S7设备上。  

Insert > Program > M7 Program，如果你的程序要运行在SIMATIC M7设备上。 

这时，S7/M7程序已进入“Project”窗口。它包括一个程序文件夹和一个空的符号表，在

此你可以建立，编写软件块。 

 

编写程序 

你可以编写与某种程序模式无关的程序，而后再用移动或复制方式，将程序移到相应模式

中。 

添加程序到库中 
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如果你需要多次使用某个SIMATIC S7的程序，并将其设置成软件工具，可将这个程序插入

库中。但是测试时，一定将其放入项目中，因为这是程序与可编程控制器联接的唯一途径。 

 

访问可编程控制器 

选择项目的在线方式。在含有程序属性的对话框中设定地址。 

提示 

当删除站点或程序模式的时候，你会得到是否删除其中程序的提示。如果你选择不删除程

序，则这个程序以无站点的形式直接插入项目。 

 

 

5.5  用户接口与操作 

 

5.5.1 操作原理 

 

目的：简化面向对象的操作 

图形方式的用户接口，使软件的操作更加直观。你可以用日常生活中熟悉的方式在软件中

找到所需对象，例如站点、模板、程序、软件块。 

包括对象的建立、选择及操作，都可以在STEP 7软件平台上完成。 

 

面向应用的操作 

以应用为导向的操作，你必须明确哪类操作用于哪类任务，然后启动。 

而以对象为导向的操作仅须确定使用哪种对象。而后打开这个对象，对其进行编辑。 

使用对象为导向的操作，无须知道指令的具体含意对象以图标的形式作为用户操作界面。

用户只须用菜单命令或光标点击则可以打开对象。 

当你打开一个对象以后，其相应的应用软件或编辑内容会自动显示出来。 

 

请阅读... 

下面几页讲述编辑对象的基本步骤。因为在手册中，对此没有详细说明，请用心详读下列

部分。 
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5.5.2  窗口内容排列 

标准窗口内容排列如下： 

 

标题栏和菜单栏 

标题栏和菜单栏位于窗口的最上端。标题栏包括窗口以及标题和控制窗口的图标。菜单栏

包括窗口所有有效菜单。 

 

工具栏 

工具栏由图标（或工具按钮）组成，这些图标以快捷键方式作为经常使用的菜单命令用鼠

标点击执行。当用光标选中某个快捷键时，在状态栏会有简单的信息显示。 

如果某些键不能操作，则呈灰色。 

 

状态栏 

状态栏显示相关信息。 

 

标题栏 
 
菜单栏 

 
工具栏 

 
 
 
 
 
 
 
状态栏 

系统菜单（最大/关闭等） 激活窗口的标题 

 

最小化按钮  最大化按钮  关闭按钮 
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5.5.3 对话框中的元素 

 

在对话框中输入信息 

你可以将某些特定任务信息输入对话框。经常显示的部分如下图所示： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

列表框或组合框 

有时文本框旁边带有一个向下的箭头。这个箭头表示还有更多的选择。点击这个箭头，则

显示一个列表框或组合框。如果用光标点击其中之一，则它可以自动显示在文本框中。 

 

对话框中的选项卡 

某些对话框由选项卡组成，通过将对话框分为选项卡，来改进信息的透明度（如下图）。 

 

 

 

 

 

 

选项卡出现在对话框的最上端。你只要用光标点击某个选项卡，这个选项卡就会凸出来。 

 

 
使用键盘输入文本
信息的文本框 

 

 
选择框选择其中之一 

 

 
复选框选择其中之一 

 

按钮 

选项卡 
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 对象的建立和管理 

无论哪一种对象基本操作步骤都是相同的，基本操作顺序在手册中另有说明，在此汇总如

下： 

• 建立对象 

• 选择对象 

• 在对象执行操作（如复制，删除） 

 

设定建立新的Projects/Libraries的路径 

新的用户项目、库和多重项目存储在缺省的文件夹“\Siemens\Step7\S7prog”中。如果要

存储在其它路径内，在存储前应先指明路径。在第一次建立一个新的Project/Libraries之前，

用菜单命令Options>Customize，建立你所希望的对象存在的路径。用对话框的“ General”

选项卡，建立Project/Libraries的路径名。 

 

建立对象 

利用STEP 7 Wizard “New Project”，建立新的项目，并且插入对象。使用菜单命令File 

>“New Project”Wizard，打开Wizard，对话框中将显示你所建立的项目结构，而后利

用Wizard，建立项目。 

如果不用Wizard，菜单命令File>New，也能建立项目和库。这些对象形成对象体系的起始

部分。你可以用插入菜单建立那些不能自动建立的对象。此外，用硬件组态或“New Project”

Wizard，在SIMATIC站建立模板对象。 

 

打开对象 

打开对象有多种方式，如下所示： 

• 双击对象图标 

• 选择对象及菜单命令Edit > Open Object。这只适用于文件夹中没有的对象。 

一旦打开对象，你就能生成或改变它的内容。 

当打开一个不含有其它对象的一个对象时，这个对象的内容是由可编辑的软件形成一个新

的窗口。你不能改变这个对象，因为其中内容已被调用。 

提示 

例外：站点以文件夹的方式显示编程模块（当你双击它们）和站点组态。当你双击

“Hardware”对象，硬件组态功能开始启动。选择这个站点和选择菜单命令Edit>Open 

Object效果相同。 
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建立对象体系 

用“New Project”Wizard建立对象体系。打开一个文件夹，它所包括的对象也就显示出来。

这时你可以用插入菜单建立更多的对象，如：在Project中增加站点。只有将对象插入到当

前文件夹的命令，才能在插入菜单中调用。 

 

设定对象属性 

对象属性是指对象本身的一些数据，这些数据决定对象的性能特点。当建立一个新的对象，

设定对象属性的对话框会自动显示，用于对象属性的设定。对象属性也可以后期改变。 

调用菜单命令Edit>Object Properties，打开对话框或设定对象属性。 

调用菜单命令Edit>Special Object Properties，打开对话框，输入有关操作控制，监测功

能及组态信息。 

例如：为了显示一个块的特殊对象属性。其属性关于操作控制及监测功能，这个块必须置

有相应的操作控制及监测功能的符号，也就是将系统属性“S7_m_c”文件通过块属性的

“Attribute”键设为“true”。 

提示 

“System Data”文件夹和“Hardware”对象的属性不能显示或改变。  

不能在只读Project对话框中输入数据。这时输入框为灰色。  

当显示编程模块时，由于一致性的原因，你这时不能编辑这些显示的参数。为此，应调用

“Configuring Hardware”功能。 

 

剪切、粘贴、复制 

所有的对象都可以在窗口下剪切、粘贴、复制。也可以在编辑菜单中找到这类指令。 

你也可以用光标拖、放的方法，复制对象。如果错误地将其移动或复制到一个非法的目标，

光标就会显示一个禁止的报警信号。 

当复制某个对象的时候，这个对象体系下面的所有内容都将被复制。这样你为某个自控工

程所建立在该对象的内容就可以多次使用。 

提示 

“Connection”文件夹中的相关表格不能被复制。注意这时你所复制的操作相关文本表，

目标对象仅能接受它自己具有的语言形式。 

 

在复制对象时，将一步一步地提示你进行复制。 

对象更名 
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SIMATIC管理器为一些新的对象设计有一个标准名。这个名字是由对象的类型（如果在相

同的文件夹中也可以生成同样的对象代码）和代码组成。 

例如：第一个S7程序名为“S7 Program（1）”，第二个名为“S7 Program（2）”等。

符号表名为“Symbols”，因为它在每一个文件夹中仅存在一个。 

你也可以改变对象和Project的名字，使其新名字与内容相关。 

同Project一样，路径名不能超过8个字符。否则，当存档和使用“C for M7”（Borland编

译程序）时，就会出现问题。 

你可以直接地或用对象本身属性改变对象的名字。  

用直接方式： 

• 用鼠标点击对象名两次，这时对象名边框就会显示出来。你再用键盘输入一个新的名

字。 

用菜单： 

• 在项目菜单中选择相应对象及菜单命令Edit > Rename。这时对象名边框就会显示出

来。你再用键盘输入一个新的名字。 

如果某个对象名字不能修改，则该对话框的输入区域呈灰色，显示当前名字，不能输入文

本信息。 

提示 

当编辑名字或执行其它操作（例如：选择菜单命令）时，如果你将光标移到对象名框之外，

这个操作就会结束。但修改的新名字还是可以被接受。 

在“Rename Objects”菜单下，会有详细的提示 

 

移动对象 

你可以利用SIMATIC管理器，将对象从一个文件夹移到另一个不同Project的文件夹。当移

动一个文件夹的时候，它的所有内容都同时被移走。 

提示 

下列对象不能移动：  

• 联接的 

• 在线显示的系统数据块（SDB） 

• 在线显示的系统功能（SFC）和系统功能块（SFB） 

在移动对象时，在“Moving Objects”下会有详细提示。 

对象分类 
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依据对象属性对其分类预览（菜单命令View > Details）。为此，用鼠标点击相关的属性

标题。当再次点击时，对象的顺序就会反过来，软件块由它们自身的数码顺序分类，例如：

FB1、FB2、FB11、FB12、FB21、FC1。 

 

对象预置分类 

当再次打开Project时，将根据预置分类次序显示对象。如：  

• 软件块显示依次为：“系统数据、OB、FB、FC、DB、UDT、VAT、SFB、SFC。” 

• 在Project里面，首先显示所有的站，而后是S7 程序。 

因此，预置分类不能以字母增减的顺序详细预览。 

 

预置分类顺序的再分类 

例如：再分类后，点击标题“Object Name”上端，就能对预置分类进行再分类，具体操

作顺序如下：  

• 在详细预览时点击“Type”。 

• 关闭Project，而后再打开。 

 

删除对象 

你可以删除一个文件夹及对象。当删除一个文件夹的时候，其中的所有对象也同时被删除。 

你不能取消删除操作。当你不能确认某个对象是否保留，最好首先将整个Project存档。 

 

提示 

下列对象不能删除：  

• 联接的 

• 在线显示的系统数据块（SDB） 

• 在线显示的系统功能（SFC）和系统功能块（SFB） 

 

在删除对象时，在“Deleting Object”下会有详细提示。 

 

5.5.4  在对话框中选择对象 

用浏览器对话框选择对象，一般需要进行多步骤的操作。 
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调用浏览器 

你可以用硬件组态操作方式调用浏览器对话框，如：用菜单命令Station>New /Open

（“SIMATIC Manager”窗口除外）。 

 

浏览器对话框的结构 

在对话框中有下列部分可供你选择。 
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5.5.5  时间段存贮器 

SIMATIC管理器可以存贮窗口的内容（打开的Project和Libraries）及排列方式。  

• 你可以用菜单命令Options > Customize，决定在时间段结束时是否存贮窗口内容及排

列。下一个时间段开始时恢复这些内容。在打开的Project画面上，光标位于最后选择

的文件夹。 

• 用菜单命令Window > Save Settings，存贮实时运行的窗口内容及排列。 

• 你可以用Window > Restore Settings命令，恢复用Window > Save Settings存贮的窗

口内容及排列方式。在打开的“Project”画面上，光标位于最后选择的文件夹。 

 

提示 

在线“Project”的窗口内容、“Accessible Nodes”的窗口内容和“S7 Memory Card”

的窗口内容不能保存。访问可编程控制器（S7-300/S7-400）的口令，在时间段结束时不能

存贮。 

 

 

5.5.6  改变窗口的排列 

让它们叠放并能看见每个窗口的标题，选择： 

• 菜单命令Window > Arrange > Cascade。 

• 按SHIFT + F5组合键 

如果你想从上到下排列所有包含打开的符号表的窗口，选择菜单命令Window＞Arrange

＞Horizontally。 

如果你想从左到右排列所有包含打开的符号表的窗口，选择菜单命令Window＞Arrange

＞Vertically。 

 

 

5.5.7  窗口排列的存贮及恢复 

STEP 7具有这样的特性：存贮实时窗口的排列。在下一次显示时按存贮的排列方式显示窗

口。可以使用菜单命令Options > Customize“General”选项卡完成。 
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存贮什么内容? 

当存贮窗口排列时，存贮下列信息：  

• 主窗口的位置， 

• 打开的Project和Libraries及它们的窗口位置 

• 窗口级联的次序 

提示 

在线“Project”窗口，“Accessible Nodes”窗口和“S7 Memory Card”窗口不能存贮。 

 

存贮窗口排列 

用菜单命令Window > Save Settings，保存当前窗口排列。 

 

恢复窗口排列 

用菜单命令Window>Restore Settings，恢复窗口排列 

提示 

当恢复窗口时，只能显示已存贮的对象部分等级的内容。 

 

 

5.6  键盘控制 

 

国际键名 德国键名 

HOME POS 1 
END ENDE 

PAGE UP BILD AUF 
PAGE DOWN BILD AB 

CTRL STRG 
ENTER Eingabetaste 

DEL ENTF 
INSERT EINFG 
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5.6.1  用于菜单命令的组合键 

用ALT键和组其它键组合，可任意选择菜单命令。 

依次按下例键：  

• ALT键 

• 菜单中带下划线的字符（如：ALT，F用于“File”），如果菜单栏中含“File”的话。

这个菜单就会打开。 

• 菜单命令中带有下划线的字符（如ALT N用于“New”菜单命令）。如果这个菜单命令

中含有子菜单，子菜单也同时打开。如上述方式可以选择所有菜单命令。 

一旦输入组合健的最后一个字符，菜单命令就开始执行。 

如： 

菜单命令                                  组合键 

File > Archive                          ALT，F，A 

Window > Arrange > Cascade           ALT，W，A，C 

 

菜单命令快捷键 

命令 快捷键 

New                       （“File”Menu） CTRL+N 

Open                      （“File”Menu） CTRL+O 

Save as                    （“File”Menu） CTRL+S 

Print > Object Table          （“File”Menu） CTRL+P 

Print > Object Content       （“File”Menu） CTRL+ALT+P 

Exit                        （“File”Menu） ALT+F4 

Cut                        （“Edit”Menu） CTRL+X 

Copy                       （“Edit”Menu） CTRL+C 

Paste                      （“Edit”Menu） CTRL+V 

Delete                     （“Edit”Menu） DEL 

Select All                   （“Edit”Menu） CTRL+A 

Rename                    （“Edit”Menu） F2 

Object Properties            （“Edit”Menu） ALT+RETURN 

Open Object                （“Edit”Menu） CTRL+ALT+O 

Compile                    （“Edit”Menu） CTRL+B 

Download                  （“PLC”Menu） CTRL+L 

Diagnostics/Setting > Module Status   （“PLC”Menu） CTRL+D 

Diagnostics/Setting > Operating Mode （“PLC” Menu） CTRL+I 

Update                     （“View” Menu） F5 
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命令 快捷键 

Updates the status display of the visible CPUs in the 
online view 

CTRL+F5 

Customize                 （“Options”Menu） CTRL+ALT+E 

Reference Data > Display    （“Options”Menu） CTRL+ALT+R 

Arrange > Cascade          （“Window”Menu） SHIFT+F5 

Arrange > Horizontally       （“Window”Menu） SHIFT+F2 

Arrange > Vertically          （“Window”Menu） SHIFT+F3 

Context-Sensitive Help       （“Help”Menu） F1  
（如果选择菜单命令，则显示
其提示内容。否则只显示提示

起始画面） 

 

 

5.6.2 光标移动组合键 

 

在菜单栏/弹出菜单中移动光标 

功能 按键 

移到菜单栏 F10 

移到弹出菜单 SHIFT+F10 

移到带有下划线字符或数字的菜单 ALT+菜单中带有下划线的字符 

选择带有下划线字符的命令 菜命令中带有下划线的字符 

移向左边菜单命令 左箭头 

移向右边菜单命令 右箭头 

移向上边菜单命令 上箭头 

移向下边菜单命令 下箭头 

执行菜单命令 ENTER键 

放弃菜单名或关闭打开的菜单并返回 ESC键 

 

编辑文本时光标的移动 

功能 按键 

向上移一行或如文本仅有一行向左移一个字符 上箭头 

向下移一行或如文本仅有一行向右移一个字符 下箭头 

左移一个字符 左箭头 

右移一个字符 右箭头 

左移一个字 左箭头 

右移一个字 右箭头 

移到行首 HOME 

移到行尾 END 
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功能 按键 

翻转到上一页 PAGE UP 

翻转到下一页 PAGE DOWN 

移到文本起始位位置 CTRL+HOME 

移到文本起终止位置 CTRL+END 

 

在对话框中移动光标 

功能 按键 

从一个对话框到另一个对话框（从左到右，从上
到下） 

TAB 

在对话框内以反方向移动 SHIFT+TAB 

选择带下划线字符菜单 ALT+菜单中带有下划线的字符 

选择选项列表 箭头键 

打开选项列表 ALT+下箭头键 

选择或放弃菜项标题 空格键 

确认输入并关闭对话框（“OK”键） ENTER 

关闭对话框对修正不做存贮（“Cancel” 按钮） ESC 

 

 

5.6.3  选择文本的组合键 

选择或放弃文本 按键 

右移一个字符 SHIFT+右箭头键 

左移一个字符 SHIFT+左箭头键 

移到行的起始位置 SHIFT+HOME 

移到行的终止位置 SHIFT+END 

移到上一行 SHIFT+上箭头键 

移到下一行 SHIFT+下箭头键 

翻转到上一页 SHIFT+PAGE UP 

翻转到下一页 SHIFT+PAGE DOWN 

移到文本文件起始位位置 CTRL+SHIFT+HOME 

移到文本文件起终止位置 CTRL+SHIFT+END 
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5.6.4  访问在线帮助的组合键 

功能 按键 

打开帮助功能 F1（如正在执行菜单命令，则显示相应帮
助否则显示功能初始画面） 

选择带有问号的帮助键 SHIFT+F1 

关闭帮助窗口并返回 SHIFT+F4 

 

 

5.6.5  用复合键完成窗口切换 

功能 按键 

选择不同的窗口 F6 

如没有相应窗口，返回前一级窗口 SHIFT+F6 

注释窗口与保留窗口（变量表窗口间的切换）。
如果没有保留窗口，则返回前一级窗口 

SHIFT+F6 

注释窗口间的切换 CTRL+F6 

返回到前一级注释窗口 SHIFT+CTRL+F6 

在注释窗口间的切换（应用系统和保留窗口），
当返回这一系统后则激活最后打开的注释窗口 

ATL+F6 

返回前一级注释窗口 SHIFT+ALT+F6 

关闭时实运行窗口 CTRL+F4 
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6 创建并编辑项目 
 

6.1  项目结构 

项目可用来存储为自动化任务解决方案而生成的数据和程序。这些数据被收集在一个项目

下，包括：   

• 硬件结构的组态数据及模板参数 

• 网络通讯的组态数据 

• 为可编程模板编制的程序 

生成一个项目的主要任务就是为编程准备这些数据。 

数据在一个项目中以对象的形式存储。这些对象在一个项目下按树状结构分布（项目层次）。

在项目窗口中各层次的显示与Windows 95资源管理器中的相似。只是对象图标不同。 

项目层次的顶端结构如下： 

1层：项目 

2层：子网、站或S7/M7程序。 

3层：依据第二层中的对象而定。 

 

项目窗口 

项目窗口分成二个部分。左半部显示项目的树状结构。右半部窗口以选中的显示方式（大

符号，小符号，列表），或明细数据显示左半窗口中打开的对象中所包含的各个对象。 

在左半窗口点击“+”符号以显示项目的完整的树状结构。最后的结构看起来就象下图一

样。 

在对象层次的顶层是对象“S7_Pro1”作为整个项目的图标。它可以用来显示项目特性并

以文件夹的形式服务于网络（组态网络），站（组态硬件），以及S7或M7程序（生成软

件）。当选中项目图标时，项目中的对象显示在项目窗口的右半部分。位于对象层次（库

以及项目）顶部的对象在对话框中形成一个起始点用以选择对象。 
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项目查看 

在项目窗口中，你可以通过选择“offline（离线）”，显示编程设备中该项目结构下已有

的数据，也可以通过选择“online（在线）”，通过该项目显示可编程控制系统中已有的

数据。 

如果安装了相应的可选软件包，你还可以设置另外一种查看方式：设备查看。 

注意 

硬件及网络的组态只能在“offline”下进行。 

 

 

6.2  建立一个项目 

6.2.1 建立项目 

使用项目管理结构来构造一个自动化任务解决方案，你需要生成一个新的项目。新项目应

生成在你的“General”菜单中为项目设定的路径下，该操作可通过菜单命令Options > 

Customize选中。 

注意 

SIMATIC管理器允许名字多于八个字符。但是，由于在项目目录中名字被截短为八个字符，

所以一个项目名字的前八个字符应区别于其它的项目。名字不必区分大小写。 

无论是手动生成项目还是使用向导（Wizard）生成项目，你都会找到每一步骤的向导。 

 

使用向导生成一个项目 

生成一个新项目最简单的办法是使用“New Project（新项目）”向导。使用菜单命令File>

“New Project” Wizard，打开Wizard，对话框中将显示你所建立的项目结构，向导会

注意你在对话框中输入所要求的详细内容，然后生成项目。除了硬件站、CPU、程序文件、

源文件夹、块文件夹及OB1，你甚至还可以选择已有的OB作故障和过程报警的处理。 
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下图所示为使用向导生成的项目 

 

手动生成项目 

你还可以在SIMATIC管理器中，使用菜单命令File > New，生成一个新的项目。它已包括

“MPI Subnet（MPI网络）”对象。 

 

可选步骤 

当你编辑项目时，大部分任务的执行顺序是可以灵活掌握的。一旦生成了一个项目，接下

来你可以选择以下的任一方法： 

• 首先组态硬件，然后为它生成软件程序，或 

• 先生成一个与组态的硬件无关的软件程序。 

 

可选方法1：先组态硬件 

如果你想先组态硬件，可参照《STEP 7手册》第二卷中组态硬件部分进行。如果已经组态

硬件，组态硬件完成后，生成软件所需的“S7 Program”和“M7 Program”文件夹则已

插入。接下来，继续插入编程所需的对象。 

 

可选方法2：先生成软件 

你可以在没有硬件组态的情况下先生成软件；然后再组态硬件。对于程序编辑来说，并不

需要将站的硬件结构事先设好。 

基本步骤如下： 

1.  在项目中插入所需的无站或CPU S7软件文件夹S7/M7程序。 

    在这儿你可以决定是否在程序文件夹中包含S7硬件或M7硬件。 

2.  然后就可以为可编程模板生成软件了。 

3.  组态硬件。 

4.  一旦完成硬件组态，就可以将M7或S7程序与CPU联系起来。 
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6.2.2 插入一个站点 

在项目中，站代表着可编程控制器的硬件结构，它包含着每一个模板的组态数据及参数赋

值。 

用“New Project（新建项目）”向导生成的新项目中已经包含了一个站。另外，你可以用

菜单命令Insert > Station，生成站。 

你可在下列各种站中作选择： 

• SIMATIC 300站 

• SIMATIC 400站 

• SIMATIC H 站 
• SIMATIC PC 站 

• PC/Programming device（可编程设备） 
• SIMATIC S5 

• 其它站，即，非SIMATIC S7/M7及SIMATIC S5 

站在插入时带有预置名（如，SIMATIC 300 Station（1），SIMATIC 300 Station（2））

等。如果愿意的话，你可以用一个相应的站名替代预置名。 

在帮助“Inserting a Station（插入一个站）”下面，你可以找到一步步插入一个站的向导。 

 

组态硬件 

当你组态硬件时，可以借助于模板样本对可编程控制器中的CPU及各模板进行定义。你可

以通过双击站来启动硬件组态的应用程序。 

一旦你存储并退出硬件组态，对于在组态中生成的每一个可编程模板，都会自动生成S7或

M7程序及连接表（“Connections”对象）。用“New Project”向导生成的项目则已包含

这些对象。 

在帮助“Configuring the Hardware（组态硬件）”下面，你能够找到一步一步组态的向导，

更详细的信息见帮助“Basic Steps for Configuring a Station（组态站的基本步骤）”。 

 

生成连接表 

每一个可编程模板可自动生成一个（空）的连接表（“Connections”对象）。连接表可用

来定义网络中可编程模板之间的通讯连接。打开连接表，则有一个表格窗口显示出来，你

可以在这里定义可编程模板之间的连接。 

在帮助“Networking Stations within a Project（在一个项目中连网各站）”下面，你可以

得到更详细的信息。 
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下一步骤 

一旦完成了硬件组态，你可以为可编程模板生成软件（见帮助“ Inserting a S7/M7 Program

（插入S7/M7程序）”）。 

 

6.2.3  插入S7/M7程序 

为可编程模板编制的软件存储在对象文件夹中。对SIMATIC S7模板而言，该对象文件夹称

作“S7 Program”，对SIMATIC M7模板，它则被称作“M7 Program”。 

下图是在一个SIMATIC 300站中可编程模板的S7程序的示例。 

 

现已存在的组件 

每个可编程模板都会自动生成一个S7/M7程序来存储软件； 

在新生成的S7程序中，以下对象已经存在： 

• Symbol table符号表（“Symbols”对象） 

• “Blocks（块）”文件夹，用于存储第一个块 

• “Source Files（源文件）”文件夹，用于生成源文件 

在新生成的M7程序中，以下对象已经存在： 

• Symbol table符号表（“Symbols”对象） 

• “Blocks”文件夹 

 

生成S7块 

要用语句表、梯形图、或功能块图生成程序。可选择已经存在的“Blocks”对象，然后选

择菜单命令Insert > S7 Block。在子菜单中，你可以选择想要生成的块的类型（如：数据

块、用户定义的数据类型（UDT）、功能、功能块、组织块或变量表）。 

你可以打开一个（空）的块，然后用语句表、梯形图或功能图输入程序。你可以在语句表、

梯形图及功能图手册里，在生成逻辑块的基本操作的章节中得到更多的相关信息。 
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注意 

在用户程序中，可能会有由系统生成的“系统数据”（SDB）。你可以打开它，但为了保

持一致性，你不能修改它。一旦你装载，并将修改后的内容下载到可编程控制器就会改变

组态。 

 

使用标准库中的块 

你可以使用软件提供的标准库中的块来生成用户程序。使用菜单命令File>Open，可以访

问库。你可以在“Working with Libraries（使用库进行工作）”以及在线帮助中得到更多

的有关使用库及生成自己的库的信息。 

 

生成源文件/CFC图表 

如果你想用某种特定的编程语言生成一个源文件或CFC图表，可选择S7程序中的对象

“Source Files”或“Charts”，然后选择菜单命令Insert > S7 Software。在子菜单中选

择与你的编程语言相配的源文件。现在可以打开一个（空）的源文件输入程序了。你可以

在“Basic Information on Programming in STL Source Files（STL源文件的基本编程信息）”

中获得更多的信息。 

 

生成M7程序 

如果你想为M7系列的可编程模板的RMOS操作系统编制程序，可选择M7程序。然后选择

菜单命令Insert > M7 Software。在子菜单中，可选择与你的编程语言或操作系统相匹配

的对象。现在，你可以打开所生成的对象并访问相应的编程环境。 

 

生成符号表 

当生成一个S7/M7程序时会自动生成一个（空）符号表（“Symbols”对象）。打开符号

表时，“符号编辑器”窗口将显示一张符号表，可在该表中定义符号。你可以在“ Entering 

Multiple Shared Symbols in the Symbol Table（在符号表中输入多个共享符号）”中得到

更多的信息。 

 

插入外部源文件 

你可以用任何ASCII编辑器生成并编辑源文件。然后将这些文件引入到项目中，并且编译生

成各个块。 

将引入的源文件进行编译，所生成的块存储在“Blocks”文件夹中。 

你将在“Inserting External Source Files（插入外部源文件）”中获得更多的信息。 
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6.3  编辑项目 

 

打开一个项目 

要打开一个已存在的项目，可选择菜单命令File > Open，在随后的对话框中选中一个项目，

然后，该项目窗口就打开了。 

注意 

如果你想要的项目没有显示在项目列表中，点击“Browse”按钮。在这里可以搜寻包括已

列在项目列表中的项目在内的所有项目。可以使用菜单命令File > Manage改变选项。 

 

拷贝一个项目 

使用菜单命令File > Save As，可以将一个项目存为另一个名字。 

你可以使用菜单命令Edit > Copy，拷贝项目的部分如：站，程序，块等。 

你可以在“Copying a Project and Copying Part of a Project （拷贝项目及项目的一部分）”

中找到拷贝项目操作的向导。 

 

删除一个项目 

使用菜单命令File > Delete，可删除一个项目。 

使用菜单命令Edit > Delete，可删除项目中的一部分，比如：站，程序，块等。 

你可以在“Deleting a Project and Deleting Part of a Project（删除项目及删除项目的一部

分）”中找到删除项目的操作步骤。 

 

6.3.1 检查项目所使用的选件包 

如果你正在编辑的项目中含有选件包所创建的对象，则编辑时需要该选件包。 

不论使用什么编程器编辑多重项目、项目或库，STEP 7将提示你所需的选件包及版本。 

在下列条件下需要选件包信息： 

• 如果用STEP 7 V5.2创建项目(或多重项目中所有项目)或库。 

• 首先进入SIMATIC管理器并选择相应项目。选择菜单命令Edit > Object Properties。

在显示的对话框中，选择“Required optional packages”，该选择框中的信息将告诉

你是否检查项目的选件包。 
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6.4 管理多语言文本 

使用STEP 7，可以导出使用一种语言在项目中生成的文本，并进行翻译，重新导入，并以

所翻译的语言显示。 

下列文本类型可以进行多语言管理。 

• 注释和标题 

-  块标题和块注释 

-  网络标题和网络注释 

-  STL程序行注释 

-  符号表、变量声明表、用户定义数据类型和数据块注释 

-  HiGraph程序注释、状态名和转移名 

-  S7-Graph程序中的步名和步注释扩展 

• 显示文本 

-  STEP 7、S7-Graph、S7-HiGraph或S7- PDIAG生成的报文文本 

系统文本库  

用户定义的文本库 

操作员相关的文本 

用户文本 

 

导出 

在所选对象中，导出所有块和符号表。每个文本类型都将生成一个导出文件。该文件包括

一列源语言和一列目标语言。源语言中的文本禁止改变。 

 

导入 

在导入过程中，目标语言栏的内容（右列）将装入所选项目中。只有与找到的源语言栏中

现有文本相匹配的文本，才能被接受。 

 

转换语言 

在转换语言时，可以选择导入所选项目时指定的所有语言。然后，改变所选对象语言。 
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删除语言 

在删除一种语言时，该语言中的所有文本都将被从内部数据库中删除。 

在项目中应总有一种语言作为基本语言。例如，可以是你的母语。该语言不能删除。在导

入和导出时，一定要指定该基本语言为源语言。目标语言可以根据需要设定。 

 

基本程序 

 

 

 

6.4.1 多语言文本的类型 

导出时每种文本类型将创建一个单独的文件。项目中可以翻译的文本分为以下文本类型： 

 

文本类型 说  明 

Block Title 块标题 

BlockComment 块注释 

NetworkTitle 程序段标题 

NetworkComment 程序段注释 

LineComment STL中行注释 

InterfaceComment 变量部分注释(程序中的声明表)、UDT注释 (用户自定义数据类
型)和数据块注释 

SymbolComment 符号注释 

  

生成翻译导出文件（菜单命令Options > Manage
Multilingual Text > Export） 

翻译文本 

导出翻译文件（菜单命令Options > Manage    
Multilangual Text >Import） 

在显示文本的地方选择语言（菜单命令Options >   

Manage Multilingual Text > Change Language） 
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HiGraphStateName 
HiGraphStateComment 
HiGraphTansitionName 
HiGraphTransitionComment 

S7-HiGraph 
语句名 

语句注释 

转换名 

转换注释 

S7UserTexts 用户输入的、可以输出到显示设备的文本 

S7SystemTextLibrary 可集成到报文中的系统库的文本，该报文可以在运行期间动态
更新，并可在PG或其它显示设备上显示 

 

 

6.4.2 导出文件的结构 

导出文件的结构如下： 

$_Languages  

9(1)English(USA) 7(1)German(Germany) 
$_Type(SymbolComment)  

要翻译的第一句 翻译 

要翻译的第二句 翻译 

 

 

 

1. 下面内容可能不被修改、覆盖或删除： 

- 以“$_”为域的开始(这些是关键字) 

- 语言代码(在上面的解释中：9(1)是源语言英语，7(1)是目标语言德语)。 

2. 每 个 文 件 包 含 有 单 个 测 试 类 型 的 文 本 。 例 如 ： 文 本 类 型 是

NetworkTitle($_Type(NetworkTitle))。翻译该文件的规则包含在导出文件自身的介绍

性文字中。 

3. 在类型定义($_Type… )或最后一栏后必须出现关于文本或注释的其它信息。 

注意： 

如果目标语言栏被“512(32) $_Undefined”所覆盖，当文件导出时将不指定目标语言。为

了更好地观察，你可以用目标语言替换该文本。例如“9(1)English(US)”。当导入翻译文

件时，必须检验所要使用的目标语言，如果需要，选择正确的语言。 

输入关键字 $_hide可以隐藏而不显示目标语言。但它不会影响变量注释

(InterfaceComment)和符号注释(SymbolComment)。 

 

源语言                        目标语言 
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导出文件的格式 

导出文件的格式为CSV格式，当用EXCEL编辑时，必须记住只有当使用Open对话框时，才

能在EXCEL正确打开CSV文件。在浏览器中双击打开CSV文件将导致文件不能使用。按下

列步骤可以很方便地在EXCEL下使用： 

1. 在EXCEL下打开导出文件 

2. 将文件存储为XLS文件 

3. 翻译XLS文件中的内容 

4. 在EXCEL中以CSV格式保存XLS文件 

 

注意： 

导出文件可能不能更换名称。 

 

 

6.4.3 管理还没有装入字体的用户文本 

可以导出操作系统中还没有装入字体的用户文本，可以翻译并重新导入它们并进行保存。 

但是，这些文本只能在装入字体的计算机上才能显示出来。 

例如：如果用户文本要翻译成俄语，但是操作系统中没有Cyrillic字体，则需要按下列步骤

进行： 

1. 导出要翻译的用户文本。 

2. 翻译好导出的CSV格式的文件。 

3. 导入翻译好的CSV文件。结果：您的计算机中已经有了英文和德文的项目文件。 

4. 保存整个项目文件并将其发给要使用俄文的用户，如果他的机器上有Cyrillic字体，则

可以显示它们。 

 

 

6.4.4 优化需翻译的源文件 

通过和并不同的术语和说明可以为所需翻译的文件做好准备。 
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例如 

准备前(导出文件)： 

$_Languages  

9(1)English(USA) 9(1)English(USA) 
$_Type(SymbolComment)  

Auto-enab.  
Automatic enable  
Auto-enable  

 

 

 

和并为一个单个说明： 

$_Languages  
9(1)English(USA) 9(1)English(USA) 

$_Type(SymbolComment)  
Auto-enab. Auto-enable 

Automatic enable Auto-enable 
Auto-enable Auto-enable 

 

 

 

准备后(导入和导出后)： 

$_Languages  
9(1)English(USA) 9(1)English(USA) 

$_Type(SymbolComment)  
Auto-enab. Auto-enable 
  

  

 

 

 

源语言                        目标语言 

源语言                        目标语言 

源语言                        目标语言 
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6.4.5 优化翻译过程 

如果现有的项目中的结构和文本与以前的项目相似，则可以优化翻译过程。 

在特殊情况下，如果通过复制而创建的项目并要对其进行修改，我们推荐按下列步骤进行。 

 

前提条件 

必须有一个已经翻译好的导出文件CSV文件。 

 

步骤 

1. 将该导出文件拷贝到要翻译的新的项目的文件夹中。 

2. 打开新项目并导出文本(菜单命令Options > Manage Multilingual Texts > Export)。

因为导出的目标文件已经存在，将会提示您是否对其覆盖。 

3. 点击Add按纽。 

4. 翻译导出文件(只需翻译新文本)。 

5. 然后导入翻译好的文件。 
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7 用不同版本STEP 7编辑项目 
 

7.1 编辑版本2的项目和库 

STEP 7 V5.2不再支持V2项目中的变化。当编辑V2项目或库时，将会发生不一致的情况，

诸如不能用更老版本的STEP 7编辑V2项目或库。 

为了能继续编辑V2项目或库，必须用V5.1以前的版本的STEP 7。 

 

7.2 扩展用以前版本STEP 7创建的DP从站 

 

通过导入新的*.GSD文件构成 

如果在硬件目录中安装了新的设备的数据库文件(*.GSD文件)，则HW Config可以接受新的

DP从站。安装后，可以在其它现场设备文件夹中使用它们。 

如果下列条件都成立时，不能用常用方法用STEP 7 SP3对模块化DP从站进行重新配置和

扩展： 

• 从站是用以前版本的STEP 7组态的 

• 在硬件目录中，从站是以类型文件表示的，而不是用*.GSD文件表示的 

• 从站上已安装了一个新的*.GSD文件 

 

解决方法 

如果DP从站使用了用*.GSD文件描述的新的模板： 

• 删除DP从站并重新组态。则DP从站是以*.GSD文件说明的，而不是用类型文件说明的。 

 

如果不想使用任何一个只用*.GSD文件描述的新模板： 

• 在硬件目录窗口中的 PROFIBUS-DP下，选择Other Field Devices/Compatible 

PROFIBUS-DP Slaves文件夹。当它们被新的*.GSD文件更新时，STEP 7将把“旧”的

类型文件移到该文件夹中。在这个文件夹中，你可以发现这些模板，用它们可以对已

组态好的DP从站进行扩展。 
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在STEP 7 V5.1 SP4中用GSD文件更换类型文件 

对于STEP 7 V5.1 SP4，既可以更新类型文件或用GSD文件替换。该替换只会影响STEP 7

提供的目录。 

以前通过类型文件定义的DP从站的属性现在可以通过GSD文件定义，这些DP从站始终放

在硬件目录中的相同的位置上。 

不会删除“旧”的类型文件，而是将其移到硬件目录中的其它地方。目前它们位于目录文

件夹“Other field devices\Compatible PROFIBUS DP slaves\…”中。 

 

用STEP 7 SP4扩展现有的DP组态 

如果你要编辑用以前版本STEP 7(V5.1 SP4以前的版本)建立的项目，并要扩展一个模块化

DP从站，则不能使用从硬件目录中通常的地方取出的模板或子模板。在这种情况下，使用

“Other field devices\Compatible PROFIBUS DP slaves\…”中的DP从站。 

 

用以前版本的STEP 7(V5.1 SP4以前的版本)编辑用STEP 7 SP4建立的项目 

如果要组态一个用STEP 7 V5.1 SP4“更新”的DP从站，然后用以前版本的STEP 7编辑该

项目，由于以前版本的STEP 7不识别所使用的GSD文件，所以不能编辑该DP从站。 

解决方法：在以前版本的STEP 7中安装所需的GSD文件。在这种情况下，GSD文件存储在

该项目中。如果该项目后来用V5.1进行编辑，组态时STEP 7将使用最新安装的GSD文件。 

 

7.3 用以前版本的STEP 7编辑当前的组态 

 

组态直接数据交换 

在非DP主站系统中组态与DP主站的直接数据交换： 

• 不能用STEP 7 V5.0 SP2(或以前的版本) 

• 可以用STEP 7 V5.0 SP3和STEP 7 V5.1 

如果用当前的STEP 7 V5.0 SP3或STEP 7 V5.1用所赋值的直接数据交换存储DP主站，并要

继续用以前版本的STEP 7 V5编辑该项目，将会发生： 

• 将显示一个DP主站系统和从站，该从站是对所赋值的STEP 7内部数据存储区进行直接

数据交换而使用的。这些DP从站不属于所显示的DP主站系统。 

• 不能将一个新的DP主站系统或一个孤立的DP主站连接到该DP主站上。 
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通过PROFIBUS DP接口在线连接到CPU 

不用DP主站系统组态PROFIBUS DP接口： 

• STEP 7 V5.0 SP2(或以前版本)：不能用该接口连接到CPU。 

• STEP 7 V5.0 SP3或STEP 7 V5.1：在编译过程中生成PROFIBUS-DP接口的系统数据；

下载后可用该接口连接到CPU。 

 

7.4 对以前版本的SIMATIC PC组态的添加 

 

STEP 7 V5.1项目的PC组态(最高到SP1) 

对于STEP 7 V5.1 SP2，可以用对于S7-300或S7-400站相同的方法向PC站下载通讯。然而，

通常是在存储或编译过程中生成组态文件，这样才能使用该方法向PC目标站传送组态信

息。 

该结果是“旧”的PC站不能解释包含在新生成的组态文件中的一些信息。STEP 7将自动适

应这些情况： 

• 如果用STEP 7 V5.1 SP2创建一个新的SIMATIC PC站，STEP 7将假设PC目标站是通过

SIMATIC NET CD(7/2001)的帮助组态的，也就是假定安装了 S7RTM(Runtime 

Manager)。用这种方法生成的组态文件可以通过“新”的PC站进行解释。 

• 如果对以前版本的SIMATIC PC站的组态进行扩展(例如对用STEP 7 V5.1 SP1组态的

PC站扩展)，STEP 7不会假设PC目标站是通过SIMATIC NET CD(7/2001)的帮助组态的。

用这种方法生成的组态文件可以通过“旧”的PC站进行解释。 

如果该缺省特性不能满足您的需要，则要按照下述内容进行修改： 

 

在Context菜单“Configuring Hardware”中进行设定： 

1. 打开PC站的硬件配置 

2. 右击站窗口(白色区域) 

3. 选择Context-sensitive菜单“Station Properties” 

4. 检查或清除“Compatibility”选择框。 

 

在Context菜单“Configuring Networks”中进行设定： 

1. 打开网络配置 

2. 选择PC站 
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3. 选择菜单命令Edit > Object properties 

4. 在对话框中选择“Configuration” 

5. 检查或清除“Compatibility”选择框。 

 

STEP 7 V5.0项目的PC组态 

如果要对用STEP 7 V5.0 SP3组态的SIMATIC PC站组态新的部件，只有SP3或更高版本才

支持这些部件，此时必须对站进行转换： 

1. 在SIMATIC管理器中，选中SIMATIC PC站并选择菜单命令Edit > Object properties。 

2. 在属性对话框中的“Functions”选项中，点击“Expand”按钮对SIMATIC PC站进行

转换。现在，只能用STEP 7 V5.0 SP3或更高版本对其进行编辑。 

 

7.5 用更高版本的STEP 7或选件包表示模板的组态 

对于STEP 7 V5.1 SP3，可以显示所有模板，即使用更高版本STEP 7组态的模板。也可以

显示用选件包组态的模板，即使编程器上没有安装所需的相应选件包也可以显示。 

在以前版本的STEP 7中，不能显示一些模板及其附属部件。在当前版本中，这些模板是可

见的并可进行编辑。例如即使在其它计算机上用比较新的STEP 7建立的项目，以及由于模

板具有新的特性和参数而不能用老板本的STEP 7对模板进行组态的情况下，也可以使用该

功能修改用户程序。 

STEP 7不识别的模板用下列图标显示： 

如果用适当的版本的STEP 7或用可兼容的选件包打开项目，将以标准的方法显示所有模

板，并可进行编辑。 

 

装有最新版本的STEP 7/选
件包的PG 

 装有旧版本的STEP 7/无选
件包的PG 

 

 
 

 >>> - - - 项目数据 - - - >>>  

对最新模板表示为“识别”  对最新模板表示为“不识别” 
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在SIMATIC管理器中表示模板的表示 

在站级别下，表示模板表示为可见的。在该级别下的所有附属部件，诸如用户程序、系统

数据和连接表均是可见的并可从SIMATIC管理器下进行下载。 

也可以打开、编辑、编译和装载用户程序。但是，对于可见块的项目应遵守下列限制： 

• 不能复制一个包含可见块的站 

• 不能完全使用“Save project as…”中“with reorganization”选项。在复制和重新组

织项目时将丢失该模板以及该模板的所有参考和附属部件(例如用户程序) 

 

在硬件配置中表示模板的表示 

在所组态的插槽上显示表示模板。 

可以打开该表示模板，但不能修改参数或下载。模板属性受给出的“Representative”表

属性的限制。不能修改站属性(例如不能增加新模版)。 

可进行硬件诊断(例如在线打开一个站)。 

 

在网络组态中表示模板的表示 

也可以在NetPro上显示该表示模板。在这种情况下，站上的该模板名称显示为问号。 

在NetPro下只能以写保护的形式打开带有表示模板的项目。 

如果以写保护的形式打开项目，可以显示和打印网络组态。也可以得到连接状态，该状态

至少包含当前使用的STEP 7版本所支持的信息。 

通常情况下，不能对其修改、保存、编译和下载。 

 

模板的安装顺序 

如果模板来自更高版本的STEP 7，并已对其进行的硬件更新，可以用“真实”模板更换该

表示模板。根据所打开的站，接收必要的硬件更新或选件包的信息，用对话方式进行安装。

也可以通过菜单命令Options > Install HW Updates进行安装。 
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8 定义符号 
 

8.1 绝对地址和符号地址 

在STEP 7 程序中，你可以寻址I/O信号、存储位、计数器、定位器、数据块和功能块。你

可以在程序中用绝对地址来访问这些地些，但是，如果使用符号地址，你的程序读起来会

更容易（例如，参照你们工厂的代码系统），使用Motor_A_On或其它的标识符。你的用

户程序中的地址则可通过这些符号来寻址。 

 

绝对地址 

一个绝对地址由一个地址标识符和一个存储地址组成（如，Q4.0，I1.1，M2.0，FB21）。 

 

符号地址 

如果你给绝对地址赋予符号名字，则你的用户程序的可读性会更好，故障诊断更容易。 

STEP 7可自动地将符号地址转换成所需的绝对地址。如果要用符号名访问数组、结构、数

据块、局域数据、逻辑块以及用户定义的数据类型，必须首先将符号名赋给绝对地址，然

后才能对这些数据进行符号寻址。 

例如，你可以将符号名MOTOR_ON赋给地址Q4.0，然后在程序指令中就可以使用

MOTOR_ON寻址了。使用符号地址可以比较容易地辨别出程序中所用操作数与过程控制

项目中的元素的对应关系。 

注意 

在符号名中不允许使用两个连续的下划线（如MOTOR_ON）。 

 

编程支持 

在梯形图、功能块图及语句表这三种编程语言的表达方式中，你可以使用绝对地址或符号

来输入地址、参数和块名。 

使用菜单命令View>Display>Symbolic Representation，你可以在绝对地址和符号地址两

种表达方式之间进行切换。 

为使符号地址编程更简单，你可以显示该符号的绝对地址及注释。使用菜单命令

View>Display>Symbol information，可激活此信息功能。这意味着语句表指令后面的行

注释包含更多的信息。你无法在显示中进行编辑，任何修改都需在符号表或声明表中进行。 
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下图所示为语句表中的符号信息。 

当打印一个块时，当前屏幕上带有语句注释或符号注释的表达方式会被打印出来。 

 

8.2 共享和局域符号 

符号寻址允许你用有一定含义的符号地址来替代绝对地址。将短的符号和长的注释结合起

来使用，可以使编程更简单，程序文件作得更好。 

你必须区分局域（块定义）符号和共享符号。 

 共享符号 局域符号 

有效性 • 在整个用户程序中有效， 

• 可以被所有的块使用， 

• 在所有的块中含义是一样的， 

• 在整个用户程序中是唯一的。 

• 只在定义的块中有效 

• 相同的符号可在不同的块中用于不
同的目的 

允许使用 

的字符 

• 字母、数字及特殊字符， 

• 除0x00，0xFF及引号以外的强调
号 

• 如使用特殊字符，则符号须写出在
引号内 

• 字母 

• 数字 

• 下划线（_） 

使用 你可以为以下各项定义共享符号： 

• I/O信号（I，IB，IW，ID，Q， QB，
QW，QD） 

• I/Q输入与输出（PI，PQ） 

• 存储位（M，MB，MW，MD） 

• 定时器（T）/计数器（C） 

• 逻辑块（FB，FC，SFB，SFC） 

• 数据块（DB） 

• 用户定义数据类型（UDT） 

• 变量表（VAT） 

你可以为以下各项定义局域符号： 

• 块参数（输入，输出及输入/输出参
数）， 

• 块的静态数据， 

• 块的临时数据。 

在哪里定义 符号表 块的变量声明表 
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8.3 显示共享或局域符号 

 

如下所示，你可以在程序的指令部分区分开共享符号和局域符号。  

• 符号表中定义的符号（共享）显示在引号内。 

• 块变量声明表中的符号（局域）显示时前面加上“#”。 

你不必输入引号或“#”。当你以LAD、FBD或STL方式输入程序时，语法检查自动增加这

些字符。 

如果你担心会出现混淆，比如同一个符号在符号表和变量声明表中都使用了，那么，你必

须明确地输入标志着共享符号的代码（引号）。因为在此情况下，如果没有相应的代码符

号一律解释为块定义（局域变量）。 

如果符号地址中包含空格，则也需在此符号地址上加上共享符号的代码。 

当使用STL编辑源文件时，可使用同样的特殊字符及划线。在自由编辑模式下不自动加上

代码字符，但是，如果你希望避免混淆，有必要输入共享符号的代码。 

 

注意 

使用菜单命令View>Display>Symbolic Representation，你可以在所声明的符号地址和

绝对地址之间进行切换。 

 

 

 

8.4 建立地址优先权(符号地址/绝对地址) 

当修改了符号表、数据块或功能块的参数名、UDT所代表的部件名或修改了多重背景时，

地址优先级将帮助您修改相应的程序。 

当下列状态改变时，应确保认真地设置地址优先级。为了更好地使用地址优先级，必须完

成每个修改步骤，然后再开始对其它类型进行修改。 

设定地址优先级，进入SIMATIC管理器，选择块文件夹然后选择菜单命令Edit > Object 

Properties。在“Address Priority”栏中进行设置。 
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为了对地址优先级进行优化设置，需要区分下列状态的变化： 

• 对每个名称进行修正 

• 修改文件名或赋值 

• 新的符号、变量、参数或部件 

 

对每个名称进行修正 

举例： 

在符号表或程序编辑器/块编辑器中，要对名称的拼写错误进行修正。它将对符号表中的所

有名称以及程序编辑器/块编辑器可以修改的参数、变量或部件的所有名称起所用。 

 

设定地址优先级 

 

 

对修改进行跟踪： 

在SIMATIC管理器中，选择块文件夹并选择菜单命令Edit > Check Block Consistency。

“检查块的一致性”功能可以对每个块中的必要部分进行修改。 

 

修改文件名或赋值 

举例： 

• 修改符号表中已赋值的名称。 

• 对符号表中以赋值的名称赋值一个新的地址。 

• 在程序编辑器/块编辑器中修改变量名、参数明或部件名。 
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设定地址优先级 

 
 

对修改进行跟踪： 

• 当修改符号表中逻辑块的赋号名时(OB/FB/FC)，使用块文件夹中的源程序，生成一个

源程序然后重新对其编译。 

• 其它情况：在SIMATIC管理器中，选择块文件夹并选择菜单命令Edit > Check Block 

Consistency。“检查块的一致性”功能可以对每个块中的必要部分进行修改。 

 

新的符号、变量、参数或部件 

举例： 

• 你正在为程序中使用的地址建立一个新的符号。 

• 你正在为数据块、UDT或功能块添加新变量或参数。 

 

设定地址优先级 

• 在符号表中进行修改 
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• 在程序编辑器/块编辑器中进行修改 

 

 

 

 

 

 

 

 

 

对修改进行跟踪： 

在SIMATIC管理器中，选择块文件夹并选择菜单命令Edit > Check Block Consistency。

“检查块的一致性”功能可以对每个块中的必要部分进行修改。 

 

8.5  共享符号的符号表 

共享符号在符号表中定义。 

当你生成S7或M7程序时，一个（空的）符号表（“Symbols”对象）会自动生成。 

 

有效性 

符号表只对你的用户程序所连接的模板是有效的。如果你想在几个CPU中使用同样的符号，

必须确保各符号表中的内容是相配的（比如，拷贝该表）。 

 

8.5.1  符号表的结构及元素 

符号表的结构 
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R/O/M/C/CC  

R/O/M/C/CC 列显示各符号是否赋予了特殊对象的特性： 

• R（监控）意思是指使用任选软件包S7-PDIAG（V5）生成过程诊断错误定义符号。 

• O指该符号能够在WinCC下被操作和监控。 

• M指该符号被赋予了与符号相关的信息（SCAN）。 

• C指该符号被赋予了通讯特性（只能在NCM中被选中）。 

• CC指可以在符号编辑器中直接监控的赋号（“Control at Contact”）。 

 

Symbol（符号） 

符号名不能长于24个字符。一张符号表最多可容纳16380个符号。 

数据块中的地址（DBD，DBW，DBB，DBX）不能在符号表中定义。它们的名字应在数据

块声明表中定义。 

组织块（OB）、一些系统功能块（SFB）以及系统功能（SFC）已预先被赋予了符号名，

当你为S7程序编辑符号表时可以引入这些符号名。该引入文件存在SIMATIC路径下⋯

\S7data\Symbol\Symbol.sdf。 

 

地址 

地址是一个特定存储区域和存储位置的编写，例如，输入I12.1例如：Input I 12.1 

输入时要对地址的语法进行检查，还要检查看该地址是否可以赋给指定的数据类型。 

 

数据类型 

在SIMATIC中可以选择多种数据类型。在数据类型区域中已有一个缺省数据类型，如果需

要，用户可以修改。如果所作的修改不适合该地址或存在语法错误，当你退出该区域时会

显示一条错误信息。 

 

注释 

你可以给所有的符号加注释。简短的符号名与更详细的注释混合使用。可使编程更有效，

使程序文件更完善。注释最长80个字符。 

 

转换为C变量 

你可以在M7程序的符号表中选中符号，然后将它们转换成相应的与ProC/C++软件选项相

连接的C变量。 
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8.5.2 符号表中允许使用的地址和数据类型 

在整个符号表中只能使用一套助记符。在Windows管理器中使用菜单命令

Options>Customize，在“Language”选项中，可以在SIMATIC（德语）和IEC（英语）

两套助记符之间进行切换。 

 

IEC SIMATIC 说  明 数据类型 范  围 

I E 输入位 BOOL 0.0 - 65535.7 

IB EB 输入字节 BYTE，CHAR 0- 65535 

IW EW 输入字 WORD，INT，S5TIME，DATE 0 - 65534 

ID ED 输入双字 DWORD，DINT，REAL，  TOD，
TIME 

0 - 65532 

Q A 输出位 BOOL 0.0 - 65535.7 

QB AB 输出字节 BYTE，CHAR 0 - 65535 

QW AW 输出字 WORD，INT，S5TIME，DATE 0 - 65534 

QD AD 输出双字 DWORD，DINT REAL TOD， 
TIME 

0 - 65532 

M M 存储位 BOOL 0.0 - 65535.7 

MB MB 存储字节 BYTE，CHAR 0 - 65535 

MW MW 存储字 WORD，INT，S5TIME，DATE 0 - 65534 

MD MD 存储双字 DWORD, DINT, REAL，TOD，TIME  0 - 65532 

PIB PEB 外设输入字节 BYTE，CHAR 0 - 65535 

PQB PAB 外设输出字节 BYTE，CHAR 0 - 65535 

PIW PEW 外设输入字 WORD，INT，S5TIME，DATE 0 - 65534 

PQW PAW 外设输出字 WORD，INT，S5TIME，DATE 0 - 65534 

PID PED 外设输入双字 DOWRD, DINT, REAL TOD， 
TIME 

0..65532 

PQD PAD 外设输出双字 DOWRD, DINT, REAL，TOD，TIME  0 – 65532 

T T 定时器 TIMER 0 - 65535 

C Z 计数器 COUNTER 0 - 65535 

FB FB 功能块 FB 1 - 65535 

OB OB 组织块 OB 1 - 65535 

DB DB 数据块 DB，FB，SFB，UDT 0 - 65535 

FC FC 功能 FC 0 - 65535 

SFB SFB 系统功能块 SFB 0 - 65535 

SFC SFC 系统功能 SFC 0 - 65535 

VAT VAT 变量表  0 - 65535 

UDT UDT 用户定义数据
类型 

UDT 0 - 65535 
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8.5.3 符号表中不完整的和不唯一的符号 

 

不完整的符号 

你有可能存储了不完整的符号。比如，先只输入符号的名字，以后再加上相应的地址。这

意味着你可能在任何时候中断符号表的编辑，暂时存储这一临时结果，另外再找时间来完

成。当你要用符号来编程时（没有错误信息显示），必须事先输好符号名、地址及数据类

型。 

 

不唯一的符号是怎样出现的 

当你在符号表中插入一个符号，而该符号名和/或地址已在其它行中使用，这时就会出现不

唯一的符号。即：新的符号与已存在的符号不唯一。 

上述情况会出发生在，比如你为了作一些微小的改变而拷贝并粘贴某一符号。 

 

标定不唯一的符号 

在符号表中，以图形加亮（颜色，字符）方式对不唯一的符号进行标定。这种在表达方式

上的改变意味着它们仍需要编辑。你可以显示所有符号或有选择地进行显示，即只显示唯

一的符号或不唯一的符号。 

 

使符号唯一 

当你修改引起符号不唯一的元素（符号和/或地址）时，不唯一的符号就变成了唯一的符号。

如果两个符号相互不唯一，当改变其中一个使之成为唯一符号时，另一个也就成了唯一的

符号。 

 

8.6  输入共享符号 

有三种方式进行符号输入，这些符号可以在后面的编程当中使用：  

• 通过对话框 

在程序输入窗口中你可以打开一个对话框，定义新的符号或对已有的符号重新定义。

这种方法最好用于对单个符号的定义，比如，当你编程时发现少了一个符号或想更正

某个符号。这种方法你不用显示整张符号表。 

• 直接在符号表中 

你可以直接在符号表中输入符号及其绝对地址。这种方法推荐用于编辑大量符号或者
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为项目生成符号表的情况。因为这种方法会在屏幕上显示已经赋值的符号，你可以更

容易地观察这些符号。 

• 从其它表格编辑器中引入符号表 

你可以用任何一种你所喜欢的表格编辑器来生成符号数据（比如，Microsoft Excel），

然后将该文件引入符号表。 

 

8.6.1  输入符号时的注意 

在符号表中输入新符号，将光标点中表中的第一空行并填写该单元。你可以使用菜单命令

Insert>Symbol，在当前行前面插入一个新行。如果光标前面的行已包括有一个地址，在通

过“Address”和“Data Type”栏的预定值插入新的符号时，会受到支持。从前一行中导

出地址；缺省数据类型作为数据类型输入。 

还可以使用Edit菜单中的命令拷贝并修改表中已有各项。存储然后关闭符号表，你还可以

保存那些还未完全定义完的符号。 

当你在表中输入符号时，须注意以下各点： 

列 注  意 

符号 在整个符号表中名字必须唯一。当你确认该区域的输入或退出该区域时，不唯一的
符号则被标定出来。符号名最长可达24个字符。引号（″）不允许使用。 

地址 当你确认或退出该区域时，程序会自动检查该地址输入是否是允许的。 

数据类

型 
当你确认或退出地址时，该区域被自动地赋予一个缺省数据类型。如果你修改这个

缺省类型，程序会检查你的数据类型是否与地址相匹配。 

注释 你可以输入注释简单地解释该符号的功能（最多80个字符）。输入注释任选。 

 

 

8.6.2  在对话框中输入单个共享符号 

下文所描述的是如何在编辑程序块时利用对话框改变符号或定义新符号而不必显示符号

表。 

如果你想编辑单个符号，这种方法非常有用。如果你要编辑大量的符号，应打开符号表，

直接在里面输入。 

 

在块中激活符号显示 

你可以在一个打开的块中用菜单命令View > Display > Symbolic Reprosentation，可激

活符号显示。在菜单命令前有一个对号表示该表达方式激活。 
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输入程序时定义符号 

1. 确认在块的编辑窗口中激活了符号表达方式（菜单命令View > Display > Symboilic 

Representation）。 

2. 在程序指令中选中你想对其进行符号赋值的绝对地址。 

3. 选择菜单命令Edit>Symbol。 

4. 填写对话框并关闭它，用“OK”确认你的输入并且确保输入的是一个符号。 

被定义的符号输入到符号表中。任何导致符号不唯一的输入都将被拒绝并显示错误信息。 

 

在符号表中进行编辑 

使用菜单命令Options > Symbol Table，可打开符号表并进行编辑。 

 

8.6.3 在符号表中输入多个共享符号 

打开符号表 

有几种方法打开符号表：  

• 在项目窗口双击符号表。 

• 在项目窗口选中符号表，然后使用菜单命令Edit > Open Object。 

处于激活状态的程序的符号表显示在自己的窗口中。此时你可以生成或编辑符号。当你在

符号表生成后第一次打开时它是空的。 

 

输入符号 

在符号表中输入新符号，将光标点中表中的第一空行并填写该单元。你可以使用菜单命令

Insert > Symbol，在当前行前面插入一个新的空行。还可以使用Edit菜单中的命令拷贝并

修改表中已有各项。存储然后关闭符号表，你还可以保存那些还未完全定义完的符号。 

 

分类符号 

符号表中的数据可以按照符号、地址、数据类型或注释进行按字母的分类。 

使用菜单命令View > Sort，可以打开一个对话框，重新定义分类显示以改变当前表中的分

类方式。 

 

筛选符号 

你可以用筛选功能在符号表中选择某组数据。 

使用菜单命令View > Filter，可以打开“Filter”（筛选）对话框。 
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你可以定义标准，只有满足标准的数据才能被包括在筛选后的显示当中。可按如下标准进

行筛选： 

• 符号名、地址、数据类型、注释 

• 具有操作员控制及监控属性的符号、具有通讯特性的符号、信息的二进制变量的符号

（存储位或过程输入） 

• 有效的符号、无效的符号（不唯一、不完整） 

各个标准之间通过与操作相连接。筛选后的数据以指定的字符串开始。 

如果你想了解“Filter”对话框中更多的选项，可以按F1打开与之相关的在线帮助。 

 

8.6.4  大小写符号 

在大小写字符之间无区别 

以前，STEP 7中定义的符号可能与用于其它情况的符号有所不同。这在STEP 7 V4.02中已

经进行修改。现在不在有符号之间的差异。  

这种修改可以根据客户的需要进行，由此大大减少程序中的错误发生率。符号定义限制也

支持PLCopen forum，以定义转换程序标准。 

具有大小写区别的符号定义现在不再支持。在以前，例如，在符号表中可能有下述定义： 

Motor1 = I 0.0 

motor1 = I 1.0 

这些符号的第一个字母都具有大小写区别。这种符号区别很容易造成混淆。新的符号定义

避免了这种错误源。 

 

对现有程序的影响 

如果你已经使用过不同符号之间的区分标准，你可能对使用新的符号定义有困难，如果：  

• 符号只在使用大小写字符时不同。 

• 参数只在使用大小写字符时不同。 

• 符号与参数只在使用大小写字符时不同。 

但是，如下所述，这三种冲突都可进行分析和解决。 
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符号只在使用大小写字符时不同 

冲突： 

如果没有使用当前版本软件编辑符号表，在编译源文件时，将使用符号表中不唯一符号的

第一个符号。 

如果已经编辑符号表，这些编译的符号也无效；意思是指在打开块时不显示符号，并且编

译包含这些符号的源文件时，将会出现错误。 

排除： 

打开符号表，检查符号表是否有冲突，并保存。这操作可以识别非唯一符号。然后，你可

以使用“非唯一符号”滤镜显示非唯一符号，并修正。你还可以修正包含冲突的任何源文

件。由于在打开块时，可以自动使用当前版本（无冲突）符号表，因此无需修改块。 

 

参数只在使用大小写字符时不同 

冲突： 

在编译包含这些接口的源文件时会出现错误。可以打开使用这些接口的块，但是不能再访

问这些参数中的第二个参数。如果你想存取第二个参数，在保存块后，程序将自动返回第

一个参数。 

排除： 

为了检查包含这种冲突的块，建议使用“生成源文件”功能，生成所有程序块的源文件。

如果在编译已生成源文件时出现错误，必定有冲突。 

应确保参数的唯一性，以校正源文件；例如，通过“查找和替换”功能。然后，再编译文

件。 

 

只在使用大小写字符时符号与参数不同 

冲突： 

如果源文件中的共享符号和局部符号，只在使用在小写字符时不同，并且没有使用首字母

大写，以区分共享（“符号名”）符号或局部（＃符号名）符号，在编译时将总是使用局

部符号。这会导致修改机器代码。 

排除： 

在这种情况下，建议生成所有块的新源文件。由此，可自动赋值局域和共享符号的首字母，

可保证在将来编译程序时，正确处理。 
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8.6.5 导入/导出符号表 

你可以导出当前的符号表到一个文本文件，这样就可以用任意的文本编辑器进行编辑。 

你还可以将其它应用程序中生成的表导入到你的符号表中并继续编辑。这种导入功能可以

用于，比如将S5程序转换为S7之后，将STEP5/ST中生成的符号赋值表导入进来。 

可选择的文件格式有：*.SDF、*.ASC、*.DIF以及*.SEQ。 

 

导出规则 

可以导出整个符号表、筛选后的部分符号表或表中选中的几行。 

用菜单命令Edit>Special Object Properties，设定的符号特性不能导出。 

 

导入规则 

• 为经常使用的系统功能块（SFB）、系统功能（SFC）以及组织块（OB）预先定义的

符号表已存在文件⋯⋯\S7DATA\SYMBOL\SYMBOL.SDF中，需要的话，可以从该文

件中导入。 

• 当进行导入和导出时，符号的特性不予考虑。符号特性可通过命令菜单Edit > Spectal 

Object Properties设定。 

 

8.6.6 导入/导出符号表的文件格式 

下列文件格式可从符号表中被导入或导出：  

• ASCII文件格式（ASC） 

• 数据交换格式（DIF） 

可以在Microsoft Excel中打开、编辑并存储DIF文件。 

• 系统数据格式（SDF） 

使用SDF文件格式从或向Microsoft Aceess应用程序导入或导出数据。 

-  可以在Microseft Access中打开、编辑并存储SDF文件。 

-  在Access中，选择文件格式“Text（带分隔符）”。 

-  使用双引号（”）作为文本分隔符。 

-  使用逗号（，）作为单元分隔符。 

• 赋值表（SEQ） 

注意：当导出符号表到一个SEQ文件时，注释长于40个字符则第40个字符以后的注释

将被截去。 
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ASCII文件格式（ASC） 

 

文件类型 *.ASC 

结 构 数据长度，逗号分隔符，数据 

示 例 126，green_phase_ped.  T    2    TIMER Duration of green phase 

                                  for pedestrians 
126，red_Ped.          Q    0.0   BOOL Red for pedestrians 

 

数据交换格式（DIF） 

 

文件类型 *.DIF 

结构 一个DIF文件包含文件首部及数据 

 

（Header）首部 表（TABLE） DIF文件的开始 

 0，1  

 “<Title>”标题 注释串 

 VECTORS 文件中记录的数量 

 0，<No. of records>（记录数）  

 “”  

 TUPLES 记录中的数据区域的数量 

 0，<No. of cloumns>（列数）  

 “”  
 DATA 作为首部结束及数据开始的

标识 

 0，0  

 “”  

数据（每个记录） <type>（类型）<numeric 

 value>（数字值） 

数据类型、数字值的样识 

 <string>（字符串） 字母部分或 

 V 如果没有使用字母部分 

 

首部： 文件首部必须按规定的顺序包含TABLE、VECTORS、TUPLES及DATA。在DATA

前面，DIF文件可以包含更多的可选记录类型。然而这些都被符号编辑器忽略不计。 

数据： 在数据部分，每项都包含三个部分：类型的标识（数据类型）、一个数字值以及一

个字母部分。 

可以在Microsoft Excel中打开、编辑并存储DIF文件。不必使用重音符、变音符或其它的特

殊语言字符。 
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系统数据格式（SDF） 

 

文件类型 *.SDF 

结构： 引号中的字符串，用逗句隔开各部分 

示例： “green_phase_ped”，“T   2”，“TIMER”，“Duration of green                         
phase for pedestrains”， 

“red_ped”，         “Q  0.0”，“BOOL”，“Red for pedestrains” 

要在Microsoft Access中打开一个SDF文件，你应选择“Text（带分隔符）”文件格式。

用双引号（”）作为文本的分隔符，用逗号（，）作为区域的分隔符。 

 

赋值表（SEQ） 

 

文件类型 *.SEQ 

结构： TAB  地址  TAB  符号  TAB  注释  CR 

示例： T2  green_phase_ped.  Duration of green phase for pedestrains Q0.0 
Red_ped. Red for Pedestrains 

TAB代表制表跳格键（09H） 

CR代表RETURN键（0DH）回车。 
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9 程序块和程序库的生成 
 

9.1  选择一种编程方法 

根据生成程序时所选用的编程语言，我们可以用增量输入方式输入程序或用自由编辑（文

本）方式输入。 

 

增量编辑器适用于梯形逻辑、功能块图、语句表以及S7-GRAPH等编程语言 

增量输入方式编辑器适用于梯形图、FBD、STL和S7-GRAPH，用该方式生成的块存放在用

户程序中。如果你想立刻检查所输入的内容，就应该用增量输入方式。这种编程方式尤其

适合于初学者。用增量输入方式输入时，每一行或每个元素都会立即进行句法检查。只有

改正了所指出的错误才能完成输入。句法修正过的所有输入经过自动编译存到用户程序中。 

任何用于语句中的符号必须事先定义。如果在程序块中使用了没有定义的符号，则该块不

能完全编译，但是这种不一致的临时版程序可以存盘。 
 

源代码（文本）编辑器适用于语句表、S7 SCL、S7 HiGraph编程语言 

在源代码编辑器中，是用源文件的形式生成用户程序，该文件再编译成各类程序块。 

我们建议您使用源代码进行编辑，因为它是高效地进行编程和监视。 

在文本文件中编辑程序或块的源代码，然后再进行编译。 

文本文件（源文件）存在你的项目中S7 Program下的“source file”文件夹中，例如：STL 

source file或SCL source file。一个源文件可包含一个块或多个块的程序代码。用文本编

辑器进行STL和SCL编程可生成OB、FB、FC、DB 及UDT（用户定义数据类型）的代码，

也可以生成整个用户程序。CPU的所有程序（意味着所有的块）可包含在一个文本文件中。 

当你编译源文件时，就会生成各种类型的块，并在用户程序中存起来。在文件中使用的任

何符号必须在编译之前加以定义。在编译的过程中，由编译器报告错误。 

为了顺利地通过编译，在编程语言中使用专门的句法是非常重要的。只有当选择了相容性

检查命令或将源文件编译成程序块时，才运行句法检查功能。 
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9.2  选择编程语言 

 

为编辑器设置编程语言 

当用户要生成某程序块或源文件时，应在对象的属性中设置用于生成该块或源文件的编程

语言和编辑器类型。该输入确定当该程序块或源文件打开时，启动的是哪种编辑器。 

 

启动编辑器 

在SIMATIC管理器中，用双击相应的对象（块，源文件，等），或选择菜单命令Edit > Open 

Object，或在工具条中选择相应的按钮，来启动相应的语言的编辑器。 

在表中列出的编程语言都可用于生成S7程序。在标准的STEP 7软件包中包括LAD、FBD、

STL。也可购买做为可选软件包的其它的编程语言。 

你可以选择一系列不同的编程方法（梯形逻辑、功能块图、语句表、高级语言、顺序控制

或状态图形）。还可以选择是用文本方式编程，还是用图形方式编程。 

选择好编程语言，也就确定了可以用哪种输入方式（·）。 

编程语言 用户类 应用 增量
输入 
自由
编辑

方式 

可从CPU备
份程序块 

语句表STL 愿意用类似于机器码语言编
程的用户 

程序在运行时间和存贮
空间要求上最优 

· · · 

梯形逻辑LAD 习惯电路图的用户 编写逻辑控制程序 · － · 

功能块图FBD 熟悉布尔代数逻辑图的用户 编写逻辑控制程序 · － · 

F-LAD，F-FBD 

可选软件包 

熟悉LAD和FBD的用户 编写F系统的程序 · － · 

SCL（结构控制语
言）可选软件包 

用高级语言，如PASCAL或C
编程的用户 

数据处理任务程序 － · － 

S7-Graph 
可选软件包 

有技术背景，没有PLC编程经
验的用户 

以顺序过程的描述很方
便 

· － · 

HiGraph 
可选软件包 

有技术背景，没有PLC编程经
验的用户 

对异步非顺序过程的描
述很方便 

－ · － 

CFC可选软件包 有技术背景，没有PLC编程经
验的用户 

适于连续过程的描述 － － － 

如果程序块中没有错误，可将其在梯形逻辑、功能块图和语句表之间进行切换。如果有部

分程序不能切换，则用语句表显示。 

可用源文件的语句表生成各程序块，也可将各程序块反编译到源文件中。 
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9.2.1 梯形逻辑编程语言（LAD） 

图形编程语言梯形逻辑是基于电路图表示法的基础之上，在程序段中将电路图中的元素如

常开触点和常闭触点组合而成。一个逻辑块的程序部分由一段或多段程序组成。 

 

梯形逻辑程序段举例 

 

梯形逻辑编程语言包含在STEP 7标准软件包中。梯形逻辑程序是用增量编辑器生成。 

 

9.2.2 功能块图编程语言（FBD） 

编程语言功能块图（FBD）使用类似于布尔代数的图形逻辑符号来表示控制逻辑。一些复

杂功能诸如算术功能等，可直接用逻辑框表示。 

FBD编程语言包含在STEP 7标准软件包中。 

 

举例：FBD中的一个程序段 

 

 

 

 

 

 

在FBD方法中用增量编辑器生成程序 
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9.2.3 语句表编程语言（STL） 

编程语言的另一种表示法是语句表，它类似于机器码的一种文本语言。每条语句对应CPU

处理程序中的一步。多条语句可组成一程序段。 

 

举例：语句表中的程序段 

语句表编程语言类型包含在STEP 7标准软件包中。用这种语言，你可以用增量编辑器编辑

S7块，在源代码编辑器中可以创建和编译STL程序源文件，以生成程序块。 

 

9.2.4 S7 SCL编程语言 

编程语言SCL（结构化控制语言）是一个可选软件包，它是按照国际电工技术委员会

IEC1131-3标准定义的文本语言。PASCAL类型语言在编写诸如回路和条件分枝时，用其高

级语言指令要比STL容易。因此，SCL适合于公式计算，复杂的最优化算法或管理大量的数

据。 

S7 SCL程序是在源代码编辑器中编写的。 

 

例如： 

FUNCTION_BLOCK FB20 

VAR_INPUT 

ENDVAL：    INT； 

END_VAR 

VAR_IN_OUT 

IQ1：     REAL； 

END_VAR 

VAR 
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INDEX：    INT； 

END_VAR 

 

BEGIN 

CONTROL：=FALSE； 

FOR INDEX：= 1 TO ENDVALUE DO 

IQ1：= IQ1 * 2； 

IF IQ1 >10000 THEN 

CONTROL = TRUE 

END_IF 

END_FOR； 

END_FUNCTION_BLOCK 

 

9.2.5 S7-GRAPH 编程语言（顺序控制） 

图形编程语言 S7-GRAPH属于可选软件包，适用于顺序控制的编程。它包括生成一系列顺

序步，确定每一步的内容，以及步与步之间的转换条件。编写每一步的程序要用特殊的编

程语言（类似于语句表），转换条件是在梯形逻辑编程器中输入（梯形逻辑语言的流线型

版本）。 

S7-GRAPH 表达复杂的顺序控制非常清晰，用于编程及故障诊断更为有效。 

 

S7-GRAPH的顺序控制程序举例 
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程序块的生成 

用 S7-GRAPH 编辑器，将生成含有步顺控器的功能块程序。相应的背景数据块中含有顺

控器的数据，例如：FB的参数，顺序步和转换条件。用S7-GRAPH编辑器能自动生成背景

数据块。 

 

源文件 

通过S7-GRAPH 生成的功能块可以产生一个文本源文件（图形源文件），该源文件可由操

作员面板（OP）或操作员接口文本显示（TD）编译显示成顺控器。 

 

9.2.6 S7 HiGraph编程语言（状态图形） 

图形编程语言 S7 HiGraph属于可选软件包，可以将程序中的各块做为状态图形编程。这种

方法将你的项目分成不同的功能单元，每个单元有不同的状态。不同状态之间的切换要定

义转换条件。用类似于语句表的放大型语言描述赋给状态的功能以及状态之间转换的条件。 

每个功能单元都用一个图形来描述该单元的特性。整个项目的各个图形组合起来为图形组。

各功能单元的同步信息可在图形之间交换。 

各功能单元的状态条件的清晰表示，使得系统编程成为可能，故障诊断简单易行。与S7 

Graph不同，在 S7 HiGraph中任何时候只能一个状态（在S7 Graph中：“步”）是激活的。

下列图形为功能单元的图形是怎样生成的（举例）。 
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                                                   状态 

 

 

 

        从状态3至状态0的转变 

                                                         转换条件： 

 

 

 

图形组存在HiGraph源文件中 S7 program之下的“Source Files”文件夹中。该源文件可

编译成用户程序中的S7程序块。 

句法和形式参数在图形最后输入时检查（当工作窗口关闭时）。地址和符号在源文件编译

时检查。 
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9.2.7 S7 CFC 编程语言 

可选软件包CFC（Continuous Function Chart，连续功能图），是一种用图形的方法连接

复杂功能的编程语言。 

编程语言S7 CFC用于连接已存在的各种功能。有许多标准功能不需要用户编程，而是可以

使用含有标准块（例如：逻辑、算术、控制和数据处理等功能）的程序库。使用CFC不需

要用户掌握详细的编程知识以及有关可编程序控制方面的专门知识。只需要具有行业所必

需的工艺技术方面的知识就可以。 

用户生成的程序块可按自己的意愿进行连接，连接的方法分不同的情况，如果用SIMATIC 

S7，可用S7编程语言中的任一种，如果是用于SIMATIC M7则用C/C++编程语言。 

程序是按CFC图表生成并存贮。这些程序存在S7 program下面的“Charts”文件夹中。这

些图表可编译成用户程序中的S7程序块。 

 

 

9.3  生成软件块 

9.3.1  软件块文件夹 

用户可以按下列形式生成S7 CPU 中的程序：  

• 软件块 

• 源文件 

文件夹“Blocks（软件块）”在S7 program路径之下，用于存放各程序块。 

该文件夹中的程序块需要用户下载到S7 CPU 中用于执行自动控制任务。这些可装载的程

序块包括逻辑块（OB，FB，FC）和数据块（DB）块文件夹中会自动生成一个空的组织块

OB1，在S7 CPU中必须用该组织块来执行用户程序。 

块文件夹还包含下列对象： 

• 用户生成的用户定义数据类型（UDT）。UDT可使编程变得容易，但不需要下载到CPU

中。 

• 用户可生成变量表（VAT）在测试用户程序时用于监视和修改变量。变量表不下载到

CPU中。 

• 在对象“系统数据”（系统数据块）中含有系统信息（系统组态，系统参数）。这些

系统数据块是当用户进行硬件组态时提供数据并生成的。 
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• 系统功能（SFC）和系统功能块（SFB），需要时可在用户程序中调用。但是，用户不

能自己编写SFC和SFB。 

除了系统数据块（只能通过对可编程序控制器的进行组态编辑和生成）以外，用户程序中

的其它块都需要用相应的编辑器进行编辑。其编辑器在双击相应的块时自动打开。 

注意 

用源文件编写的各程序块，当编译后也存在块文件夹之下。 

 

9.3.2  用户定义的数据类型（UDT） 

用户定义数据类型是一种特殊的数据结构，由用户自己生成，该结构一旦定义好了之后，

可在整个S7程序中使用。  

• 用户定义数据类型可在逻辑块（FC，FB，OB）变量表中用做数据类型元素或复杂的数

据类型。或者在数据块（DB）中做为数据的变量类型使用。其优点是，用户只需定义

一次某种常用的特殊的数据结构，然后，可多次使用。 

• 用户定义数据类型也可做为样板，用于生成与其数据结构相同的数据块。这就意味着，

用户只需生成 一次数据结构，然后，简单地将用户定义数据类型分配给所要生成的数

据块。（举例：配方：数据块的结构总是相同的，只是数值不同。） 

用户定义数据类型在SIMATIC管理器中生成，或在增量编辑器中生成— —与其它类型块相

同。 

 

用户定义数据类型（UDT）的结构 

当你打开一个用户定义数据类型时，出现一个新的工作窗口，在该窗口中用变量表的形式

显示用户定义数据类型。  

• 在第一行和最后一行已经有STRUCT和END_STRUCT用于表明用户定义数据类型的开

始和结束。用户不能编辑这两行。 

• 用户在变量表的第二行相应的列中开始输入用户定义数据类型。 

• 用户可从下列数据类型中建立用户定义数据类型： 

-  基本数据类型 

-  复杂数据类型 

-  已存在的用户定义数据类型 

S7用户程序中的用户定义数据类型不下载到S7 CPU中。既可用增量输入编辑器直接生成

和编辑，也可通过源文件编译时生成。 
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9.3.3  块属性 

块属性可使用户更容易辨识所生成的各程序块，并且还可以对这些程序块加以保护，防止

非法修改。 

用户应在某程序块建立时编辑块属性。除了用户编辑的属性，属性对话框也显示信息：但

是用户不能编辑这些信息。 

块属性和系统属性也在SIMATIC管理器中每块的对象属性中显示。在此用户只能编辑名称，

系列，作者和版本等属性。 

当通过SIMATIC管理器建一个新块时，用户可编辑对象属性。如果不是用SIMATIC管理器，

而是用其它编辑器生成程序块，则该块的某些属性（如：编程语言）会自动地存入对象属

性中。 

 

注意 

用于S7程序块编程的记忆系统，可通过SIMATIC 管理器菜单命令Options > Customize

和“Language”表设置。 

 

块属性表 

当输入块属性时，输入顺序如下表。 

关键字/属性 含  义 举  例 

[KNOW_HOW_PROTECT] 块保护；使用该指令后，当该块进行
编译时，使程序部分不可见。块的界
面可以显示，但不能改变。 

KNOW_HOW_PROTECT 

[AUTHOR:] 作者名，公司名，部门名或其它名你
（最多为没有空格的8个字符） 

AUTHOR: Siemens, 
没有关键字。 

[FAMILY:] 块系列名：例如：控制器（最多为没
有空格的8个字符） 

FAMILY: Controllers 
没有关键字。 

[NAME:] 块名（最多8个字符） NAME: PID  
没有关键字。 

[VERSION:int1,int2] 块的版本号（两个数的范围均在0到15
之间，意为0.0到15.15） 

VERSION: 3.10 

[CODE_VERSION1] 功能块能否有多重背景的标识符。如
果想用多重背景则功能块不应有该属

性 

CODE_VERSION1 

[UNLINKED]只适用于DB 某个数据块的属性是UNLINKED，则
不将其连接到程序中 

 

[READ_ONLY]只适用于DB 数据块的写保护；其数据只能读，不
能修改 

FAMILY = Examples 
VERSIONI = 3.10 
READ_ONLY  
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块保护命令KNOW_HOW_PROTECT 具有下列效果： 

• 如果想在增量STL、FBD或梯形图编辑器中输出编译后的保护块，则该块的程序部分不

能显示。 

• 该块的参数声明表中只显示类型为 var_in、var_out和var_in_out的变量。类型为var_stat

和var_temp的变量隐含。 

 

对应：块属性与块类型 

下表所示为哪种块类型可具有哪些块属性： 

特  性 OB FB FC DB UDT 

KNOW_HOW_PROTECT · · · · － 

AUTHOR · · · · － 

FAMILY · · · · － 

NAME · · · · － 

VERSION · · · · － 

UNLINKED － － － · － 

READ_ONLY  － － － · － 

当你用源文件编写程序块时，可设置KNOW_HOW_PROTECT属性，并在“块属性”对话

框中显示，但不能修改。 

 

9.3.4  显示块长度 

块长度的显示单位为“bytes（字节）” 

 

块文件夹属性显示 

下述长度将显示在离线窗口中的块文件夹属性中。 

• 可编程控制器的装入存储器大小（不包括系统数据的所有块之和）。 

• 可编程控制器的工作存储器大小（不包括系统数据的所有块之和）。 

• 编程器（PG/PC）上的块长度不显示在块文件夹属性中。 

 

块属性显示 

在块属性中将显示以下内容： 

• 所需局域数据数量：局域数据按字节表示的大小， 

• MC7：MC7按字节表示大小或DB用户数据的大小， 

• 编程控制器中输入存储器的大小， 
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• 编程控制器中工作存储器的大小只有在识别出硬件分配时，才显示。 

显示时，与块是位于在线窗口还是离线窗口中无关。 

 

SIMATIC管理器中显示（详细视图） 

如果打开一个块文件夹，并选择了“Details View（详细视图）”，工作存储器的要求将显

示在项目窗口中，与文件夹是位于在线窗口中还是离线窗口中无关。 

选择所有有关块，可以计算块长度的总和。在这种情况下，所选块长度的总和将显示在

SIMATIC Manager的状态栏中。 

对于没有下载到可编程控制器中的块，将不显示其长度（例如变量表）。 

编程器（PG/PC）上的块长度不显示在详细视图中。 

 

9.3.5 块比较 

比较块： 

1. 在SIMATIC管理器中选择要比较的块文件夹或单个块 

2. 选择菜单命令Options > Compare Blocks 

3. 在“Compare Blocks”对话框中选择比较类型(在线/离线或Path1/Path2) 

4. Path1/Path2比较：在SIMATIC管理器中选择要比较的块文件夹或单个块，块将自动地

输入到对话框中 

5. 如果要进行比较，始能检查框 

6. 如果要比较程序代码，选择“Compare code”。一旦该功能有效，也可以在下一个检

查框指定比较用不同编程语言生成的程序块(例如：STL、FBD… ) 

7. 点击对话框中的“OK”按钮。 

在另一个对话框中显示比较结果。 

 

注意： 

当离线块文件夹与在线块文件夹进行比较时，只比较下载的块(OB、FB… )。 
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9.3.6 再接线 

下列块和地址可以被再接线：  

• 输入、输出 

• 存储位定时器计数器 

• 功能、功能块 

 

要进行再接线： 

1. 在SIMATIC管理器中，选择含有要再接线的单个块的“Blocks”文件夹。 

2. 选择菜单命令Options＞Rewire。 

3. 在“再接线”对话框中的表中输入所要的替代（旧地址/新地址）。 

4. 如果你想要的再接线的地址区域（字节、字、双字），选择选项“All addresses within 

the specified address area（指定地址区域内的所有地址）。” 

例如：你输入IW0和IW4作为地址区域。则地址I0.0-I1.7被再接线为I4.0-I5.7。要进行

再接线的区域的地址（如，I0.1）不能够在表中再单独输入。 

5. 点击“OK”按钮。  

这就启动了再接线过程。在再接线完成后，你可以在一个对话框中指定是否要看关于再接

线的信息文件。该信息文件包含“旧地址”和“新地址”的列表。对每个块还列出了对其

所作的接线处理的个数。 

在再接线时，应注意以下事项： 

再接线块时（即重新命名），不能存在新块。如果存在，过程将中断。 

当再接线功能块（FB）时，实例数据块将自动赋值给再接线FB。实例DB不能改变，即，

仍保持原有的DB号。 

 

9.3.7  软件块及参数属性 

有关特性的描述可查找在线帮助中的系统特性。 
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9.4  有关程序库 

程序库用于存放SIMATIC S7/M7中可多次使用的程序部件。这些程序部件可从已有的项目

中复制到程序库中，也可以直接在程序库中生成。该程序库与其它项目无关。 

如果在S7 program下的程序库中存放有用户希望多次调用的块，可节省大量的编程时间并

提高效率。可以将这些程序块拷贝到用户程序中所需要的地方。 

在程序库里生成S7/M7程序，与在项目中的做法相同，只是没有测试功能。 

 

生成程序库 

生成程序库的方法与生成项目的方法一样，用菜单命令 File > New。新生成的程序库，其

目录在菜单命令Option>Customize中的“General”页设置。 

注意 

SIMATIC管理器允许名字多于八个字符。但是，程序库目录名多于8个字符将截去。所以各

程序库的名称在前8个字符中不能相同。名字不必区分大小写。当该目录在浏览器中打开时，

可见全名。但当浏览该目录时，则只出现短名。注意，不能在老版本的STEP 7项目中，使

用新版STEP 7程序库中的程序块。 

 

打开程序库 

用菜单命令File > Open打开一个已存在的程序库。然后选择对话框中的程序库名。最后打

开程序库窗口。 

注意 

如果在程序库表中找不到所需的程序库，则可用“打开”对话框中的“Browse”浏览键。

在标准的浏览器窗口中通过显示的目录结构来查找所需的程序库。  

注意，文件名总是对应程序库生成时的原始名。在SIMATIC管理器中修改文件名不改变文

件级的文件名。 

当你选择了程序库，则将其列入程序库表中。用户可用菜单命令File > Manage，修改程

序库表中的输入。 

 

复制程序库 

用户可用菜单命令File > Save as，将一个程序库存在另一个名下来复制程序库。 

使用菜单命令Edit > Copy，可复制程序库中的某一部分，如：程序、块、源文件等。 

删除程序库 
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使用菜单命令File > Delete，可删除一个项目。 

用菜单命令File > Delete，删除程序库。 

 

9.4.1  程序库的等级结构 

程序库结构按等级进行，与项目一样：  

• 程序库可含有S7/M7 programs。 

• S7 program可含有一个“块（Blocks）”文件夹（用户程序）一个“源文件（Source Files）”

文件夹，一个“图表（Charts）”文件夹，和一个“符号（Symbols）”对象（符号表）。 

• M7 program可含有用于可编程M7模板的图表和C程序以及一个“Symbols（符号）”

对象（符号表）和一个“Blocks（块）”文件夹用于数据块和变量表。 

• “Blocks（块）”文件夹包含有可下载到各种程序块。S7 CPU.在文件夹中的变量表

（VAT）和用户定义数据类型不能下载到CPU中。 

• “Source Files（源文件）”文件夹包括各种编程语言生成的源文件程序。 

• “Chart（图表）”文件夹包含CFC图表（只有安装了CFC可选软件后才出现）。 

当用户插入一个新的S7/M7 program、“Blocks”文件夹“Source Files”文件夹（只有S7）

和“Symbols”对象会自动插入。 

 

9.4.2  标准库总览 

在STEP 7标准软件包中包括标准程序库：  

• 系统功能块：系统功能块（SFB）和系统功能（SFC） 

• S5-S7转换块：用于转换STEP 5程序的块 

• TI-S7转换块：通用标准功能。 

• IEC功能块：用于IEC功能的块，诸如：处理时间和日期信息、比较操作、字符串处理

以及选择最大值和最小值。 

• 组织块：标准组织块（OB） 

• PID控制块：用于PID控制的功能块（FB） 

• 通讯块：SIMATICNET CP功能（FC）和功能块。当用户安装可选软件包后，也许还会

增加其它的程序库。 

• 其它块：用于时间标签和TOD同步的块。 

当安装可选软件包时，可增加其它库。 
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删除及安装所提供的程序库 

在SIMATIC管理器中，用户可以删除所提供的程序库，然后再重新安装。要想安装程序库，

用户必须重新执行一次STEP 7的起动程序。 

 

注意 

当用户安装STEP 7时，所提供的程序库总是自动安装。如果用户编辑了这些程序库，在重

新安装STEP 7时，修改过的程序库将会被原始的程序库覆盖。  

由于这个原因，用户应在做任何改动之前，复制所提供的程序库，然后只在复制的程序库

中进行编辑。 
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10  逻辑块的生成 
 

10.1 建立逻辑块的基础 

 

10.1.1 程序编辑器窗口的结构 

 

程序编辑器的窗口分为以下几个区域： 

 

表格 

“Program Elements”显示可以插入到你的LAD、FBD或STL程序的程序单元表。“Call 

Structure”显示当前S7程序中块调用的层次。 

 

变量声明表 

变量声明表分为“Variable Table”(变量表)和“Variable Detail View”(变量详细显示)两个

部分。 

  

指令 

指令表显示PLC要处理的块代码。它包含一个或多个网络段。 

 

详细 

“Details”窗口中的各种表格提供诸如显示故障信息、编辑符号、提供地址信息、控制地

址、块比较和硬件诊断故障等功能。 
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10.1.2  建立逻辑软件块 

逻辑块（OB、FB、FC）具有变量声明表部分、程序指令部分和属性部分。当用户编程时，

必须编辑下列三部分： 

• 变量声明表：在变量声明表中，用户可以规定参数及参数的系统特性和本地块特定变

量。 

• 程序指令部分：在程序指令部分，用户编写能被可编程序控制器执行的块指令 代码。

这些程序可分为一段或多段，可用诸如编程语言梯形逻 辑（LAD）、功能块图（FBD）

或语句表（STL）来生成程序段。 

• 块属性：块属性中有进一步的信息，如：由系统输入的时间标记或路径。此外，用户

可输入自己的内容，如：块名、系列名、版本号和作者，并且用户可将系统属性分配

给程序块。 

原则上说，用户编辑逻辑块各部分的顺序并不重要。当然，各部分可随时修改及增加。 

 

 

 

注意： 

如果用户希望使用符号表中的符号，必须首先检查一下，它们是否存在，需要时可进行修

改。 

编辑程序指令表 

增量STL编辑器 

用STL编写逻辑块的步骤 

在SIMATIC 管理器中生成逻辑块（FB、FC或OB） 

编辑逻辑块的变量声明表 

编辑逻辑块的属性 

块存盘（菜单命令File > Save） 



逻辑块的生成 

 10-4 

10.1.3  LAD/STL/FBD程序编辑器的预先设置 

在开始编程之前，用户应熟悉一下编辑器的预置表，借助它可使用户在编程时感觉容易并

且方便。 

用菜单命令Options > Customize，打开一个分页的对话框。在不同的“Editor（编辑器）”

页中，用户可为逻辑块编程做以下预置，例如“逻辑器”页中： 

• 文本和表格中的字体（类型和大小）。 

• 在一个新块中是否显示符号和文字注释。 

用户在编辑状态中，用View >…下拉式菜单中的命令可以修改编程语言表示法、文字注释

和符号的设置。 

在“LAD/FBD”页中，用户可以改变主要部分的颜色，例如：程序段或语句行。 
 

 

10.1.4  逻辑块和源文件的访问授权 

当编辑一个项目时，通常使用一个共同的数据库，这就意味着项目组的全体成员也许想在

同时访问同一个块或数据源。 

读/写访问授权分配如下：  

• 离线编辑： 

当用户试图打开一个块/源文件时，会检查该用户是否对该块有“写”访问权。如果某

块/源文件已经打开，用户只能进行复制。如果用户希望存盘，系统会要求你是否想要

覆盖原块，还是存到一个新的名下。 

• 在线编辑：  

当用户通过组态连接打开一个在线块时，对应的离线块禁止使用，以保护离线块不会被

同时修改。 

 

 

10.1.5  程序元件目录的指令集 

程序元件目录中提供一系列LAD和FBD中的各元素，以及已经声明的多重背景，已经编好

的逻辑块，和程序库中的各逻辑块。目录由菜单命令View > Tables来访问。用菜单命令

Insert > Program Elements，将程序元素插入到程序指令部分中。 
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LAD中程序元素目录举例 
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10.2 编辑变量声明表 

 

10.2.1  在逻辑块中的变量声明 

当用户打开一个逻辑块时，在窗口的上半部分为变量声明表，下半部分为程序指令部分，

用户在下半部分编写逻辑块的指令程序。 

 

例如：STL中变量声明表和程序指令部分 

 

在变量声明表中，用户声明在本块中专用的变量包括块的形参和参数的系统属性。这具有

以下效果： 

• 声明变量后，在本地数据堆栈中为瞬态变量保留一个有效存贮空间，对于功能块，还

要为联合使用的背景数据块的静态变量保留空间。 

• 当设置输入、输出和输入/输出类型参数时，用户还要在程序中声明块调用的“接口”。 

• 当用户给某功能块声明变量时，这些变量（瞬态变量除外）也在功能块联合使用的每

个背景数据块中的数据结构中声明。 

• 通过设置系统特性，用户为信息和连接组态操作员接口功能分配特殊的属性，以及参

数的过程控制组态。 
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10.2.2  变量声明表与指令部分之间的关系 

逻辑块中的变量声明表和指令部分是紧密联系的，因为在指令部分的程序中要用到变量声

明表中的名称。因此，在变量表中的任何变化都将影响整个指令部分的程序。 

 

变量声明表中的改动 指令部分的反应 

重新正确输入 使用以前没在变量表中声明的变量，造成无效语
句，现在变为有效 

变量名改变但类型没变 所有地方的符号立即表示为相应的新名称 

正确的变量名改为无效的变量名 指令保持不变 

无效的变量名改为正确的变量名 如果有无效语句、变为有效 

类型改变 如有无效语句，可变为有效 

如有有效语句，可变为无效 

删除一个程序中使用的变量（符号名） 有效语句变为无效 

文字注释内容的修改，一个新变量的不正确输入、改变初始值或删除一个没用的变量，对

指令部分没有影响。 

 

10.2.3  变量声明表的结构 

变量声明表窗口包括变量概述和变量详细说明。 

 

当打开一个新的程序块后，将显示一个缺省的变量表。它只列出了所选择块所允许的声明

类型(输入、输出、输入/输出、静态、动态变量)，你可以编辑这个缺省的变量声明表。 

变量声明表中包括：地址、声明类型、符号名、数据类型，初值以及变量的文字注释。表

中的每一行表示一个变量声明。数据类型为ARRAY（数组）或STRUCT（结构）的变量需

要多行。 
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用户可在逻辑块的本地数据分配数据类型附录表中找到适用于各种块类型的本块数据的有

效数据类型。 

 

列 含  义 要  点 编  辑 

Address 
（地址） 

按BYTE.BIT格式
产生地址 

对多于一个字节的数据类型，地址用跳
到下一个字节地址来表示，关键字为：  

*：一个数组元素按字节表示的大小 

+：与STRUCT（结构）的开始有关的初
始地址 

=：STRUCT（结构）要求的完整存贮区  

系统输入：地址是由系统进行
分配的，并且，当用户结束一

个变量声明的输入时显示 

Variable 
（变量） 

变量的符号名 变量符号必须以字母开始，不允许用保
留的关键字 

需要 

Declaration 
(声明类型) 

声明类型，变量的
“目的” 

根据不同的块类型，可以用下列之中的
类型 

输入参数：“ in” 

输出参数：“out” 

In/Out参数：“in_out” 

静态变量：“stat” 

瞬态变量：“temp” 

根据不同的块类型，由系统提
供 

Data type 
(数据类型) 

变量的数据类型 

(BOOL、INT、 

WORD,ARRAY
等) 

可用鼠标右键弹出菜单再选择合适的

元素数据类型 
需要 

Initial Value 
(初值) 

如果不想用缺省
值，可在该栏中设
置初值 

必须与数据类型匹配。 

当数据块第一次存盘时若用户没有明
确地声明实际值，则初值将被用于实际

值 

可选 

Comment 
(文字注释) 

用于文档目的的
文字注释 

 可选 

 

 

 



逻辑块的生成 

 10-9 

10.3 变量声明表中的多重背景 

 

10.3.1  使用多重背景 

如果用户希望或不得不用有限的几个数据块存放背景数据以提高S7 CPU中的性能（例如：

存储能力）是可能的。如果在你的用户程序中调用其它已经存在的功能块（FB）的多层调

用，用户可调用这些功能块，而不需要它们自己的（额外的）背景数据块。 

解决的方法如下：  

• 在调用功能块的变量声明表中，将被调用的功能块做为静态变量参数。 

• 在该功能块中，调用其它功能块不带其自己的（额外的）背景数据块。 

• 这就将背景数据都压缩在一个背景数据块中，意味着，用户能够更有效地使用数据块。 

下面的例子所示为：FB2和FB3使用调用它们的FB1的背景数据块。 

 

唯一的要求：用户必须“告诉”调用功能块，哪个背景你要调用以及这些背景的类型（FB

是什么?）。这些细节必须在调用功能块的参数声明窗口输入。被调用的功能块在数据区中

至少要有一个变量或参数VAR_TEMP不能用。 

使用多重背景数据块时，当CPU正在运行时不能在线修改。使用背景数据块时，只能保证

无冲撞重装。 
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10.3.2  声明多重背景的规则 

多重背景的声明有下列规则：  

• 只有在版本2以上的STEP 7中生成的功能块（参看功能块的属性中的块特性），才可能

声明多重背景。 

• 为了声明多重背景，功能块必须设置为有多重背景能力（在STEP 7中缺省设置），可

在编辑器中用Options > Customize取消。 

• 必须有一个背景数据块分配给声明了多重背景的功能块。 

• 多重背景只能声明为静态变量（声明类型为“Stat”）。 

注意 

• 用户也可以为系统功能块生成多重背景。 

• 如果功能块生成时不具备多重背景的能力，而你又想增加这个功能，可以用该功能块

产生一个源文件，然后将块属性中的CODE_VERSION1删除，再重新编译该功能块即

可。 

 

 

10.3.3  在变量声明窗口中输入多重背景 

打开功能块，在该功能块中将调用下一级功能块。 

如果你不想给被用调的功能块使用背景数据块，可以为这些功能块的每一次调用在调用它

们的功能块的变量声明表中定义一个静态变量。 

-   将光标放在“stat（静态）”声明的一个空行的第二栏中。 

-   在声明类型“stat”的后面，在“Name（名）”栏中为FB的调用输入一个名字。 

-   在“Type（类型）”栏中输入你想调用的功能块作为一个绝对地址或用它的符号

名。 

-   你可以在注释栏输入任何需要的解释。 

 

在程序部分调用 

当你已声明了多重背景，你可以调用FB和无需指定一个背景DB。 

例如：If the static variable "Name: Motor_1 , Data type: FB20" is defined, the instance 

can be called as follows: 

Call Motor_1   // Call of FB20 without instance DB 
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10.4 编辑语句和文字注释时的注意事项 

 

10.4.1  程序指令部分的结构 

在程序指令部分，用户通过在程序段中用所选的编程语言输入相应的语句按顺序完成逻辑

块中的程序。当语句输入进去时，编辑器立即起动句法检查，发现的错误用红色和斜体显

示。 

逻辑块的程序指令部分通常由若干段组成，而这些段又由一系列语句组成。 

在程序指令部分，用户可以编辑块标题，块注释，段标题，段注释和各程序段中的语句行。 

 

用STL编程语言的程序指令部分结构 

 

 

 

 

 

 

 

 

 

 

 

段标题 

语句 

段注释 

块标题 

块注释 
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10.4.2  输入语句的步骤 

用户可以按任意的顺序来编辑程序指令部分的各项内容。当你第一次编程时，我们建议你

按如下步骤进行。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

用户既可以在修改状态也可以在新插入状态修改上述内容。用执行键（INSERT）切换两种

状态。 

 

输入块标题（可选） 

输入块注释（可选） 

编辑程序段 

输入段标题（可选） 

输入段注释（可选） 

输入语句 

输入语句注释（可选） 



逻辑块的生成 

 10-13 

10.4.3  在程序中输入共享符号 

用菜单命令Insert > Symbol，用户可在程序的指令部分插入符号，当光标位于字符串的开

始、结束或中间时，如果符号已经存在，则总是以小短线“ -”开始。如果用户修改字符串，

则该选择也在符号表中刷新。 

一个字符串开始和结尾的分开标志是，例如，空格、句号、逗号。在共享符号中没有分开

标志。 

按如下步骤输入符号： 

1.   在程序中输入所需符号的第一个字母。 

2.   同时按下CTRL和 J 键，显示符号表。第一个符号按你所输入的字母开始。 

3.   按RETURN键输入符号或选择另一个符号， 

然后，有引号圈起来的符号代替第一个字母。 

通常下列情况实现：如果光标位于一个字符串的开始、结尾或中间，当插入一个符号时，

该字符串被带引号的符号所替代。 

 

 

10.4.4  块和段的标题与注释 

注释可使用程序易于阅读，因此，也使得程序调试和故障诊断容易进行且更有效率。它们

是程序文档中的重要组成部分，确实应该加以利用。 

 

在梯形图、功能块图和语句表程序中的文字注释 

可用下列文字注释：  

• 块标题：块的标题（最多64个字符） 

• 块注释：整个逻辑块的文字说明，例如：该块的目的。 

• 段标题：段的标题（最多64个字符） 

• 段注释：单个段的功能说明。 

• 变量详细窗口中的注释栏：所声明的本块数据的说明。 

• 符号注释：在符号表中当符号名及地址声明之后的文字说明。  

用户可以用菜单命令View > Display with > Symbol Information，显示这些注释。 

在逻辑块的程序部分，用户可以输入块标题、段标题、块注释或段注释。 
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块标题或段标题 

要想输入块标题或段标题，需把光标放在“Title”的位置，向右输入块名称或段名（例如

Network1：Title）。当你输入标题时打开一个文字输入框，最长可输入64个字符。 

 1.        Network 2: Title 

                                        鼠标点击 

 2.        Network 2:  在此显示程序段标题 

块注释是整个逻辑块的注释，在块注释中，可以注释块的功能。段注释是具体段的注释，

可以详细说明段。 

自动显示程序段标题，选择Options > Settings并在“General”表中点击选项“Automatic 

Assignment of Network Title”。 

 

块注释和段注释 

 1． ? ? ?                    

                                            鼠标点击 

 2． Comment for network or block 

用户可以用菜单命令View > Display with > Comments，显示或不显示灰色的注释域。

双击注释域打开文字输入框，可输入注释要点。当你输入标题时打开一个文字输入框，最

长可输入64个字符。 

 

 

10.4.5  使用网络段模板 

当编写程序块时，如果你愿意多次实用网络段，可以将这些网络段存储在库中作为网络段

模板。在建立网络段模板前，该库必须存在。 

 

建立网络段 

如果需要，在SIMATIC管理其中建立一个新库。选择Insert > Program > S7 Program 将

一个程序插入库中。 

打开包含网络段的程序块，从这里可以建立一个网络段模板。 

在打开的块中，按照需要用通配符替换标题、注释或地址。通配符可以使用%00至%99。

地址通配符以红色显示。这不会对原有的程序块产生影响，因为在创建网络段模板后，不

会存储该程序块。 
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选择你要包含在网络段模板的“Network <No.>”。 

选择Edit > Create Network Template。 

在显示的对话框中为每个所使用的通配符输入一个有意义的注释。 

点击“OK” 

在网络段模板库中选择S7程序的Source file folder(源文件夹)并为网络段模板输入名称。 

点击“OK”确认输入。网络段模板存储在所选择的库中。 

不存盘退出该程序块。 

 

在一个程序中插入一个网络段 

打开一个程序段，在此要插入一个新的程序段。 

在打开的程序段中，点击网络段，在此之后要按照网络段模板插入一个新的网络段。 

使用Insert > Program Elements打开程序单元。 

在目录中的相应库中打开“S7 Program”文件夹。 

双击网络段模板。 

插入对话框，在网络段模板中输入所需替换的通配符。 

点击“OK”，在当前的网络段后面将插入一个网络段模板。 

 

 

10.4.6  在程序指令部分搜索错误的功能 

在程序指令部分的错误，由于是红颜色，很容易识别。编辑器提供两种搜索功能Edit > 

GoTo > Previous Error/Next Error，用于查找屏幕可见部分以外的错误。 

搜索错误的范围超过一个程序段。这就意味着在整个程序指令部分搜索，不只是一个段，

或当前屏幕能看见的范围。 

如果用菜单命令View >Status Bar激活状态条，找到的错误显示在哪儿。 

用户也可在修改状态下修改错误和进行改进。用执行键（INSERT）可切换插入状态和修改

状态。 

10.5 在程序指令部分中用梯形图（LAD编程） 
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10.5.1  梯形逻辑编程的一些设置 

 

设置梯形逻辑布局 

用户可以设置在梯形逻辑表示法中生成程序的布局。所选的格式（A4窄幅/宽幅/最大尺寸）

将影响一行中所能显示的梯形元素的数目。 

1.   选择菜单命令Options > Customize。 

2.   在出现的对话框中选择“LAD/FBD”页。 

3.   在“Layout（布局）”列表框中，选择所需的格式。输入所需格式的大小。 
 

设置打印 

如果希望打印梯形程序指令部分，用户应在开始编程之前，设置合适的打印纸格式。 

 

在“LAD/FBD”页中的设置 

用菜单命令Options > Customize，可访问“LAD/FBD”页，在该页中你可以做基本设置，

例如布局和地址域宽。 

 

 

10.5.2  输入梯形逻辑元素的规则 

用户在《S7-300/400梯形逻辑-编辑手册》一书中，或梯形逻辑在线帮助中，可以找到有关

梯形逻辑编程语言表示法的描述。 

一个梯形程序段中，可以有多个分支，每条分支上可有多个元素。所有的元素和分支都必

须连接；左边的能源轨不算连接（IEC 1131-3）。 

当用户编写梯形程序时，必须遵守编程规则。如果有错误发生，会有信息提示。 

 

结束梯形程序段 

每个梯形程序段都必须以输出线圈或功能框结束，下列的梯形元素不能用于程序段结束： 

• 比较框 

• 中间输出结果的线圈 _/(#)_/ 

• 上升沿 _/(P)_/ 或下降沿 _/(N)_/ 线圈 
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功能框的位置 

用于功能框连接的分枝起始点必须总是左边的能源轨，在该功能框前的分支上可以有逻辑

操作或其它功能框。 

 

线圈的位置 

线圈自动位于程序的最右端，在这个位置上形成分支的终点。 

下列情况除外：中间输出结果的线圈 _/(#)_/和正极 _/(P)_/或负 

用于中间结果输出的线圈_/(#)_/ ，以及上升沿线圈 _/(P)_/ 或下降沿线圈_/(N)_/ ，都不能

置于分支的最左端或最右端。也不允许放在平行分支上。 

有些线圈要布尔逻辑操作，而有些线圈一定不能不能用布尔逻辑操作。 

• 要求布尔逻辑的线圈为： 

-  输出 _/()，置位输入_/(S)，复位输入 _/(R) 

-  中间结果输出_/(#)_/，上升沿 _/(P)_/，下降沿 _/(N)_/  

-  所有的计数器和定时器线圈 

-  逻辑非跳转 _/(JMPN) 

-  主控继电器接通 _/(MCR<) 

-  将RLO存入BR存贮器_/(SAVE) 

-  返回_/(RET) 

• 不允许布尔逻辑的线圈： 

-  主控继电器激活 _/(MCRA) 

-  主控继电器取消_/(MCRD) 

-  打开数据块_/(OPN) 

-  主控继电器关_/(MCR) 

所有其它的线圈既可以用布尔逻辑操作也可以不用。 

 

下列线圈一定不能用于平行输出： 

• 逻辑非跳转 _/（JMPN） 

• 跳转 _/（JMP） 

• 从线圈调用 _/（CALL） 

• 返回_/（RET） 
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使能输入/使能输出 

功能框的使能输入端“EN”和使能输出端“ENO”可以连接使用，也可以不用。 

 

删除和修改 

如果分支中只有一个元素，当删除这个元素时，整个分支也同时删掉。 

当一个功能框删除时，该功能框的所有布尔输入分支都将删除，主分支除外。 

修改状态可用于简单的同类型元素的覆盖。 

 

平行分支 

• 从左到右画一个或（OR）分支。 

• 向下打开平行分支，向上闭合。 

• 选择某一梯形元素后，总是可以打开一个平行分支。 

• 在选择的梯形元素之后，总是可以闭合一个平行分支。 

• 删除一个平行分支，将删掉该分支上的所有元素。当分支上最后一个元素删除，则分

支自动删除。 

 

常数 

二进制连接不能赋予常数(例如：TRUE或FALSE)。取而代之，用BOOL数据类型地址。 

 

 

10.5.3  梯形图中的非法逻辑操作 

 

能量流从右到左 

不允许生成使能量流向相反方向的分支。下图所示为：当I 1.4的信号状态为“0”时，能量

流经I 6.8的方向是从右到左。这是不允许的。 

 
 

 

 

 

 

非法能量流 
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短路 

不允许生成造成短路的分支。下图所示为举例：下图所示为： 

 

 

 

 

 

10.6 在程序指令部分用功能块图（FBD）编程 

 

10.6.1 功能块图编程的一些设置 

 

设置功能块图布局 

用户可以设置在功能块图表示法中生成程序的布局。所选的格式（A4窄幅/宽幅/最大尺寸）

将影响一行中所能显示的FBD元素的数目。 

1.   选择菜单命令Options > Customize。 

2.   在出现的对话框中选择“LAD/FBD”页。 

3.   在“Layout（布局）”列表框中，选择所需的格式。输入所需格式的大小。 
 

设置打印 

如果希望打印FBD的程序指令部分，用户应在开始编程之前，设置合适的打印纸格式。 

 

在“LAD/FBD”页中的设置 

用菜单命令Options > Customize可访问“LAD/FBD”页，在该页中你可以做基本设置，

例如布局和地址域宽。 

 

  非法能量流 
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10.6.2  输入FBD元素的规则 

用户在《S7-300/400功能块图编程手册》一书中，或FBD在线帮助中，可以找到有关FBD

编程语言表示法的描述。 

一个FBD程序段中，可以有多个元素，所有的元素都必须连接（IEC1131-3）。 

当用户编写FBD程序时，必须遵守编程规则，如果有错误发生，会有信息提示。如果有错

误发生，会有信息提示。 

 

输入和编辑地址和参数 

当插入一个FBD元素时，符号“???”和“⋯”用作地址和参数的标记符号。  

• 红色的标记符号“???”表示其地址和参数必须修改。 

• 黑色的符号“⋯”表示其地址和参数可以修改 

如果用户将鼠标点在标记符号上，可显示相应的数据类型。 

 

功能框的位置 

标准功能框（触发器、计数器、定时器、算术操作等）可插在二进制逻辑操作框（&（与），

>=（或），XOR（异或））的中间。比较功能框除外。 

在一个程序段内不允许有不同逻辑操作的不同输出的程序。可是，用户可以利用T型分支将

一串逻辑操作分别赋值给不同的输出。下图所示为一个程序段中有两个赋值输出。 

下列功能框只能放在逻辑串的最右边，在那结束该逻辑串。  

• 设置计数器值 

• 加计数器参数赋实参（实际参数），减计数器形参赋实参 

• 脉冲定时器参数赋值及起动，扩展脉冲定时器参数赋值及起动。 

• 接通延迟/断开延迟定时器的参数赋值和起动。 

有些功能框要求布尔逻辑操作，而有些功能框一定不能用布尔逻辑操作。 
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要求布尔逻辑操作的功能框： 

• 输出，置位输出，复位输出 _/[R] 

• 中间结果输出_/[#]_/，上升沿_/[P]_/，下降沿_/[N]_/ 

• 所有的计数器和定时器功能框 

• 逻辑非跳转 _/[JMPN] 

• 主控继电器接通 _/[MCR<] 

• 将RLO存入BR存贮器 _/[SAVE] 

• 返回 _/[RET] 

 

不允许布尔逻辑的功能框： 

• 主控继电器激活[MCRA] 

• 主控继电器取消[MCRD] 

• 打开数据块[OPN] 

• 主控继电器断开[MCR>] 

所有其它功能框既可用布尔罗辑，也可不用。 

 

使能输入/使能输出 

功能框的使能输入端“EN”和使能输出端“ENO”可以连接使用，也可以不用。 

 

删除和修改 

当一个功能框删除时，该功能框的所有布尔输入分支都将删除，主分支除外。 

修改状态可用于简单的同类型元素的覆盖。 

 

常数 

二进制连接不能赋予常数(例如：TRUE或FALSE)。取而代之，用BOOL数据类型地址。 
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10.7  在程序指令部分编辑STL语句 

 

10.7.1  语句表编程的设置 

 

记忆性设置 

用户可以选择两种记忆性设置： 

• German（德语） 

• English（英语） 

用户在打开逻辑块之前，在SIMATIC管理器中通过菜单命令Options > Customize中的

“Language（语言）”页来设置记忆性。在编辑块时，不能改变记忆码。 

在对话框中，编辑块属性。 

在编辑器中，用户可以打开许多块，需要时交替地进行编辑。 

 

10.7.2  输入STL语句的规则 

用户在《S7-300/400语句表编程手册》一书中，或STL在线帮助中，可以找到有关语句表

编程语言的描述。 

当用户在增量输入方式下输入STL语句时，必须注意以下基本规则：  

• 逻辑块编程的顺序很重要。在调用某逻辑块之前，该块必须已编好并存在。 

• 每条语句都是由标号（可选），指令，地址和文字注释（可选）组成。  

例如： M001：A      I 1.0     //Comment 

• 每条语句占一行。 

• 逻辑块中最多有999个程序段 

• 每个程序段最多将近2000行左右。如果用户使用放大或缩小功能，相应的行数多些或

少些。 

• 当输入指令或绝对地址时，不区分大小写。 
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10.8 刷新块调用 

用户可以在“LAD/STL/FBD— Programming S7 Blocks”编辑器中，用菜单命令Edit > Block 

Call > Update，自动刷新那些由于下列接口发生变化而变为非法的块调用或用户定义数据

类型： 

• 插入新形参 

• 删除形参 

• 修改形参名 

• 修改行参类型 

• 修改形参的顺序 

当用户进行形式参数和实际参数的赋值时，必须按顺序遵循下列规则： 

参数名相同： 

如果形参名保持不变，实参自动赋值。  

特例：在梯形图和功能块图中，预先连接的二进制输入参数只有将数据类型（BOOL）

相同时才自动赋值。如果数据类型改变，则预先连接变为开路分支。 

参数的数据类型相同：  

当同名参数已经赋值完成之后，迄今还未赋值的实参将赋值给那些与“旧”形参数据

类型相同的形参。 

参数位置相同： 

当用户按规则1和2执行完之后，还没有赋值的那些实参，现在按照他们在“旧”接口

的参数位置，赋给形参。 

4．  如果按照上面三条规则，还有实参不能赋值，它们将被删除，或在梯形图和功能图中

预先连接的二进制信号，将变为开路分支。 

当执行完这个功能之后，请检查在变量声明表和程序指令部分做的修改。 

 

10.8.1  改变接口 

你也可以用incremental Editor修改用STEP 7 V5编写的离线块接口： 

确信所有的块均已用STEP 7 V5编译过。 

修改相关块的接口。 

现在一个一个地打开所有调用的块 – 相应的调用以红色显示。 
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选择菜单命令 Edit > Block Call > Update。 

再次生成相关的背景数据块。 

 

注意： 

• 改变在线打开的程序块接口时可能会导致CPU进入STOP模式。 

• 重新进行块调用。首先修改所调用块的块号，然后执行Rewire功能以匹配所进行的调

用。 

 

 

10.9 逻辑块存盘 

 

输入新生成的程序块或在编程器数据库中修改了程序指令部分或变量声明表之后，用户必

须将相应的块存盘。然后，该数据写到编程器的硬盘中。 

 

将逻辑块存入到编程器的硬盘中： 

1.   激活你想存盘的块的工作窗口。 

2.   选择下列菜单命令之一： 

     -  File > Save，将块存在同一名下。 

     -  File > Save As，将块存在不同的S7用户程序下或不同的名下。在出现的对话框

中输入新的路径或新的块名。 

在以上两种情况中，只有当逻辑块中没有句法错误时才能存盘。当生成逻辑块时，出现句

法错误，会立即识别并用红颜色显示出来。这些错误必须在存盘之前修改。 

 

注意 

• 用户也可以在SIMATIC管理器中（比如，用拖放功能）将逻辑块或源文件存到其它项目

或程序库中。 

• 用户在SIMATIC管理器中，只能将块或整个用户程序存到存储卡中。 

• 如果某些较大的逻辑块在存盘或编译时出现问题，用户应重新组织项目。在SIMATIC

管理器中，用菜单命令File > Reorganize 来进行。然后，再试一次存盘或编译。 
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11   数据块的生成 
 

11.1 有关生成数据块的基本信息 

 

数据块（DB）可用于，例如，存贮设备或生产线中可访问的值。与用编程语言梯形图、语

句表或功能块图之一编程的逻辑块不同，数据块只有变量声明部分。这就意味着，在这里

不用程序指令部分，所以也就没有程序段。 

当用户打开数据块时，既可用声明表形式显示，也可用数据显示形式浏览数据块。用户可

以用菜单命令View > Declaration View和View > Data View，来切换两种显示状态。 

 

声明表显示状态 

如果用户有如下期望，应用声明表显示状态： 

• 浏览或确定共享数据块的数据结构。 

• 浏览带某相关的用户定义数据类型（UDT）的数据块的数据结构。 

• 浏览与功能块（FB）相关的数据块的数据结构。 

与功能块或用户定义数据类型相关的数据块的结构不能修改。要想修改它们，首先必须修

改相应的FB或UDT，然后再生成一个新数据块。 

 

数据显示状态 

如果用户想修改数据，就应用数据显示状态。在数据显示状态中，用户只能显示，输入或

改变每个元素的实际值。在数据块的数据浏览中，复杂数据类型变量的各元素，分别用其

全名列出。 

 

背景数据块与共享数据块之间的区别 

共享数据块不附属于任何逻辑块。它含有生产线或设备所需的值，并可以在程序的任何点

直接使用。 

背景数据块直接附属于某逻辑块，例如：功能块。背景数据块中所含数据为功能块的变量

声明表中所存数据。 
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11.2 数据块的声明表显示状态 

对于不能共享的数据块，在声明表显示状态不能进行修改。 

列 解    释 

地址（Address） 当用户结束变量声明的输入时，STEP 7自动分配并显示进址 

声明类型 
（Declaration） 

本栏只在背景数据块中显示。表明在功能块的变量声明表中各变量是
如何声明的： 

• 输入参数（IN） 

• 输出参数（IN） 

• 输入/输出参数（IN_OUT） 

• 静态数据（STAT） 

名称 （Name） 这里输入给每个变量的符号名 

数据类型 （Type） 输入用户赋给变量的数据类型（BOOL，INT，WORD，ARRAY，等）。
变量可以有基本数据类型，复杂数据类型，或用户声明数据类型 

初值 （Initial Value） 这里可输入初值，如果用户不想输入，则软件根据所输入的数据类型
给出缺省值。 

如果用户没有给变量声明实际值，当数据块第一次存盘时，初值将用
做实际值 

请注意：初值不能下载到CPU中。 

注释 （Comment） 输入对变量文档有帮助的注释，最多可以有80个字符 

 

11.3 数据块中的数据总览 

数据显示状态为用户显示该数据块中所有变量的实际值。用户只能在数据显示状态形式中

改变这些值。对所有的共享数据块来说，数据显示状态的表格表示都是相同的。对于背景

数据块，还增加一个“参数声明（Declaration）”栏。 

对于用复杂数据类型或用户定义数据类型的变量，在数据浏览时，所有的元素都占有自己

的一行，并有其完整的符号名。如果元素位于背景数据块的IN_OUT区，则指针指向“实际

值（Actual value）”栏中的复杂数据类型或用户定义数据类型。 

数据显示状态中有下列栏目显示： 

栏 解    释 

地址（Address） STEP 7自动为变量分配并显示地址 

声明类型 

（Declaration） 

本栏只在背景数据块中显示，表明在功能块的变量声明表中各变量是
如何声明的： 

• 输入参数（IN） 

• 输入参数（IN） 

• 输入/输出参数（IN_OUT） 

• 静态数据（STAT） 
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栏 解    释 

名称（Name） 在变量声明时给的符号名。在数据浏览中用户不能编辑该域 

数据类型（Type） 显示变量所声明的数据类型 

对于共享数据块，这里只列出基本数据类型，因为在数据浏览中，复
杂数据类型变量或用户声明数据类型要分别列出元素。 

对于背景数据块，也显示参数类型，对于用复杂或用户声明数据类型
的in/out参数（IN_OUT），指针指向“实际值”栏中的数据类型 

初值（Initial Value） 用户为变量输入的初值，如果用户不想输入，则软件会根据所声明的
数据类型给出缺省值。 

如果用户没有给变量声明实际值，当数据块第一次存盘时，初值将用
做实际值 

请注意：初值不能下载到CPU中。 

实际数值 

（Actual Value） 

离线：打开数据块时或最后改变或保存的变量数值（即使是在线打开

的数据块，也不刷新该显示）。  

在线：将显示打开数据块时的实际数值，但不会自动刷新。按动F5，
可以刷新该窗口。  

如果不属于复杂或用户定义数据类型的输入 /输出参数（ IN_OUT），你
可以编辑该区域。所有的值必须与数据类型匹配。 

注释（Comment） 对变量进行说明所输入的注释。在数据浏览中用户不能编辑该域。 

 

 

11.4 数据块的编辑与存盘 

 

11.4.1  输入共享数据块的数据结构 

如果用户打开一个不是用功能块或用户定义数据类型生成的数据块，则可以在该数据块的

声明表显示状态中声明其结构。对于不能共享的数据块，在声明表显示状态不能进行修改。 

打开一个共享数据块，意为该数据块与UDT或FB无关。 

如果声明表显示状态没有设置，则需要选择该数据块的声明表显示状态进行显示。 

按下列信息，填写表格来声明数据块的结构。 

对于不能共享的数据块，声明表显示状态不能修改 

 

列 解释 

地址（Address） 当用户结束变量声明的输入时，STEP 7自动分配并显示地址 

名称（Name） 这里输入给每个变量的符号名 

数据类型 

（Type） 

输入用户赋给变量的数据类型（BOOL，INT，WORD，ARRAY，等）。变
量可以有基本数据类型，复杂数据类型，或用户声明数据类型 
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列 解释 

初值 

（Initial Value） 

这里可输入初值，如果用户不想输入，则软件根据所输入的数据类型给出
缺省值。 

如果用户没有给变量声明实际值，当数据块第一次存盘时，初值将用做实
际值 

注释 

（Comment） 

输入对变量文档有帮助的注释。最多可以有80个字符。 

 

 

11.4.2  输入并显示与FB有关的数据块（背景DB的数据结构） 

输入 

当用户将数据块与某一功能块相连时（背景DB），则功能块的变量声明表决定该数据块的

结构。任何修改只能在相关的功能块中进行。 

1.  打开相关的功能块（FB）。 

2.  编辑该功能块的变量声明表。 

3.  再生成背景数据块。 

显示 

在背景数据块的声明表显示状态中，用户可以显示功能块的变量是如何声明的。 

打开数据块。 

如果声明表显示状态没有设置，则需要选择该数据块的声明表显示状态进行显示。 

参看下表中有关声明表的更多信息。 

对于不能共享的数据块，在声明表显示状态不能进行修改。 

列 解  释 

地址（Address） STEP 7自动为变量分配并显示地址。 

参数类型 

（Declaration） 

本栏表明在功能块的变量声明表中各变量是如何声明的： 

• 输入参数（IN） 

• 输入参数（IN） 

• 输入/输出参数（IN_OUT） 

• 静态数据（STAT） 

所声明的功能块临时局域数据不位于背景数据块中。 

名称（Name） 在功能块变量声明表中给出的符号名 

数据类型 

（Type） 

显示功能块的变量声明表中给出的数据类型。变量可以有基本数据类
型，复杂数据类型，或用户声明数据类型。 

如果在功能块中调用其它功能块，必须声明其调用静态变量，用这个
静态数据类型也可声明一个功能块或一个系统功能块（SFB） 
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列 解  释 

初值 

（Initial Value） 

用户在功能块的变量声明表中输入初值，如果不想输入，则软件给出
缺省值。  

当数据块第一次存盘时若用户没有明确地声明实际值，则初值将被用
于实际值。 

 

注释（Comment） 在功能块的变量声明表中输入的注释，以便对数据元素文字说明。用
户不能编辑该域。 

   

注意 

对于分配给某功能块的数据块，用户只能编辑变量的实际值。为输入变量的实际值，用户

必须工作在数据块的数据浏览形式中。 

 

 

11.4.3   输入用户定义的数据类型（UDT）的数据结构 

打开用户定义数据类型（UDT）。 

显示声明表形式如果该显示形式没设置的话。 

通过声明变量的顺序，变量的数据类型以及初值确定UDT的结构。下表中给出所需的信息。 

用TAB或RETURN键退出某行，来完成该行的变量输入。 

 

列 解    释 

地址（Address） 当用户结束变量声明的输入时，STEP 7自动分配并显示地址。 

名称（Name） 这里输入给每个变量的符号名。 

数据类型（Type） 输入用户赋给变量的数据类型（BOOL，INT，WORD，ARRAY，等）。
变量可以有基本数据类型，复杂数据类型，或变量自己的用户声明数
据类型。 

初值（Initial Value） 这里可输入初值，如果用户不想输入，则软件根据所输入的数据类型
给出缺省值。所有的值必须与数据类型匹配。如果用户没有给变量声
明实际值，当第一次用户定义数据类型或一个变量，或一个数据块的

背景存盘时，初值将用做实际值。 

注释（Comment） 输入对变量进行文字说明的注释，最多可以有80个字符。 

 

 

 

11.4.4  输入并显示与UDT相关的数据块结构 

输入 
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当用户用UDT生成某数据块时，UDT的数据结构就决定了该数据块的结构。任何修改都只

能在相关的用户定义数据类型（UDT）中进行。 

1.  打开用户定义数据类型（UDT）。 

2.  编辑用户定义数据类型的结构。 

3.  再生成数据块。 

 

显示 

用户只能在数据块的声明表显示状态中，显示用户定义数据类型中变量是怎样声明的。 

1.  打开数据块。 

2.  如果声明表显示状态没有设置，则需要选择该数据块的声明表显示状态进行显示。 

3.  参看下表中有关声明表的更多信息。 

在声明表显示状态下不能进行修改。任何修改都只能在相关的用户定义数据类型（UDT）

中进行。 

列 解    释 

地址（Address） STEP 7自动为变量分配并显示地址 

名称（Name） 在用户数据类型的变量声明表中给出的符号名 

数据类型（Type） 显示在用户声明数据类型的变量声明表中给出的数据类型。变量可以
有基本数据类型，复杂数据类型，或用户声明数据类型。 

初值（Initial Value） 用户在用户声明数据类型中为变量输入的初值，如果用户不想输入，
则软件给出缺省值。 

当数据块第一次存盘时若用户没有明确地声明实际值，则初值将被用
于实际值。 

注释（Comment） 在用户声明数据类型的变量声明表中输入的注释，用于对数据元素进
行文字说明 

 

注意 

对于用UDT生成的数据块，用户只能编辑变量的实际值。为输入变量的实际值，用户必须

工作在数据块的数据浏览形式中。 

   

 

11.4.5  在数据显示状态下编辑数据值 

只有在数据块的数据显示状态下，才可能编辑实际值。 

如果需要，用菜单命令View > Data View，将显示表格切换到数据显示状态。 
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在“实际值（Actual Value）”一栏的域里输入各数据元素的实际值。实际值必须与这些数

据元素的数据类型相匹配。 

任何不正确的输入（例如，如果输入的实际值与数据类型不匹配，在编辑时能立即识别，

并显示为红颜色）。这些错误必须在数据块存盘之前改正过来。 

注意 

一旦数据块存盘，数据值的任何变化都将保存。 
 

 

11.4.6   将数据值恢复为初始值 

只有在数据块的数据显示状态，才可能将数据值恢复为初始值。 

1.  如果需要，用菜单命令View > Data View，将显示表格切换到数据显示状态。 

2.  选择菜单命令Edit>Initialize Data Block来进行。 

所有的变量又恢复了初始值，这意味着所有变量的实际值被它们的初始值所替代。 

注意 

一旦数据块存盘，数据值的任何变化都将保存。 
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11.4.7  存储数据块 

在编程器数据库中，输入的新生成的块或在数据块中修改了数据值，用户都必须将相应的

块存盘。然后，该数据写到编程器的硬盘中。 

 

将逻辑块存入到编程器的硬盘中： 

1.  激活你想存盘的块的工作窗口。 

2.  选择下列菜单命令之一： 

    -  File > Save，将块存在同一名下。 

    -  File>Save as，将块存在不同的 S7 用户程序中或不同的名下。在出现的对话框中

输入新的路径或新的块名。对于数据块，用户不能使用DB0，因为这个号码被系统占用。 

在以上两种情况中，只有当逻辑块中没有句法错误时才能存盘。当生成逻辑块时，出现句

法错误，会立即识别并用红颜色显示出来。这些错误必须在存盘之前修改。 

 

注意 

• 用户也可以在SIMATIC管理器中（比如，用拖放功能将逻辑块或源文件存到其它项目或

程序库中）。 

• 用户在SIMATIC管理器中，只能将块或整个用户程序存到存储卡中。 

• 如果某些较大的逻辑块在存盘或编译时出现问题，用户应重新组织项目。在SIMATIC

管理器中，用菜单命令File > Reorganize 来进行。然后，再试一次存盘或编译。 
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12  数据块的参数赋值 
 

数据块的参数赋值功能可以不在LAD/STL/FBD程序编辑器内工作： 

• 不用调用整个数据块，可以修改背景数据块的实际值并下载到PLC中。 

• 在线监视背景数据块。 

• 用“S7_Techparam”系统属性(技术功能)可以方便地对背景数据块和多重背景进行赋

值并可在线监视。 

 

步骤： 

在SIMATIC管理其中，双击打开背景数据块。 

如果要打开“Parameter Assignment for Data Blocks”(对数据块参数赋值)，点击“Yes”。

结果：打开背景DB。 

通过菜单命令View > Data View或View > Declaration View显示哪个数据块。对于带有

“S7_techparam”系统属性的背景数据块或多重背景，自动打开“ technological 

parameters”窗口。 

按照需要编辑背景数据块。在报文窗口中显示任何相关的信息、警告信息或错误信息。双

击相应的警告或错误信息可以进入其相应位置。 

通过菜单命令PLC > Download Parameter Setting Data可以将修改的实际值从PG下载到

CPU中。 

通过菜单命令Debug > Monitor显示打开块的程序状态，并在线监视所下载的实际值。 

 

注意 

可以识别带有“S7_techparam”系统的数据块。察看一个块是否具有该系统属性，可进入

SIMATIC管理器并选择该块，通过菜单命令Edit > Object Properties并打开属性框。 
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12.1 对技术功能参数赋值 

 

对于功能“Parameter Assignment for Data Blocks”，可以方便地对标准库提供的温度控

制块FB 58 “TCONT_CP”和FB 59 “TCONT_S”进行参数赋值并可在线监视。 

 

步骤： 

在SIMATIC管理器中，通过File > Open > Libraries选择并打开STEP 7标准库。 

选择“PID Control Blocks”然后点击“Blocks”。你可以发现带“S7_techparam”属性

的功能块： 

FB 58 “TCONT_CP”：带连续或脉冲输入信号的温度控制器 

FB 59 “TCONT_S”：积分型执行器的温度控制器 

将功能块(FB 58或FB 59)从标准库中拷贝到你的项目中。 

通过Insert > S7 Block > Data Block为所选的FB创建一个背景DB。 

在SIMATIC 管理器中双击打开背景DB，并启动功能“Parameter Assignment for Data 

Blocks”。结果：在技术窗口中打开背景DB。现在可以轻松地对背景DB进行参数赋值并

在线监视。 

在窗口中输入适当的控制值。在报文窗口中显示任何相关的信息、警告信息或错误信息。

双击相应的警告或错误信息可以进入其相应位置。 

 

注意 

可以识别带有“S7_techparam”系统的数据块。察看一个块是否具有该系统属性，可进入

SIMATIC管理器并选择该块，通过菜单命令Edit > Object Properties并打开属性框。 
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13  建立STL源文件 
 

13.1 编写STL源文件的基本信息 

 

用STL源文件输入程序然后将其编译成实用的软件块。这类源文件包括一个代码，这个代

码与编译后的软件块号码相同。 

用源文件形式编写程序有如下优势： 

• 用ASCII编辑器编写源文件，而后将其编译成实用软件块。并将这些软件块存贮在S7用

户程序文件夹中。 

• 用源文件编写软件块的号码。 

• 源文件可保存，即使含有语句错误。如果使用对逻辑软件块语法检测，则不能保存。

因为你一旦编译源文件其语句错误就会暴露出来。 

用语句表（STL）方式编写源文件。并设定它的软件块结构、变量表和程序段关键字。 

当建立STL源文件时，应注意以下几点： 

• 编写STL源文件的有关注意。 

• 软件块在STL源文件中的语句及格式。 

• 软件块在STL源文件中的结构方式。 
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13.2 编写STL源文件的规则 

 

13.2.1  在STL源文件输入语句的规则 

STL源文件由文本方式组成。为将其编译成软件块，必须按一定规则编写其结构及语句。 

请注意下列有关建立STL源文件的注意： 

标  题 规  则 

语句 除CALL指令结构以外，与STL语句表中的语句相同。 

CALL 在源文件中将参数输入到括号内，并将各参数用逗号分开。  

例如：FC call（one line） 

CALL FC10 （param1：=I0.0，param2：=I0.1）；  

例如：FB call （one line）  

CALL FB10， DB100 （para1：=I0.0，para2：=I0.1）； 

 
例如：FB call （more than one line）  

CALL FB10， DB100 （ 

              para1：=I0.0，  

              para2：=I0.1）； 

注意：  

调用软件块时，应按ASCII码编辑器依次编写的参数顺序完成参数的
转换。否则STL与源文件中的赋值就会不匹配。 

大/小写 除系统属性和转移选项卡以外，编辑器不能识别大小写。当输入字符
串时（数据类型STRING），必须确定大小写。关键字要用大写字母表
示。在编译的时候看不到大小写，因此可以用大写、小写或大小写混

合方式输入关键字。 

分号 在STL语句和变量表的结尾使用分号（；）。这样就可以在一行输入多
条语句。 

双斜线（ // ） 双斜线（ // ）作为注释的开始，RETURN作为注释的结束。 

 

13.2.2  在源文件中声明变量的规则 

源文件中的每一个软件块都要声明所需的变量。 

变量声明表应设置在每个软件块的代码部分之前。 

如果某些变量正在被调用，应按声明类型以正确的顺序声明这些变量。也就是说这类变量

是一体的。 

以梯形图、功能块图和语句表方式编程时，虽然填写了变量声明表，但是还要设置相关的

关键字。 
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变量声明表的关键字 

声明类型 关键字 用于 

输入参数 ″VAR_INPUT″ 

声明表 

″END_VAR″ 

FB，FC 

输出参数 ″VAR_OUTPUT″ 

声明表″ 

END_VAR″ 

FB，FC 

输入/输出参数 ″VAR_IN_OUT″ 

声明表″ 

END_VAR″ 

FB，FC 

静态变量 ″VAR″ 

声明表 

″END_VAR″ 

FB 

临时变量 ″VAR_TEMP″ 

声明表″ 

END_VAR″ 

OB，FB，FC 

关键字END-VAR表示声明表结束。 

声明表是以某声明类型组成的变量表，表中的变量都有一个预置的值（VAR-TEMP除外）。

下面是一个声明表的结构的例子： 

Duration_Motor1：   S5TIME    ：=     S5T#1H_30M； 

Variable        Data type       Default value 

注意： 

• 变量符号必须以字母开始。变量符号不能与已保留的关键字相同。 

• 如果局部声明表与符号表中的变量符号相同，则应在局部声明表中的变量名前增加“ #”

符号，在符号表中的变量应加上引号。否则，此变量视为局部变量。 

  

13.2.3  STL源文件中软件块次序的规则 

被调用的软件块应在调用它的软件块之前。意思是： 

• 在大多数情况下，OB1用于调用其它的软件块，所以被调用的软件块应在OB1之前输

入，OB1应在最后。 

• 用户定义的数据类型（UDT）应在使用它的软件块之前输入。 

• 带有用户定义的数据类型（UDT）的数据块应紧接在用户定义的数据类型之后。 
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• 如多个软件块使用同一数据块，则应首先输入这个数据块。 

• 背景数据块应在其相应的功能块之后。 

• DB0备用。用户不能建立DB0。 

 

 

13.2.4  STL源文件设定系统属性的规则 

设定作用于软件块和参数的系统属性。系统属性用于管理报文组态、连接组态、操作员接

口功能及过程控制组态等功能。 

• 在源文件中输入系统属性时有如下规则： 

• 系统属性的关键字以“S7_”开始 

• 系统属性应位于括号内。 

• 句子格式：{S7_idenifier：= ’string’}  

• 标识代码应用“；”分开。 

• 用于软件块的系统属性应在软件块属性之前，在关键字ORGANIZATION_和TITLE之后。 

• 用于参数的系统属性应与参数声明在一起，并且位于数据声明的冒号之前。大小写字

符不同。在输入时大小写应有所区别。 

在“System Attributes”下面，用菜单命令File > Properties，可以检查或修改用于软件

块的“属性”选项卡。 

用菜单命令File > Object Properties，检查或修改用于参数的系统属性，光标必须放在参

数声明的名称上。 

 

 

13.2.5  STL源文件设定软件块属性的规则 

块属性可使用户更容易辨识所生成的各程序块，并且还可以对这些程序块加以保护，防止

非法修改。 

在“General Part1”和“General Part2”选项卡下，用菜单命令File > Properties，可以

检查或修改软件块属性。 

其它软件块属性依次在源文件输入。 

请按下列规则在源文件中输入：  

• 软件块属性应在变量声明表之前 

• 每个软件块属性各占一行 
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• 各行用分号结束 

• 用关键字指定软件块属性 

• 输入的软件块属性在软件块属性表中顺序显示 

• 对应各种软件块类型的有效的软件块属性列表：从软件块属性到软件块类型 

注意： 

块属性能够在SIMATIC管理器目标中显示并能在此编辑下列属性：AUTHOR、FAMILY、

NAME和VERSION。 

 

软件块属性和软件块次序 

当输入块属性时，输入顺序如下表。 

次序 关键字/属性 含义 举例 

1. [KNOW_HOW_PR
OTECT] 

块保护；使用该指令后，当该块进
行编译时，使程序部分不可见 

KNOW_HOW_PROTECT 

2. [AUTHOR：] 作者名：公司名，部门名或其它名
你（最多为没有空格的8个字符） 

AUTHOR：Siemens， 

没有关键字 

3. [FAMILY：] 块系列名：例如，控制器（最多为
没有空格的8个字符） 

FAMILY：Controller， 

没有关键字 

4. [NAME：] 块名（最多8个字符） NAME：PID， 

没有关键字 

5. [VERSION：int1.int2] 块的版本号（两个数的范围均在0
到15之间，意为0.0到15.15） 

VERSION：3.10 

6. [CODE_VERSION1] 功能块能否有多重背景的标识符。
如果想用多重背景则功能块不应

有该属性。 

CODE_VERSION1 

7. [UNLINKED] 
只适用于DB 

具有“UNLINKED” 属性的数据
块只能存储在局部存储器中，它不
占用工作存储器的空间，也不能与
程序连接。他们不能用MC7的命令
访问。只能用SFC20 BLKMOV或
SFC 83 READ_DBL指令将这样的
DB传送到工作存储器。 

 

8. [READ_ONLY] 
只适用于DB 

数据块的写保护；其数据只能读，

不能修改。 
FAMILY=Examples 
VERSION=3.10  
READ_ONLY  
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13.2.6  每个软件块类型的许可软件块属性 

下表所示为哪种块类型可具有哪些块属性： 
特性 OB FB FC DB UDT 

KNOW_HOW_PROTECT • • • • - 
AUTHOR • • • • - 

FAMILY • • • • - 
NAME • • • • - 

VERSION • • • • - 

UNLINKED - - - • - 
READ_ONLY  - - - • - 

 

使用KNOW_HOW_PROTECT设定块保护 

当用户在STL源文件中编程块时，通过使用关键字“KNOW_HOW_PROTECT”设定块保

护，可以保护块，防止非特许用户使用。 

该块保护命令具有下列效果： 

• 如果想在增量STL、FBD或梯形图编辑器中输出编译后的保护块，则该块的程序部分不

能显示。 

• 该块的变量声明表中只显示类型为 var_in、var_out和var_in_out的变量。类型为var_stat

和var_temp的变量隐含。 

• 在输入任何其它块属性之前，输入关键字KNOW_HOW_PROTECT。 

 

使用READ_ONLY，设定数据块为写保护 

对于数据块，用户可以设定写保护，以防在程序执行期间改写数据块。为此，数据块必须

以STL源文件的形式存在。 

使用源文件中的关键字“READ_ONLY”，可以设置写保护。这个关键字必须输入在声明

变量之前的那一行。 
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13.3 软件块在STL源文件中的结构方式 

 

在STL源文件中用关键字设定软件块结构。根据软件块的类型有如下结构选择：  

• 逻辑块 

• 数据块 

• 用户定义的数据类型（UDT） 

 

13.3.1   逻辑块在STL源文件中的结构方式 

逻辑块由下列部分组成，各部分由相应的关键字定义： 

• 块的开始部分 

• 由关键字定义块的号码和名称，例如： 

- “ORGANIZATION_BLOCK OB1”定义组织块 

- “FUNCTION_BLOCK FB6”定义功能块，或 

- “FUNCTION FC1：INT”定义功能。这样也同时设定了功能的类型。 

它可以是简单或复杂的数据类型（ARRAY和STRUCT除外），并定义返回值的数据类型

（RET_VAL）。如果没有返回值，则使用关键字“VOID”。 

• 关键字“TITLE”引导软件块的标题（标题最长64个字符）。 

• 用双斜线作为注释的开始 

• 软件块的属性（可选） 

• 变量声明表 

• “BEGIN”作为代码部分的开始。代码部分由1个或多个段组成，仅用“NETWORK”

作为段的标识符。不能输入段的号码。 

• 关键字“TITLE=”作为段的开始。（标题最长64个字符） 

• 用双斜线“// ”作为每个段注释的开始。 

• END_ORGANIZATION_BLOCK，END_FUNCTION_BLOCK或END_FUNCTION作为软

件块的结束。 

• 软件块类型和号码之间应加空格。符号块名应加上引号，以确保局部变量符号名与符

号表中的名称一致。 
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13.3.2  数据块在STL源文件中的结构方式 

数据块由下列部分组成，各部分由自己的关键字引导：  

• 启动部分：关键字和块号码或块名称，例如：DATA_BLOCK DB26 

• 依照相关的UDT或功能块（可选） 

• 由关键字“TITLE：”引导块的标题。（最长64个字符） 

• 用双斜线“// ”作为块注释的开始。 

• 软件块的属性（可选） 

• 变量声明表（可选） 

• BEGIN作为缺省设置赋值部分的开始（可选） 

• END_DATA_BLOCK作为块的结束 

数据块有三种类型： 

• 用户定义的数据块 

• 带有用户定义的数据类型（UDT）的数据块 

• 与功能块相联的数据块（作为背景数据块） 

 

13.3.3  用户定义数据类型在STL源文件中的结构方式 

用户定义的数据类型由下列部分组成，各部分由自己的关键字引导：  

• 启动部分：关键字TYPE和块号码或块名称，例如：TYPE UDT20 

• 结构化数据类型 

• END_TYPE作为块的结束 

当输入用户定义的数据类型时，数据类型应位于使用它的软件块之前。 

 

13.4 软件块在STL源文件中的语句及格式 

如果编程STL源文件，格式表将显示语法和格式。语法说明如下：  

• 各部分的说明在右边一栏。 

• 输入内容应用引号。 

• 方括号[...]其中内容可选择填写。 

• 用大写字符输入关键字。 
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13.4.1  组织块的格式表 

结  构 说  明 

"ORGANIZATION_BLOCK" ob_no或
ob_name 

ob_no— 块的符号，如B1；  

ob_name—在符号表中定义的符号名 

[TITLE=] 块标题（最长64个字符） 

[块注释] 块注释应从“// ”开始 

[块的系统属性] 块的系统属性 

[块的属性] 块的属性 

变量声明表 临时变量声明表 

"BEGIN" 关键字用于变量声明表和STL指令部分之间 

NETWORK 段的开始 

[TITLE=] 段标题（最多64个字符） 

[段注释] 块注释应从“// ”开始 

STL指令部分 块指令 

"END_ORGANIZATION_BLOCK" 组织块结束的关键字 

 

 

13.4.2  功能块的格式表 

下表是STL源文件中功能块的简单格式表： 

结  构 说  明 

"FUNCTION_BLOCK" fb_no 或 
fb_name 

fb_no ：符号表中的符号名，如FB6；fb_name 符号表
中的符号名  

[TITLE=] 块标题（最长64个字符） 

[块注释] 块注释应从“// ”开始 

[块的系统属性] 块的系统属性 

[块的属性] 块的属性 

变量声明表 
（输入、输出及输入/输出参数），临时变量，静态变量
的声明表参数声明表包括参数的系统属性声明 

"BEGIN" 关键字用于变量声明表和STL指令部分之间 

NETWORK 段的开始 

[TITLE=] 段标题（最多64个字符） 

[段注释] 块注释应从“// ”开始 

STL指令部分 块指令 

"END_FUNCTION_BLOCK 表示功能块结束的关键字 
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13.4.3  功能格式表 

下表是STL源文件中功能的简单格式表： 

结  构 说  明 

“FUNCTION” fc_no：fc_type 

 或fc_name：fc_type 

fc_no：为块编号，如FC5； 

fc_name为符号表中所定义的块符号名；   

fc_type：功能返回值（RET_VAL）的数据类型。它是一
种简单或复杂的数据类型（ARRAY和STRUCT除外）或
VOID。 

如使用系统属性作为返回值（RET_VAL），必须将用于
参数的系统属性输入在数据声明表之前。 

[TITLE=] 块标题（最长64个字符） 

[块注释] 块注释应从“// ”开始 

[块的系统属性] 块的系统属性 

[块的属性] 块的属性 

变量声明表 （输入、输出及输入/输出参数），临时变量，静态变量 

"BEGIN" 关键字用于变量声明表和STL指令部分之间 

NETWORK 段的开始 

[TITLE=] 段标题（最多64个字符） 

[段注释] 块注释应从“// ”开始 

STL指令部分 块指令 

“END_FUNCTION” 表示功能结束的关键字 

 

 

13.4.4  数据块的格式表 

下表是STL源文件中数据块的简单格式表： 

结  构 说  明 

"DATA_BLOCK"  db_no或    
db_name 

db_no：块的编号，如DB5； 

db_name：符号表中的符号名  

[TITLE= ] 块标题（最长64个字符） 

[块注释] 块注释应从“// ”开始 

[块的系统属性] 块的系统属性 

[块的属性] 块的属性 

声明部分 
声明此块是否与UDT或FB相关，定义块的号码或符号表
中的符号名或某种复杂的数据 

"BEGIN" 关键字用于变量声明表和STL指令之间 

[初始赋值] 
变量具有初始值各变量或是赋值与常数值或赋与其它块
相关的值 

"END_DATA_BLOCK" 块结束的关键字 
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13.5 建立STL源文件 

 

13.5.1  建立STL源文件 

源文件必须在S7程序下的源文件夹中生成。可以在SIMATIC管理器或编辑器窗口生成源文

件。 

在SIMATIC管理器中生成源文件 

1. 通过双击打开相应的“源文件”夹。 

2. 要插入一个STL源文件，可以用菜单命令Insert > S7 Softwore > STL Source File。 

 

在编辑器窗口生成源文件 

选择菜单命令File ＞ New。 

在对话框中选择包含那些块的用户程序的同一个S7程序里的源文件夹。 

为新源文件输入一个名字。 

用“OK”确认。 

该源文件在你输入的名字下生成，并显示一个编辑窗口。 

 

 

13.5.2  编辑S7源文件 

对于一个被编辑的源文件，可以在其对象特性中设置编程语言和编辑器。这就确保了当打

开源文件编辑时，启动了正确的编辑器和正确的编程语言。STEP 7标准软件支持在STL源

文件中编程。 

作为可选软件还有其它编程语言可以使用。如果相应的软件选项已装入你的计算机，你只

能选择菜单命令插入源文件。 

要编辑一个S7源文件可按如下进行： 

1.   通过双击打开相应的“源文件”夹。 

2.   按下述方法启动编辑所需的编辑器： 

     -  双击右半窗口中所要的源文件。 

     -  选择右半窗口中所需的源文件，并选择菜单命令Edit>Open Object。 
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13.5.3  设定源代码文本的布局 

为了提供源文件的可读性，选择菜单命令Options > Settings以及“Source Code”。可以

指定源代码中各个单元的字体、字号和颜色。 

 

13.5.4 将软件块模板插入STL源文件 

用于STL源文件编程的块模板有组织块（OB）、功能块（FB）、功能（FC）、数据块（DB）、

背景数据块、与用户定义的数据类型相关的数据块、用户定义的数据类型（UDT）。块模

板使得在源文件中输入块更容易，并且可以观察语法和结构框架。 

要插入一个块模板可按如下进行： 

1.   激活你要插入块模板的源文件窗口。 

2.   将光标放在源文件中你想在其后插入块模板的位置。 

3.   选择下面的菜单命令之一Insert>Block Template>OB/FB/FC/DB / Instance DB/DB 

Referencing UDT/UDT。 

块模板被插入到光标位置后的文件中。 

 

13.5.5  插入其它STL源文件的内容 

可以将其它源文件的内容插入到你的STL源文件中。步骤如下： 

激活要插入其它源文件的目标源文件的窗口。 

将光标指向该目标文件中要插入的位置。 

选择菜单命令Insert > Object > File。 

在出现的对话框中选择要插入的源文件。 

所选择的源文件内容插入到光标位置之后。 

 

13.5.6  从STL源文件现有的块中插入源代码 

你可以将其它块的源代码插入到你的STL源文件中，该源文件可以是用LAD、FBD或STL

编写的。它可以是OB、FB、FC、FB、UDT。其步骤如下： 

1.  激活要插入块的目标源文件的窗口。 

2.  将光标指向该块中要插入的位置。 
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3. 选择菜单命令Insert > Object > Block。 

4. 在出现的对话框中选择要插入的块。 

 

13.5.7  插入外部源文件 

可用ASCII编辑器生成并编辑源文件，然后将它导入到项目中，再用这个应用程序将它编译

成块。要实现这一步，你必须将源文件导入到S7程序的“源文件”夹中，在编译过程中生

成的块将存储在该S7程序的S7用户程序中。 

要插入外部源文件可按如下进行： 

1.   选择S7程序的源文件夹，外部源文件将被导入到该文件夹中。 

2.   选择菜单命令Insert>External Source File。 

3.   在显示的对话框中选中要导入的源文件。 

要导入的源文件必须有有效的扩展名。STEP 7用扩展名来判定源文件的类型。这就意味着，

例如，当STEP 7导入扩展名为.AWL的文件时建立STL源文件。有效的文件扩展名列在对话

框的“File Type（文件类型）”中。 

注意 

也可以用菜单命令Insert > External Source File，导入你用STEP 7版本1生成的源文件。 

 

 

13.5.8  从软件块建立STL源文件 

你可以用已有的块生成一个可以在任何文本编辑器中编辑的STL源文件。该源文件生成在

S7用户程序的源文件夹中。 

要用块生成一个源文件可按如下进行： 

在程序编辑器中，选择菜单命令File > Generate Source File。 

在对话框中选择欲在其中生成新源文件的源文件夹。 

在文本框中为源文件输入名字。 

在“选择STEP 7块”对话框中，选择你想用来生成特定的源文件的块。所选的块显示在右

边的列表框中。 

用“OK”确认。 

来自所选块的STL源文件被生成并显示在编辑窗口中。 
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13.5.9  导入源文件 

可以将源文件从任何目录中导入到项目中： 

在SIMATIC管理器中，选择要导入到的文件夹。 

选择菜单命令Insert > External Source File。 

在显示的对话框中，选择要插入的源文件。 

点击“Open”。 

 

13.5.10  导出源文件 

可以将源文件从项目中导出到任何目录中： 

在源文件夹中选择源文件 

选择菜单命令Insert > Export Source File。 

在显示的对话框中，选择目的路径和文件名。 

点击“Save”。 

 

注意： 

如果对象没有文件扩展名，将对该文件加入该文件类型的扩展名。例如：STL源文件“prog”

导出的文件为“prog.awl”。 

如果该对象已经有了一个合法的扩展名，则将保持该文件扩展名。 

如果该对象的扩展名不合法(指文件名中含有点)，则不会对其加扩展名。 

“File type”下的“Export Source File”对话框中列出了可以使用的合法的扩展名。 
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13.6  存储并编译STL源文件并执行一致性检查 

 

13.6.1   存储STL源文件 

你可以在任何时候在一个STL源文件的当前状态下对其进行存储。程序并不编译也不运行

语法检查，这意味着任意错误都可以同时被存储。 

语法错误的检查和报告只在源文件编译时或一致性检查后进行。 

要在同一名下存储源文件： 

激活要存储的源文件的窗口。 

选择菜单命令File > Save。 

             要将源文件存在一个新名/另一个项目下： 

激活要存储的源文件的窗口。 

选择菜单命令File > Save As。 

在对话框中选择要在其中存储源文件的源文件夹并输入新名字。 

 

13.6.2  检查STL源文件的一致性 

用菜单命令File > Consistency Check，可以显示源文件中的所有语法错误。与编译相比，

不会有块生成。 

当一致性检查完成后，有对话框显示已发现的错误的总数。 

所有发现的错误分别列在窗口的下部并各有一行参考。为了能够生成各个块，在编译前修

改这些错误。 

 

13.6.3  在STL源文件中诊断故障 

源文件的活动窗口被分割为两部分。在下半部分显示以下错误：  

• 用菜单命令File > Compile，启动编译运行后所发现的错误。 

• 用菜单命令File > Consistency Check，启动一致性检查后所发现的错误。 

要找到错误在源文件中的位置，将光标放在窗口下部相应的错误信息上。窗口上部包含错

误的文件行自动加亮。错误信息也显示在状态栏中。 
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13.6.4  编译STL源文件 

要求 

为了将你用STL源文件生成的程序编译成块，必须满足下列要求： 

• 只有存储在S7程序下的“源文件”夹中的源文件才能被编译。 

• 除了“源文件”夹之外，还要有一个“块”文件夹在S7程序下，编译过程中生成的块

将存储在这个“块”文件中。只有源文件编译不出错。源文件中编程的块才能生成。

如果在一个源文件中有许多块，只有那些没有错误的块才能生成。然后你就可以打开

这些块编辑它们，下载CPU并一个一个地进行调试。 

在编辑器中的编译过程 

打开要编译的源文件。该源文件必须在S7程序的源文件夹中，编译生成的块也要存储在这

个S7程序的S7用户程序中。 

选择菜单命令File > Compile。 

“编译报告”对话框显示出来，显示已编译的行和已发现的错误。 

只有当源文件编译时无错才能生成文件指定的块。如果在一个源文件中有许多块，只有那

些没有错误的块才能生成。错误警告不妨碍块的生成。 

编译过程中查到的所有错误都显示在工作窗口的下部，并且在生成各个块之前必须进行改

正。 

在SIMATIC管理器中的编译过程 

通过双击打开合适的“源文件”夹。 

选择一个或多个要编译的源文件。对于一个关闭的源文件夹，无法启动编译运行来编译其

包含的所有源文件。 

选择菜单命令File > Compile，开始编译。你为源文件所选择的正确的编译器被调用。被

成功编译的块则存储在S7程序的块文件夹中。 编译过程中查出的所有语法错误显示在对

话框中，并且必须被纠正，以便生成错误所在块。 
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13.7 STL源文件的例子 

 

13.7.1  STL源文件声明变量的例子 

 

基本类型的变量 

// 注释与声明表双斜线分开。 

VAR_INPUT // 关键字：输入变量 

in1：INT； // 用“：”将变量名和类型分开 

in3：DWORD； // 变量声明用分号结束 

in2：INT：= 10； // 设置声明表中的初始值 

END_VAR // 同一类型的变量声明结束 

VAR_OUTPUT // 关键字：输出变量 

out1WORD； 

END_VAR // 关键字：临时变量 

VAR_TEMP 

temp1：INT； 

END_VAR 

 

数组型的变量 

VAR_INPUT // 输入变量 

array1：ARRA array1：ARRAY [1..20] of INT； // 数组1是1维数组 

array2：ARRAY [1..20，1..40] of DWORD； // 数组2是2维数组 

END_VAR 

 

结构型的变量 

VAR_OUT // 输出变量 

OUTPUT1：STRUCT // OUTPUT1具有STRUCT数据类型 

var1：BOOL； // 结构中的元素1 

var2：DWORD； // 结构中的元素2 

END_STRUCT； // 结构结束 

END_VAR 

 



建立STL源文件 

 13-18 

13.7.2  STL源文件中组织块例子 

ORGANIZATION_BLOCK OB1  

TITLE = Example for OB1 with different block calls  

// 第3段显示块的调用 

// 带有或不带参数 

 

{S7_m_c；= ’true’}   // 块的系统属性 

AUTHOR   Siemens 

FAMILY   Example 

NAME   Test_OB 

VERSION    1.1 

VAR_TEMP 

Interim value：INT；   // 缓存器 

END_VAR 

 

BEGIN 

 

NETWORK 

TITLE = Function call transferring parameters  

//  传送参数只有1行 

CALL FC1 （param1：=I0.0，param2：=I0.1）； 

 

NETWORK 

TITLE = Function block call  

// 传送参数 

// 传送参数多行 

CALL Traffic light control，DB6（   // FB名称，背景数据块 

dur_g_p   ：= S5T#10S，   // 参数赋实际值 

del_r_p   ：= S5T#30S， 

starter    ：= TRUE， 

t_dur_y_car   ：= T 2， 

t_dur_g_ped  ：= T 3， 

t_delay_y_car  ：= T 4， 

t_dur_r_car   ：= T 5， 

t_next_red_car  ：= T 6， 
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r_car    ：= "re_main"， // 引号表示符号 

y_car    ：= "ye_main"， // 在符号表输入名称 

g_car    ：= "gr_main"， 

r_ped    ：= "re_int"， 

g_ped    ：= "gr_int"）； 

 

NETWORK 

TITLE = Function block call  

// 传送参数 

// 传送参数1行 

CALL FB10， DB100（para1：=I0.0，para2：=I0.1）； 

END_ORGANIZATION_BLOCK 

 

 

13.7.3  STL源文件中功能的例子 

FUNCTION FC1：VOID  

//  仅用于调用 

VAR_INPUT  

   param1：bool； 

   param2：bool；  

END_VAR   

begin  

end_function 

 

FUNCTION FC2：INT 

TITLE = Increment number of items  

// 传送条目<1000个，这个功能增加了传送条目个数。 

// 如果传送条目数超出1000个， 

// 则在返回值功能（RET_VAL）显示“-1”。 

 

AUTHOR   Siemens 

FAMILY   Throughput check 

NAME：   INCR_ITEM_NOS 

VERSION：   1.0 
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VAR_IN_OUT  

ITEM_NOS：INT；     // 当前制造零件号 

END_VAR 

 

BEGIN 

 

NETWORK 

TITLE = Increment number of items by 1  

// 运行的条目数少于1000个 

// 计数器加1 

L ITEM_NOS； L 1000；     // 多于1个的例子 

> I； JC ERR；       // 行指令 

L 0； T RET_VAL；  

L ITEM_NOS； INC 1； T ITEM_NOS； BEU；  

ERR：L -1；  

T RET_VAL；  

END_FUNCTION 

 

FUNCTION FC3 {S7_pdiag：= ’true’}：INT 

TITLE = Increment number of items  

// 传送条目<1000个，这个功能 

// 增加了传送条目个数。如果传送条目数超出1000个， 

// 则在返回值功能（RET_VAL）显示“-1”。  

// RET_VAL具有参数的系统属性 

 

AUTHOR：   Siemens 

FAMILY：   Throughput check 

NAME：   INCR_ITEM_NOS 

VERSION：   1.0 

 

VAR_IN_OUT 

ITEM_NOS {S7_visible：= ’true’}：INT； // 当前制造零件号 

// 参数的系统属性 

END_VAR 
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BEGIN 

 

NETWORK 

TITLE = Increment number of items by 1  

// 运行的条目数少于1000个 

// 计数器加1 

L ITEM_NOS； L 1000；    // 多于1个的例子 

I； JC ERR；      // 行指令 

L 0； T RET_VAL；  

L ITEM_NOS；INC 1；T ITEM_NOS；BEU； 

ERR：L -1；  

T RET_VAL；  

 

END_FUNCTION 

 

13.7.4  STL源文件中功能块例子 

FUNCTION_BLOCK FB6 

TITLE = Simple traffic light switching  

// 行人穿越 

// 主路时指示灯的控制 

 

{S7_m_c：= ’true’}  // 块的系统属性 

AUTHOR  ：  Siemens 

FAMILY  ：  Traffic light 

NAME   ：  Traffic light01 

VERSION   ：  1.3 

 

VAR_INPUT 

 

Starter ： BOOL：= FALSE； //  对行人的要求 

t_dur_y_car ： TIMER；   // 绿灯亮时对行人的要求 

t_next_r_car ： TIMER；  // 红灯亮时对行人的要求 

t_dur_r_car ： TIMER； 
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number    {S7_server：= ’alarm_archiv’； S7_a_type：= ’alarm_8’}： 

           DWORD； 

// 车的号码 

// 号码是具有系统属性的参数 
 
END_VAR 

VAR_OUTPUT 

g_car： BOOL： =FALSE； //  绿灯对车的要求 
 
END_VAR  

VAR 

condition： BOOL： =FALSE； //  红灯对车的出现的条件 

END_VAR 
 
BEGIN 

NETWORK 

TITLE = Condition red for main street traffic  

// 1分钟后，行人穿越主路的绿灯                                

// 作为红灯亮条件 

// 主路交通量 

A（； 

A  #starter；   // 行人进路时绿灯的要求 

A   #t_next_r_car； // 红灯亮的时间 

O  #condition；  // 或红灯亮的条件 

）； 

AN  #t_dur_y_car；  // 红灯不亮的条件 

=  #condition；  // 红灯亮的条件 

NETWORK 

TITLE = Green light for main street traffic 

AN  #condition；   // 主街上没有红灯亮的条件 

=      #g_car；    //  主街上的绿灯 
 
NETWORK  

TITLE = Duration of yellow phase for cars 

// 增加控制 

// 交通灯的程序 

END_FUNCTION_BLOCK 
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FUNCTION_BLOCK FB10  

VAR_INPUT 

para1：bool； 

para2：bool； 
 
end_var  

begin  

end_function_block 
 
data_block db10 

FB10  

begin  

end_data_block 
 
data_block db6 

FB6  

begin  

end_data_block 
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13.7.5  STL源文件中的数据块举例 

数据块 

DATA_BLOCK DB10  

TITLE = DB Example 10 

STRUCT 

aa：BOOL； // Bool类型的变量 

bb：INT； // INT类型的变量INT 

cc：WORD； 

END_STRUCT；  

BEGIN // 赋初值 

aa：= TRUE； 

bb：= 1500； 

END_DATA_BLOCK 

 

带有用户定义的数据类型的数据块 
 

DATA_BLOCK DB20     

TITLE = DB （UDT） Example  

UDT 20    // 用户定义的相关数据类型 

BEGIN 

start：= TRUE；  // 赋初值 

setp.：= 10；  

END_DATA_BLOCK 
 

注意： 

所用的UDT必须在源文件中数据块的前面。 

 

带有相关功能块的数据块： 

DATA_BLOCK DB30  

TITLE = DB （FB） Example  

FB30      // 相关功能块 

BEGIN 

start：= TRUE；   // 赋初值 

setp：= 10；  

END_DATA_BLOCK 
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注意： 

相关功能块必须在源文件中的数据块之前。 

 

 

13.7.6  STL源文件中用户定义数据类型的举例 

Type  UDT20  

STRUCT 

Start：BOOL；  // Bool类型的变量 

Setp： INT；  // INT类型的变量 

数值：WORD； // WORD类型的变量 

END_STRUCT； 

END_TYPE 
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14  显示参考数据 
 

14.1 可用参考数据概述 

 

生成并评估参考数据可使你的用户程序的调试和修改更加容易。参考数据作可作以下应用： 

• 作为你的整个用户程序的一个概述 

• 作为修改和测试的基础 

• 完善你的程序文档  

下表说明在各个视窗中可以摘取哪些信息： 

视窗 目的 

交叉参考列表 

在存储区域I、Q、M、P、T、C以及DB、FB、FC、SFB、SFC块中由用户程
序使用的地址概述。  

用菜单命令View > Cross Reference for Address，可以显示包括对所选地址
的重复访问在内的所有交叉参考数据。 

输入、输出及位存储赋值表 
用户程序已占用的定时器和计数器（T和C）以及I、Q、M存储区中的位地址
的概述；为故障诊断或修改用户程序奠定了重要基础 

程序结构 在一个用户程序内块的分层调用结构，以及所使用的块及其嵌套层次的概述 

未用符号 
所有已在符号表中定义但未在用户程序的任何一个部分使用的符号概述。这
些用户程序有可供使用的参考数据 

无符号的地址 
在有可供使用的参考数据的用户程序中，使用了但未在符号表中定义符号的
绝对地址概述 

所选用户程序的参考数据包括表中所列各项。可以为一个用户程序或多个用户程序生成并

显示一种或多种列表。 

 

同时显示多个视窗 

在附加窗口显示其它列表可以让你：例如， 

• 比较不同的S7用户程序的同一种列表。 

• 显示某个列表的不同视窗，例如，不同显示的交叉参考列表在屏幕上并行排列。比如，

你还可以在一个交叉参考列表中只显示S7用户程序的输入而在另一个列表中只显示输

出。 

• 同时打开一个S7用户程序的多个列表，例如，程序结构和交叉参考列表。 
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14.1.1  交叉参考列表 

交叉参考列表给出了S7用户程序所用地址的概述。 

一旦显示交叉参考列表就可以得到输入（I）、输出（Q）、位存储（M），定时器（T）、

计数器（C）、功能块（FB）、功能（FC）、系统功能块（SFB）、系统功能（SFC）、

I/O（P）和数据块（DB）这些存储区域中被S7用户程序使用的地地列表，在该列表中显示

它们的地址（绝对地址或符号地址）及使用情况。显示在一个激活的窗口中。这个工作窗

口的标题栏显示该交叉参考列表所属的用户程序名。 

窗口中的每一行都对应着交叉参考列表的一个输入项。查寻功能让你很容易地找到指定的

地址和符号。 

当你显示参考数据时，交叉参考列表为缺省视窗。你可以改变这个缺省设置。 

 

结构 

一个交叉参考列表的输入项包括以下各栏： 

栏 内容／含义 

Address 绝对地址 

Block 使用该地址的块 

Type 对有关地址的访问是读（R）和／或写（W） 

Language/Details 用于生成块的编程语言的信息 

只有为交叉参考列表选择了相应的选项才会显示符号（ Symbol）、块（Block）、类型（Type）

和语言/明细数据（Language/Details）。块信息则依据该块编写时所用的编程语而定。 

可以使用鼠标按照需要在屏幕上显示的交叉参考列表中设置栏宽。 

 

分类 

交叉参考列表的缺省选项是按存储区域分类。如果用鼠标点中栏标题，则可以按缺省分类

标准对这一栏的输入项进行分类。 

 

交叉参考列表格式示例 

地址 符号 块 类型 语言 详细数据 

I1.0 Motor on OB2 R STL Nw 2 Inst 33 /0 
M1.2 MemoryBit FC2 R LAD Nw 33 

C2  Counter2 FB2   FBD Nw2 
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14.1.2  程序结构 

程序结构概述了在一个S7用户程序内块的分层调用结构。你还可以对所用的块、它们的从

属关系以及它们对局域数据的需求有一个概括的了解。 

在“Generating Reference Data（生成参考数据）”窗口，用菜单命令View > Filter打开

一个标签对话框。在“Program Structure（程序结构）”标签中，你可以设置你想要程序

结构如何显示。 

你可以选其中之一： 

•  树形结构和 

•  父子结构（表格形式） 

 

程序结构的符号 

符号 含义 

正常调用的块（CALL FB10） 

无条件调用的块（UC FB10） 

条件调用的块（CC FB10） 

数据块 

循环 

循环且条件调用 

循环且无条件调用 

块未调用 

 

• 在树形结构中识别并指示调用中的循环。 

• 调用的分层结构中的循环被标记为不同的符号。 

• 正常调用的块（CALL），条件调用的块（CC）或无条件调用的块（UC）被标记为不

同的符号。 

• 未被调用的块显示在树形结构的底部并且标记有黑叉。对于未被调用的块不会有更进

一步的调用结构的分解。 
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调用结构 

整个调用分层结构显示如下。 

 

 

 

 

 

 

 

 

 

 

如果要为所有的组织块（OB）生成程序结构，并且OB1不在S7用户程序中，或者指定的

起始块不在程序中，你会被自动注意指定另一个块作为程序结构的根。 

对于块的多重调用的显示，可以通过选项设置使之无效，这适用于调用结构，也适用于从

属结构。 

 

在调用结构中显示对局域数据的最大需求 

为使你对显示的用户程序中的组织块的局域数据的需求有一个快速而概括的了解，在树形

结构中可显示以下内容： 

• 每个OB所要求的最大局域数据数以及 

• 每个路经所要求的局域数据 

你可以在“Program Structure”标签中激活或取消这个显示。 

如果出现同步错误OB（OB121，OB122），则在所要求的最大局域数据的数字后面显示

一个加号以及该同步错误OB所另外要求的局域的数据数。 

 

从属结构 

从属结构显示项目中每个块和其它块之间的从属关系。 

 

显示删除块 

与册除块有关的行将显示为红色。 
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14.1.3  赋值表 

赋值表将向你显示在用户程序中已经赋值的地址。这个显示是用户程序的故障查寻和修改

的重要基础。 

I/Q/M赋值表的显示使你能概括地了解输入(I)、输出(Q)和位存储(M)、定时器(T)、计数器(C)

中哪个字节的哪一位被使用了。I/Q/M赋值表在一个工作窗口中显示。这个工作窗口的标题

栏显示该赋值表所属的S7用户程序名。 

 

I/Q/M表 

显示中每一行包含存储区的一个字节，在该字节中八个位，按其访问的情况标有代码。它

还指示这个访问是否为一个字节、一个字或一个双字。 

 

I/Q/M赋值表中的代码 

白色背景 地址未被访问，因而也没有赋值 

X 直接访问的地址 

蓝色背景 间接访问的地址（字节、字或双字访问） 

 

I/Q/M赋值表的列 

 

列 内容／含义 

7 
6 
5 
4 
3 
2 
1 
0 

相应字节的位号 

B 该字节以单字节访问的形式被占用 

W 该字节以单字访问的形式被占用 

D 该字节以双字访问的形式被占用 
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赋值表（I/Q/M）格式举例 

下列例子显示了输入、输出和位存储（I/Q/M）的典型格式。 

 

第一行给出了输入字节IB0的分配。可直接访问地址IB0的输入(位访问)。第1、2、3、4、5、

6列标为“X”，可进行位访问。 

存储字节1和2、2和3或4和5也可作为字访问。此时在W列上显示了一个数条并以蓝色背景

显示。黑点表示字的起始字节。 

 

T/C赋值表 

每行显示10个定时器或计数器。 

 

举例 

 0 1 2 3 4 5 6 7 8 9 
T00-09 • T1 • • •  T6 • • • 
T10-19 • • T12 • • • • T17 • T19 

T20-29 • • • • T24 • • • • • 

C00-09 • • C2 • • • • C7 • • 
C10-19 • • • • • • • • • C19 

C20-29 • • • • • • • • • • 
C30-39 • • • • C34 • • • • • 

 

14.1.4  未使用的符号 

你可以看到具有下列特征的所有符号的一个概述显示： 

• 已在符号表中定义的符号。 

• 有参考数据的存在却未在用户程序的任何一部分中使用的符号。 

它们在一个活动窗口中显示。这个工作窗口的标题栏显示该列表所属的用户程序名。 
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窗口中显示的每行对应一个列表输入项。由地址，符号、数据类型和注释组成一行。 

行 内容/含义 

地址 绝对地址 

数据类型 地址的数据类型 

备注 符号表中地址备注 

 

未用符号的格式举例 

Symbol Address Data Type Comment 

MCB1 I 103.6 BOOL Motor circuit breaker 1 

MCB2 I 120.5 BOOL Motor circuit breaker 2 
MCB3 I 121.3 BOOL Motor circuit breaker 3 

你可以通过点中栏标题来对条目分类。 

 

14.1.5  没有符号的地址 

当你显示没有符号的地址列表时，可以得到在S7用户程序中使用了但未在符号表中定义的

地址的列表。它们在一个活动窗口中显示。这个工作窗口的标题栏显示该列表所属的用户

程序名。 

每一行包括地址和该地址在用户程序中使用的次数。 

 

例如： 

地址 次数 

Q 2.5 4 
I 23.6 3 

M 34.1 20 

该列表按照地址来存储。 

 

14.1.6  显示LAD、FBD和STL的块信息 

在交叉参考列表和程序结构中可以显示梯形图、功能块图和语句表的编程语言信息。这个

信息包括块的语言和明细数据。 

如果在“Program Structure”(程序结构)中将过滤器设置为“Call Structure”(调用结构)

并且选择了各自的选项，则程序结构显示相关的语言信息。 

通过菜单命令View > Filter可以显示或隐藏“交叉参考”中的语言信息。 

• 激活“Filter（筛选器）”对话框的“cross Reference（交叉参考）”标签中的“Block 
language and details（块语言和明细数据）”复选框以显示语言信息。 
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语言信息根据块编写时的编程语言的不同而变化，用缩写显示。 

语言 段 语句 指令 

STL Nw Inst / 

LAD Nw   

FBD Nw   

Nw和Inst指示在哪个段和哪条语句中使用了该地址（交叉参考列表）或调用了该块（程序

结构）。 

 

为可选编程语言显示块信息 

如果安装了相应的可选软件包则可访问有关块信息的在线帮助。 

 

 

14.2 用参考数据 

 

14.2.1  参考数据显示方式 

以下是可用来显示参考数据的方法： 

 

从SIMATIC管理器中显示 

1.  在离线组件视窗的项目窗口中，选择“Blocks（块）”文件夹。 

2.  选择菜单命令Options > Reference Data > Display。 

 

从编辑器窗口显示 

1.   在“Blocks”文件夹中打开一个块。 

2.   在编程语言编辑器的窗口中，选择菜单命Options > Reference Data。 

将显示“Customize（用户自定义）”对话框。在此，用户可以首先选择所显示的窗口。

缺省窗口为应用程序中显示参考数据最后关闭的窗口。用户可以取消对话，以便以后调用。 

 

从编译的块直接显示 

可以从语言编辑器中的一个编译的块直接显示参考数据，以获得你的用户程序的当前概况。 
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14.2.2  在另外的工作窗口显示列表 

使用菜单命令Window > New Window，可以打开另一个工作窗口，显示参数据的其它视

窗（例如，未使用的符号列表）。 

使用菜单命令Reference Data > Open，可以为以前隐藏的参考数据打开一个工作窗口。

选择“View（视窗）”菜单中的某个命令或工具栏中相应的按钮，可以改变为其它的参考

数据的视窗： 

参考数据视窗 显示该参考数据视窗的菜单命令 

没有符号的地址 View > Addresses Without Symbols 

未使用的符号 View > Unused Symbols 

赋值 View > Assignment  

程序结构 View > Program Structure 

交叉参考列表 View > Cross References 

  

14.2.3  生成并显示参考数据 

 

生成参考数据： 

1.  在SIMATIC管理器中，选择你要为之生成参考数据的块文件夹。 

2.  在SIMATIC管理器中选择菜单命令Options > Reference Data > Generate。 

在生成参考数据之前，计算机检查是否已有参考数据，如果有，是否为当前数据。 

• 如果有参考数据，则已被生成。 

• 如果已有参考数据不是当前的，可以选择是否刷新这些参考数据或是否重新全部生成。 

 

显示参考数据： 

使用菜单命令Options > Reference Data > Display，可以显示参考数据。 

在显示参考数据前，要作一个检查以确定是否已有参考数据存在，以及存在的参考数据是

否是当前的。 

• 如果没有参考数据存在则生成它们。 

• 如果有不完整的参考数据存在，显示的对话框会注意该参考数据不一致。然后你可以

决定是否要刷新该参考数据并且到什么程度。有以下几种可能： 

为刷新参考数据，块被再次编译。调用适当的编译器以编译每一个块。使用菜单命令View 

> Update，可以刷新已显示在活动窗口中的参考数据的视窗。 

 



显示参考数据 

 14-10 

14.2.4  在程序中快速查找地址的位置 

编程时使用参考数据，可将光标定位于某一个地址在程序中的不同位置上。要这样做，你

必须有最新的参考数据。但是，你不必启动应用程序来显示参考数据。 

 

基本步骤 

在SIMATIC管理器中，选择菜单命令Options > Reference Data > Generate，生成当前的

参考数据。只有当没有参考数据时或参考数据是旧的，这一步才有必要。 

在一个打开的块中选择地址。 

选择菜单命令Edit > Go To > Instance。 

现在显示一个对话框，包含该地址在程序中的背景。 

如果你还要显示与被调用的地址的物理地址或地址区域相重叠的那些地址的背景，选择选

项“Overlapping access to memory areas（地址区域的重叠访问）”。则这种“地址”栏

被加到表中。 

在列表中选中某位置并点击“Go To”按钮。 

如果打开对话框时参考数据不是最新的，则会有与之相关的信息出现。然后就可以刷新参

考数据了。 

 

位置列表 

对话框中的位置列表包含以下明细数据。 

• 使用了该地址的块。 

• 块的符号名，如果该块有符号名的话。 

• 详细数据，例如，位置信息，以及依据块或源文件（SCL）最初所用的编程语言而定，

如果合适的话，还会有指令显示。 

• 依语言而定的信息。 

• 对该地址的访问类型：只读（R）、只写（W）、读且写（RW）、未知（?）。 

• 块语言。 

可以对位置的显示作筛选，比如，只显示对某一个地址的写访问。关于此对话框，在线帮

助为你提供了更多的关于在该区域中输入什么以及显示的其它信息的详细信息。 

注意 

参考数据只能离线存在。因此该功能总是使用离线块的交叉参考。即使在一个在线块中调

用该功能也是这样。 
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14.2.5  使用地址位置表的示例 

要判定输出Q1.0（直接/间接）在哪个位置被置位了。用以下的STL指令的OB1作为一个示

例： 

 

Network 1： ........... 

A Q1.0    // 在本例中 

= Q1.1    // 无关 

 

Network 2： 

A M1.0 

A M2.0 

=Q 1.0  // 赋值 

 

Network 3： 

// 注释行 

SET 

=M1.0  // 赋值 

 

Network 4： 

A  I  1.0 

A  I  2.0 

=M2.0  // 赋值 

得到以下的Q1.0的赋值关系树： 
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然后按如下进行： 

在LAD/STL/FBD编辑器中将光标位于OB1的Q1.0（NW1，Inst1）上。 

选择菜单命令Edit > Go To > Location或用鼠标右键选择“Go to Location”。  

    现在对话框中显示Q1.0的所有赋值关系： 

OB1     Cycle Execution    NW 1  Inst 3  /=    W    STL 

OB1     Cycle Execution    NW 2  Inst 4  /A    R    STL 

在对话框中用“GO TO”按钮，跳到编辑器中的“NW2 Inst3（第二段第三条指令）”： 

Network 2： 

A M1.0 

A M2.0 

= Q 1.0 

现在必须检查对M1.0和M2.0的赋值。首先将光标位于LAD/STL/FBD/编辑器中的M1.0上。 

选择菜单命令Edit > Go To > Location或用鼠标右键选择“Go to Location”。现在对话框

中显示M1.0的所有赋值关系：  

OB1    Cycle Execution NW 3  Inst 2  /=    W STL 

OB1  Cycle Execution NW 2  Inst 1  /A    R STL 

用对话框中的“Go To”按钮跳到编辑器中的“NW3 Inst2（第三段第二条指令）”。 

在LAD/STL/FBD编辑器中的第三段中可以看到，对M1.0的赋值不重要（因为总是1），因

此应该检查M2.0的赋值。 

    在早于V5的STEP 7版本中，这时你就得重新把整个赋值顺序完整地查一遍。按钮“>>”

及“<<”能使这个操作简单一些： 

将打开的对话框“Go to Location”拖至前台，或从LAD/STL/FBD编辑器中你的当前位置

上调用功能“Go to Location”。 

点击“<<”按钮一次或两次直至显示Q1.0的位置；选择最后一个跳转位置“NW2 Inst3”。 

用“GO TO”按钮（如第三点中所示）从地址位置对话框跳到编辑器中的“NWI Inst3”。 

Network 2： 

A M1.0 

A M2.0 

= Q 1.0 

 

 

在第4点中，检查了M1.0的赋值。现在要检查所有（直接/间接）对M2.0的赋值。将光标放

在编辑器中M2.0上并调用功能“Go to Location：”所有对M2.0的赋值都显示出来： 
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OB1     Cycle Execution    NW 4  Inst 3  /=    W STL  

OB1     Cycle Execution    NW 2  Inst 2  /A    R STL 

用“Go To”按钮跳到LAD/STL/FBD编辑器中的“NW4 Inst3”： 

    Network 4： 

    A  I  1.0 

    A  I  2.0 

    = M2.0 

现在要检查对I1.0和I2.0的赋值。在本例中不再描述这一过程，因为可以按照和以前一样的

方式进行（从第4点开始）。 

通过在LAD/STL/FBD编辑器和地址位置对话框之间进行切换，可以在你的用户程序中找到

并检查相关的位置。 
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15   检查块的一致性和作为块特性的时间标记 
 

15.1 检查块的一致性 

简介 

如果必须使用或扩展单个块的接口或代码，会导致时间标记冲突。同样，时间标记冲突会

造成调用块和被调块或基准块之间的不一致，从而带来繁重的修正工作。 

“检查块的一致性”功能可以避免这种修正工作。“检查块的一致性”功能可以清除所有

时间标记冲突和不一致块的一大部分。对于不一致性不能自动消除的块，该功能可以将你

切换到相应的编辑器中，在此，可以进行修改。所有块的不一致性都可以消除，并一步一

步地进行编译。 

 

要求 

只有STEP 7 V5.0 Service Pack 3生成的项目，才能检查块的不一致性。对于较早的项目，

在进行块的一致性检查时，你必须首先编译每一项（菜单命令Program > Compile All）。 

对于使用任选软件包生成的块，必须安装任选软件包，才能检查块的一致性。 

 

启动块的一致性检查 

在开始进行块的一致性检查时，应检查块接口的时间标记，并且会造成块的不一致性的块

将高亮显示在树视窗中（Dependency Tree/Reference Tree（相关树/参考树））。 

在SIMATIC管理器中，进入项目窗口，选择所需块的文件夹，通过菜单命令Edit > Check 

Block Consistency执行块的一致性检查。 

2.  选择菜单命令Program > Compile。 

STEP 7可以自动识别相关块的编程语言，并调用相应的编辑器。应尽可能地自动修正

时间标记冲突和块的不一致性，并编译块。如果不能自动清除块中的时间标记冲突或

不一致性，在输出窗口中将出现错误信息（参见第3步）。对于树视窗中的所有块，

将自动重复这一过程。 

如果在编译运行时，不能自动清除所有块的不一致性，在输出窗口中，相应的块将标记为

错误信息。将鼠标放在相应的错误处，并使用鼠标右键，调用弹出菜单中的错误显示。打

开相关错误，程序将跳到被修改的位置。清除所有块的不一致性，保存并关闭块。对于所

有标记为错误的块，重复这一过程。 

4.  重新执行第2步和第3步。重复该过程，直至在信息窗口中不再有错误显示。  
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15.2 作为块特性的时间标记及时间标记冲突 

块中包含一个代码时间标记和一个接口时间标记。这些时间标记可以被显示在块特性的对

话框中。你可以监控STEP 7程序使用时间标记的一致性。 

STEP 7在进行时间标记比较时，如发现违背了规则，就会显示时间标记冲突。以下是可能

出现的违背规则的几种情形： 

• 一个被调用的块比调用它的块的时间标记新（CALL）。 

• 一个被参考的块比使用它的块的时间标记更新。 

• 第二种违背规则的示例： 

• 一个UDT比使用它的块的时间标记更新；这些块可以是一个DB或其它的UDT，或者在

变量声明表中使用了该UDT的FC、FB、OB。 

• 一个FB比其相应的背景数据块的时间标记更新。 

• 一个FB2在FB1中被定义为多重背景，并且FB2的时间标记比FB1的更新。 

注意 

既使接口时间标记之间的关系是正确的，不一致性仍可能出现： 

• 被参考的块的接口的定义与在它被使用的区域中的定义不匹配。 

这些不一致就是所说的接口冲突。它们可能会出现在，比如，当块由不同的程序中拷贝出

来或者当一个ASCII源文件编译时，不是程序中所有的块都生成了。 

 

 

15.3 逻辑块中的时间标记 

 

代码时间标记 

块生成时的时间和日期就存储在这里。该时间标记会被刷新：  

• 当程序代码被修改 

• 当接口描述被修改 

• 当注释被修改 

• 当ASCII源文件第一次生成并编译 

• 当块特性（“properties”对话框）被修改 

 



检查块的一致性和作为块特性的时间标记 

 15-3 

接口时间标记 

该时间标记会被刷新： 

• 当接口描述改变（修改了数据类型或初始值、增加新参数） 

• 如果接口结构上有改变，当ASCII源文件第一次生成并编译。 

 

该时间标记不会被刷新： 

• 当符号被修改 

• 当变量声明表中的注释被修改 

• 当TEMP（临时）区域有改变 

 

块调用的规则 

• 被调用的块的接口时间标记必须比调用块的代码时间标记旧。 

• 只有当设有任何一个调用这个块的块被打开时，才可以修改这个块的接口。否则，当

你修改了这个块之后再存储调用它的块，就无法从时间标记上识别这种不一致性。 

 

时间标记冲突出现的程序 

当调用块被打开时，时间标记冲突就显示出来。在对FC或FB接口作修改之后，在调用块中

对这个块的所有调用以扩展的形式显示。 

如果一个块的接口修改了，则所有调用该块的块都必须相应修改。 

在对一个FB的接口修改后，已有的多重背景的定义及背景数据块必须刷新。 

 

 

15.4 共享数据块的时间标记 

 

代码时间标记 

该时间标记会被刷新： 

• 当一个ASCII源文件首次生成时 

• 当一个ASCII源文件编译时 

• 当在块的声明表显示方式下或在数据显示方式下作出修改时 
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接口时间标记 

该时间标记会被刷新：  

• 当在声明表显示方式下，接口描述被修改（修改数据类型或初始值、有新参数）时。 

 

 

15.5 背景数据块的时间标记 

 

一个背景数据块用于为功能块存储形式参数和静态数据。 

 

代码时间标记 

背景数据块生成的时间和日期存储在这里。当你在背景数据块的数据显示方式下送入实际

值时，该时间标记被刷新。由于背景数据块的结构来自于相关的功能块（FB）或系统功能

块（SFB），所以用户无法改变其结构。 

 

接口时间标记 

当一个背景数据块生成时，存储与其相关的FB或SFB的接口时间标记。 

 

无冲突打开的规则 

FB/SFB及其相关的背景数据块的接口时间标记必须相匹配。 

 

时间标记冲突出现的程序 

如果你修改了FB的接口，该FB的接口时间标记则被刷新。当你打开一个与其相关的背景数

据块时，则显示时间标记冲突的报告。因为此时背景数据块的时间标记与FB的不再匹配。

在数据块的声明部分，接口显示由编译器生成的符号（伪符号）。该背景数据块此时只能

看不能改。 

为改正这种类型的时间标记冲突，你必须为修改过的FB重新生成背景数据块。 
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15.6 UDT的以及源自于UDT的数据块的时间标记 

 

用户定义的数据类型（UDT）可以用来生成大量的、具有相同结构的数据块。 

 

代码时间标记 

任何一种修改都会使代码时间标记刷新。 

 

接口时间标记 

当接口描述改变（修改数据类型或初始值、增加新参数），接口时间标记会被刷新。 

当ASCII源文件编译时，UDT的接口时间标记也会被刷新。 

 

无冲突打开的规则 

• 用户定义的数据类型的接口时间标记必须比使用该数据类型的逻辑块的接口时间标记

旧。 

• 用户定义的数据类型的接口时间标记必须与源自于该UDT的数据块的时间标记一致。 

• 用户定义的数据类型的接口时间标记必须比二级UDT的时间标记新。 

 

时间标记冲突出现的程序 

如果你修改了一个UDT的定义，而该UDT被用于某个数据块、功能、功能块或另一个UDT

的定义，当使用这个UDT的块被打开时，“STEP 7将报告时间标记冲突。 

UDT的元素被显示为一个展开结构。所有变量名被系统预置值覆盖。 

 

 

15.7 更改功能、功能块或UDT中的接口 

如果需要修改FC、FB或UDT中的接口，按下列步骤可避免时间标记冲突： 

从要修改的块以及所有的直接的或间接的块中生成一个STL源文件。 

保存所生成的源文件中的变化。 

编译所修改的源文件。 

现在可以保存/下载接口的变化。 
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15.8 调用块时避免错误 

 

STEP 7覆盖DB寄存器中的数据 

当执行各种指令时，STEP 7将修改S7-300/400 CPU中的数据纪录。当调用一个FB时，DB

和DI纪录中的内容将调换。这样可以在不丢时以前背景DB地址的情况下打开所调用的FB

的背景DB。 

如果采用绝对寻址方式，在向寄存器保存数据时可能会发生错误。在一些情况下，寄存器

AR1中的地址和DB寄存器中的地址将被重写。这样可能会读/写错误的地址。 

 

危险 

当发生下面情况时可能会对财产和人身造成危险： 

使用CALL FC，CALL FB，CALL多重背景。 

用绝对地址访问DB(例如：DB20.DBW10)。 

存取复杂数据类型的变量。 

可能会改变DB寄存器(DB和DI)、地址寄存器(AR1、AR2)以及累加器(ACCU1、ACCU2)中

的内容。 

此外，当调用FB或FC时不能使用状态字的RLO位作为其它参数。 

 

保存正确数据 

如果用缩写格式访问数据的绝对地址，DB寄存器中的内容会发生危险。例如，如果假设

DB20打开(并且其号存储在DB寄存器中)，你可以通过DBX0.2访问DB中的字节0的第2位数

据，如果DB寄存器中的是不同的DB号，则访问的数据不正确。 

通过下列方法访问DB寄存器中的数据，可以避免发生错误： 

• 用符号地址 

• 用绝对地址(例如：DB20.DBX0.2) 

如果用这种方法寻址，STEP 7将自动打开正确的DB。如果用AR1寄存器进行间接寻址，必

须经常在AR1中调用正确的地址。 

 

修改寄存器的条件 

只有在STL中才能使用间接寻址的地址寄存器。其它编程语言不支持间接寻址功能。 
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地址寄存器AR1和所调用块的DB寄存器的内容按下述状态覆盖： 

条  件 说  明 

带DB的实际参数 • 一旦对DB块分配了实际参数 (例如DB20.DBX0.2)，STEP 7则打开相应
的DB(DB20)并采用DB寄存器的内容。在块调用后程序使用该DB 

用较高数据类型调用块 • 当在一个FC内调用一个块后，将向所调用的块传送一个较高数据类型
的形参部件(字符串、数组、结构或UDT)，同时修改AR1和所调用块的
DB寄存器的内容。 

• 如果参数在VAR_IN_OUT区中，则在FB内调用的情况是相同的。 

访问较高数据类型的部件 • 当FB访问VAR_IN_OUT区中较高数据类型的形参部件时(字符串、数
组、结构或UDT)，STEP 7使用地址寄存器AR1和DB寄存器。它将修
改两个寄存器中的内容。 

• 当FC访问VAR_IN_OUT区中较高数据类型的形参部件时(字符串、数
组、结构或UDT)，STEP 7使用地址寄存器AR1和DB寄存器。它将修
改两个寄存器中的内容。 

 

注意： 

• 当从版本1中的块内调用一个FB时，如果调用前的命令没有限制RLO，则第一个布尔参

数IN或IN_OUT的实际参数不能正确传送。在这种情况下，它是与现有的RLO组合的逻

辑状态。 

• 当调用一个FB(单个背景或多重背景)时，地址寄存器AR2被写入。 

• 如果在一个FB中修改了地址寄存器AR2，则不能保证正确地执行FB。 

• 如果全部的绝对DB地址没有传送给一个ANY参数，则ANY指针不会得到打开的DB的

DB号。而其得到的DB号为0。 
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16  组态报文 
 

16.1 报文概念 

报文（Message）功能允许你在可编程控制器运行过程中快速地检测、定位及纠正错误，

从而可显著地减少工厂的停工期。 

要想有报文输出，首先要进行组态。 

使用STEP 7，你可以生成并编辑报文，这些报文与已被赋予报文文本和报文属性的事件相

连。还可以编译这些报文并将它们显示在显示装置上。 

 

16.1.1  什么是不同报文方法? 

有许多生成报文的不同方法。 

 

位报文 

位报文需用编程器完成以下三步： 

• 在编程设备上生成用户程序并设置所需要的位。 

• 使用任意文本编辑器生成一张赋值表，在该表中一条报文文本被赋给一个报文位（如，

M3.1=limit switch pressure）。 

• 在赋值表的基础上，在操作面板上生成报文文本列表。 

  

 

 

 

 

 

操作员接口系统不断地循环查询可编程控制器，查看是否有报文位发生变化。如果可编程

控制器有信号变化，相应的报文则会显示。报文从操作员接口系统接收时间标记。 

 

在编程器上编写程序        赋值表 操作及监控的报文列表 
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报文编码 

报文计数功能只需要编程器完成一个步骤： 

• 在编程器上生成用户程序，设置所需要的位，并在编程时直接将所需的报文文本赋值

给这个位。 

 

 

可编程控制器不进行循环查询。当可编程控制器信号变化时，相应的报文号被传送到操作

员接口系统，相应的报文文本被显示出来。该报文从可编程控制器接收时间标记，因此和

位报文相比，它能够更准确地被追踪。 

 
 

 

不需要PLC的循环查询。当PLC的信号改变时，相应的报文号传送到操作员界面系统，并

显示相应的报文。报文从PLC上按收到时间标记，并可以更准确地跟踪。 

 

 

16.1.2  选择一种报文方法 

概述 

下表是不同报文方法的特性及要求： 

报文编码 

• 在编程设备和操作面板的公共数据库中进行报
文处理 

• 总线负载低（可编程控制器信号激活） 

• 报文从可编程控制器接收时间标记 

位报文 

• 编程设备和操作面板没有公共数据库 

• 总线负载高（操作面板查询） 

• 报文从操作面板接收时间标记 

 

可编程控制器中的程序  操作员控制及监控系统上的显示 
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报文编码方式可以识别以下三种类型的报文： 

与块相关的报文 与符号相关的报文 用户定义的诊断报文 

• 与程序同步 

• 使用WinCC和ProTool显示
（只有ALARM_S） 

• 可用于S7-300/400 

• 用报文块编程：  
- ALARM 
- ALARM_8 
- ALARM_8P 
- NOTIFY 
- NOTIFY_8P 
- ALARM_S(Q） 
- AR_SEND 
- ALARM_D(Q) 

• 传送到操作面板 

- 通过AS-OS连接组态用
于WinCC  

  - 通过ProTool功能用于
ProTool  

• 与程序异步 

• 用WinCC显示 

• 只用于S7-400 

• 用符号表组态 

• 通过系统数据块（SDB）传
送到可编程控制器 

• 通过PLC-OS连接组态传送
至操作面板 

 

• 与程序同步 

• 在编程设备的诊断缓冲区
中显示 

• 可用于S7-300/400 

• 使用报文块（系统功能）编
程 
-  WR_USMSG 

• 不传送到操作面板 

 

STEP 7支持更加用户友好的报文编码方式，我们将在下面进行详细的描述。在HMI设备中

组态位报文。 

 

报文编码示例 

报文方式 应用程序 

与块相关的报文 用于报告与程序同步的事件，比如，显示控制器到达了一个定限值 

与符号相关的报文 用于报告与程序无关的事件，比如，一个开头装置被监控 

用户定义的报文 用于对每个SFC的调用报告诊断缓冲区中的诊断事件 
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16.1.3  SIMATIC组件 

概述 

下图所示为与组态和显示报文有关的SIMATIC组件的概观。下表中列出了一条报文可能的

组成部件： 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

16.1.4  报文的部件 

一条报文如何显示要看报文方式、使用的报文块以及显示设备。 

部 件 描  述 

时间标记 当报文事件出现时，在可编程控制器中生成 

报文状态 可能有以下状态：到来，离开，离开无应答，离开有应答 

相关值 有时报文可被赋予一个过程值，该值可被所用的报文块进行评估 

图像 如果系统故障，出现的报文可随后显示在操作站上 

报文编号 由系统分配一个在整个项目或CPU中唯一的号码用以识别该报文 

报文文本 用户组态 

 

 

 

数据传送 

组态/生成报文 显示报文 

装 载 程 序
/SDB（系统数
据块） 报文结构/模板数据 
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举例 

下列所示，是操作面板上的一个报警信息。 

 

16.1.5  可使用的报文块 

你可以选择下列报文块，每个报文块包含一个可编程的报文功能： 

• SFB 33: “ALARM” 

• SFB 34: “ALARM_8” 

• SFB 35: “ALARM_8P” 

• SFB 36 “NOTIFY” 

• SFB 18: “ALARM_S” 和 SFC 17: “ALARM_SQ” 

• SFB 37: “AR_SEND” (用于发送归档) 

• SFB 31: “NOTIFY_8P” 

• SFC 107: “ALARM_DQ” 

• SFC 108: “ALARM_D” 

详细信息请参见在线帮助。 

 

什么时候使用哪个报文块 

下表帮助您选择使用哪个报文块，选择的依据是： 

• 模板中可使用的通道号以及每个块所监控的信号数量 

• 是否响应报文 

• 指定相关值的选项 

• 使用的显示设备 

• CPU使用的项目数据 
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报文块 通
道 
应答 相关值 WinCC

显示 
ProTool
显示 

CPU信息
/S7状态
显示 

PLC 解释 

ALARM 
SFB33 

1 可能 最多10个 有 无 无 S7-400 每个上升沿或下
降沿到来时发送

报文 

ALARM_8 
SFB34 

8 可能 无 有 无 无 S7-400 一个或多个信号
的每个到来或离

开边沿发送报文 

ALARM_8P 
SFB35 

8 可能 最多10个 有 无 无 S7-400 同 ALARM_8 

NOTIFY 
SFB36 

1 无 最多10个 有 无 无 S7-400 同 ALARM 

NOTIFY_8P 
SFB 31 

8 无 最多10个 有 无 无 S7-400 As NOTIFY 

AR_SEND 
SFB37 

1   有 无 无 S7-400 用于发送文档 

ALARM_SQ 
SFC17 

1 可能 1 有 有＊ 有 S7-300
/ S400 

不是边沿变化而
是每个SFC调用产
生报文 

ALARM_S 
SFC18 

1 无 1 有 有＊ 有 S7-300
/ 400 

As ALARM_SQ 

ALARM_DQ 
SFC 107 

1 可能 1 有 有 有 S7-300
/ 400 

As ALARM_SQ 

ALARM_D 
SFC 108 

1 无 1 有 有 有 S7-300
/ 400 

As ALARM_SQ 

＊取决于OP类型 

 

 

16.1.6  形式参数、系统属性以及报文块 

作为报文编码输入的形式参数 

在你的用户程序中每个报文或每组报文需要一个形式参数，该形参在程序的变量声明表中

定义为IN参数，从而可以使用这个形参作为报文编码输入，形成报文的基础。 

 

如何用系统属性提供形参 

作为开始组态报文的前提要求，你必须首先按如下所述，用系统属性提供形式参数： 

1.  为参数“S7_server”和“S7_a_type”增加下述的系列属性：“S7_server”    和

“S7_a_type” 

2.  根据你在程序指令中调用的报文块，给系统属性赋值。赋给“S7_server”的总是

“alarm_archiv”，而赋给“S7_a_type”的值要依据被调用的块而定。 
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系统属性和相应的报文块 

报文块本身不会在报文管理器中作为一个对象显示出来；取而代之，显示中包含系统属性

“S7_a_type”的值。这些值作为报文块具有相同的名字，以SFB或SFC的形式存在（例外：

“alarm_s”）。 

S7_a_type 报文块 描述 特  性 

alarm_8 ALARM_8 SFB34 8通道，能被应答，无相关值 

alarm_8p ALARM_8P SFB35 8通道，能被应答，每个通道的相关值最多10个 

notify NOTIFY SFB36 1通道，不能被应答，相关值最多10个 

alarm ALARM SFB33 1通道，能被应答，相关值最多10个 

alarm_s ALARM_S SFC18 1通道，不能被应答，最多1个相关值 

alarm_s ALARM_SQ SFC17 1通道，能被应答，最多1个相关值 

ar_send AR_SEND SFB37 用于发送文档 

notify_8p NOTIFY_8P SFB31 8通道，不能被应答，相关值最多10个 

alarm_s ALARM_DQ SFC107 1通道，不能被应答，最多1个相关值 

alarm_s ALARM_D SFC108 1通道，能被应答，最多1个相关值 

参考块的在线帮助，你会得到更详细的信息。 

如果你在你用户程序中所使用的报文块为具有相应系统属性的SFB或FB，并作为多重背景

调用，系统属性将自动赋值。 

 

16.1.7  报文模板及报文 

报文组态允许你按不同的步骤去生成报文模板或报文。至于采取何种步骤，要依据你通过

哪个报文类型块去访问报文组态而定。 

 

报文类型块即可以是一个功能块（FB）也可以是一个背景数据块 

• 使用FB可以生成一个报文模板作为生成报文的样板。你为报文模板所作的所有项都自

动地输入到报文中。如果你将一个背景数据块赋给一个功能块，则该背景数据块的报

文按照报文模板和所赋值的报文编码自动生成。 

• 对背景数据块来说，你可以修改报文，该报文是基于特定背景数据的报文模板而生成

的。 

这里明显的差别是：报文编码是赋给报文的而不是给报文模板的。 

 

为报文模板进行数据加锁 

报文组态允许你为依事件而定的报文输入文本和属性。比如，你可以指定在特定的显示设

备上怎样显示报文。为使报文生成更容易，可以使用报文模板。 
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• 当你为报文模板输入数据（属性和文本）时，可以指定它们是否被加锁。若带有加锁

属性则输入框旁边会增加一个键符。已加锁的文本在“Locked”栏中显示一个复选标

志。 

• 使用报文模板的“加锁数据”，你不能在特定的背景数据报文中进行修改。数据只能

被显示。 

• 如果确实需要修改，必须回到报文模板，去掉锁，并在这里修改。这些修改不会自动

加到以前生成的背景数据中。 
 

修改报文模板的日期 

当建立项目时，如果向项目或CPU所赋值的报文号为全局赋值，则报文模板的日期更改将

影响背景数据。 

• 对项目进行报文号赋值：当稍候修改报文模板日期时，而且也想同样影响背景数据时，

你必须也要修改背景数据的日期。 

• 对CPU进行报文号赋值：稍候修改报文模板日期将自动影响背景数据 (例外：以前已修

改了背景数据的日期或随后加锁或解锁报文模板日期)。 

注意：当向其他程序拷贝背景数据而没有拷贝报文模板时，则只可能显示背景，若要全

部显示，必须将报文模板也拷贝到新程序中。 

 

 

16.1.8  如何从报文块中生成STL源文件 

当从报文块中生成STL源文件时，组态信息同时也写入该源文件。 

该信息写入pseudo-comment，用“$ALARM_SERVER”开始，用“*”结束。为了在一

个源文件中区分多个块，源文件的初始部分还包括与该报文有关的块的入口(例如：

FUNCTION_BLOCK_FB2)。 
 

注意 

当为块设置符号参考时，注意在编辑源文件前不能修改符号表。 
 

当源文件含有多个块时，几个pseudo-comment将和并为一个注释块。在 pesudo-comment

中的块的标识必须与实际块源文件相匹配。当修改源文件中的块名称时必须修改

pseudo-comment中的块名称。如果这些条目不一致时将不能编译报文源文件。 

系统文本库也将拷贝到源文件中。因为它们始终与报文有关，因此它们将作为一个结构集

成到报文的源文件中。 
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16.1.9  分配报文号 

当为项目或CPU分配报文号时，你可以指定这些报文号。对CPU分配报文号可以允许在不

改变报文号的情况下拷贝程序，在这种情况下需要对其重新编译。如果要在HMI设备上显

示报文，报文号必须已经分配给CPU，并使用WinCC V6.0或ProTool V6.0软件。 

 

16.1.10  对项目和CPU分配报文号的区别 

下表列出了对项目和CPU进行报文号赋值的区别： 

项  目 CPU 

一些报文属性和文本取决于所使用的HMI设备，必须
设置其显示特性 

属性及文本的赋值不用根据所使用的HMI设备而决
定 

当生成源文件时将丢失报文数据 当生成源文件时保存报文数据，也可以从源文件恢复

报文数据 

复制后必须重新编译程序 可将程序拷贝到一个项目的其它地方或拷贝到其它
项目中。如果只拷贝了单个块，则程序必须重新编译  

当以后修改报文类型数据时(文本和属性)，必须修改
背景 

当以后修改报文类型数据时(文本和属性)，将自动修
改背景(例外：如果在以前改变了背景) 

文本只能在线时写入 文本可以写入多个网络线中 

 

16.1.11  修改一个项目的报文号赋值的选项 

在SIMATIC管理器的“Message number”表中可以预置要为以后的项目以及库赋值的报

文号(Options > Customize )。在该表中可以指定赋值对象只是项目或只是CPU。如果想在

以后赋值，可以选择“No preset”。 

如果在创建项目或创建库时初始的却省设置为“Only for the CPU”或“Only for the 

project”出于激活状态，则不再需要改变为该项目或库修改报文号赋值类型。 

如果原来设置为“Only for the project”，现在想设置为“Only for the CPU”，则按下列

步骤进行： 

在SIMATIC管理器中选择相应的项目或相应的库。 

选择菜单命令File > Save As。 

在下一个对话框中选择“With rearrangement”，并输入一个新名字。 

点击“OK”。 

在下一个对话框中可以指定报文号赋值采用“Only to the CPU”。 

可以用File > Delete命令删除原始项目或库。 
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16.2 为项目组态报文 

16.2.1  如何为项目分配报文号 

在整个项目中，每个报文有一个唯一的号，通过该号进行识别。为了对其归档，每个STEP 

7程序被分配一定范围的号码，该号码在总范围(1至2097151)之内。如果要分配的号码已被

站用，则新程序必须分配一个新的号码段。如果发生该状态，STEP 7将自动打开可以指定

新号码段的对话框。 

如果还没有组态报文，也可以用Edit > Special Object Properties > Message Numbers为

一个S7程序设置或改变号码段。 

缺省时，报文的号码段以20000为步进单位。 

 

16.2.2  赋值与编辑与块相关的报文 

与块相关的报文被赋值到一个块的背景数据块。可以使用系统功能块SFB和系统功能SFC

作为报文块，来创建一个与块相关的报文。 

16.2.2.1 如何生成与块相关的报文 

基本程序 

 

 

 

 

 

 

 

 

 

 
 

为你的任务选择合适的报文块 

编辑FB作为报文类

型块。 

• 选择你想要赋值报

文的功能块并打开它 

调用报文组态（标准对话框或PCS7报文
组态） 

将背景数据块与FB相连并按照你的要求
进行修改 

传送组态的数据到WinCC数据库 

在FB中生成有文本、属性及显示设备的报
文模板 
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编程报文类型块（FB） 

在SIMATIC管理器中选择一个你想为它生成块相关报文的功能块（FB），双击打开它。 

    结果：打开被选中的块并显示在“LAD/STL/FBD”窗口。 

2.  填写变量声明表。因为对每一个被调用的报文块，必须在调用功能块中声明变量。 

在变量声明表中，在“Declaration”栏中输入下列变量： 

- 在参数“ IN”中输入一个符号名作为报文块的输入，例如，“Meld01”（为报文输入01）

以及数据类型（必须是“DWORD”，没有初始值）。 

- 在参数“STAT”中为调用的报文块输入符号名，例如，“alarm”及相应的数据类型，这

里为“SFB33”。 

3. 在功能块的指令部分，插入对选中的报文块的调用，这里为“CALL alarm”，用RETURN

键完成输入。 

结果：被调用的报文块（这里是SFB33）的输入变量显示在功能块的指令区。 

4. 将第2步中为报文块输入分配的符号名，这里是“Mess01”赋给变量“EV_ID”并确

认系统属性被用于报文组态。 

结果：如果“Name”栏没有选中，则在该栏中会出现一个标志。选中的块则被设置为报

文类型块。所要求的系统属性（如S7_server和S7_a_type）及相应值会自动被赋值。(注意：

对于当前的SFC，只能自己为“ IN”参数分配系统属性。方法是通过菜单命令Edit > Object 

Properties并选择“Attributes”)。 

5. 在功能块中为所有的报文块的调用重复步骤2至4。 

6. 用菜单命令File>Save保存该块。 

7. 关闭“LAD/STL/FBD”窗口。 
 

打开报文组态对话框 

• 在SIMATIC管理器中选择菜单命令Edit > Special Object Properties > Message。 

结果：STEP 7报文组态对话框（标准对话框）打开。在PCS 7报文组态下可以找到有关打

开PCS 7报文组态功能的信息。 

 

生成报文模板 

1.  选择显示出来的报文块并且在“Attributes”和“Text”选项卡中输入所需的属性和报

文文本。 

如果你选择的是一个多通道报文块（例如，“ALARM_8”），你可以将其自己的报文文本

赋值给每个报文子编码。属性适用于所有报文子编码。 
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2. 击“New Device”按钮将所需的显示设备赋给报文模板，并在“Add Display Device”

对话框中选择所需的显示设备。 

在下面的制表页中为显示设备输入所需文本及属性。用“OK”退出对话框。 
 
注意 

当编辑特定的显示设备文本和属性时，请阅读随同你的显示设备提供的文件。 

 

生成背景数据块 

1.  当你生成报文模板时，可以给它关联一个背景数据块，并且为这些数据块编辑特定背

景报文。 

要实现这一步，需在SIMATIC管理器中打开一个块，在该块中要调用前面组态的功能块，

例如，双击“OB1”。在该OB块的指令部分输入调用指令（“CALL”），FB的名字和号

码以及作为背景与FB相关的背景数据块。用RETURN，确认你的输入。 

例如：输入“CALL FB1，DB1”。如果DB1不存在，对是否生成背景数据块的注意回答

“Yes”。 

结果：背景数据块生成了。在OB的指令部分显示相关FB的输入变量，这里的示例是

“Mess01”，以及由系统分配的报文编码，这里为“1”。 

2.  用菜单命令File>Save，存储OB，并关闭“LAD/STL/FBD”窗口。 

 

编辑报文 

1.  在SIMATIC管理器中，选择已生成的背景数据块，例如“DB1”，选择菜单命令

Edit>Special Object Properties>Message，打开报文组态对话框。 

结果：“Message Configuration”对话框打开，显示所选中的带有由系统分配的报文编码

的背景数据块。 

2.  在适当的表栏中，输入相应的背景数据块所需的修改，如果需要，可增加其它的显示

设备。用“OK”退出对话框。 

结果：为选中的背景数据块所作的报文组态就完成了。 

 

传送组态数据 

• 将组态的数据传送至WinCC数据库（通过PLC-OS连接组态）或ProTool数据库。 
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16.2.2.2 如果编辑与块相关的报文 

在SIMATIC管理器中，先选择一个块，然后选择菜单命令Edit > Special Object Properties 

> Message。 

在文件夹结构中，点击一个报文块输入。 

在“Text”和“Attributes”栏中输入所需的文本和属性。 

结果：在所有的显示设备上显示已经创建的标准报文。 

使用“New Device”按钮，加入一个“ProTool”(Opx)或“WinCC”类型的新的显示设备。

所组态地报文只能在这些显示设备上显示。 

结果：可以加入或选择新的显示设备。 

在“Texts”和“Attributes”栏中输入显示指定的报文的文本和属性。 

如果要在现有的显示设备上编辑其它报问： 

• 通过双击可以选择和打开详细察看栏中的本文块。 

结果：自动选择第一个显示设备，可以针对该设备编辑与显示相关的报文。 

 

16.2.2.3 如何对PCS 7报文进行组态 

为编辑报文模板以及将报文送出到WinCC显示设备，STEP 7中的PCS7报文组态功能提供

用户友好方式如下： 

• 显示设备组态的简化（自动生成） 

• 报文属性和文本输入的简化 

• 确保报文标准化 

 

打开PCS 7报文组态功能 

1. 在SIMATIC管理器中，选择你想要编辑报文文本的块（FB或DB），使用菜单命令Edit > 

Object Properties，打开输入系统属性的对话框。 

2. 在显示的表格中输入以下系统属性： 

属性：“S7_alarm_ui”以及值“1”用于非事件驱动PCS7报文（数值“0”将关闭PCS7

报文组态）。在LAD/STL/FBDP中可以设定特性参数。以后生成并赋值到相应FB的DB，将
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采用这些属性，并且可以切换，与其报文类型无关（FB）。 

   -  属性：“S7_alarm”和数值“alarm_16”（如果所选块为事件驱动通讯块（EDC））。

对于事件驱动通讯，不能赋值特性参数。赋值给DB的这些FB的报文文本在SIMATIC 

Manager中不能编辑。 

注意 

当你输入系统属性时，语法检查正在运行，不正确的输入被标定为红色。 

3.  用“OK”退出对话框。 

4.  选择菜单命令Edit>Special Object Properties>Message。 

结果：“PCS7 Message Configuration”对话框被打开。 

 

编辑报文模板 

1.  在SIMATIC管理器中，选择你想编辑报文文本的FB，打开PCS7报文组态对话框。 

    结果：对每一个在FB中声明了变量的报文块，有一个选项卡显示在对话框中。对于事

件驱动通讯块，在对话框中将出现两个选项卡。 

2.  为报文的组件“Origin”、“OS area”及“Batch ID”填写文本框。 

3.  输入报文级别并为报文块使用的所有事件输入事件文本，指定每个事件是否必须一一

应答。 

4.  对于用于所有背景的、不能被修改的报文组件，点击“Locked”复选框。 
 

编辑报文 

1.  在SIMATIC管理器中，选择你想编辑报文文本的背景数据块，打开PCS7报文组态对话

框。 

2.  不要修改未加锁的特定背景报文。 

 

16.2.3  设定和编辑与符号相关的信息 

16.2.3.1 如何赋值和编辑与赋号相关的报文 

在符号表中符号相关的报文（SCAN）被直接赋值给信号。所允许的信号都是布尔地址：

输入（I）、输出（Q）及位存储（M）。你可以用报文组态功能给这些信号赋予不同的属

性、报文文本及多达10个的相关值。你可以通过设置筛选在符号表中轻松地选择信号。 

用符号相关报文，你可以以一个预先设定的时间间隔来扫描信号，从而决定是否有信号变
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化。 

注意 

时间间隔依据所用的CPU而定： 

 

基本程序 

 
 

 

 

 

 

 

 

 

 

在程序处理过程中，与程序同步对已组态报文的信号进行检查。这种检查以组态的时间间

隔进行。报文显示在指定的显示设备上。 

 

 

16.2.4  生成并编辑用户定义的诊断报文 

使用这一功能，你可以在诊断缓冲区中写入用户条款，并发送在报文组态应用程序中生成

的相应的报文。用户定义的诊断报文可通过用作报文块的系统功能SFC52（WR_USMSG：

错误等级A或B）生成。你必须在用户程序中插入对SFC52的调用并给它分配事件ID。 

 

要求 

在生成用户定义的诊断报文之前，必完成以下事项： 

• 在SIMATIC管理器中生成项目 

• 在项目中生成S7/M7程序，报文将被分配给该程序 

 

基本程序 

用符号编辑为你的S7程序生成符号表 

选择你想要为之生成报文的符号 

打开报文组态对话框并生成一个报文 

生成系统数据块（SDB） 

将一个显示设备赋给报文 
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成并显示用户定义的诊断报文，可按以下步骤进行： 

 

 

 

 

 

 

 

16.3 为CPU组态报文 

16.3.1  如何对CPU赋值报文号 

CPU的报文号是唯一的。对每个CPU分配一个报文号区段。与对项目赋值报文号相比，对

新程序不需要分配一个新的报文号区段。因此不需要对程序进行新的编译。但当你拷贝单

个块时，则必须重新编译程序。 

 

要求 

• WinCC V6.0 

• ProTool V6.0 

 

在SINATIC管理器，选择所需的S7程序并启动报文组态应用 

生成带有报文编码、报文名（标识）及文本的新报文 

通过SFC 52的调用在CPU的诊断缓冲区中输入报文 

显示通过“CPU messages”生成的报文 
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16.3.2  赋置与编辑与块相关的报文 

16.3.2.1 如何为CPU创建与块相关的报文 

工作原理 

 

 

 

 

 

 

 

 

 

编写报文类型块(FB) 

在SIMATIC管理器中，选择要为其生成与块相关的报文的功能块FB，冰双击打开它。 

填写变量声明表。你必须为每个在功能块中进行调用的报文声明相应的变量。 

在变量表概述栏中输入下列变量： 

对与参数“IN”，输入一个符号名作为报文块输入，例如“Meld01”(报文输入01)以及数

据类型(必须是没有初始值的“DWORD”)。 

对于参数“STAT”，输入一个符号名作为报文块调用，例如“alarm”以及相应的数据类

型，在此为“SFB33”。 

在功能块的程序中，插入调用所选择得报文块的程序，在此为“CALL alarm”，并按回车

键。 

结果：所调用报文块的输入变量显示在功能块的程序中。 

赋值在第2步中已分配的符号名。对于报文块输入，此处为“Mess01”赋值给变量“EV_ID”。 

结果：如果没有选择“Name”栏，则在该栏中出现一个标志。所选择的块被设置为报文

类型块。所需的系统属性(例如S7_server和S7_a_type)以及相应的值将自动赋值。(注意：

对于一些特定的SFC，只能自己对“IN”参数进行系统属性赋值，通过选择Edit > Object 

Properties并选择“Attributes”选择框实现)。 

注意：如果所调用的FB含有多个背景，并且已经对所代替的SFB组态了报文，你也必须在

选择适合的报文块 

编写报文类型的FB 

• 选择并打开要赋值报文的FB 

• 填写变量声明表 

• 在FB的指令表中编写报文块调用程序 

调用报文组态对话 

在FB中，用文本和属性创建报文类型 

向FB赋值背景DB，并按需要进行修改 

向WinCC数据库传送组态数据 
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调用的块中为该FB组态报文。 

重复第2至4步，实现功能块中所有的报文块调用。 

用File > Save进行保存。 

关闭“LAD/STL/FBD”窗口。 

 

打开报文组态对话框 

• 选择所需的报文块，并使用SIMATIC管理器中的Edit > Special Object Properties > 

Message。 

结果：STEP 7报文组态对话框被打开。打开PCS 7报文组态功能可以在PCS7报文组态

中得到。 

 

编辑报文模板 

• 选择所需的报文框。 

• 输入所需的文本或属性 

在“Message Configuration”对话框中，点击“More”按钮可以在“Default Texts”

表中输入报文文本和其它文本。如果选择了多通道报文块 (例如“ALARM_8”)，可以

为每个子号输入特殊文本及属性。 

• 如果不想改变背景的文本或属性，可以在报文模板中对其加锁。 

 

创建背景数据块 

建立完报文模板后，可以对报文模板创建背景数据块并对这些数据块的背景报文进行编辑。

在SIMATIC管理器中打开程序块，该程序块调用了以前组态好的功能块，例如双击打开

“OB1”。在打开的OB1程序中输入调用指令(“CALL”)，写好调用FB的号码及名称，以

及FB所使用的背景数据块，按回车确认。 

举例：输入“CALL FB1，DB1”。如果DB1不存在，会出现是否要创建背景数据块的提示

符，点击“Yes”。 

结果：创建背景DB。在OB的程序中将显示FB的输入变量(例如“Mess01”)以及系统所分

配的报文号(例如：“1”)。 

用File > Save保存OB并关闭“LAD/STL/FBD”窗口。 

 

编辑报文 

在SIMATIC管理器中选择创建好的背景DB(例如：“DB1”)，用菜单命令Edit > Special 

Object Properties > Message打开报文组态对话框。 
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结果：“Message Configuration”对话框被打开，显示系统所分配的背景DB的报文号。 

输入要修改的相应的背景数据块并增加其它显示设备(如果需要)。点击“OK”退出对话框。 

结果：所选择的背景数据块的报文组态已完成。 

 

传送组态数据 

• 将组态数据传送到WinCC数据库(通过AS-OS连接)或ProTool数据库。 

 

16.3.2.2 如何编辑与块相关的报文 

选择报文块，然后选择菜单命令Edit > Special Object Properties > Message来调用报文组

态。 

在“Default Texts”和“Additional Texts”栏中输入所需的文本。也可以点击“More”按

钮并在“Default Texts”和“Additional Texts”对话框中输入所需的文本。 

结果：你已经建立了一个标准报文。 

 

16.3.2.3 如何为CPU组态PCS 7报文 

对于编辑报文模板以及在WinCC显示设备(V6.0)显示要输出的报文，通过STEP 7提供的

PCS 7 报文组态功能可以实现： 

• 简化了显示设备的组态 

• 简化了报文的输入属性和输入文本 

• 保证报文的标准化 

 

打开PCS 7报文组态功能 

在SIMATIC管理器中选择要编辑的FB块或DB块。通过菜单命令打开 Edit > Object 

Properties打开系统属性对话框。 

在显示的表格中，输入系统属性“S7_alarm_ui”并输入值“1”(0为禁止PCS7报文组态工

具)。可以用LAD/STL/FBD设置属性参数。随后生成的DB以及对相应FB进行的赋值将使用

这些设置，并可通过其自身的设定、不受报文类型限制地进行切换。 

注意： 
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当输入系统属性时会进行语法检查。错误的输入会以红色高亮显示。 

点击“OK”退出对话框。 

选择菜单命令 Edit > Special Object Properties > Message。 

结果：打开“PCS 7报文组态”对话框。 

 

编辑报文模板 

在SIMATIC管理器中，选择要编辑报文文本的FB，并打开PCS 7报文组态对话框。 

点击“More”按钮打开“Message text block”。在“Origin”、“OS area”和“Batch ID”

中输入文本。 

对所使用的所有报文块的事件输入报文等级和事件文本，并指定是否对每个事件进行单独

响应。 

对适用于所有背景以及不会改变的报文部分，选择“Locked”选择框。 

 

编辑报文 

打开SIMATIC管理器，选择要对其报文进行编辑的背景数据块，并打开PCS7报文组态功能。 

不要编辑没有加锁的特定的背景报文部分。 
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16.3.3  赋值和编辑与符号相关的报文 

16.3.3.1 如果对CPU进行赋值和编辑与符号相关的报文 

与符号相关的报文可直接赋值到符号表中的信号。所允许的信号全部是布尔地址：输入(I)、

输出(Q)和位存储器(IM)。可以对这些信号赋与不同的属性和报文文本，以及最多10个带报

文组态功能的值。通过设置过滤器可以很方便地在符号表中选择这些信号。 

对于一个与符号相关的报文，你可以在一个预置的时间段内对信号进行扫描，以决定信号

是否发生了变化。 

注意： 

时间段取决于所使用的CPU。 

 

基本步骤 

 

 

 

 

 

 

 

在处理期间，已组态报文的信号将与您的程序进行异步检查。该检查是在所组态的时间段

内进行。在所分配的显示设备上显示报文。 

 

16.3.4  赋值和编辑用户定义的诊断报文 

使用该功能可以在诊断冲区内写用户输入，并可以发送在报文诊断应用中建立的相应的报

文。通过系统功能SFC52(WR_USMSG；故障等级A或B)建立用户定义的诊断报文，必须

在用户程序中插入SFC52的调用指令，并为其分配事件ID号。 

 

要求 

在建立用户定义的诊断报文前，必须完成下列任务： 

• 在SIMATIC管理器中建立好一个项目 

• 在项目中建立好一个S7/M7程序，对该程序赋值一个或多个报文。 

用符号编辑器为S7程序创建符号表 

打开报文组态对话框并建立报文 

生成系统数据块(SDB) 

选择一个要为其生成报文的赋号 



组态报文 

 16-22 

基本步骤 

建立和显示用户定义的诊断报文的步骤如下： 

 

 

 

 

 

16.4 编辑报文的技巧 

16.4.1  向报文加入关联值 

为了将当前信息(例如来自过程的信息)加入到与块相关的和与符号相关的报文中，可以将关

联值加入到报文文本中的任何位置。 

 

加入关联值的步骤如下： 

建立一个新块，结构如下： 

@<关联值号>[<单元类型>]<格式代码>@ 

将该块插入到报文文本中要显示该关联值的地方。 

 

单元类型 

单元类型 数据类型 

Y 字节 

W 字 

X 双字 

I 整形数 

D 整形数 

B 布尔类型 

C 字符 

R 实数 

单元类型唯一指定了通过PLC输送的数据类型。如果没有指定数据类型，则将会把每个数

值的两个字节作为整形数。 

格式代码 

这些代码指定了显示设备上的关联值的输出格式。格式指令以“%”赋号为前缀。对于报

文文本，有以下固定的报文代码： 

在SIMATIC管理器中，选择所需的S7程序， 
并启动报文组态应用 

通过调用SFC52在CPU诊断缓冲区中输入报文 

显示通过“CPU messages”建立的报文 

建立一个带报文号、报文名及文本的新报文 
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格式代码 说明 

%[i]X 带 i 索引符的十六进制值 

%[i]u 带 i 索引符的无符号的十进制值 

%[i]d 带 i 索引符的有符号的十进制值 

%[i]b 带 i 索引符的二进制值 

%[i][.y]f 整数(定点数) 

带[-]dddd.dddd格式的符号值 

dddd： 

%[i]s 字符串(ANSI串) 

%t#<文本库的名称> 访问文本库 

如果格式代码太小，则值将以全部长度输出。 

如果格式代码太长，则输出的值前面为空码。 

 

相关值举例 

@1%6d@：相关值1的值以十进制显示，最多6位。 

@2R%6f@：相关值2的值，例如“5.4”以整数形式显示“5.4”(前三位为空)。 

@2R%2f@：相关值2的值，例如“5.4”以整数形式显示“5.4”(数位太少，不会发生截断

情况)。 

注意： 

当使用ProTool时，必须始终指示单元类型，除“I”外。 

当使用S7-PDIAG时，单元类型必须始终为“X”。 

 

 

16.4.2  将文本库中的文本集成到报文中 

可以将最多4个不同文本库中的文本集成到一个报文中。文本可以自由放置，也可以用外语

报文。 

步骤如下： 

在SIMATIC管理器中，选择CPU并选择菜单命令Options > Text Libraries > System Text 

Libraries或Options > Text Libraries > User-Specific Text Libraries来打开文本库。 

注意 

如果已选择了将报文号赋值给CPU，则只能将用户文本库中的文本集成到报文中。 

 



组态报文 

 16-24 

确定要集成的文本。 

在报文中要显示文本的地方输入一个 @[Index]%t#[Textbib]@格式的站位符。 

 

注意： 

[Index]=1W，1W是WORD类型报文的第一个相关值。 

 

举例 

所组态的文本：Pressure rose @2W%t#Textbib1@ 

文本库的名称Textbib1： 

索引 德语 英语 

1734 Zu hoch Too high 
   

传送的第二个相关值已赋值为1734。显示下列信息：Pressure rose too high。 

 

16.4.3  删除相关值 

你可以删除表示相关值的报文文本中的字符串来删除相关值。 

 

步骤： 

选择要删除相关值的报文文本中的信息块。该块以@符号开始，并以@符号结束。 

从报文文本中删除该信息。 
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16.5 翻译并编辑用户文本 

在过程编辑当中输出到显示设备上的文本通常用与自动化任务编程相同的语言输入。 

也许会有这样的情况，对显示设备上的报文进行反应的操作员却不讲这种语言。这样的用

户需要的是他自己语言的文本，以确保顺利、无障碍地处理并对系统输出的报文快速反应。 

STEP 7允许你将任意的、所有操作相关的文本翻译成所需的语言。唯一的前提条件是你已

在项目中安装了该语言（SIMATIC管理器中的菜单命令Options> Language for Display 

Devices）。可用的语言的数量由安装Windows 时决定（系统特性）。 

用这种方法你可以确信，以后任何用户面对这条报文都可以让它以适当的语言显示。这一

系统特征明显地增加了过程的安全性和准确性。 

操作者相关文本为用户文本和文本库。 

 

 

16.5.1  翻译并编辑用户文本 

对整个项目、S7程序、块文件夹、单个块或符号表来说，如果在这些对象中有组态的报文，

则可生成用户文本列表。它们包含有比如所有文本和报文，可以在设备上显示。对于一个

项目，可以有一些操作相关文本列表，你可以将它们翻译成所需的语言。 

你可以在一个项目中选择已有的语言（菜单命令：Options > Language for Display 

Devices…）。还可以在晚些时候增加或删除语言。 

 

导入和导出与操作员相关的文本 

你可以翻译或编辑相关的操作文本，无论它是在STEP 7内生成的还是在STEP 7之外生成

的。要实现这一点，将所显示的相关的操作文本列表导出到一个CSV文本文件中，这个文

本文件可以在ASCII编辑器或象Microsoft Excel这样的表格编辑器中编辑。然后你可将文本

导回STEP 7。 

相关的操作文本从项目哪个部分导出的，只能从这个部分导入。 

 

基本步骤 

在SIMATIC管理器中，用菜单命令Options > Language for Display Devices…，设置好了

你的用户文本想要转换的语言。 
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16.6 翻译和编辑文本库 

16.6.1  用户文本库 

一个用户文本库可以让你根据相关值动态查看文本或文本段。在此，相关值为当前文本提

供文本库索引。在要显示动态文本的地方输入一个占位符。 

你可以为程序创建用户库，在其中可以输入文本和选择自己的索引。应用程序将自动检查

用户库中索引的唯一性。该CPU中可以使用的所有报文均与用户文本库中有交叉参考。 

文本库文件夹中的文本库的数量是有限的。因此可以用同一个程序控制不同的控制任务或

只根据应用需要采用文本库。 

 

注意： 

当将含有交叉参考的报文类型块拷贝到另一个程序的文本库中时，必须要包含相应的文本

库，或者建立一个相同名字的新的文本库或在报文文本中编辑交叉参考。 

当建立一个新的文本输入时，将自动以默认值赋值一个索引。文本库以及应用程序中的必

须是明确的索引。 

 

16.6.2  系统文本库 

当生成一个新块时将自动建立系统文本库，例如在“Report System Errors”中。用户不

能自己创建系统文本库，只能编辑现有的文本库。 

选中你打算翻译的文本对象 

选择菜单命令Options > Manage Multilingual
 Texts > Export 

翻译文本 

选择菜单命令Options > Manage Multilingual
 Texts > Import来导入翻译 
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16.6.3  翻译文本库 

系统文本库和用户文本库提供有可以集成在报文中的文本列表，并可在运行时间动态刷新，

显示在编程器或其它显示装置上。并将赋值给CPU。 

系统文本库中的文本可以由STEP 7或STEP 7任选软件包提供。可以有几个文本库赋值给一

个CPU。你可将这些文本翻译成所需语言。 

在SIMATIC Manager中，你可以选择适用于项目的语言（菜单命令Options > Language 

for Display Devices…）。以后，你也可以添加或删除语言。 

当你开始翻译文本库时(菜单命令Options > Manage Multilingual Texts > Export)，将生

成一个*.csv的文件，可以用EXCEL对其进行编辑。当你打开该文件后，在显示屏上将显示

一个表。表的每一栏都表示一种语言。 

注意： 

不能用双击该文件的方法打开该*.cvs文件，只能用EXCEL的File > Open命令打开。 

 

csv文件的举例 

德文 英文 

ausgefallen Failure 

gostort Disruption 
Parametrierfehler Faulty parameter assignment 

 

基本步骤 

在SIMATIC Manager（SIMATIC管理器）中，用菜单命令Options > Language for Display 

Devices…，设置好了你的用户文本想要转换的语言。 

 
 

 

 

 

 

 

调用菜单命令Options > Manage Multilingual texts > Imp
ort来导入你的译文 

选中你打算翻译文本对象的CPU或CPU下的一个对象 

翻译文本 

选择菜单命令Options > Translate Texts > System Text  
Library，并选择你要编辑的文本 
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16.7 传送报文组态数据到可编程控制器 

 

16.7.1  传送报文组态数据到可编程控制器 

 
概述 

使用传送程序AS-OS Engineering，你可将生成的报文组态数据送至WinCC数据库。 

 

要求 

在开始传送之前，下列要求必须满足： 

• 已安装了AS-OS连接组态的Setup程序。 

• 已为建立报文生成了组态数据 

 

基本程序 

 

 

 

16.8 显示CPU报文和用户定义的诊断报文 

用“CPU Message（CPU报文）”功能(菜单命令PLC > CPU Messages)，可以显示诊断

事件的异步报文和用户定义的诊断报文以及ALARM_S块的报文(SFC 18和SFC 108用来生

成需要响应的与块相关的报文以及SFC 17和SFC 107用来生成可以响应的与块相关的报

文)。 

你还可以通过使用菜单命令  Edit > Message > User-Defined Diagnostics从CPU 

Messages应用程序中启动报文组态应用程序，并且生成用户定义的诊断报文。这就要求

你通过一个在线项目启动CPU Messages应用程序。 

 

 

 

显示选项 

用“CPU Messages”功能，可以决定所选CPU的在线报文是否显示以及如何显示：  

在SIMATIC管理器中，生成你想要显示报文的OS对象 

使用菜单命令Options > AS-OS Connection Data >  
Transfer，启动组态数据的传送 
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• “Bring to the Foreground（至前台）”：包含CPU报文的窗口显示在前台。每当收

到新报文，该窗口都显示于屏幕的前台。 

• “Leave in the Background（至后台）”：CPU报文被接收到后台中。当收到新报文

时该窗口仍处于后台中，如果需要可以被提到前台。 

• “Ignore Message”：CPU报文不显示，并且与前两种模式相比，不存档。 

在“CPU Messages”窗口，你可以选择“Archive”或“Interrupt”。两种选择中，可以

选择菜单命令View > Display Info Text来指定报文显示时是否带有信息文本。 

 

“Archive” 

在此显示和归档进来的报文，并根据时间进行排序。通过菜单命令Options > Settings，

在“Settings-CPU Messages”对话框中设置归档的容量(40至2000条CPU报文)。如果超

过设定的容量，则删除最早的报文。 

可响应的报文(ALARM_SQ和ALARM_DQ)以加粗的形式显示。可以在菜单命令Edit > 

Acknowledge CPU Message下响应这些报文。 

见下图所示。 

 

“Interrupt” 

在“Interrupt”中显示还没有收到的或还没有响应的发自ALARM_S块的报文的状态。 

通过菜单命令View > Multiline Messages显示在一行或多行上显示报文。此外，可根据需

要对其排序。 

 

更新ALARM_S块的报文 

在更新期间，所有为发送的或为响应的报文重新输入导归档中。以下情况更新报文： 

• 与报文相关的模板执行重启动(不是冷启动)。 

• 在模板列表中点击ALARM_S块报文的“A”选项。 
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基本步骤 

为所选的模板组态CPU报文。 

 

 

 

 

 

16.8.1  组态CPU报文 

要为所选择的模板组态CPU报文，可如下进行： 

在SIMATIC管理器中选择S7 Program并选择菜单命令
PLC > CPU Messages。 

确定要接收的报文，并确定如何显示它们。 
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1.   在SIMATIC管理器中，通过一个在线项目起动CPU报文应用程序。要实现这一步，选

择一个在线在S7程序并且使用菜单命令PLC > CPU Messages为所选的CPU调用报文应

用程序。 

结果：出现“CPU Messages”应用窗口，在此列出了所记录的CPU。 

2.   你可以通过重复步骤1.为其它程序或接口扩展注册CPU列表。 

3.   在列表选项前点击复选框，并指定应为该模板接收哪些报文： 

A：激活（ALARM_SQ （SFC 17）和ALARM_S （SFC 18），例如，报告S7 PDIAG、 

S7-GRAPH过程诊断信息或系统错误。 

W：激活诊断事件。 

4.   设置档案的容量。 

结果：只要上述报文一出现，它们就被写入报文档案并且以你所选择的方式显示。 

 

注意 

你在SIMATIC管理器中使用菜单命令PLC > CPU Messages，调用的CPU在“Customize”

应用窗口中已被存入注册模板列表。列表中的各项除非在“CPU Messages”应用窗口中

删除，否则会一直保留下来。 

  

 

16.8.2 显示存储的CPU报文 

CPU报文总会被记录在档案中，除非你选择了菜单命令“View > Ignore Message”。所

有的存档报文总是会被显示。 
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16.9 组态“系统错误报告” 

 

简介 

当系统错误时，S7组件和DP标准从站可以激活组织块调用。 

例如：如果有断线，具有诊断功能的模块就可以触发诊断中断（OB82）。 

S7组件可以提供系统错误信息。开始事件信息，即赋值OB的局域数据（包括数据记录0）

提供有关错误的位置（例如模块的逻辑地址）和类型（例如通道错误或备份错误）的一般

信息。 

另外，错误还可以详述其它诊断信息（使用SFC51读取数据记录1或使用SFC13读取DP标

准从站的诊断报文）。例如通道0或通道1以及断线或测量范围超限错误。 

使用“Report System Error（报告系统错误）”功能，STEP 7 提供了一种极其方便的由

报文形式的组件提供的诊断信息显示方法。 

STEP7可以自动生成所需块和报文文本。所有用户所需要做的就是将所生成的块装入CPU

中，并将文本传送至所连接的HMI设备。 

你可查找“Supported Components（支持组件）”和“Functional Scope（功能范围）”

部分中各种从站的诊断信息总览。 

 

基本步骤 

 
 

 

 

 

 

 

 

 

 

 

 

组态站，并赋值模板参数（使能诊断中断） 

进行系统故障报告设置，并组态报文 

启动块的生成 

检查并增补所生成的块 

将所生成报文的组态数据传送到相应的HMI装置中
，以便生成系统故障报告 

下载所生成的块至CPU 
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通过标准报文路径ALARM_S/SQ，将报文传送至编程器上的CPU Messages中或所连接的

HMI装置。 

 

16.9.1  支持组件和功能范围 

只要S7 300站、S7 400站、DP从站和WinAC支持诊断、中断、插入/移开模板中断以及通

道诊断等功能，“Report System Error（报告系统错误）”就支持它们。 

下述组态不被“Report System Error（报告系统错误）”所支持： 

• S7-300站中的DP主站接口模板（CP 342-5 DP）上的M7、C7和PROFIBUS-DP组态。 

在重新启动时，你必须注意可能会出现遗失的中断报文。这是由于CPU的报文响应存储器

在重新启动时，没有删除，但Report System Error 重新设置的内部数据。 

在下面两个表中，你可找到Report System Error所支持的各种从站的所有诊断块。 

诊断块 ID(故障槽) 通道名称   
(通道错误)1） 

模板状态  

(模板错误、不正确/没有
模板) 

设备名(只适用于ET 
200 B) 

Header ID 2） 0x01 
 

0x10 0x00 
Type 0x82 

0x00 + 1 
Byte Diagnostic Info 

ET 200S 报文：“诊断可用” 纯文本报文 纯文本报文 -   4） 

ET 200M 不评估 不评估 不评估 - 

ET 200X 报文：“诊断可用” - - - 

ET 200X 
DESINA 

报文：“诊断可用” 纯文本报文 纯文本报文 - 

ET 200L 不评估 -  - 

数字ET 200B  报文：“诊断可用” - - 报文：“模板故障” 

模拟ET 200B  报文：“诊断可用” - -  

模拟ET 200C  报文：“诊断可用”   报文：“模板故障” 

ET 200U 报文：“诊断可用”   报文：“模板故障” 

ET 200iS 报文：“诊断可用” 纯文本报文 纯文本报文 报文：“模板故障” 

DP AS-i Link 报文：“诊断可用”  纯文本报文  

 

诊断块 DS0/DS1  1) 其它实例 

Header ID   2 0x00  Type 0x01 0x00 
其它类型 

ET 200S   
ET 200M 纯文本报文 不评估 

ET 200X   

ET 200X DESINA 纯文本报文  

ET 200L 报文：“模板故障”  
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诊断块 DS0/DS1  1) 其它实例 

数字ET 200B    

模拟ET 200B  纯文本报文  

数字ET 200C   

模拟ET 200C 纯文本报文  

ET 200iS 纯文本报文  

DP AS-i Link 报文：“模板故障”  

1）DS0：标准诊断，例如模板错误、外部辅助电压或正面连接器遗失、范围4字节、OB82局域数据中。 

   DS1：通道错误，每种通道类型都不同，可通过SFC 51在用户程序中读取。文本来自S7 HW诊断。 

2）标题标识符：诊断报文中可以标识不同诊断部分的标识符。 

 

诊断报文（又成为Norm从站报文）有上述诊断块组成，并可通过SFC 13使用用户程序读

取。 

在STEP 7中，在“Hex display”下，通过在“DP Slave Diagnostics”选项卡中的在线窗

口“HWConfig”中调用模块状态，可以显示诊断报文。 

诊断中继器：诊断中继器的报文以纯文本形式输出。报文读自GSD文件。 

 

16.9.2  报告系统出错设置 

有几种方法可调用设置对话框：  

• 在HW Config中，选择你想组态系统错误报告的CPU。选择菜单命令Options > Report 

System Error。 

• 如果已经生成报告系统错误块，双击所生成的块（FB、DB），可以调用对话框。 

• 在站的“Properties（属性）”对话框中，在Save（保存）和Compile（编译）组态时，

选择自动调用选项。 

 

在Save（保存）和Compile（编译）时，你可以如下进入自动调用选项： 

1. 在SIMATIC管理器中，选择相应的站。 

2. 选择菜单命令Edit＞Object Properties。 

选择“Settings”选项卡。 

 

注意： 

可以通过菜单命令PLC > Properties打开HW Config中的属性对话框中的“Settings”。 
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在对话框中，输入以下内容：  

• 生成FB以及赋值背景DB。 

• 是否应生成参考数据。 

• 是否在生成Report System Error（报告系统错误）时，总是显示警告。 

• 是否在保存和编译组态后（见上述设置）自动调用Report System Error时，显示对话

框。 

• 生成错误OB：在S7程序中是否应生成仍不能使用的错误OB。 

• CPU出错特性：你可以设置在系统出错报告后，是否将CPU切换为“STOP”。 

• 是否应响应报文。 

• 报文外部特征（文本部分的结构和顺序） 

在调用对话框上的帮助中，你会得到更详细的信息。 

 

 

16.9.3  生成报告系统出错块 

当对报告系统出错的设定完成后，可以生成所需的块（FB和DB，并根据设置，OB仍不可

用）。在“Report System Errors”对话框中点击“Generate”按钮。可以生成以下的块：  

• 错误OB（如果“Generate error OBs（生成错误OB）”复选框激活）。 

• 诊断FB（缺省：FB49）。 

• 诊断FB背景DB（缺省：DB49）。 

• 由诊断FB调用的任选用户FB。 

 

16.9.4  生成错误OB 

可以用“Report System Error”生成以下的OB： 

• OB81（电源故障），调用所生成的诊断FB。 

• OB82（诊断中断OB；仅适用于组态模板DP从站），调用所生成的诊断FB。 

• OB83（插入/清除中断），调用所生成的诊断FB。 

• OB84（CPU硬件故障）该OB生成时没有内容，因此，当通讯发生故障时， 

CPU不会切换到STOP模式（例如当插入或移开MPI电缆时，MPI终端电阻故障）。对错误

不评估；不生成报文。 
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• OB85（程序执行错误） 如果在刷新过程映象时（例如移开模板时）出现错误，只能

防止CPU 切换到STOP 模式。由此，可以处理OB83中的诊断FB。任何一个Report 

System Error 报文后的CPU STOP设置，都会影响OB83。对于所有其它OB85错误事

件，CPU都将进入STOP模式。 

• OB86（扩展机架、DP主站系统或分布式I/O设备故障），可以调用生成的诊断FB。 该

OB只有在组态上述组件之一时，才生成。 

 

如果故障OB已存在... 

现有故障OB不会被覆盖。你必须亲自在相应OB中插入调用所生成的FB。 

 

如果组态包括分布I/O设备... 

对于分布I/O中的评估错误，所生成的FB会自动调用SFC13（读取DP从站的诊断数据）。

为了保证该功能，所生成的FB必须在OB1或短时循环中断OB以及启动OB中调用。 

 

注意 

请注意以下事项：  

• 当由于“Error While Updating Process Image（刷新过程映象时出现的错误）”错误

事件， Report System Error生成OB85时，CPU不能进入STOP模式。 

• 当出现以下错误时，CPU还可调用OB85： 

- OB“ That Is Not Loaded Error Event（没有装入OB错误事件）”  

- “Error When Calling or Accessing an OB That Is Not Loaded（调用或访问没有装入的

OB错误）” 

当出现这些错误时，如果Report System Error在使用之前生成OB85，CPU仍可进入STOP

模式。 

• 由于在这些OB中不会调用Report System Error的FB，在执行诊断FB后，CPU进入

STOP模式不会影响OB84和OB85。对于OB85，该设置可以通过在OB83中调用FB直

接说明。 

 

 

16.9.5  所生成的FB、DB 

所生成的FB可以评估故障OB的局域数据，读取触发故障的S7组件的其它诊断信息，并自

动生成相应的报文。 
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FB具有以下特性： 

• RSE（Report System Error，报告系统错误）生成语言（也适用于所生成的背景DB）。 

• Know-how保护（也适用于所生成的背景DB）。 

• 运行期中断延时。 

• 双击调用“Report System Error”功能设置对话框（也适用于所生成的背景DB）。 

 

用户块 

由于诊断FB为know-how保护，因此你不能对它进行编辑。但是，FB提供有用户程序接口，

因此你可以存取错误状态或报文编号等。 

使用以下参数可以在所生成的FB中调用用户程序中的评估块（可以在对话框中的“User 

Block”选项卡中设置）： 

EV_C：BOOL；   // 来报（TRUE）或外发报文（FALSE） 

EV_ID：DWORD ；  // 生成报文编号 

IO_Flag：BYTE ；  // 输入模板：B#16#54 输出模板：B#16#55 

logAdr：WORD；  // 逻辑地址 

TextListID：WORD；  // 文本库的ID（缺省文本库= 1） 

ErrorNo：WORD ；   // 生成故障编号 

Channel_Error：BOOL ； // 通道错误（TRUE） 

ChannelNo：WORD； // 通道编号 

ErrClass：WORD；  // 错误等级 

HerrClass：WORD；  // H系统的错误等级 

如果没有用户FB，可以使用上述参数由SFM生成。 

标准故障所生成的错误文本排列如下： 

错误号  影响的OB OB中的错误代码  

从 至  从 至 

1 86 OB 72 B#16#1 B#16#56 
162 163 OB 70 B#16#A2 B#16#A3 
193 194 OB 72 B#16#C1 B#16#C2 

224  OB 73 B#16#E0  
289 307 OB 81 B#16#21 B#16#33 

513 540 OB 82   
865 900 OB 83 B#16#61 B#16#84 
1729 1763 OB 86 B#16#C1 B#16#C8 
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大于12288的错误号是指通道故障。如果以16进制显示错误号，则可以计算出通道类型和

故障识别位。详细说明，参见相应模板的或通道的帮助文本。 

例如： 

12288 = W#16#3000 -> 高字节 0x30 – 0x10 = 通道类型 0x20 (CP接口)； 

        低字节 0x00，指错误位0 

32774 = W#16#8006 -> 高字节 0x80 – 0x10 = 通道类型 0x70 (数字输入)； 

        低字节 0x06，指错误位6 
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17   控制和监视变量 
 

17.1 组态操作员控制和监视变量 

 

概述 

当你使用WinCC对过程或可编程控制器进行监控时，STEP 7可提供用户友好方式对变量进

行控制和监视。 

与前面的方法相比，这一方法的优势在于你不需要再去给每一个操作站（OS）分别作组态

数据，你只需要使用STEP 7作一次组态即可。你可以使用传送程序AS-OS Engineering

（“Process Control Syetem PCS 7”软件包的一部分）将STEP 7中组态生成的数据传送

给WinCC，在传送过程中要检查数据的一致性及它们与显示系统的可兼容性。WinCC使用

变量块及图象对象中的数据。 

使STEP 7，你可以为下列变量组态或修改操作员控制和监视属性： 

• 功能块中的输入、输出及入/出参数 

• 存储位及I/O信号 

• CFC图表中的CFC块的参数 

 

基本程序 

组态操作员控制及监视变量的基本程序要依据所选的编程 /组态语言以及想控制和监视的

变量而定。但基本程序总会包括以下各步： 

1. 为操作员控制及监视将系统属性赋给功能块的参数或赋给符号赋值表中的符号。 

     在CFC中无需此步骤，因为你可以使用库中已准备好的块。 

2. 给你想控制和监视的变量赋予所需的属性在一个对话框中的（S7_m_c）登录特性。

在“Operator Interface（操作者接口）”对话框中（菜单命令Edit > Special Object 

Properties > Operator Interface），你可以改变WinCC属性，例如极限值、替代值

以及协议特性等。 

3. 使用工具PLC-OS Engineering将STEP 7中生成的组态数据传送到你的显示系统

（WinCC）。 
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命名规则 

为存储和传送而给WinCC作的组态数据要存储在一个由STEP 7自动赋赋给的一个唯一的

名字下面。用于操作员控制及监视、CFC图表以及S7程序的变量名是组成该名字的一部分，

因此要符合以下规律： 

• 在S7项目下的S7程序的名字要唯一（不同的站不能包含同名的S7程序）。 

• 变量、S7程序和CFC图表的名字不能包含下划线、空格或下列特殊字符：  [ ‘ ]  [ . ]  

[ % ]  [ - ]  [ / ] [ * ]  [ + ]。 

 

17.2 用STL、LAD及FBD组态操作员控制及监视的属性 

 

概述 

使用下面描述的步骤，你可以设置功能块的参数以适合于操作员控制和监视，并且可以将

所需的O，C，M属性赋值给你的用户程序中相关的背景数据块或其享数据块。 

 

要求 

你必须有一个STEP 7项目，一个S7程序以及一个功能块。 

 

基本程序 

 

 
将系统属性 S7_m_c 赋值给所有的你想控制和监视的功

能块的参数 

将 WinCC 的属性赋值给FB 的背景数据块或共享数据块 
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17.3 用符号表组态控制与监测属性 

 

概述 

不论使用什么编程语言，你都可以按下面所描述的步骤态下列变量： 

• 位存储 

• I/O信号 

 

要求 

在你开始之前，必须满足下列要求：  

• 在SIMATIC管理器中已生成一个项目。 

• 在该项目下有一个带有符号表的S7程序。 

• 该符号表必须是打开的。 

 

基本步骤 

 

 

 

 

 

 

17.4 用CFC改变操作员控制和监视属性 

 

概述 

在CFC中，你可以从库中选择已有操作员控制和监视功能的块来生成你的用户程序，并且

将这些块在图表中相应的位置上相连接。 

 

要求 

在STEP 7项目中已插入一个S7程序，生成了CFC图表并放置块在里面。 

 

将特殊对象特性“Operator Control and Monitoring 
（操作员控制和监视）”赋给符号 

将 WinCC 属性赋给符号 
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基本程序 

 

 

注意 

如果你使用自己生成的块，并且已给它们赋予了系统属性S7_m_c，你可以通过激活

“Operator Control and Monitoring”对话框中的“Operator Control and Monitoring”复

选窗口给这些块赋予操作员控制和监视能力（菜单命令Edit > Special Object Properties 

> Operator Control and Monitoring）。 

 

17.5 传送组态数据到操作员接口可编程控制器 

概述 

使用传送程序AS-OS Engineering，你可以将为操作员控制和监视而生成的组态数据送到

WinCC的数据库中。 

你可以选择许多不同的传送选项。比如，可以选择一个地址和文本比较以确保当前WinCC

属性已被传送。 

 

要求 

在开始传送之前，下列要求必须满足： 

• 已经安装了AS-OS Engineering。 

• 已为操作员控制和监视生成了组态数据。 

 

基本程序 

将操作员控制和监视的组态数据传送到WinCC数据库，其过程如下： 

 

 

 

 

 

 

 

 

编辑块的对象属性 

选择传送选项 

在SIMATIC管理器中生成操作站对象 

如果需要，显示传送协议 

传送数据 
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18  建立在线连接并进行CPU设置 
 

18.1 建立在线连接 

要下载S7用户程序/块、从S7可编程控制器上载程序到编程器和其它操作，需在编程设备

和可编程控制器之间建立在线连接： 

• 测试用户程度 

• 显示和改变CPU操作模式 

• 为CPU设置时间和日期 

• 显示模板信息 

• 比较在线和离线的块 

• 诊断硬件 

为建立在线连接，编程设备和可编程控制器必须通过合适的接口相连接（例如，多点接口

（MPI））。然后，你可以通过一个在线的项目窗口或“Accessible Nodes（可访问站）”

窗口访问可编程控制器。 

 

18.1.1  通过“Accessible Nodes”窗口建立在线连接 

这种访问方式可令你快速访问可编程控制器，可用于测试的目的。你可以在网络中访问所

有的可访问的可编程模板。如果你的编程设备中没有关于可编程控制器的项目数据则可选

择该种方式。 

使用菜单命令PLC > Display Accessible Nodes，打开“Accessible Nodes”窗口。在

“Accessible Nodes”对象中显示网络中所有可访问的可编程模板及其地址。 

那些不能用STEP 7编程的站（如编程设备或操作面板）也能显示出来。 

 

18.1.2  通过在线的项目窗口建立在线连接 

如果在编程设备/PC的项目中有组态的可编程控制器，你可以选择该种方法。你可以在

SIMATIC管理器中使用菜单命令View > Online打开一个在线窗口。该窗口显示可编程控制

器中的项目数据（离线窗口与之相反，显示编程设备/PC中的项目数据）。可编程控制器中

的S7程序和M7程序的数据都可以在在线窗口显示。 
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你可以将项目的这种显示用于与访问可编程控制器相关的功能。SIMATIC管理器中，菜单

“PLC”中的某些功能只能在在线窗口中激活，不能在离线窗口中使用。 

有以下两种访问类型： 

• 用组态的硬件访问 

这意味着你只能访问离线组态的模板。哪个在线模板可以访问由组态可编程模板时设置

的MPI地址决定。 

• 无需组态硬件的访问 

这种方法要求有一个与硬件无关的S7程序或M7程序存在（即该程序直接位于项目之

下）。由S7/M7程序对象属性中定义的相应的MPI地址决定哪个在线模板可以访问。 

通过在线窗口访问，显示的数据是可编程控制器与编程设备中的数据的组合。比如，如果

你在一个在线项目下打开一个S7块，则显示组合如下： 

• 来自于可编程控制器CPU中的块的指令代码部分，及 

• 来自编程设备数据库中的注释和符号（如果离线程序中有这些注释和符号）。如果你

不通过项目结构，而是直接打开所连的CPU，则显示的程序就是这些程序在CPU中的

原样，即没有符号和注释。 

 

 

18.1.3  在多项目中在线访问PLC 

 

用一个PG/PC进行项目间访问 

用于对象“PG/PC”和“SIMATIC PC站”的“Assign PG/PC”功能同样适用于多项目中。 

可以在任何一个项目中指定进行在线访问的目标模板。其步骤与仅在一个项目中进行访问

是一样的。 

 

需求 

• 用于在线访问PLC的PG/PC或PC站必须已经在多项目中的任何一个项目中进行了分

配。 

注意：当相应的项目打开时，所分配的PG/PC或PC站以黄色高亮显示。 

• 所有项目的子网已连接。 

• 所有项目已进行了编译，组态数据已下载到相应的战；例如，为建立连接的PG/PC和目

标模板间提供路由信息。 

• 通过网络可以访问目标模板。 
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当工作在分布式项目中可能出现的问题 

如果所分配的项目改变以及在PG/PC上打开一个还没有生成的项目时，PG/PC的分配是不

可见的。 

即使如此，所组态的PG/PC对象还依然保持所分配的状态，但是是错误的PG/PC。 

在这种情况下，必须清除现有的分配并重新分配PG/PC对象。这样可以没有问题地在多项

目中在线访问模板。 

 

                    1.  在网络中用所分配的PG/PC保存项目A 

                    2.  用不同的计算机打开相同的项目A 

 

在分布式项目中的运行提示 

如果多个人要访问在其PG上在线的PLC，最好在多项目中建立一个“ PG/PC”或“SIMATIC 

PC站”，然后再为每个PG建立一个分配。 

取决于哪台PG打开了项目，SIMATIC管理器只以黄色箭头形式指示分配给该PG的对象。 

 

18.1.4  设定访问可编程控制器的口令 

使用口令保护，你可以：  

• 保持CPU中的用户程序及其数据未经授权不能改变（写保护） 

• 保护你的用户程序中的编程专利（读保护） 

• 保护在线功能以免可能对过程造成干扰 

如果模板支持口令保护的功能，你用这种方法就可以保护该模板。 
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如果你想用一个口令来保护一个模板，则必须在对模板进行参数赋值的过程中定义保护级

别并设置口令，然后将修改的参数送至模板。 

如果需要对执行在线功能输入口令，“Enter Password”对话框会显示出来。若输入正确

的口令，你就可以得到模板的访问权，该模板在参数赋值过程中已被设置了特定的保护级

别。此时你就可以与被保护的模板建立在线连接并执行属于那个保护级别的在线功能。 

使用菜单命令PLC>Access Rights> Setup，你可以直接调用“Enter Password”对话框。

由此，例如，在对话开始时，你可以一次输入口令，以后在线访问时，将不再询问。输入

的口令将有效至SIMATIC Manager关闭或使用菜单命令PLC > Access Rights > Cancel

取消口令。 

CPU参数 要点 

测试操作 /过程操
作（无S7-400 或  

CPU 318-2） 

 
 
 
 

可在“Protection”选项卡中设置  

在过程操作中，为保证设置允许的循环扫描时间的增加不超限，象程序
测试或监视／修改变量这样的测试功能是受制约的。 

这意味着，比如，在程序测试中不允许调用条件，并且编程循环的状态
显示在返回点被中断。  

使用断点的测试及程序的单步执行在过程操作中不能使用。  

在测试操作中，通过编程设备 /PC的所有测试功能都可以不受限制地使
用，即使这些功能可能会使循环扫描时间的增加相当可观。 

保护级别 
可在“Protection”选项卡中设置如果知道正确的口令，你就可以对CPU
进行写读 /写访问。口令在此选项卡中设定。 

 

 

18.1.5  刷新窗口内容 

你需要注意以下事项： 

• 由于用户操作（如下载或删除块）而在一个在线的项目窗口造成的修改不会在任何已

打开的“Accessible Nodes（可访问站）”窗口自动刷新。 

• 任何在“Accessible Nodes”窗口中所作的修改，不会自动刷新任何已打开的在线项目

窗口。 

要刷新一个并行打开的窗口，你必须直接在该窗口刷新（使用菜单命令或功能键F5）。 
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18.2 显示和改变操作模式 

例如用这个功能，你能够在纠正错误之后将CPU切换到“RUN”。 

 

显示操作模式 

1.   打开你的项目并选择S7/M7程序，或用菜单命令PLC > Display Accessible 

Nodes打开“Accessible Nodes”窗口并选择一个站（“MPI=⋯”）。 

2.   选择菜单命令PLC > Diagnostics/Settings > Operating Mode。 

该对话框显示当前和最近一次的操作模式以及在模板上当前模式选择开关的设置。对于那

些无法显示其当前开关设置的模板，显示文本“Undefined”。 

 

改变操作模式 

你可以使用按钮改变CPU的模式。只有当这些按钮是激活的，才能在当前的操作模式下被

选择。 

 

18.3 显示并设置时间和日期 

 

18.3.1  CPU时钟，带有时区设定和夏令时设定 

处理日期时间外，还可以用STEP 7 V5.1 SP2在新的CPU中(固件V3以上)设置或评估夏令时

以及时差。 

 

时区显示 

系统通过TOD运行。TOD是一个全球的、连续的、不中断的模板时间。 

本地自动化系统允许计算于模板时间不同的当地时间，并可在用户程序中使用。当地时间

不直接输入，它是通过模板时间脉冲减去与模板时间的时差来计算的。 

 

夏令时/冬令时 

当建立了TOD和日期后也可以设置夏令时或冬令时。当从夏令时切换到冬令时时，用户程

序只需考虑与模板时间的时差。 
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读取和调整TOD以及TOD状态 

夏令时/冬令时的标识以及与模板时间的时差包含在TOD的状态中。可通过下列方法读去或

调整TOD及其状态： 

用STEP 7(在线) 

• 通过菜单命令PLC > Diagnostics/Setting > Adjust TOD(读取和调整) 

• 通过“模板信息”对话框中的“Time System”(只能读) 

在用户程序中 

• SFC 100 “SET CLKS”(读取和调整) 

• SFC 51 “RDSYSST” with SZL 132, Index 8(只能读) 

 

诊断缓冲区、报文和OB启动信息中的时间标签 

用模板时间生成时间标签。 

 

TOD中断 

当冬令时切换到夏令时时，由于“时间跳转”而没有触发TOD中断，则调用OB 80。 

 

TOD同步 

设置为主TOD的CPU(例如在CPU中登记“Diagnostics/Clock”)可以同步其他时钟的模板时

间和当前TOD状态。 

 

18.3.2  显示并设置时间和日期 

按如下进行： 

1. 打开你的项目并选择S7/M7程序，用菜单命令PLC>Display Accessible Nodes打开

“Accessible Nodes”窗口并选择一个站（“MPI=⋯”）。 

2. 选择菜单命令PLC > Diagnostics/Setting > Set Date and Time。 

只有当所选的S7/M7程序是在一个项目窗口（在线显示）或在“Accessible Nodes”

窗口选中了一个站（“MPI=...”），该命令才能被选中。 

3. 在显示的对话框中你可以读到所选模板当前的时间和日期。 

4. 如果需要，可以在“Date”（日期）和“Time”（时间）栏中输入新的值，或者用缺

省选项接受你的编程设备/PC上的时间和日期。 
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注意 

如果模板没有实时时钟，对话框中时间显示为“00：00：00”，日期显示为“00.00.00”。 

 

 

18.4 更新固件 

18.4.1  更新模板和子模板中的固件 

对于STEP 7 V5.1 SP3，你可以用标准方法更新一个站中的模板或子模板。步骤如下： 

 

概念 

更新诸如一个CPU、一个CP或一个IM模板的固件时，必须有包含最新固件信息的文件

(*.UPD)。 

选择一个文件并下载到模板中。 

 

前提条件 

要更新固件的模板必须能够在线访问。此外，该模板必须也支持该功能。 

在PG/PC中必须有包含最新固件版本的文件。一个固件在一个文件夹中。 

 

在硬件配置中的更新步骤 

打开需要更新模板的站。 

选择模板。对于类似IM 151 PROFIBUS DP接口模板，为DP从站选择图标。在这种情况下，

它是一个标准的ET 200S。 

选择菜单命令PLC > Update firmware。如果所选择的模板或DP从站支持“更新固件”功

能，则只能激活菜单命令。 

在显示的“更新固件”对话框中点击“Browse”按钮并选择固件更新文件路径。 

选择完一个文件后，下方的“更新固件”对话框中将告诉您该文件适用于哪个模板以及其

固件版本。 

点击“RUN”按钮。STEP 7将检查所选择的文件是否适用于该模板，如果正确，则向模板

下载该文件。如果需要改变CPU的运行模式，对话框将提示您执行这些步骤。 

在STEP 7中检查(读CPU诊断缓冲区)是否能用新固件启动该模板。 
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19   下载和更新 
 

19.1 从PG/PC中下载到可编程序控制器 

 

19.1.1  下载条件 

下载到可编程序控制器的条件 

• 你的编程设备和可编程序控制器里的CPU之间必须有一个联接（例如，多点接口） 

• 必须可以访问可编程序控制器。 

• 你下载的程序已无误地编译。 

• CPU必须在允许下载的工作模式下（STOP或RUN-P）。  

RUN-P模式表示，这个程序将一次下载一个块。如果你这样重写一个旧的CPU程序，可

能出现冲突，例如，如果块参数已改变了。当处理循环时，CPU就会进入STOP模式。

我们因此建议你在下载前将CPU切换到STOP模式。 

• 如果你要离线打开一个块并要下载它，CPU必须与SIMATIC管理器中的一个在线用户程

序相联接。 

• 在下载你的用户程序之前，你必须使CPU复位，保证没有旧块在CPU上。 

 

STOP方式 

在你做下列事情前，把工作方式从“RUN”模式置到“STOP”模式：  

• 下载完整的或部分用户程序到CPU 

• 在CPU执行存储器全清 

• 压缩用户存储器 

 

热启动（转换到“RUN”方式） 

如果你在“STOP”模式时执行一个热启动，程序重新启动并在“STARTUP”模式下首先

运行启动程序（在块OB100里）。如果启动成功，CPU转到“RUN”方式。做下列事后需

要热启动：  

• CPU复位 

• 在STOP模式下载用户程序 
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19.1.2  如何编译和下载对象 

在编译和下载对话框中，选择要传送给CPU的项目文件。该对话框可用于一个站、一个项

目或一个多重项目的对象。 

步骤： 

在SIMATIC管理器中，选择要编译或下载的对象。可选择： 

-  多个项目 

    -  项目 

    -  站 

    -  没有分配站的S7/M7程序 

在SIMATIC管理器中，选择菜单命令PLC > Compile And Download Objects。 

如果不向CPU下载，选择“Only Compile”(只进行编译)。 

为了防止将不正确的块下载到CPU，始能检查框“No download on compilation error”(编

译错误时不下载)。 

在编译和下载栏中，选择要进行编译或下载的对象。所选择的内容将通过检查标记进行指

示。如果象第3步那样只选择编译，则下载栏将变为灰色并不能执行。 

点击“START”开始编译。 

按照屏幕上的指令继续进行。 

 

19.1.3  保存和下载块的区别 

你一定要区分保存块和下载块。 

 

 保  存 下  载 

菜单命令 

 

File > Save  
File > Save As 

PLC > Download 

功能 
编辑器中块的当前状态被保存在编程
设备的硬盘上 

编辑器里块的当前状态仅下载到CPU
上 

语法检查 

运行语法检查。任何错误都将在对话框
里被报告。错误的原因和位置也将显示
出来。在你下载或保存块前必须纠正这
些错误。如果在语法上没有发现错误，
块将被编译成机器码或者保存下载。 

运行语法检查。任何错误都将在对话框
里被报告。错误的原因和位置也将显示
出来。在你下载或保存块前必须纠正这
些错误。如果在语法上没有发现错误，
块将被编译成机器码或者保存下载。 

这个表的应用与你是在线打开块还是离线打开块无关。 
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块修改的技巧— —先保存后下载 

要存入新创建的块或在逻辑块的程序区中进行修改，在声明表中修改或在数据块中输入新

的或更改的数据值，你必须对各个块进行保存。用命令菜单PLC > Download可将在编辑

器里进行的任何修改传送到CPU，例如，检查小的修改—，在你退出编辑程序前，任何情

况下都必须（把变更）保存在编程设备的硬盘上。否则，在CPU里和编程设备上，你将得

到不同版本的用户程序。一般建议你先保存所有的更改，然后再下载它们。 

 

19.1.4  CPU里的装载存储器和工作存储器 

在完成组态，参数赋值，程序创建和建立在线连接后，你可以下载整个用户程序或个别块

到一个可编程序控制器。要测试单个块，你必须至少下载一个组织块（OB），在OB里被

调用的功能块（FB）和功能（FC）以及使用的数据块（DB）。要下载硬件组态，网络组

态和创建连接表生成的系统数据到可编程控制器，你可下载对象“System Data”。 

在程序测试的末段或运行已完成了用户程序期间，你可以用SIMATIC管理器下载用户程序

到一个可编程序控制器。 

 

关系—装载存储器和工作存储器 

完整的用户程序下载到装载存储器；与程序执行有关的部分也已经装入到工作存储器中。 

 

 

 

 

 

 

 

 

 

CPU 装载存储器 

• 装载存储器用来存储没有符号表和注释的用户程序（这些符号和注释保留在编程设备

存储器中） 

• 没有被标记为运行需要的块，将仅存储在装载存储器里 

• 装载存储器可以是RAM，ROM或EPROM存储器，随可编程序控制器而定 

 

编程器 

 

 

向CPU下载 

程序 

CPU 
负载存储器 工作存储器 

EPROM 

 

RAM 

RAM 

 

与程序执行

有关的部分 



下载和更新 

 19-4 

• 装载存储器也可以有一个集成的EEPROM部分以及一个集成的RAM部分（如，CPU 

312IFM和CPU 314IFM） 

• 在S7-400中，用一个存储卡（RAM或EEPROM）来扩展装载存储器是很必要的 

 

CPU工作存储器 

工作存储器（集成RAM）用来存储程序处理所需要的那一部分用户程序。 

 

可能的下载/上载步骤 

• 你用下载功能下载用户程序或可装载的对象（如，块）到可编程序控制器。如果这个

块已存在于CPU的RAM中，你将被注意，要确定这个块是否要重写。 

• 你可以在项目窗口中选择可装载的对象，并从SIMATIC管理器中下载它们（菜单命令：

PLC > Download）。 

• 当编程块，组态硬件和网络时，可直接下载这个当前正在编辑的对象，你可以用你工

作所需的应用程序的主窗口里的菜单来进行。（菜单命令：PLC > Download）。 

• 另一个可能是，打开一个在线窗口查看可编程控制器（例如，用 View > Online或PLC > 

Display Accessible Nodes），并且复制你想要下载到这个在线窗口的对象。 

另外可以通过装载功能从CPU的装载存储器RAM把块的当前内容上载到你的可编程序控

制器里。 

 

 

19.1.5   下载方式随装载存储器而定 

CPU里装载存储器中RAM区和EEPROM区的分配决定了在你的用户程序中下载用户程序

或块时可用的方式。以下是下载数据到CPU中的可能方式： 

 

装载存储器 装载方式 PG和PLC之间的通信类型 

RAM 下载和删除各个块 PG-PLC在线连接 

 下载和删除整个用户程序 PG-PLC在线连接 

 重新装入各个块 PG-PLC在线连接 

集成（仅S7-300）
或外插EPROM 

下载整个用户程序 PG-PLC在线连接 

外插EPROM 下载整个用户程序 
外部加载EPROM并插入存储卡或通过
插入EPROM的PLC上的在线连接。 
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通过在线连接下载到RAM 

在可编程序控制器中，如果掉电且RAM没有被备份则数据丢失。这种情况下，RAM中的数

据也将随着丢失。 

 

保存到EPROM存储卡中 

块或用户程序被保存在一个EPROM存储器上，然后插在CPU的一个插槽中。 

存储卡是便携式数据记录媒体。它们通过编程设备来写入，然后插在CPU上恰当的插槽里。 

当电源关断后和CPU复位时，保存在它们上面的数据将被保留。在CPU存储器复位且电源

掉电之后，电源重新恢复时如果RAM中的内容没有备份，EPROM中的内容被重新复制到

CPU存储器的RAM区。 

 

保存在集成EPROM里 

对于CPU312，你也可以保存RAM的内容到集成EPROM中。在电源断开时，集成的EPROM

中的数据将被保留。在电源断开且CPU存储器复位后再重新恢复时，如果RAM没有被备份，

集成的EPROM中的内容将被重新复制到CPU存储器的RAM区。 

 

 

19.1.6  在可编程控制器中重新下载块 

对S7可编程控制器，CPU装载存储器（RAM）或工作存储器中已有的块可以用新版本进行

重写（再次装入它们）。原来的版本则被覆盖。 

对S7块重新装入的步骤与下载相同。只是有一个注意出现，询问你是否要覆盖原来的块。 

存在EPROM中的块不能被删除，但是一旦它被重新装入，原来的块就被声明无效了。替

代它的块被装入RAM中。这就会在装载存储器或工作存储器中产生间隙。这些间隙最终意

味着无法装入新的块，你该对存储器作压缩了。 

 

注意 

如果掉电又恢复而RAM没有备份电池，或者在CPU作了一个存储器复位之后，“旧”块又

重新有效了。 
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19.1.7  通过EPROM存储卡下载 

要求 

用编程设备为S7可编程控制器访问EPROM存储卡必须有合适的ERPOM驱动器。为M7可

编程控制系统访问EPROM存储卡，则必须安装了闪存文件系统（只能在PG720、PG740

和PG760上）。当安装STEP 7标准软件包时，EPROM驱动器和闪速文件系统作为可选项

提供。如果使用PC，要存储到EPROM存储卡需要一个外置EPROM写入装置，也可以在晚

些时候再安装驱动器。要这样作，通过Start>Simatic>STEP 7>Memory Card Parameter 

Assignment调用相应的对话框，或者通过控制面板（双击图标“Memory Card Parameter 

Assignment（存储卡参数赋值）”）。 

 

保存在存储卡上 

要将块或用户程序保存到存储卡可按如下进行： 

1. 在编程设备的槽口中插入存储卡。 

2. 打开“Memory Card（存储卡）”窗口，可用以下方式： 

     -  的“Memory Card”按钮。如果有必要可用菜单命令View > Toolbar激活工具栏。 

     - 选择菜单命令File>S7 Memery Card>Open。 

3. 打开或激活显示你要存储的块的下列窗口之一：下列窗口都可以： 

     - 项目窗口，“在线”视窗 

     - 项目窗口，“离线”视窗 

     - 库窗口 

     -“Accessible Nodes（可访问站）”窗口 

4. 选择“Blocks”文件夹或单个块并将它们拷备到“S7 Memory Card”窗口。 

5.   如果一个块已存在在存储卡中，则有错误信息显示。这种情况下，删除存储卡中的内

容然后从步骤2开始重复。 

 

 

19.2 从可编程控制器上载到PG/PC 

当执行以下操作时，这个功能支持你：  

• 保存来自可编程序控制器中的信息（例如，为了维护目的） 

• 快速组态和编辑一个站，如果在你开始组态前硬件部分是可用的 
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保存来自可编程序控制器的信息 

这个措施是必需的，举例来说，如果这个版本的离线项目数据不能或部分不能在CPU上运

行。这种情况下，你至少可以恢复在线的可用的项目数据并上载它们到你的编程设备上。 

 

快速组态 

如果你组态完硬件并重新启动站后，从可编程序控制器中上载组态数据到你的编程设备，

那么输入站组态就较容易。这提供给你站组态和每个模块的类型。然后你要做的全部事情

就是以更多的细节来定义这些模块（定货号），并且对它们进行参数赋值。 

下列信息可上载到编程设备上：  

• S7-300：中央机架和任何扩展机架的组态 

• S7-400：带一个CPU和信号模块的中央机架的组态，没有扩展机架 

• 分布式I/O的组态数据不能上载到编程设备上 

如果在可编程序控制器上没有组态信息，则这个信息将被上载；例如，如果在系统上执行

了一个存储器的复位。否则，上载功能可提供更好的结果。 

对于没有分布式I/O的S7-300系统，你要做的全部事情就是以更多的细节来定义这些模块

（定化号），并且对它们进行参数赋值。 

 

注意 

当上载数据时（如果没有一个离线组态），STEP 7不能确定全部组件的定货号。 

当你用命令菜单Options>Specify Module组态硬件时，可以输入“未完成的”定货号。

这样，你可以对STEP 7不能识别的模块进行参数赋值（那是指，没有出现在“硬件样本”

窗口里的模块）；不管怎样，STEP 7将不会检查你是否遵守参数法则。 

 

从可编程序控制器上载时的约束 

下列约束适用于从可编程序控制器上载到编程设备的数据：  

• 块不包含任何参数、变量和标号的符号名称 

• 块不包含任何注释 

• 上载带有全部系统数据的完整的程序，只有这样系统才能继续处理属于“组态硬件”

应用程序的系统数据 

• 不能更进一步地处理全局数据通信（GD）和组态符号相关报文 

• 强制作业不能把其他数据一起上载到编程设备上。它们必须作为变量表（VAT）被单独

保存 

• 模块对话框里的注释不能上载 
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• 只有在组态期间，这个选项被选中，模块的名称才会被显示（HWConfig：选项“在可

编程序逻辑控制器中保存对象名称”在Options>Customize下的对话框里） 

 

19.2.1  上载站参数 

用命令菜单PLC > Upload Station，可以从所选的可编程控制器中上载当前的组态、和所

有块到编程设备上。 

要作到这一步，STEP 7在当前项目中生成一个新站，站的组态将存储在这个项目下。你可

以修改这个新工作站的预定名称。（例如，“SIMATIC 300-Station（1）”）。这个插入

的工作站在在线视图和离线视图中都会显示。 

当一个项目打开时，这个命令菜单会被选中。是在这个项目窗口选择一个对象还是在视图

（在线或离线）中选择一个对象对这个菜单命令没有影响。 

你可以用这个功能更容易地组态 

• 对于S7-300可编程控制器，被上载的实际硬件组态包括扩展机架，但是没有分布式I/O

（DP） 

• 对S7-400可编程序控制器，被上载的机架组态没有扩展机架和分布式I/O 

对于没有分布I/O的S7-300系统，你要做的全部事情就是对模板作更详细的定义（定货号）

并对它们进行参数赋值。 

 

上载工作站时的限制 

下列限制适用于数据上载到编程设备：  

• 块不包含任何参数、变量和标号的符号名称。 

• 块不包含任何注释。 

• 包括所有的系统数据在内的完整的程序被上载，由此并非所有数据都能被进一步处理。 

• 全局数据通信（GD），组态符号相关的报文和组态网络的数据不能被进一步处理。 

• 强制作业不能被上载到编程设备上然后再装载回可编程序控制器上。 

 

19.2.2  从一个S7 CPU中上载块 

你可以用SIMATIC管理程序，从CPU中上载S7块到编程设备的硬盘上。在下列情况中，上

载块到编程设备上是有用的： 

• 制作一个装载到CPU中的当前用户程序的备份。这个备份可以接着被重新下载，例如，

维修人员维修后或CPU的一个存储器复位后。 
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• 你可以从CPU中上载用户程序到编程设备上并在那里编辑它，例如，为了故障检修的

目的。这种情况下，你不能访问到程序文档的符号或注释。因此，我们建议这一过程

仅应用于维修目的。 

 

19.2.3  在PG/PC中编辑上载块 

能从CPU中上载块到编程设备上有下列用途： 

• 测试阶段中，可以在CPU上直接修改一个块，并为结果制作文档 

• 可以通过装载功能从CPU的RAM装载存储器中上载块的当前内容到你的编程设备上 

 

注意 

在线和离线工作时，时间标志冲突。 

以下过程导致时间标志冲突，因此要避免。 

当你在线打开一个块时，会有时间标志冲突： 

• 在线所作的修改未保存到离线的S7用户程序中 

• 离线所作的修改未下载到CPU 

当你离线打开一个块时，会有时间标志冲突： 

• 一个在线块的时间标志冲突被复制到离线的S7用户程序中，并且在离线时被打开 

 

两种不同情况 

当从CPU上载块到编程设备时，记住有两种不同情况： 

1.  块所属的用户程序在编程设备上。 

2.  块所属的用户程序在编程设备上。 

这表示下面列举的不能下载到CPU的程序部分就无法得到。这些内容是： 

• 存有地址的符号名和注释的符号表 

• 梯形逻辑或功能块图程序的段注释 

• 语句表程序的行注释 

• 用户定义的数据类型 
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19.3 在可编程序控制器中删除 

19.3.1 清除装载/工作存储器并复位CPU 

在下载你的用户程序到S7可编程序控制器之前，你要在CPU上完成一个存储器复位，以保

证没有旧块仍留在CPU上。 

 

存储器复位的要求 

CPU必须在STOP模式下完成一个存储器的复位（模式选择开关设置为STOP，或设成

RUN-P并用菜单命令PLC > Diagnostics/Settings > Operating Mode更改模式为

STOP）。 

 

在一个S7 CPU上执行存储器的复位 

当在S7 CPU上执行存储器复位时，有下列情况出现：  

• 这个CPU复位 

• 全部用户数据被删除（除了MPI参数以外的块和系统数据块（SDB）） 

• CPU中断全部现有的联接 

• 如果数据保存在一个EPROM中（存储卡或集成EPPOM），随存储器复位后，CPU把

EPROM的内容复制回存储器的RAM区。 

诊断缓冲区的内容和MPI参数将被保留。 

 

在M7 CPU/FM上执行存储器的复位 

当在M7CPU/FM上执行存储器复位时，会有下列情况出现： 

• 初始状态被恢复 

• 除了MPI参数以外的系统数据块（SDB）被删除 

• CPU/FM断开全部现有的联接。在你把CPU从STOP转换到RUN后，用户程序被保留并

继续运行 

使用“存储器复位”功能，当出现严重错误时，可通过删除工作存储器中当前系统数据块

（SDB）并从只读存储器中重新装载SDB来恢复M7CPU或FM的初始状态。在有些情况下，

要求操作系统作暖起动。要这么做，可使用模式选择开关（切换到MRES位置）清除M7。

只有当CPU/FM上使用的是RMOS32操作系统时才能够用模式选择开关在 SIMATIC 

M7CPU或FM上作复位。 
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19.3.2  删除可编程序控制器上的S7块 

在CPU程序的测试阶段，删除CPU上的单个块可能是必要的。块被保存在CPU用户存储器

的EPROM中或RAM中（依据CPU和装载步骤）。 

• RAM中的块可被直接删除。装载或工作存储器被占据的空间将空出来并可以被重新使

用。 

• 随着CPU存储器的复位，集成EPROM中的块总是被复制到RAM区。对于RAM中的备

份可以直接作删除。被删除的块接着会在EPROM中被标记为无效，直到下一次存储器

复位或没有RAM备份的电源掉。在存储器复位或没有备份RAM的情况下电源掉电后，

“删除”的块从EPROM从中被复制到RAM中并且生效。集成EPROM中的块（例如，

在CPU312中）将通过用新的RAM内容来重写它们而被删除。 

• EPROM存储卡只能在编程设备上被擦除 

 

19.4 压缩用户存储器（RAM） 

19.4.1  用户存储器里的间隙（RAM） 

删除和重装块之后，用户存储器（装载和工作存储器）将出现间隙，并且减少了可用的存

储区。用压缩功能，现有的块将在用户存储器中无间隙地重新排列，一个连续的空存储器

将产生。 

下图显示了如何用压缩功能将占用存储器的块移到一起。 

 

 

压缩前存储器的占用 

压缩后存储器的占用 

占用的存储器 

空存储器 
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尽可能地在STOP模式下压缩存储器 

有在“STOP”模式下压缩存储器才能够将所有间隙闭合。在RUN-P模式时（模式选择开关

设置），当前正在处理的块由于被打开了而无法移动。在RUN模式（模式选择开关设置）

（写保护!）下压缩功能不起作用。 

 

 

19.4.2  压缩S7 CPU存储器的内容 

压缩存储器的方法 

有下列两种方法可以压缩用户存储器： 

• 当下载到编程器时存储器容量不够，将出现一个对话框提示您出现错误。可以点击对

话框中相应的按钮对存储器进行压缩。 

• 作为预防措施，可以显示存储器可用空间 (菜单命令PLC > Diagnostics/Setting > 

Module Information，“Memory”选择框)，如果需要，可以启动压缩功能。 

 

步骤 

选择“Accessible Nodes”窗口中的S7程序 

选择菜单命令PLC > Diagnostics/Setting > Module Information 

在出现的对话框中选择“Memory”选择框。如果CPU支持该功能，则在此页会出现一个

压缩按钮。 
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20   用变量表进行测试 
 

20.1 使用变量表测试简介 

使用变量表，可以保存各种测试环境。这样，在操作或进行维修和维护时，可以有效地进

行测试和监控。对于所保存的变量表的数量没有限制。 

当使用变量表进行测试时，有如下功能：  

• 监视变量 

该功能可以让你在编程设备/PC上显示用户程序中或CPU中每个变量的当前值。 

• 修改变量 

你可以用这个功能将固定值赋给用户程序或CPU中的每个变量。使用程序状态测试功能

时也能立即进行一次数值修改。 

• 使用外设输出并激活修改值 

这一功能允许你在停机状态下将固定值赋给CPU中的每个I/O输出。 

• 强制变量 

你可以用这个功能给用户程序或CPU中的每个变量赋予一个固定值，这个值是不能被用

户程序覆盖的。 

你可以为以下变量赋值或显示数值：  

• 输入、输出、位存储、定时器及计数器 

• 数据块的内容 

• I/O（外设） 

在变量表中输入你想要显示或修改的变量。 

你可以通过定义触发点和触发频率来决定变量什么时候、以什么样的频率被监视或赋予新

值。 
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20.2 用变量表进行监视和修改的基本程序 

要使用监视（Monitor）和修改（Modify）功能可按如下进行： 

1. 生成新的变量表或打开已存在的变量表。 

2. 编辑或检查变量表的内容。 

3. 用菜单命令PLC > Connect to，建立当前变量表与所需的CPU之间的在线连接。 

4. 用菜单命令Variable > Trigger，选择合适的触发点并设置触发频率。 

5. 菜单命令Variable > Monitor和Variable > Modify，可使监视和修改功能在有效和无

效之间转换。 

6. 用菜单命令Table > Save或Table > Save As存储完成了的变量表，以便在以后的任

何时候再调用它。 

 

20.3 编辑并存储变量表 

20.3.1  生成并打开一个变量表 

在你能够监视或修改变量之前，必须生成一个变量表（VAT）并输入所需要的变量。要生

成变量表可选择以下方法之一： 

 

在SIMATIC管理器中： 

• 选择“Blocks”（块）文件夹，使用菜单命令Insert > S7 Block > Variable Table。 在

对话框中，你可以给定表名（“Symbolic Name（符号）名”文本框）。名称显示在

这个对象窗口中。可以通过双击该对象打开变量表。 

• 选择一个连接或者一个在线视窗、可访问站（accessible nodes）中的S7或M7程序。

用菜单命令PLC > Monitor/Modify Variables，生成一个无名变量表。 

 

在“Monitor/Modify Variables（监视/修改变量）”中： 

• 可以用菜单命令Table > New生成一个新的变量表，该表没有被赋给任何S7或M7程

序。你可以用Table > Open打开已存在的表。 

• 可以在工具栏中使用相应的符号来生成或打开变量表。 

一旦已生成一个变量数，你可以存储、打印和多次使用该表进行监视和修改。 
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20.3.2  复制/移动变量表 

你可以在一个S7/M7程序中的块文件夹中复制或移动变量表。 

在复制或移动变量表时，应注意以下事项：  

• 必须刷新目标程序符号表中的现有符号。 

• 当移动变量表时，源程序符号表中的相应符号也将被移动到目标程序的符号表中。 

• 当你从块文件夹中删除变量表时，S7/M7程序符号表中的相应符号也将被删除。 

• 如果目标程序中包含一个具有相同名字的变量表，在复制变量表时，将被赋值更大的

一个编号。 

• 如果目标程序中已包含有一个相同名字的变量表，在复制时，你可以重新命名变量表

（缺省为现有名字编号）。 

 

20.3.3  存储变量表 

当你再次测试程序时可以使用已存储的变量表来监视和修改变量。 

1. 令Table > Save，存储变量表。 

2. 如果已经生成变量表，现在你必须给变量表起个名字，例如“ProgramTest_1”。 

当你存储一个变量表时，所有当前设定和表的格式都被存储起来。这意味着在菜单选项

“Trigger”下的设置也存储起来。 

 

20.4 在变量表中输入变量 

20.4.1  变量表中插入地址或符号 

选择你想要修改或监视的变量，在变量表中输入。从“外部”开始，由“外”向“内”地

工作，这意味着你首先应该选择输入，然后是被输入影响的变量以及影响输出的变量，最

后是输出。  

例如，如果你想监视输入位1.0，存储字5以及输出字节0，则在“Address”栏中输入以下

内容： 例如： 

I 1.0 

MW5  

QB0 
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已完成的变量表的示例 

下图所示是一个显示下述各栏的变量表：地址（Address）、符号（Symbol），显示格式

（Monitor Format），监视值（Monitor Value）和修改值（Modify Value） 

 

关于插入符号的注意 

• 对你想要修改的变量输入地址或符号。即可以在“符号”栏输入符号，也可以在“地

址”栏输入地址。然后输入便会自动地在正确的栏中写入。如果相应的符号已在符号

表中定义，则符号栏或地址栏会自动填入。 

• 你只能输入已在符号表中定义过的符号 

• 符号必须准确地按照它在符号表中所定义的进行输入 

• 符号名中含有特殊字符则必须用引号括起来（例如，“Motor.off”，“Motor+Off”，

“Motor-off”） 

• 要在符号表中定义新符号，可使用菜单命令Options > Symbol Table。还可以从符号

表中拷贝符号然后粘贴到变量表中。 

 

语法检查 

当你在变量表中输入变量时，在每行的结束都会执行语法检查。任何不正确的输入都会被

标为红色。如果你把光标放在红色的行上，可以显示错误的原因。按F1可得到关于错误纠

正的注意。 
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注意 

如果用键盘而不用鼠标编辑变量表，应始终始能“Brief Information When Using the 

Keyboard”(使用键盘时显示简短信息)特性。 

如果需要，可以通过菜单命令Option>Customize>General修改变量表的设置。 

 

最大限度 

在变量表中每行最多可有255个字符。回车进入第二行是不可能的。一个变量表最多可有

1024行。这是最大限度。 

 

 

20.4.2  插入修改值 

修改值作为注释 

如果你想使变量的“修改值”无效，可以使用菜单命令Variable > Modify Value as 

Comment。一个变量的修改值之前的注释符号“// ”表示它已经无效。命令符号“ // ”

也可以代替菜单命令调用，插在“修改值”的前面。通过再次调用菜单命令Variable > 

Modify Value as Comment 或删除注释符号，可以取消“修改值”的无效性。 

 

 

20.4.3  定时器输入的上限 

注意，下面是输入定时器的上限： 

例如：W#16#3999（BCD格式的最大值） 

 

举例 

地址 监视格式 输入 修改值显示 解释 

T 1 SIMATIC_TIME 137 S5TIME#130MS 转换为毫秒 

MW4 SIMATIC_TIME 137 S5TIME#890MS 可用BCD格式表达 

MW4 HEX 137 W#16#0089 可用BCD格式表达 

MW6 HEX 157 W#16#009D 
不能用BCD格式表达，所以监视格式不能选
择为SIMATIC_TIME 

 

 

注意 
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• 你可以用毫秒级来输入定时器，但输入值会被作一些改变以适应时间结构。时间结构

的大小要根据输入的时间值而定（137变成130ms，7ms被舍去）。 

• 对于数据类型是WORD的地址的修改值，如IW1，被转换为BCD格式。但是，不是所

有的位模式都是有效的BCD码。如果把一个数据类型是WORD的地址的输入表达为

SIMATIC-TIME，则应用程序会自动转向缺省设置（这里是：HEX，请查看选择监视格

式，缺省命令（“view”视窗菜单）），这样数值就可以被显示了。 

 

用于SIMATIC-TIME格式的变量的BCD码 

为变量类型为SIMATIC_TIME的变量输入数值时要用BCD码。16个位具有以下含义： 

| 0 0 x x | h h h h | t t t t | u u u u |  

位15和14 总是零 

位13和12 （标为xx）为位0至位11设置乘数： 

00=>乘数为10毫秒 

01=>乘数为100毫秒 

10=>乘数为1秒 

11=>乘数为10秒 

位11至8为百位（hhhh） 

位7至4为十位（tttt） 

位3至0为个位（uuuu） 

 

20.4.4  计数器输入的上限 

注意下面计数器输入的上限： 

计数器的上限是：C#999 

W#16#0999（BCD格式的最大值） 

 

例如： 

地址 监视格式 输入 修改值显示 解释 

C1  COUNTER 137 C#137 转换 

MW4 COUNTER 137 C#89 可用BCD格式表达 

MW4 HEX 137 W#16#0089 可用BCD格式表达 

MW6 HEX 157 W#16#009D 
可表达为BCD格式，又不能选择
COUNTER格式来监视 

注意 

• 如果你为计数器输入一个十进制数但却没有标识该值为C#，这个值会自动转为BCD格
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式（137变化C#137）。 

• 对于数据类型是WORD的地址的修改值，如IW1，被转换为BCD格式。但是，不是所

有的位模式都是有效的BCD码。如果，数据类型为WORD的地址的输入值无法表达为

COUNTER，则应用程序会自动转向缺省格式（这里为：HEX，请查看选择监视格式，

缺省命令（view视窗菜单）），这样数值就可以被显示了。 

 

20.4.5  插入注释行 

注释行以注释标志“// ”开始。  

如果你想使一行或多行变量表无效（作为一个注释行），可以使用菜单命令Edit > Line 

without effect 或工具栏中相应的符号      。 

 

20.4.6  举例 

20.4.6.1 输入变量表的地址示例 

允许的地址： 数据类型： 举例（英语助记符）： 

Input | Output | Bit memory BOOL I 1.0  | Q 1.7 |  M 10.1 

Input | Output | Bit memory BYTE IB 1  | QB 10 |  MB 100 

Input | Output | Bit memory WORD IW 1  | QW 10 |  MW 100 

Input | Output | Bit memory DWORD ID 1  | QD 10 |  MD 100 

I/O （Input | Output） BYTE PIB 0  | PQB  1 

I/O （Input | Output） WORD PIW 0  | PQW 1 

I/O （Input | Output） DWORD PID 0  | PQD  1 

Timers TIMER T 1 

Counters COUNTER C 1 

Data block BOOL DB1.DBX 1.0 

Data block BYTE DB1.DBB 1 

Data block WORD DB1.DBW 1 

Data block DWORD DB1.DBD 1 

 

注意： 

“DB0…”不允许使用，因为它已被内部占用。 

在强制数值窗口： 

• 对S7-300模板进行强制时，只有输入、输出和I/O（输出）是可以的。 
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• 对S7-400模板作强制时，只有输入、输出、位存储和I/O（输入/输出）是可以的。 

20.4.6.2 输入连续的地址范围的示例 

打开一个变量表并用菜单命令 Insert > Range of Variables 调用“ Insert Range of 

Variables（插入变量范围）”对话框。 

作为对话框的输入，位存储的下列各行被插入到变量表中： 

• From address（开始地址）：M 3.0 

• Number（数量）： 10 

• Display format（显示格式）：BIN 

 

地址 显示格式 

M 3.0 BIN 

M 3.1 BIN 
M 3.2 BIN 

M 3.3 BIN 
M 3.4 BIN 

M 3.5 BIN 
M 3.6 BIN 
M 3.7 BIN 

M 4.0 BIN 
M 4.1 BIN 

注意示例中“地址”栏中从第八项以后字节地址改变。 

20.4.6.3 输入修改值和强制值的示例 

位地址 

可能的位地址 允许修改 /强制值 

I1.0 true 

M1.7 false 
Q10.7 0 

DB1.DBX1.1 1 
I1.1 2#0 
M1.6 2#1 

 

字节地址 

可能的字节地址 允许修改 /强制值 
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IB 1 2#00110011 

MB 12 B#16#1F 

MB 14 1F 
QB 10 ‘a’ 
DB1.DBB 1 10 

PQB 2 -12 

 

字地址 

可能的字地址 允许修改 /强制值 

IW 1 2#0011001100110011 
MW 12 w#16#ABCD 

MW 14 ABCD 
QW 10 B#(12,34) 

DB1.DBW 1 ‘ab’ 
PQW 2 -12345 
MW3 12345 

MW5 s5t#12s340ms 
MW7 0.3s or 0,3s 

MW9 c#123 
MW11 d#1990-12-31 

 

双字地址 

可能的双字地址 允许修改 /强制值 

ID 1 2#00110011001100110011001100110011 

MD 0 23e4 
MD 4 2 

QD 10 dw#16#abcdef10 
QD 12 ABCDEF10 

DB1.DBD 1 b#(12,34,56,78) 
PQD 2 ‘abcd’ 
MD 8 I#-12 

MD 12 I#12 
MD 16 -123456789 

MD 20 123456789 
MD 24 t#12s345ms 

MD 28 tod#1:2:34.567 
MD 32 p#e0.0 

 

 

 

定时器 

可能的”Timer”类型地址 允许修改 /强制值 解释 
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T 1 0 转为毫秒 

T 12 20 转为毫秒 

T 14 12345 转为毫秒 

T 16 s5t#12s340ms  
T 18 3 转为1s300ms 

T 20 3s 转为1s300ms 

修改定时器只影响其数值不影响状态。这意味着定时器T1的时间值可设为零，但却不会改

变A T1的逻辑操作结果。 

字符串5t、s5time，大写或小写均可。 

 

计数器 

可能的“Counter”类型地址 允许修改 /强制值 

C 1 0 

C 14 20 
C 16 c#123 

修改计数器只影响其数值不影响其状态。这意味着可将计数器C1的数值修改为零，却不会

影响A C1的逻辑操作结果。 

 

 

20.5 建立与CPU的连接 

 

为了监视或修改在当前变量表（VAT）中输入的变量，你必须与相应的CPU建立连接。可

以将每个变量表与不同的CPU建立链接。 

 

显示在线连接 

如果有在线连接存在，变量表窗口标题栏中的“ONLINE（在线）”项会显示该情况。状

态栏将显示操作状态“RUN”、“STOP”、“DISCONNECTED”或“CONNECTED”，

这取决于CPU。 

 

建立与CPU在线连接 

如果与所要求的CPU的在线连接不存在，使用菜单命令PLC > Connect To > ⋯来定义与

所需的CPU的连接，以便进行变量的监视或修改。 

中断与CPU的在线连接 

使用菜单命令PLC > Disconnect，可以中断变量表和CPU的连接。 
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注意 

如果用菜单命令Table > New，生成了一个未命名的变量表，你可将它连接到最后组态的

CPU上。 

 

 

20.6 监视变量 

20.6.1  监测变量 

以下方法可用监视变量：  

• 用菜单命令Variable > Monitor，激活监视功能。所选变量的数值依据所设定的触发点

和触发频率显示在变量表中。如果设置触发频率为“Every Cycle（每一循环）”，你

可以用菜单命令Variable > Monitor，将监视功能切换成无效。 

• 你可以使用菜单命令Variable > Update Monitor Values，对所选变量的数值作一次立

即刷新。所选变量的当前数值则显示在变量表中。 

 

用ESC键放弃“监视” 

如果在监视功能激活的状态下按ESC键，该功能则不经询问就退出。 

 

20.6.2  为变量表定义触发 

你可以在编程设备上显示用户程序中每个变量在程序处理过程中的某一特定点（触发点）

的当前数值，以便对它位进行监视。 

当你选中一个触发点时，就决定了监视的变量在哪个时间点的数值被显示出来。 

可以用菜单命令Variable > Trigger，设置触发点和触发频率。 

触发 可能的设置 

触发点 循环开始 

循环结束 

从RUN转换到STOP 

触发频率 一次 

每个周期 

触发点 

下图所示为触发点的位置。 

 
过程映像输入表 

触发点 “Start of cycle（循环开始）” 
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要想监视修改值，你应将监视触发点设在“Status Value”栏上，将修改触发点设在“End 

of cycle”。 

 

立即触发 

你可以用菜单命令Variable > Update Monitor Values，刷新所选变量的数值。这个命令

即为“立即触发”，不参照用户程中的任何点，尽可能快地执行。这些功能主要用于停机

模式下的监视和修改。 

 

触发频率 

下表显示了触发频率对变量监视的影响： 

 触发频率：一次 触发频率：每一个循环 

监视变量 依据触发点的不同只触发
一次 

在定义的触发点上监视 

当测试一个块时，你可以准确地追踪处理的过程 
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20.7 修改变量 

20.7.1  修正变量 

你可以利用下述方法进行变量修改：  

• 用菜单命令Variable > Modify，激活修改功能。在变量表中，根据触发点和触发频率

的设定而对所选变量作的数值修改将应用到用户程序中。如果设置触发频率为“Every 

Cycle（每一循环）”，你可以用菜单命令Variable > Monitor，将监视功能切换成无

效。 

• 你可以用菜单命令Variable > Activate Modify Values，对所选变量的数据作一次立即

刷新。 

强制功能和外设输出（PQ）使能提供一些其它的可能性。 

 

当进行修改时，注意： 

• 只能对那些起动修改功能时在变量表中可以看到的地址进行修改。  

一旦你起动修改功能时缩小了变量表的可视区域，有一些也许已修改了的值却看不到

了。如果把变量表可视区域变大一些，则可看到一些未修改的地址。 

• 修改功能已经做了，就不能再取消（比如，用Edit > Undo）。 

 

危险 

在程序运行中修改变量值，如果功能或程序中出错可能导致对人身或财产的损害。在执行

“修改”功能前，要确认不会有危险情况出现。 

 

用ESC键放弃“修改” 

如果在“Modifying（修改）”功能进行过程中你按了ESC键，该功能无询问退出。 

 

20.7.2  为变量表定义触发 

你可以在程序运行中的某一个特定点（触发点）给用户程序的每个变量赋予固定值（一次

或每一循环）。 

当你选中一个触发点时，就决定了监视的变量在哪个时间点的数值被显示出来。 

可以用菜单命令Variable > Trigger，设置触发点和触发频率。 
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触发 可能的设置 

触发点 循环开始 

循环结束 

从运行转为停机 

触发频率 一次 

每一个循环 

 

触发点 

下图所示为触发点的位置。 

 

 

 

 

 

 

 

 

 

 

 

所示为触发点的位置： 

• 修改输入只适用于触发点“Start of cycle”（对应于用户程序OB1的开始），因为在修

改后将刷新过程映象。 

• 修改输出只适用于触发点“End of cycle”（对应于用户程序OB1的结束），因为用户

程序可以覆盖输出的过程映象。 

要想监视修改值，你应将监视触发点设在“Status Value”段上，将修改触发点设在“End 

of cycle”。 

 

以下是变量修改时不同的触发点的情形：  

• 如果你设置触发频率为“Once”，而所选变量不能被修改时，会显示信息。 

• 对触发频率“Every cycle”则无信息出现。 

 

过程映象输入表 

OB1 

过程映象输出表 

触发点 “Start of cycle（循环开始）” 
 

 触发点 “Start of cycle（循环开始）” 
 

触发点“Transition 
 from RUN to STOP 
（从运行转为停机）” 
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立即触发 

你可以用菜单命令Variable > Activate Modify Values，对所选变量的数值进行修改。这

个命令即为“立即触发”，不参照用户程中的任何点，尽可能快地执行。这个功能主要用

于在停机模式下修改。 

 

触发频率 

下表所示为触发条件的设定对变量修改的影响： 

 触发频率：一次 触发频率：每一个循环 

修改变量 
激活一次 

与触发点无关，你可以
将数值赋给变量一次 

在定义的触发点进行修改 

通过赋予固定数值，你可以为用户程序模拟某一情
形，用这个功能可调试你已编好的功能 

 

 

20.8 强制变量 

20.8.1  强制变量时的安全措施 

 

注意人员伤害和财产损失 

注意，当使用“强制”功能时，任何不正确的操作都可能会：  

• 危及人员的生命或健康或者 

• 造成设备或整个工厂的损失 

 

 

小心（Caution） 

• 在你开始强制功能之前必须检查确保同一时间在同一CPU上没有其他人在执行该功

能。 

• 一个强制作业只能用菜单命令Variable > Stop Forcing，来删除或终止。关闭强制数

值窗口或退出“监视和修改变量”应用程序并不能删除强制作业。 
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• 强制功能不能被取消（例如，用Edit > Undo）。 

• 请阅读有关信息，了解强制和修改之间的差别。 

• 如果一个CPU不支持强制功能，则在变量菜单中与强制有关的所有菜单命令都不能激

活。 

如果用菜单命令Variable > Enable Peripheral Output，使输出禁用失效，所有被强制的

输出模板输出它们的强制值。 

 

 

20.8.2  强制变量 

你可以给用户程序的每个变量赋予固定值，这样它们就不能够被CPU中正在执行的用户程

序改变或覆盖。实现这一功能的要求是CPU支技该功能（如，S7-400的CPU）。通过将固

定值赋给变量这一功能，你可以为用户程序设置特定的情形并用该方法对已编程的功能进

行测试。 

 

“强制数值（ForceValues）”窗口 

只有当“强制数值”窗口处于激活状态，才能选择用于强制的菜单命令。 

要显示这个窗口可选择菜单命令Variable > Display Force Values。 

你只需为CPU打开一个“强制值”窗口。激活的强制作业的变量和它们各自的强制值就都

一起显示在窗口中。 

 

强制数值窗口示例 

 

当前在线连接的名字显示在标题栏中。 

状态栏中显示的是从CPU中读出的强制作业的日期和时间。 

如果没有激活的强制作业，该窗口是空的。 
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在“强制数值”窗口中不同的显示变量的方法有以下含义： 

显示 含  义 

黑体 该变量在CPU中已被赋予固定值 

正常 该变量正在被编辑 

灰色 模板的变量在机架上不存在/未插入或者变量地址错误，显示错误信息  

 
使用变量表中的可强制地址 

选择你要在强制变量窗口中的变量表中输入一个变量，选择变量表及所需的变量，然后调

用菜单命令Variable > Force values来打开强制值窗口。可以强制的变量输入到强制值窗

口中。 

 

使用CPU中的强制作业或建立新的强制作业 

如果“强制数值”窗口是打开并且激活的，则有另外的信息显示：  

• 如果你确认它，该窗口中的改变将会被CPU中已存在的强制作业覆盖。用菜单命令

Edit>Undo，可以重新存储前一窗口的内容。 

• 如果你取消它，当前窗口中的内容就保留下来。  

然后你可以用菜单命令Table > Save As，将“强制数值”窗口的内容存为一个变量表，

或者选择菜单命令Variable > Force：这样就将当前窗口的内容写到CPU中作为一个新

的强制作业。 

变量的监视和修改只能在变量表中进行，不能在“强制数值”窗口。 

 

删除强制值 

调用菜单命令Variable > Display Force Values打开强制值窗口。然后调用菜单命令Variable 

> Delete Force从所选的CPU中删除强制值。 

 

存储强制数值窗口?  

你可以将强制数值窗口中的内容存到一个变量表中。使用菜单命令Insert > Variable 

Table，可以在一个强制数值窗口中重新插入已存储的内容。 

 

在强制数值窗口中关于符号的提示 

除非你从其它的没有符号的应用程序中打开“监视和修改变量”应用功能，否则最后激活

的窗口中的符号会被输入。 

如果你无法输入符号名，则“Symbol（符号）”这一栏被隐藏了。这种情况下，菜单命令

Option > Symlol Table没有激活。 
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20.8.3  强制和修改变量的区别 

下表总结了强制和修改的区别： 

特点/功能 用S7-400强制 用S7-300强制 修改 

位存储(M) Yes - Yes 

定时器和计数器 (T、C) - - Yes 

数据块(DB) - - Yes 

外设输入 (PIB、PIW、PID) Yes - - 

外设输出 (PQB、PQW、PQD) Yes - Yes 

输入和输出(I、Q) Yes Yes Yes 

设置触发 总是立即触发 总是立即触发 一次或每个循环 

功能只影响激活窗口中可视区域的变量 影响所有强制值 影响所有强制值 Yes 

用户程序可覆盖修改/强制值 - Yes Yes 

无中断地有效替换强制数值 Yes Yes - 

当应用程序退出时变量仍保持其数值 Yes Yes - 

与CPU的连接断开后变量仍保持其数据 Yes Yes - 

允许的寻址错误： 

如：IW1 修改/强制值：1 

    IW1 修改/强制值：0 

- - 最后的有效 

 

注意 

• “使能外设输出”时，在相应输出模板上的强制外设输出的强制数值有效；而外设输

出的修改值却无效。 

• 使用强制功能，变量总是有被强制的值。这些值在对用户程序的读取访问过程中被读

取。所有形式的写访问都无效。 

• 用永久修改功能时，对程序的读访问是有效的并可保持到下一触发点。 
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21   用程序状态进行测试 
 

21.1 用程序状态进行测试 

你可以通过显示程序状态（RLO（操作结果），状态位）或为每条指令显示相应寄存器内

容的方法测试你的程序。可以在“Customize”对话框中定义在“LAD/FBD”画面中的显

示范围。在“LAD/STL/FBD：Programming Blocks”窗口中，使用菜单命令Options > 

Customize打开这个对话框。 

 

警告 

在过程运行过程中测试程序，如功能或程序出错，会对人员或财产造成严重损害。  

在你开始这项功能之前，确认不会有危险情况出现。 

 

要求 

要显示程序状态，必须满足下列要求： 

• 你必须存储了没有错误的程序，并且将它们下载到CPU。 

• CPU在运行并且用户程序在执行。 

• 块必须在线打开。 
 

监视程序状态的基本程序 

建议不要调用整个程序进行调试，而应一个块一个块地调用并单独地调试它们。你应该从

调用分层嵌套中最外层的块开始，例如，在OB1中调用它们，通过监视和修改变量功能为

块生成被测试的环境。 

 

 

 

 

 

 

 

在线打开块 

为程序状态定义显示 

定义调用环境（可选） 

为测试选择操作模式 

启动/关闭测试 
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程序状态中测试，并在单步模式下执行程序，测试的操作模式必须设置（见菜单命令Debug

＞Operation）。这些测试功能在过程操作模式下是不可能的。 

 

 

21.2 程序状态显示 

程序状态的显示是循环刷新的。它从所选网络开始。 

 

LAD和FBD中的预设颜色代码 

• 状态满足：绿色连续线 

• 状态不满足：兰色点线 

• 状态未知：黑色连续线 

在“LAD/FBD”选项卡中，使用菜单命令Options ＞ Customize，可改变线型及颜色的

预置。 

 

元素的状态 

• 触点的状态是： 

   - 如果该地址有“1”值则满足， 

   - 如果该地址有“0”值则不满足， 

   - 如果该地址的值不知道则为未知。 

• 带有使能输出（ENO）的元素的状态相应于以ENO输出值为地址的触点的状态。 

• 带有Q输出的元素的状态相应于有该地址值的触点状态。 

• 如果BR位在调用功能后被置位，则调用（CALL）的状态满足。 

• 如果跳转被执行则跳转指令的状态满足，即意味着跳转条件满足。 

• 带有使能输出（ENO）的元素，如果使能输出未被连接则该元素显示为黑色。 

 

线的状态 

• 线的状态如果未知或没有完全运行则是黑色的。 

• 在电力总线开始处的线的状态总是满足的（“1”）。 

• 并行分支开始处线的状态总是满足的（“1”）。 

• 如果一个元素和它前面的线的状态都满足则该元素后面的线的状态满足。 
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• 如果NOT指令前面的线的状态不满足（相反）则NOT指令后面的线状态满足。 

• 在许多线的与逻辑后面的线的状态可以满足，如果： 

   - 与之前至少有一条线的状态被满足。 

   - 分支前的线的状态满足。 

 

参数状态 

• 黑体类型的参数值是当前值。 

• 细体类型的参数值来自前一个循环；该程序区在当前扫描循环中未被处理。 

 

21.3 你应了解的关于在单步模式/断点下进行测试的信息 

在单步模式下进行测试，你可以做以下事情：  

• 一条指令一条指令地执行程序（在单步模式下） 

• 设置断点 

“在单步模式下测试”的功能并不是在所有的可编程控制器上都是可能的（参考相关的可

编程控制器的资料）。 

 

 

 

 

 

 

 

要求 

• 必须对测试模式进行设置。在过程操作模式下单步测试模式是不可能的（见菜单命令

Debug ＞ Operation）。 

• 用单步执行模式测试只有在语句列表的情况下才是可能的。对于在梯形逻辑或功能块

图方式下的块，你必须用菜单命令View > STL改变视窗。 

• 该块不能是被保护的。 

• 块必须在线打开。 

• 已打开的块不能在编辑器中被修改。 
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断点的数量 

断点的数量依据下列情况而变化：  

• 已设置的断点数 

• 运行的变量状态的数目 

• 运行的程序状态的数目 

参考你的可编程控制器的资料，查看它是否支持单步执行模式。 

在“Debug（调试）”菜单中，你可以找到菜单命令用来设置、激活或删除断点。还可以

用断点栏中的图标选择这些菜单命令，用菜单命令View＞Breakpoint Bar显示断点栏。 

 

允许的测试功能 

• 监视/修改变量 

• 模板信息 

• 操作模式 

危险（Danger） 

在HOLD（保持）模式下危险系统状态 

 

21.4 你应该了解的关于HOLD（保持）模式的信息 

如果程序遇到断点，可编程控制器进入HOLD操作模式。 

 

HOLD模式下LED的显示 

• LED  RUN   闪烁 

• LED  STOP  亮 

 

在HOLD模式下程序的处理 

• 在HOLD模式下不处理S7指令码，这意味着没有优先级被进一步处理。 

• 所有定时器被冻结：  

   - 没有定时器单元被处理 

   - 所有监视时间停止 

   - 时间控制层次的基本时钟速率被停止 

• 实时时钟继续运行 

• 为安全原因，在HOLD模式下输出总是禁止的（“输出禁止”）。 
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HOLD模式下电源掉电后的性能 

• 有备份电池的可编程控制器在HOLD模式下，随着电源掉电随后又恢复供电转为STOP

模式并保持在这儿。CPU不执行自动再启动。在STOP模式下你可以决定过程如何继续

（例如，设置/清除断点，执行一个手动再启动）。 

• 没有备份电池的可编程控制器不具有“记忆”，所以当电源恢复后执行一个自动暖启

动，不考虑以前的操作模式。 

 

21.5 编程数据块状态 

版本5以上的STEP 7都可以在数据视窗中在线观察数据块。显示屏可以由在线数据块也可

以由离线数据块激活。在这两种情况下，将显示可编程控制器中在线数据块内容。 

在启动程序状态之前，不能修改数据块。如果在线数据和离线数据块之间有结构差异（声

明），可以根据需要将离线数据块直接下载到可编程控制器中。 

数据块必须位于“data view（数据视窗）”中，以使在线数值可以显示在“Actual Value

（实际数值）”栏中。只有显示屏上可以看见的数据块部分才能刷新。在状态激活时，你

不能切换为声明视窗。 

在正在刷新时，在状态栏中将显示一个绿框，并显示操作模式。 

数值分别以各自的数据类型显示；其格式不能修改。 

在结束程序状态后，“Actual Value（实际数值）”栏将显示程序状态之前的有效内容。不

能将刷新的在线数值传送至离线数据块。 

 

刷新数据类型： 

在共享DB以及实例数据块的所有声明（ in/out/inout/stat）中，都可以刷新所有基本数据类

型。 

有些数据类型不能刷新。当程序状态激活时，包含还没有刷新数据的“Actual Value（实际

数值）”栏中的区域将显示为灰色背景。  

• 复合数据类型DATE_AND_TIME和STRING不能刷新。 

• 在复合数据类型ARRAY、STRUCT、UDT、FB和SFB中，只有那些基本数据类型元素

才能刷新。 

• 在一个实例数据块中的INOUT声明中，只显示复合数据类型指示符，不显示数据类型

的元素本身。指示符不能刷新。 

• 参数类型不能刷新 
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21.6 为程序状态设置显示 

你可以设置程序状态的显示格式为STL、FBD或LAD。 

要设置显示可按如下进行： 

选择菜单命令Options > Customize。 

在“Customize”对话框中，选择STL或LAD/FBD。 

程序所需的选项。可显示下面的状态栏。 

 

激  活 显  示 

状态位 状态位；状态字的第2位 

RLO 状态字的第1位；显示逻辑运算或算术比较的结果 

标准状态 累加器1的内容 

地址寄存器1/2 各自的带间址的地址寄存器的内容 

Accu2 累加器2的内容 

DB寄存器1/2 数据块寄存器的内容，第1个和/或第2个打开的数据块的内容 

间接 间接存储器参考；指针参考(地址)，无地址内容参考；只能对存储器间接寻
址，而不能对寄存器间接寻址。 

如果在语句中有相应的指令，则显示定时器字或计数器字的内容。 

状态字 状态字的所有的状态位 

 

 

21.7 设置测试模式 

要求： 

逻辑块必须在线打开。 

设置块的调用环境(菜单命令Debug > Call Environment)。 

 

步骤： 

令Debug > Operation显示设置的测试环境。 

选择所需的运行模式。可以选择测试运行或处理运行。 
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运行模式 说  明 

测试运行 可以不受限制地使用所有测试功能。 

会明显增加CPU扫描循环时间。 

处理运行 测试功能程序状态是受限制的，以保证在扫描循环时间内最小的调用。 

• 它是指不允许条件调用 

• 在返回点禁止程序循环的状态显示 

• 不允许测试功能HOLD和单步执行 

 

注意 

当通过向CPU赋值参数来设置运行模式时，只能通过更改参数来改变运行模式。另外也可

以在显示的对话框中改变运行模式。 
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22   使用模拟程序（可选软件包）进行测试 
 

22.1 使用模拟程序S7-PLCSIM（可选软件包）进行测试 

有可选软件包PLC Simulation（模拟PLC），你可以在计算机或编程设备（如PG740）上

的模拟可编程控制器上运行并测试你的程序。由于该模拟功能可完全由STEP 7软件实现，

你不需要任何S7硬件（CPU或信号模板）。使用模拟的S7 CPU，你可以对S7-300和S7-400 

CPU作程序测试和故障诊断。 

这个应用程序为监视和修改各种用户程序中使用的参数提供了一个简单的用户界面（如，

输入开关接通和断开）。程序由模拟的CPU处理时，你还可以在STEP 7中使用各种应用程

序。例如，可以用变量表监视和修改变量。 
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23    诊断 
 

23.1 诊断硬件和故障诊断 

你可以通过观察诊断符号来判断一个模板是否有诊断信息。诊断符号可显示相应模板的状

态，对于CPU，还可显示操作模式。 

诊断符号可显示在在线项目窗口以及快速视窗（缺省设置）或调用“Diagnose Hardware

（诊断硬件）”功能时的诊断视窗中。更详细的诊断信息显示在“Module Information（模

板信息）”应用程序中，你可以通过双击快速视窗或诊断视窗中的诊断符号起动该应用程

序。 

 

 

 

 

 

 

 

 

 

 

 

 

 

怎样进行故障定位 

令View＞Online，打开项目的在线窗口。 

打开所有的站，以便看到其中组态的可编程模板。 

查看哪个CPU显示了指示错误或故障的诊断符号。可以用F1键打开对诊断符号进行解释的

帮助页。 

选择你想要检查的站。 
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选择菜单命令PLC > Diagnostics/Settings > Module Information，为该站中的CPU显示模

板信息。 

选择菜单命令PLC > Diagnostics/Settings > Diagnose Hardware，显示CPU的“quick 

view”（快速视窗）”及本站中的故障模板。快速视窗的显示被设作缺省设置（菜单命令

Option＞Customize，“View”选项卡）。 

在快速视察中选择故障模板。 

点击“Module Information（模板信息）”按键，以获得该模板的信息。 

点击快速视窗中的“Open Station Online”按键，显示诊断视窗。诊断视窗中包含了该站

中按槽口顺序排列的所有模板。 

双击诊断视窗中的模板以显示其模板信息。用这种方式，还可以得到那些没有故障因而没

有显示在快速视窗中的模板信息。 

你不一定需要执行上述所有各步，当你得到所需的诊断信息后就可以停止。 

 

23.2 在线视窗中的诊断符号 

诊断符号显示在在线项目窗口和在线组态表的硬件组态窗口。 

诊断符号使得你的故障检查更容易。你只要看一眼模板符号，就知道诊断信息是否已经有

了。如果没有故障出现，模板类型的符号显示则没有附加的诊断符号。 

如果模板的诊断信息已经有了，则会有在模板的符号上增加一个诊断符号，或显示的模板

符号对比度降低。 

 

模板的诊断符号(例：FM / CPU) 

 

符  号 模  式 

      预置组态与实际组态不匹配：被组态的模板不存在，或者插入了不
同类型的模板 

          
故障：模板出现故障  

可能的原因：诊断中断，I/O访问错误，或检查到故障LED 

            
无诊断可能。原因：无在线连接或该CPU不支持模板诊断信息（如：
低压电源或分模数） 
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操作模式的诊断符号(例如：CPU) 

 

符  号 模  式 

 

 
起动（STARTUP） 

 
停机（STOP） 

 
停机（STOP）在多机操作模式下由另一个CPU触发的停机 

 
运行（RUN） 

 
 保持（HOLD） 

 

强制的诊断符号 

 

符  号 含  义 

 在该模板上有变量被强制，即在模板的用户程序中有变量被赋予一
个固定值，该数据值不能被程序改变。  

强制符号还可以与其它符号组合在一起显示（这里是与运行（RUN）
模式符号一起）。 

 

刷新诊断符号的显示 

激活相应的窗口。 

• 按F5或 

• 在窗口中选择菜单命令View＞Update。 

 

 

23.3 诊断硬件：快速视窗 

23.3.1  访问快速视窗功能 

快速视窗提供一种使用“Diagnosing Hardware（硬件诊断）”的快速方法，它所显示的信

息比硬件组态中诊断视窗所显示的细节要少。当“Diagnos Hardware”功能调用时，快速

视窗作为缺省设置显示出来。 
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显示快速视窗 

在SIMATIC管理器中用菜单命令PLC > Diagnostics/Settings > Diagnose Hardware，调用

该功能。 

你可以在下列情况下使用菜单命令： 

• 如果在一个在线项目窗口中选中了一个模板或一个S7/M7程序。 

• 如果在“Accessible Nodes（可访问网点）”窗口中选中了一个站（“MPI=⋯”）并

且该选项属于一个CPU。 

从显示的组态表中，你可以选择想要显示其模板信息的模板。 

 

23.3.2  快速视窗中的信息功能 

下列信息会显示在快速视窗中： 

• 在线连接的CPU的数据 

• CPU的诊断符号 

• 已查到故障的CPU的模板诊断符号（例如，诊断中断、I/O访问错误） 

• 模板类型和地址（机架、槽、带有站号的DP主系统） 

 

快速视窗中的其它诊断选项 

• 显示模板信息 

你可能通过点击“Module Information（模板信息）”键，调用该对话框。对话框依据

所选模板的诊断能力显示详细的诊断信息。特别地，你可以通过CPU的诊断信息显示诊

断缓冲区中的各项内容。 

• 显示诊断视窗 

使用“Open Station Online（打开在线站）”按键，可以打开一个对话框，与快速视窗

相比，该对话框中包含整个站的图形概述以及组态信息。它集中在“CPU/Faulty 

Modules（CPU/故障模板）”列表中被切亮的模板上。 
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23.4 诊断硬件：诊断视窗 

23.4.1  调用诊断视窗 

使用这种方法你可以为机架上的所有模板打开“Modufe Information”对话框。诊断视窗

（组态表）显示不同层的机架中站的实际结构，以及DP站及其模板。 

 

注意 

• 如果离线的组态表已经打开，你可以使用菜单命令Station＞Open Online，打开组态

表的在线视窗。 

• 根据模板的诊断能力的不同，在“Module Information”对话框中显示不同数量的选项

卡。 

• 在“Accessible Nodes”窗口，只有那些有自己的站地址（MPI或PROFIBUS地址）的

模板才能够看得见。 
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从SIMATIC管理器的在线项目视窗中调用 

IMATIC管理器中，使用菜单命令View＞Online，与可编程控制器建立在线连接。 

选择一个站并双击打开。 

然后打开其中的“Hardware”对象。诊断视窗就打开了。 

现在你可以选择一个模板，使用菜单命令PLC > Diagnostics/Settings > Module 

Information调用其模板信息。 

 

从SIMATIC管理器的离线项目视窗中调用 

执行以下步骤： 

IMATIC管理器的项目视窗中选择一个站并双击打开。 

然后打开其中的“Hardware”对象。组态表就打开了。 

选择菜单命令Station＞Open Online。 

模板（如，CPU）所决定的站组态及硬件组态诊断视窗就打开了。模板的状态由符号来指

示。各种符号的含义可参考在线帮助。故障模板以及已经组态但找不到的模板分别列在不

同的对话框中。在这个对话框中你可以直接去找选中的模板（“Go To”键）。 

双击你感兴趣的模板的符号。带有选项卡（依模板类型而不同）的对话框可以给你有关模

板状态的详细分析。 

 

从SIMATIC管理器的“Accessible Nodes”窗口中调用 

执行以下步骤： 

使用菜单命令PLC＞Display Accessible Nodes，在SIMATIC管理器中打开 “Accessible 

Nodes”窗口。 

在“Accessible Node”窗口选择一个站。 

选择菜单命令PLC > Diagnostics/Settings > Diagnose Hardware。 

 

注意 

在“Accessible Nodes”窗口，只有那些有自己的站地址的模板才能够看得见。 
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23.4.2  诊断视窗中的信息功能 

与快速视窗相比，诊断视窗显示在线已有的整个站的组态。包括： 

• 机架组态 

• 所有组态模板的诊断符号 

从这里你可以读每个模板的状态以及CPU模板的操作模式。 

• 模板类型、序号和地址细节、有关组态的注释。 

 

诊断视窗中另外的诊断选项 

双击一个模板，你可以显示该模板的操作模式。 

 

23.5 模板信息 

23.5.1  显示模板信息的选项 

你可以从不同的起点显示“Module Information（模板信息）”对话框。下面的程序是常

用的调用模板信息的方法举例： 

• 在SIMATIC管理器中从项目的“在线”或“离线”视窗。 

• 在SIMATIC管理器的“Accessible Nodes（可访问站）”窗口中。 

• 在硬件组态的诊断视窗。 
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为了要显示有自己的站地址的模板状态，你需要可编程控制器的在线连接。你可以通过项

目的在线视窗或通过“可访问站”窗口建立这种连接。 

 

23.5.2  模板信息功能 

在“Module Information”对话框中，不同的选项卡中有不同的模板信息功能。在激活状

态下显示时，只有那些与所选模板相关的选项卡显示出来。 

 

功能/选项卡 信  息 用  途 

概述 
所选模板的标识数据；比如，定货号、发
行号、状态、机架上的槽 

可将来自所插模板的在线信息与所组态模板
的数据进行比较 

诊断缓冲区 

 

诊断缓冲区中事件一览表以及所选中事件

的详细信息 

使用诊断缓冲区还可在晚些时候对系统错误
进行分析，查找停机原因并对出现的每个诊
断事件分类 

诊断中断 所选模板的诊断数据 用于评估模板故障的原因 

DP从站诊断 所选DP从站（参照EN50170）的诊断数据 评估DP从站中的故障原因 

存储器 
存贮能力所选的CPU或M7功能模板的工
作存储器和装载存储器当前的使用情况 

在传送新的块或扩展了的块传到CPU之前，
可检查CPU/功能模板的装载存储器中是否有
足够的空间，或用于压缩存储器内容 

扫描循环时间 
所选CPU或M7功能模板最长、最短和最近
的循环扫描时间 

用于检查所组态的最小循环时间，最大循环
时间和当前循环时间 

时间系统 
当前时间，操作小时数以及关正同步时钟

的信息（同步周期） 
可显示并设置模板的时间和日期，检查时间

同步 

性能数据 
地址区域和所选模板（CPU/FM）可以使
用的块 

在生成用户程序之前或之中检查CPU是否满
足执行用户程序的要求。例如，装载存储区

的大小或过程映象的大小 

块(可在
“Per-formance   
Data”选项卡中
打开) 

显示所选模板提供范围内所有可用的块类
型，包括O B、SFB、SFC列表，你可将这
些块用于该模板 

检查你的用户程序中可包含或调用哪些标准
块在所选CPU上运行 

 

通讯 
传送速率，通讯连接概述，通讯负载以及
所选模板在通讯总线上最大的信息的容量 

用来决定有多少以及哪种CPU或M7FM的连
接是可能的；有多少可处于使用中 

堆栈 

堆栈选项卡：只能在STOP模式或HOLD模
式下调用  

显示所选模板的B（块）堆栈。然后你还
可以显示I（中断）堆栈，L（局域）堆栈
以及嵌套深度堆栈。可以跳转到中断块的

故障点。 

可判明引起停机的原因并对块进行修改 
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附加的信息显示 

对每个选项卡可显示以下信息： 

• 到所选模板的在线路经。 

• 相应CPU的操作模式（例如：运行、停机） 

• 所选模板的状态（例如：出错、OK） 

• 所选模板的操作模式（例如：运行、停机），如果它有自己的操作模式的话（如CP342-5）。 

在从“Accessible Nodes”窗口打开的非CPU模板的模板信息中，CPU本身的操作模式和

所选模板的状态不能显示。 

 

同时显示许多模板 

你可以同时显示许多模板的模板信息。要做到这一点，你必须到各个模板的上下文中，选

择另一个模板，然后为它调用模板信息。“Module Information（模板信息）”对话框就

会显示出来。为每一个模板只能打开一个对话框。 

 

刷新模板的信息显示 

每次在“Module Information”对话框中转换选项卡时，数据都要再从模板上读过来。但

是，当一页显示之后，其内容不再刷新。如果你点击“Updete（刷新）”按钮，可以在不

改变选项卡的情况下从模板读数据。 

 

 

23.5.3  依模板类型而不同的模板信息的范围 

可以评估和显示的信息范围依赖以下几点： 

• 所选模板，以及 

• 从哪个视窗调用模板信息 

当从组态表的在线视窗或项目窗口调用时可得到全范围的信息。 

从“Accessible Nodes（可访问站）”窗口调用只能得到有限范围内的信息。 

根据信息的范围，模板可分为几类：“有系统诊断能力”、“有诊断能力”或“无诊断能

力”。下图所示为这些类别： 
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• 有系统诊断能力的模板是，如模板FM351和FM354 

• 有诊断能力的模板是大多数的模拟信号模板 

• 没有诊断能力的模板是大多数的数字信号模板 

 

选项卡显示 

下表显示了“模板信息”对话框中每个类型的模板都显示哪些特性选项卡。 

 

选项卡 
CPU或 

M7 FM 

有系统诊断
能力的模板 

有诊断能力
的模板 

无诊断能力
的模板 

DP从站 

常规 有 有 有 有 有 

诊断缓冲区 有 有 --- --- --- 

诊断中断 --- 有 有 --- 有 

存储器 有 --- --- --- --- 

扫描循环时间 有 --- --- --- --- 

系统时间 有 --- --- --- --- 

性能数据 有 --- --- --- --- 

堆栈 有 --- --- --- --- 

通讯 有 --- --- --- --- 

DP从站诊断 --- --- --- --- 有 

H状态1） 有 --- --- --- --- 

1） 只有H系统的CPU 

除了选项卡特性页的信息之外，有操作模式的模板还会显示操作模式。当你从在线的组态

表中打开对话框时，来自CPU的视角的模板状态会被提示（例如，OK、故障、模板不存在）。 

诊断缓冲区和模板的SZL 

模板的诊断数据 

通过模板的CPU的诊断
信息 

有系统诊断能力的模板 

所有模板≠CPU 
 

有诊断能力的模板 
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23.5.4  Y-Link后显示PA现场设备和DP从站的模板状态 

对于STEP 7 V5.1 SP3，在DP/PA链接后(IM 157)可以评估DP从站和PA现场设备的模板状

态。 

它将影响下面的组态： 

• 用于连接PROFIBUS-PA的带DP/PA连接器的IM 157 

• IM 157作为一个冗余的模块化接口模板，用于连接非冗余PROFIBUS- DP(“Y-link”)， 

在该组态中，编程器连接到相同的PROFIBUS子网。 

此外，还有一个选项，通过该选项，PG连接到一个工业以太网，并可以对一个连接到

PROFIBUS子网上的S7-400站进行路由。 

下图显示了该项设置的前提条件。 

 

用于连接PROFIBUS-PA的带DP/PA连接器的IM 157 

 

 

IM 157作为Y-link 
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在工业以太网中的PG 

 

 

23.6 在停机模式下诊断 

23.6.1 判定停机原因的基本程序 

要判断CPU为什么进入“停机”模式，可按如下进行： 

1.  选择已进入停机的CPU。 

2. 选择菜单命令PLC > Diagnostics/Settings > Module Information。 

3. 选择“Diagnostic Buffer（诊断缓冲区）”选项卡。 

4. 你可以从诊断缓冲区中最后一项判定停机的原因。 

如果有编程错误出现： 

输入项“STOP because programming error OB not loaded”意味着，CPU已查到一个编

程错误而且试图启动这个（不存在的）OB块去处理这个编程错误。前一条指出了实际的编

程错误。 

选择与编程错误相关的信息。 

点击“Open Block”按钮。 

选择“Stacks（堆栈）”选项卡。 
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23.6.2  停机模式下堆栈的内容 

通过评估诊断缓冲区和堆栈中的内容，你可以判定用户程序执行过程中引起故障的原因。 

例如，如果由于编程错误或停机指令使CPU进入停机状态。你可以用“ I Stack（中断堆栈）”

“L Stacks（局域堆栈）”和“Nesting Stack（嵌套堆栈）”按钮显示这些堆栈中的内容。

堆栈内容为你提供哪个块中的哪条指令引起CPU进入停机的信息。 

 

B堆栈内容 

B堆栈或称作块堆栈，列出了所有停机前已经被调用但还未完全处理完的块。 

 

I栈内容 

当你点击“I stack（中断堆栈）”的按钮时，中断点的数据则被显示。这个I堆栈，或称中

断堆栈包含着中断时有效的数据或状态，例如：  

• 累加器内容和寄存器内容 

• 打开的数据块和他们的大小 

• 状态字的内容 

• 优先级（嵌套层次） 

• 中断的块 

• 中断后程序将继续处理的块 

 

L堆栈内容 

对于每个列在B堆栈中的块，都可以通过选择该块并点击“L Stack（局域堆栈）”按钮显

示相应的局域数据。 

这个L堆栈，或称作局域数据堆栈，包含中断时用户程序正在工作的块的局域数据。 

解释和评估所显示的局域数据需要更深入地系统知识。显示的第一部分的数据相应于块中

的临时变量。 

 

嵌套堆栈内容 

当你点击“Nesting Stack（嵌套堆栈）”按钮时，显示嵌套堆栈在断点处的内容。 

嵌套堆栈是逻辑操作A(，AN(，O(，ON(，X(和XN(使用的存储区域。 

只有当中断时有括号操作仍在打开，该按钮才激活。 
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23.7 检查扫描循环时间以免除时间错误 

在模板信息的“Scan Cycle Time（循环扫描时间）”选项卡中可以给出有关用户程序扫描

循环时间的信息。 

如果最长的循环时间接近组态的最大扫描循环时间，就会存在由于循环时间的波动引起时

间错误的危险。如果你延长用户程序的最大循环时间（监控时间）则可以避免这种危险。 

如果循环长度短于组态的最小循环时间，则由CPU/FM自动延长循环至组态的最小循环时

间。对于CPU，在这个延长时间内背景OB（OB90）会被处理（如果它已下装）。 

 

设置扫描循环时间 

当你组态硬件时，可以设置最大和最小循环时间。要做这一步，双击组态表离线视窗中的

CPU/FM定义它的特性。你可以在“Cycle/Clock Memory（循环/时钟存储器）”选项卡中

输入适当的值。 

 

23.8 诊断信息的流动 

23.8.1  诊断信息的流动 

下图所示为在SIMATIC S7中诊断信息的流动 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
CPU检查系统错误的诊断功能 

 
 

CPU检查用户错误的诊断功能 

 
模板检查错误并
生 成一个诊断中
断(OB82)的诊断
功能 

诊断中断 系统状态列表 

诊断缓冲区 

用户程序 
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显示诊断信息 

你可以在用户程序中使用SFC 51 RDSYSST读出诊断内容，或者用STEP 7以无格式语言显

示诊断信息。 

它们可以提供以下信息： 

• 错误出现的位置和时间 

• 该输入项所属的诊断事件的类型（用户定义的诊断事件、同步/异步错误、操作模式改

变）。 

 

生成控制组报文 

CPU在诊断缓存区中送入标准诊断事件和扩展诊断事件。如果满足下列条件，它还为标准

诊断事件生成一个过程控制组报文：  

• 你已指定过程控制报文将在STEP 7中生成。 

• 至少有一个过程控制报文的显示单元已在CPU上登录。 

• 一个过程控制组报文生成的条件是当前没有相应级别的过程控制组报文（有七个级

别）。 

• 每个级别可生成一个过程控制组报文。 

 

23.8.2  系统状态列表SSL 

系统状态列表（SSL）描述可编程控制器的当前状态。它提供了组态、当前参数赋值、当

前CPU的状态和次序以及所属模板的概观。 

系统状态列表中的数据只能读不能修改。它是一个实际的列表，只当有请求时才会生成。 

使用系统状态列表能够显示的信息可分为四个区域。 

                             

                               

 

                  

 

 

 

 

系统数据 
 

系统状态列表 

CPU的诊断状态数据 模板的诊断数据 

中断缓存区 
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读出系统状态列表 

如下所示有两种读出系统状态列表的方法：  

• 间接地，通过编程设备中STEP 7的菜单命令（例如，存储器组态、静态CPU数据、状

态显示）。 

• 直接地，在用户程序中通过系统功能SFC51 RDSYSST，输入所需的部分系统状态列表

的号码（见关于该块的帮助）。 

 

系统状态列表的系统数据 

系统数据是CPU内固有的数据或赋值的性能数据。下表所示是可以显示的信息的题目（部

分系统状态列表）： 

 

标  题 信  息 

模板标识 定货号、类型标识以及模板的版本 

CPU特性 系统时间、系统行为（如：多CPU）以及对CPU的语言描述 

存储区 模板的存储器组态（工作存储器的大小） 

系统存储区 
模板的系统存储器（例如：存储位、定时器、计数器的数量、存储
器的类型） 

块类型 
模板中存在哪些块（OB、DB、SDB、FC、FB），某一类型块的最
大数量，以及某一类块的大小 

中断及错误的赋值 中断/错误与OB之间的赋值关系 

中断状态 产生的中断处理 /中断当前的状态 

优先级的状态 由参数设定的哪个OB块被执行，哪个优先级被禁止 

操作模式和模式转换 最后的操作模式和当前操作模式都可以 

 

CPU中的诊断状态数据 

诊断状态数据描述了由系统诊断监视的组件的当前状态。下表所示是可以显示的信息的题

目（部分系统状态列表）： 

 

标  题 信  息 

通讯状态数 当前在系统中设置的所有通讯功能 

诊断模板 在CPU中登录了的有诊断能力的模板 

OB的启动信息列表 有关CPU中OB的启动信息 

启动事件列表 OB的启动事件及优先级 

模板状态信息 关于插入的已赋值的所有模板的状态信息，故障或产生硬件中断 
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模板上的诊断数据 

除CPU之外，还有其它的模板具有诊断能力（SM、CP、FM），它们的数据被存入系统状

态列表。下表所示为能够显示的信息的题目（部分系统状态列表）： 

标  题 信  息 

模板诊断信息 模板起始地址、内部/外部故障、通道故障、参数错误（4字节） 

模板诊断数据 某个特定模板的所有诊断数据 

 

 

23.8.3  传送你自己的诊断报文 

你可以用系统功能SFC 52 WRUSMSG扩展SIMATIC S7的标准系统诊断：  

• 在诊断缓存区中输入你自己的诊断信息（例如，关于用户程序执行的信息）。 

• 传送用户定义的诊断报文到已登录的站（监视设备如PG、OP或TD）。 

 

用户定义的诊断事件 

诊断事件可以被分为事件级别1至F。用户定义的诊断事件属于事件级别8至B。可按如下所

示分为两组：  

• 事件级别8和9包括那些有固定编号和预定文本的报文，你可以根据编号调用。 

• 事件级别A和B包括那些可以由你自己选择分配一个号码（A000至A0FF，B000至B0FF）

和文本的报文。 

 

传送诊断报文到站 

除了可以在诊断缓存区存入用户定义的输入项，你还可以用SFC 52 WRUSMSG将你自己

的用户定义的诊断报文传送到已登录的显示设备上。当用SEND=1调用SFC 52时，诊断报

文被写入传送缓冲区并自动发送到在CPU上登录过的站。 

如果无法传送报文（比如，因为没有登录的显示设备或由于传送缓冲区满了），用户定义

的诊断事件仍然存在诊断缓存区中。 

 

生成一个带应答的报文 

如果你应答了一个用户定义的诊断事件并且想要记录这个应答，可按如下进行：  

• 当事件到来时事件状态将1写入一个BOOL类型的变量，当事件离开时事件状态将0写到

这个变量。 

• 然后你可以用SFB33 ALARM监视这个变量。 
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23.8.4  诊断功能 

系统诊断检测、评估和报告可编程控制器内出现的错误。为这一目的，每个CPU和每个有

系统诊断能力的模板（如FM354）都有一个诊断缓冲区，在这个缓冲区内诊断事件的详细

信息按它们出现的顺序存入。 

 

诊断事件 

下列事项将作为诊断事件显示，例如：  

• 模板上的内部和外部错误 

• CPU中的系统错误 

• 操作模式改变（如，从RUN到STOP） 

• 用户程序中的错误 

• 插入/移走模板 

• 用系统功能SFC52输入的用户报文 

在存储器全清后诊断缓存区中的内容仍然保留。使用诊断缓冲区还可在晚些时候对系统错

误进行分析，查找停机原因并对出现的每个诊断事件分类 

 

获取诊断数据 

你不必为获取系统诊断的诊断数据而编写程序。这是一个可自动运行的标准特性。SIMATIC 

S7提供各种诊断功能。一些诊断功能是集成在CPU上的，另一些由模板提供（SM、CP和

FM）。 

 

显示故障 

内部和外部模板故障会显示在模板的前面板上。有关LED的显示以及对它们的评估的描述

在S7硬件手册中。在S7-300中，内部和外部故障作为一个组错误显示。 

CPU能够识别系统错误和用户程序错误并将诊断信息存入到系统状态列表和诊断缓存区

中。这些诊断信息可以由编程设备读出。 

具有诊断能力的信号模板和功能模板可检测内部和外部模板错误并产生一个诊断中断，你

可以用一个中断OB来响应这个中断。 
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23.9 程序测试 

当CPU检测到程序处理过程中的错误（同步错误）和可编程控制器中的错误（异步错误）

时，CPU会调用适当的组织块（OB）： 

错  误 错误OB 

I/O冗余错误 OB 70 

CPU冗余错误 OB 72 

时间错误 OB 80 

电源错误 OB 81 

诊断中断 OB 82 

插入/移出模板中断 OB 83 

CPU硬件故障 OB 84 

优先级错误 OB 85 

机架故障或分布式I/O的站故障 OB 86 

通讯错误 OB 87 

编程错误 OB 121 

I/O访问错误 OB 122 

如果相应的OB不存在，CPU进入STOP模式。否则，可在OB中存储指令以决定对这种错误

作何反应。这意味着错误的影响可以减小或根除。 

 

基本程序 

生成并打开OB 

显示CPU的模板信息。 

选择“Performance Data（性能数据）”选项卡。 

在所显示的列表的基础上，决定你要编程的OB是否能在该CPU上执行。 

在你的程序的“Block（软件块）文件夹中插入OB并打开该OB块。 

为故障处理输入程序。 

将OB下载到可编程控制器。 

 

故障处理的编程措施 

评估OB块的局域数据以判断故障的确切原因。局域数据中的变量OB8xFLTID和

OB12xSWFLT中包含错误代码。有关它们的含义的描述在《系统和标准功能参考手册》里。 

转向响应故障的程序段 
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在标头为“用SFC51 （RDSYSST）作模板诊断的示例”的关于系统和标准功能的在

线帮助中，你能够找到处理诊断中断的示例。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.1  评估输出参数RET_VAL 

系统功能用输出参数RET_VAL（返回值）指示CPU是否正确地执行了SFC功能。 

 

返回值中的错误信息 

返回值是整数类型（INT）。整数的符号位指示该整数是正还是负。返回值与数值“0”之

间的关系用以指示在功能执行过程中是否有错误出现（见下表）：  

• 如果功能执行时出现错误，返回值小于“0”。整数的符号位是“1”。 

• 如果功能执行时没有错误，返回值大于等于“0”。整数的符号位是“0”。 

 

由CPU处理SFC 返回值 整数的符号 

错误出现 小于“0” 负（符号位是“1”） 

没有错误 大于等于“0” 正（符号位是“0”） 

 

对故障信息的反应 

如果在SFC执行时出现错误，SFC在返回值（RET_VAL）中提供一个错误代码。 

作以下区分：  

• 所有SFC都可以输出的通用错误代码以及 

• 依据SFC的特定功能而输出的特定错误代码 

 

传送功能值 

有些SFC还用输出参数RET_VAL来传送功能值，例如SFC64TIMETCK用RET_VAL传送它已

读出的系统时间。 

在SFB/SFC帮助中可以找到一些有关输出程序SFB/SFC更详细的信息。 
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23.9.2  故障OB作为对已检测错误的响应 

 

可检测的错误 

系统程序可以检测以下错误： 

• 不正确的CPU功能 

• 系统程序执行中的错误 

• 用户程序中的错误 

• I/O中的错误 

根据错误类型的不同，CPU被设定为STOP模式或调用一个故障OB。 

 

编程响应 

你可以设计程序响应不同类型的错误，并决定CPU的反应方式。为某个特定的错误而编制

的程序可以保存在一个故障OB中。如果故障OB块被调用，程序就会被执行。 

 

 

 

 

 

 

 

故障OB 

按如下所示区别同步错误和异步错误： 

• 同步错误可以分配给一个MC7指令（例如，对一个已移走的信号模板作装载操作）。 

• 异步错误可分配给一个优先级或给整个可编程控制器（例如循环超时）。 

下表所示为可能出现的错误类型。参考你的《S7-300可编程控制器，硬件及安装手册》或

《S7-400，M7-400可编程控制器，硬件及安装手册》，可找到有关你的CPU是否支持这些

特定的OB的信息。 

 

错误级别 错误类型 OB 优先级 

冗余 I/O冗余错误(只在H CPU中 ) OB 70 25 

 CPU冗余错误(只在H CPU中) OB 72 28 

一个错误出现 

CPU调用相应的故障OB 

如果编写了故障OB，CPU执行OB中的程
序，如果没有编OB，CPU进行“STOP”
模式。（如：OB 81） 
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错误级别 错误类型 OB 优先级 

异步的故障 时间错误 OB 80 26 

 电源错误 OB 81 
（或者28如果故障OB在启
动程序中调用了） 

 诊断中断 OB 82 启动程序 

 插入/移出模板中断 OB 83  

 CPU硬件故障 OB 84  

 程序顺序错误 OB 85  

 机架坏了 OB 86  

 通讯错误 OB 87  

同步 编程错误 OB 121 引起错误的OB的优先级 

 I/O访问错误 OB 122  

 

故障OB81使用举例 

使用错误OB的局域数据（启动信息），可以判断已出现的错误的类型。 

例如，如果CPU检测到一个电池故障，操作系统则调用OB81（见图）。 

 

 

 

 

 

 

 

 

 

 

 

你可以编写一个程序来判定由于OB81的调用而触发的事件代码。也可以编写程序作出响

应，如，激活与操作站上的指示灯相连的输出。 

 

1  不适用于S7-300 

 程序执行  操作系统 21   电池没电了（CPU）1 
22   无备份电压（CPU）1 

23   24 V 电源掉电（CPU） 1  
31   电池没电了（扩展单元）1 
32   无备份电压（扩展单元）1 
33   24V电源故障（扩展单元）1 

CPU检测到一个电池故障 OB81 检测已查出的电源故障的
类型并显示错误是否是由电池故

障造成的。 OB 81 
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故障OB81的局域数据 

下图所示为在这种情况下必须在OB81的变量声明表中进行声明的临时变量。 

符号“Battery error（BOOL）”必须标识为输出（例如，Q4.0），这样程序的其它部分就

能够访问这些数据了。 

声明 名  称 类型 描  述 

TEMP OB81EVCLASS BYTE 错误级别 /错误标识39xx 

TEMP OB81FLTID BYTE 错误代码：  

b#16#21 =  
CPU中至少有一个备份电池没电了1） 

b#16#22 =  
在CPU中无备份电压 

b#16#23 =  
CPU中24-V电源掉电1） 

the CPU 1  
b#16#31 =  
至少有一个扩展机架上的一个备份电池没电了1） 

b#16#32 =  
在一个扩展机架上没有备份电压1） 

b#16#33 =  
一个扩展机架24V电源掉电1） 

TEMP OB81PRIORITY BYTE 优先级=26/28 

TEMP OB81OBNUMBR BYTE 81 = OB81 

TEMP OB81RESERVED1 BYTE 保留 

TEMP OB81RESERVED2 BYTE 保留 

TEMP OB81MDLADDR INT 保留 

TEMP OB81RESERVED3 BYTE 
 

只与错误代码 

B#16#31，B#16#32，B#16#33相关 

TEMP OB81RESERVED4 BYTE  

TEMP OB81RESERVED5 BYTE  
TEMP OB81RESERVED6 BYTE  

TEMP OB81DATETIME DATEAND 
TIME 

启动OB的日期和时间 

1）=不适用于S7-300 

 

故障OB81程序举例 

在STL程序举例中说明了如何在OB81中读错误代码。 

程序结构如下： 

• OB81中的错误代码（OB81 FLTID）被读出并与事件“电池没电”（B#16#3921）的

数值作比较。 



诊断 

 23-24 

• 如果错误代码符合“（battery exhausted）电池没电”的代码，程序则跳到标号为Berr

的指令并激活输出batteryerror。 

• 如果错误代码与“（battery exhausted）电池没电”的代码不符，程序则将错误代码

与“电池故障”的代码作比较。 

• 如果错误代码符合“电池故障”代码，程序跳转到标号“Berr”，并激活输出

“batteryerror”。否则该块结束。 

 

AWL                  说明 

L     B#16#21    // 比较事件代码“电池没电” 

// （B#16#21）  

L  #OB81_FLT_ID   // 与OB81的错误代码。 

==I      // 如果相同（电池没电）， 

// 跳转到Berr。 

JC Berr 

L  B#16#21    // 比较事件代码“电池故障” 

//（b#16#22）  

==I      // 与OB81的错误代码。 

JC BF      // 如果不相同，跳转到 Berr。 

BEU      // 无电池故障信息 

Berr：L B#16#39           // 与下一事件ID进行比较 

L  #OB81_EV_CLASS  // OB81的错误代码。 

==I      // 如果电池故障或电池没电找到， 

S  batteryerror   // 设置输出“battery error”。 

//（符号表变量） 

L  B#16#38    // 比较ID，以确定OB81 

==I      // 错误代码事件。 

R batteryerror   // 复位输出“battery error”，当错误固定时。 

 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息以及事件ID解释。 
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23.9.3  为故障诊断插入替代值 

对于某种类型的故障（如，受断线影响的输入信号），你可以为由于故障而无法使用的数

值提供一个替代位。可用以下两种方法来提供替代值：  

• 用STEP 7为可组态的输出模板分配替代值。无法得到赋值参数的输出模板用缺省替代

值。 

• 用SFC44 RPLVAL，可以在故障OB中编程替代值（只适用于输入模板）。 

对于所有引起同步错误的装载指令，你可以在故障OB中为累加器内容指定一个替代值。 

 

替代数值程序举例 

在以下示例程序中，在SFC44RPLVAL中有一个可用的替代值。下图说明了CPU是如何在

检测到一个输入模板没有反应时调用OB122的。 

在这个示例中，下图所示的替代值在程序中被输入，这样程序就可以用可行的数值继续操

作。 

 

如果一个输入模板有故障，执行指令L PIB0就会产生一个同步错误并启动OB122。作为标

准，这个装载指令读得数值0。然而，用SFC44，你可以为过程定义任何合适的值。SFC用

指定的替代值替换累加器中的内容。 

以下示例程序可写在OB122中。下表所示为在这种情况下，在OB122的变量声明表中必须

声明的临时变量。 

 

       替换值: 
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声明 名称 类型 描述 

TEMP OB122EVCLASS BYTE 错误级别 /错误ID29xx 

TEMP OB122SWFLT BYTE 
错误代码：  

16#42， 16#43， 16#44 1）， 16#45 
1） 

TEMP OB122PRIORITY BYTE 优先级=错误出现的O B的优先级 

TEMP OB122OBNUMBR BYTE 122 = OB122 

TEMP OB122BLKTYPE BYTE 错误出现的块的类型 

TEMP OB122MEMAREA BYTE 存储区域和访问类型 

TEMP OB122MEMADDR WORD 出错的存储器地址 

TEMP OB122BLKNUM WORD 出错的块的号码 

TEMP OB122PRGADDR WORD 出错指令的相对地址 

TEMP OB122DATETIME DATEANDTIME 启动OB的日期和时间 

TEMP 错误 INT 存储SFC44的错误代码 

1）不适用于S7-300 

 

STL       说明 

L  B#16#2942 为应答读I/O时出现的时间错误，将OB122的事件码与事件码 

L     （B#16#2942）比较，  
#OB122SWFLT  如果一样跳到“Aerr”。 
==I      为寻址错误（向一个不存在的模板作写操作）将OB122的事件代 
JC Aerr   码与事件代码（B#16#2943）作比较。如果一样跳到“STOP”。 
L  B#16#2943 标号“Aerr”：将DW#16#2912（二进制10010）传送到SFC44 
<> I    （REPL_VAL）。SFC 44将该值装载到累加器1（替代由OB122 
JC Stop   调用而触发的数值）。SFC的错误代码存储在#Error。 
 

Aerr：    CALL ”REPL_VAL" 
VAL ：= DW#16#2912 将#Error与0比较（如果相同则OB122执行时没出错）。 
RETVAL ：= #Error 如果没有错结束块。 
L  #Erro 
L  0   “Stop”标号：调用SFC46“STP”， 
==I     将CPU转为STOP模式。 
BEC 
 

Stop：    CALL “STP" 
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23.9.4  I/O冗余错误（OB70） 

说明 

对于H CPU的操作系统，如果PROFIBUS DP上出现冗余丢失（如，DP主站总线故障或DP

从站接口模板故障），或者，如果带有转换I/O的DP从站变为激活的DP主站时，系统调用

OB70。 

 

编程OB70 

你必须用STEP 7在用户程序中将OB70作为一个对象生成。在生成的块中编写要在OB70中

执行的程序，并作为你的用户程序的一部分下载到CPU。 

例如，你可以为如下目的使用OB70： 

• 要评估OB70中的运动信息并判定哪个条件触发了I/O冗余丢失。 

• 用SFC51RDSYSST判定你的系统的状态。（SZLID=B#16#71）。 

如果出现I/O冗余错误且OB70没有编程，CPU不停机。 

如果OB70下载了并且H系统不在冗余模式，OB70在两个CPU中都被处理。H系统保持在冗

余模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.5  CPU冗余错误（OB72） 

说明 

如果出现以下事件之一，H CPU的操作系统调用OB72：  

• CPU冗余丢失 

• 比较错误（如RAM、PIQ）  

• 待机主站切断 

• 同步错误 

• SYNC子模块出错 

• 刷新过程被放弃 

• OB72被所有的CPU执行， CPU在一个伴随的起动事件后，处于RUN或STARTUP模式。 

 

 

 

 



诊断 

 23-28 

编程OB72 

必须使用STEP 7在你的S7用户程序中将OB72作为一个对象生成。在生成的块中编写将由

OB72执行的程序并将它作为你的用户程序的一部分下载到CPU。 

例如，你可以为以下目的使用OB72：  

• 要评估OB72中的起动信息和判定哪个事件触发了CPU冗余的丢失。 

• 用SFC51RDSYSST判定你的系统的状态。（SZLID=B#16#71）。 

• 要为系统对CPU的冗余丢失作出特定的反应。 

如果出现CPU冗余错误，并且OB72没有编程，CPU不会转为STOP模式。 

在相应的块帮助中，可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.6  时间错误（OB80） 

说明 

当有时间错误出现时CPU的操作系统调用OB80。时间错误包括以下，如：  

• 超过最大循环时间 

• 通过向前修改时间而跳过日时钟中断 

• 处理优先级时延迟太多 

 

编程OB80 

必须用STEP 7在你的S7程序中将OB80作为一个对数生成。在生成的块中编写要在OB80

中执行的程序并将它作为你的用户程序的一部分下载到CPU。 

例如，可为以下目的使用OB80： 

• 要评估OB80中的起动信息和判定哪个日时钟中断被跳过。 

• 通过使用SFC29 CANTINT，可以取消已被跳过的日时钟中断而不再执行它，只有与新

的时间相关的日时钟中断全被执行。 

如果你没有在OB80中取消跳过的日时钟中断，则第一个跳过的日时钟中断被执行，所有其

它的被忽略。 

如果你没有编程OB80，当CPU检测量到一个时间错误时转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 
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23.9.7  电源故障（OB81） 

说明 

如果在CPU中或在扩展单元中有以下故障出现，CPU的操作系统调用OB81 

• 24V电压提供 

• 电池 

• 完全备份 

当问题消除时OB也会被调用（OB在事件到来和离开时被调用）。 

 

编程OB81 

必须用STEP 7在你的S7程序中将OB81作为一个对象生成。在生成的块中编写要在OB81

中执行的程序并将它作为你的用户程序的一部分下载到CPU。 

例如，你可以为如下目的编写OB81： 

• 要评估OB81的起动信息以及判定出现哪个电源故障。 

• 要查找有电源故障的机架的号码。 

• 要激活操作站上的灯指示维护人员应该换电池了。 

与其它的异步故障OB相反，如果没有编写OB81，CPU检测到电源故障时不会转为STOP

模式。但是这个错误会存入诊断缓冲区并且前面板上相应的LED灯亮，指示错误。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.8  诊断中断（OB82） 

说明 

对于一个有诊断能力的模板，如果你使能了它的诊断中断，当它检测到错误，以及错误消

除时CPU的操作系统会调用OB82。（该OB在事件到来和离去时都会被调用）。 

 

编程OB82 

必须用STEP 7在你的S7程序中将OB82作为一个对象生成。在生成的块中编写要在OB82

中执行的程序，并将它作为你的用户程序的一部分下载到CPU中。 

例如，你可为以下目的使用OB82： 

• 要评估OB82的起动信息。 

• 要获得与已出现的错误有关的更确切的诊断信息。 
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当一个诊断中断被触发时，有问题的模板自动地在诊断中断OB的起动信息和诊断缓冲区中

存入4个字节的诊断数据及其起始地址。这就为你提供了错误何时出现以及出现在哪个模板

上的信息。 

在OB82中编写合适的程序，你可以进一步地评估模板的诊断数据（哪个通道出错，出现的

是哪种错误）。使用SFC51 RDSYSST可以读出模板的诊断数据，用SFC52WRUSRMSG

可以将这些信息存入诊断缓冲区。你也可以发送一个用户定义的诊断报文到监控设备。 

如果没有编写OB82，当诊断中断被触发时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.9  插入/移开模块中断（OB83） 

说明 

S7-400CPU以大约1秒的间隔监视着中央机架和扩展机架上现有的模板。 

在电池上电后，CPU检测由STEP 7生成的组态表中所列的所有模板是否都实际地插入了。

如果所有模板都有，这个实际组态被存储并用作对模板进行循环监控的参考值。在每一扫

描循环，新检测到的实际组态与原来的实际组态作比较。如果发现两个组态有差异，则发

出插入/移开模板中断信号，并且有信息存入诊断缓冲区和系统状态列表。在RUN模式下，

启动插入/移开模板中断OB。 

注意 

电源模板、CPU和IM不能在RUN模式下移开。  

在移走和插入模板两个操作之间应至少相隔两秒，以便让CPU检测到移走的或插入的模板。 

 

对新插入的模板进行参数赋值 

如果一个模板在RUN模式下插入，CPU会检测新模板的类型与原来模板是否匹配。如果匹

配，对该模板赋予参数。缺省参数或用STEP 7分配的参数被传送到模板中。 

 

编程OB83 

必须使用STEP 7在你的S7程序中将OB83作为一个对数生成。在生成的块中编写要在OB83

中执行的程序，并将它作为你的用户程序的一部分下载到CPU中。 

例如，你可以为以下目的使用OB83： 

• 要评估OB83的起动信息。 

• 用系统功能SFC55至59对新插入的模板赋值参数。 
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如果没有编写OB83，为一个插入/移开模板中断出现时，CPU从RUN转为STOP。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.10  CPU硬件故障（OB84） 

说明 

当CPU检测到连至MPI网络的接口故障、连至通讯总线的接口故障或连至分布式I/O网卡的

接口故障时操作系统调用OB84；例如，在总线上检测到一个不正确的信号层。故障消除时

也会调用该OB块（事件到来和离开时都调用该OB）。 

 

编程OB84 

必须使用STEP 7在你的S7程序中将OB84作为一个对象生成。在生成的块中编写要在OB84

中执行的程序并将它作为你的用户程序的一部分下载到CPU。 

你可以为以下目的使用OB84： 

• 要评估OB84的起动信息。 

• 用系统功能SFC52 WRUSMSG发送报文至诊断缓存区。 

如果OB84没有编程，当检测到CPU硬件错误时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.11   编程顺序错误（OB85） 

说明 

CPU的操作系统调用OB85： 

• 当一个中断OB的起动事件存在，但该OB块由于没有下载到CPU而不能被执行时。 

• 当访问一个系统功能块的背景数据块时出错。 

• 当刷新过程映象表时出错（模板不存在或出故障）。 

 

编程OB85 

必须用STEP 7在你的S7程序中将OB85作为一个对象生成。在生成的块中编写要在OB85

中执行的程序并将它作为你的用户程序的一部分下载到CPU。 

例如，你可以为以下目的使用OB85：  

• 要评估OB85的起动信息和判定哪个模板损坏或没插入（指定模板的起始地址）。 
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• 用SFC49 LGCGADR查找相关模板所在的槽。 

如果没有编写OB85，当优先级错误被检测到时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

 

23.9.12  机架故障（OB86） 

说明 

当检测到机架故障时，CPU的操作系统调用OB86，如：  

• 机架故障（找不到IM或IM损坏，或者连接电缆断线） 

• 机架上的分布电源故障 

• 在SINEC L2-DP总线系统的主系统中有一个DP从站出故障 

故障消除时也会调用该OB块（事件到来和离开时都调用该OB）。 

 

编程OB86 

必须用STEP 7在你的S7程序中将OB86作为对象生成。在生成的块中编写要在OB86中执行

的程序，并将它作为你的用户程序的一部分下载到CPU中。 

例如，你可以为以下目的使用OB86： 

• 要评估OB86的起动信息和判定哪个机架损坏或找不到。 

• 用系统功能SFC 52 WRUSNSG将报文存入诊断缓冲区，并发送报文到监视设备上。 

如果没有编写OB86，当检测到机架故障时CPU转为8TOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

 

23.9.13  通讯错误（OB87） 

说明 

当使用通讯功能块或全局数据通讯进行数据交换时出现通讯错误，CPU的操作系统调用

OB87，例如：  

• 当接收全局数据时，检测到不正确的帧标识。 

• 用于全局数据状态信息的数据块不存在或太短出。 
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编程OB87 

必须用STEP 7在你的S7程序中将OB87作出一个对象生成。在生成块中编写要在OB87中执

行的程序，并将它作为你的用户程序的一部分下载到CPU。 

例如，你可以为以下目的使用OB87： 

• 要评估OB87的起动信息。 

• 如果找不到用于全局数据通讯状态信息的数据块，要生成该数据块。 

如果OB87没有编程，当检测到通讯错误时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.14   编程错误（OB121） 

说明 

当出现编程错误时，CPU的操作系统调用OB121，例如：  

• 寻址的定时器不存在。 

• 调用的块未装载。 

 

编程OB121 

必须使用STEP 7在你的用户程序中将OB121作为一个对象生成。在生成的块中编写要在

OB121中执行的程序，并将它作为你的用户程序的一部分下载到CPU中。 

例如，你可以为以下目的使用OB121： 

• 要评估OB121的起动信息。 

• 要在报文数据块中存入故障原因。 

如果不编写OB121，当检测到编程错误时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 

 

23.9.15   I/O访问错误（OB122） 

说明 

当STEP 7指令访问一个输入或输出信号模板，而在最近的一次暖起动中没有这样的模板被

赋值，CPU的操作系统会调用OB122，例如：  

• 直接访问I/O出错（模板损坏或找不到） 

• 访问一个CPU不能识别的I/O地址 
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编程OB122 

必须使用STEP 7在你的用户程序中将OB122作为一个对象生成。在生成的块中编写要在

OB122中执行的程序，并将它作为你的用户程序的一部分下载到CPU中。 

你可以为以下目的使用OB122： 

• 要评估OB122的起动信息。 

• 要调用系统功能SFC44为输入模板提供一个替代值以便使程序可以用这个有意义的、随

过程变化的数值继续执行。 

如果不编写OB122，当检测到I/O访问错误时CPU转为STOP模式。 

在相应的块帮助中可以找有关OB、SFB、SFC的更详细的信息。 
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24  打印与归档 
 

24.1 打印项目文献 

当你完成了为你的自动化任务而编制的程序之后，你便可以利用集成于STEP7中的打印功

能将所有重要数据打印出来，作为项目的文献资料。 

 

你能够打印的项目中的部分 

你可以从SIMATIC管理器直接打印选定对象的内容，也可以打开相关的对象再起动打印过

程。 

一个项目中的下列部分能够由SIMATIC管理器直接打印出来： 

• 选定对象的树形图（项目或库的结构） 

• 选定对象的清单（一个对象文件夹的目录） 

• 选定对象的内容 

• 信息 

通过打开相关的对象，一个项目中的下列部分可以打印出来： 

• 以梯形图，语句表或功能图表述的程序模块，也能以其它语言表述（选件） 

• 带有符号名称和绝对地址的符号表 

• 组态表，包括可编程控制器中模块的排列及模块参数 

• 诊断缓冲器的内容诊断缓冲区 

• 变量表，包括监控格式及监控值和更改值 

• 参考数据，例如：交叉表、分配表、程序结构、未使用地址表、无符号地址表 

• 全局数据表 

• 带有模块状态的模块信息 

• 操作者相关文本（用户文本和文本库） 

• 选件软件包的文献，例如其它编程语言 

 

DOCPRO选件软件包 

为了生成，编辑和打印标准化的接线手册，你可以使用选件软件包DOCPRO。该软件包可

生成符合DIN和ANSI标准的工厂文献。 
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24.1.1  打印的基本步骤 

打印的步骤如下： 

打开相关的对象，将你想要打印的信息显示在屏幕上； 

在应用窗口上用菜单命令File＞Print 打开“打印”对话框。根据你所在的应用窗口不同，

菜单条上的第一项可能不是“File”而是要应用的处理对象如“Symbol Table符号表”。 

在打印对话框中，按需要改变打印选项（打印机，打印范围，份数等），然后关闭对话框。 

有些对话框有“打印”按钮，例如“模块信息”对话框。点击该按钮即可打印对话框的内

容。 

程序模块不需要打开。你可以从SIMATIC管理将其直接打印出来，使用的菜单命令为File

＞Print。 

 

24.1.2  打印功能 

对于打印对象所具有的附加功能见下表： 

打印对象 菜单命令 功能 功能 功能 功能 

  打印预览 页面设定 页头页脚 打印设定 

程序模块STL源文件 File > * • • — • 

模板信息  — • — — 

全局数据表 GD Table> * • • — • 

组态表 Station > * • • — • 

对象，对象文件夹 File > * — • • • 

参考数据 Reference Data >  * • • — • 

符号表 Symbol Table >   * • • —— • 

变量表 Table> * --- • --- • 

连接表 网络> * • • --- • 

操作者相关文本（用
户文本，文本库） 

Texts • • --- • 

* ： *号是通配符，表示菜单命令中的相关功能（例如，打印预览或页面设定） 

对于每个单独的打印对象的逐步引导说明，可以在“How to Print（如何打印）”之下找

到。 

 

 

打印预览 

利用“打印预览”功能，可以显示需要打印文献的页面布局。 
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若文献包含有若干页，则在每页的右下角页码的后边会显示两个圆点记号。最后一页上没

有这两个记号，表明无后续页。 

注意 

文献最终的打印格式在打印预览中不能显示。 

 

设定页面格式 

在SIMATIC管理器中，使用菜单命令File > Page Setup，你可以设定所有STEP 7应用程序

以及你想打印的任选软件包的页面格式（例如A4、A5、信纸）。在每个应用程序中（例如

符号编程器），可以设定只适用于当前段的临时设置。 

调整文献的页面布局使其符合打印纸的格式。若文献过宽，右侧的页边会打印到后续页上。 

如果你选择带有页边的页面格式（如A4带页边），则打印出来的文献在页的左侧留出一个

页边，使你可以穿孔和装订。 

注意 

若需要有关“页面设定”对话框的帮助，可将光标置于对话框，点击“帮助”按钮或按F1

键。 

 

设定页头页脚 

利用SIMATIC管理器中的“File＞Headers and Footers”功能，你可以为想要打印的整个

项目文献设定页头页脚。若文献包含有若干页，则在每页的右下角页码的后边会显示两个

圆点记号。最后一页上没有这两个记号，表明无后续页。这是一种简捷的方法用以检查打

印是否完整。这两个记号在打印预览中也可见。 

 

打印设定 

利用“打印设定”功能，你可以选择打印机和设定纸张格式（水平或直立放置）。这种设

定功能，取决于所使用的打印驱动程序。 

 

24.1.3  关于打印选定对象的树形图的特别说明 

在“打印对象清单”对话框中，除了对象清单之外，你还可以通过选中“树形图”选项而

打印出对象的树形图。 

若你在“打印范围”之下选择“全部”，则整个树形图可被打印出来。若你选择按钮“选

择”，则打印出从被选中对象以下的树形图。 

注意 
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这种在对话框中的设定，仅适用于打印清单和树形图，而不适应于打印对象的内容；打印

内容时在相应的应用中有相关的设定。 

 

 

24.2 项目和库的归档 

你可以将项目或库以压缩的形式存入一个归档文件中。这种压缩存储过程可以在硬盘上进

行也可以在一种便携的数据载体上进行（例如，用软盘）。 
 

归档程序 

归档功能为你提供了一个调用你所选定的归档程序的接口。归档程序ARJ和PKZIP 4.0作为

一个组成部分已包含在STEP 7软件包内。如果你要使用下列归档程序中的一个，则应选择

如下指明的版本（或更新的版本）：  

• ARJ 版本2.4.1a以上 

• PKZIP 版本2.04g以上 

• LHARC 版本2.13以上 

• WinZip 版本6.0以上 

• JAR 版本1.02以上 

 

关于归档的建议 

具有长文件名的项目（文件名字符数多于传统8.3DOS格式）或包含有多层目录结构（带有

目录其路径名称总长多于64字符）的项目，必须使用归档程序PKZIP 4.0，WinZip AR进行

归档。若使用其它归档程序，则不能保证原有结构维持不变，以及归档文件能够正确完整

地解压缩。对于包含有从WinCC选件软件包得到的对象的项目，这一点应特别注意。 
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24.2.1  使用保存/归档 

另存为（SAVE As） 

利用此功能你可以生成一个项目带有另外的名称的副本。 

你可以利用此功能： 

• 生成备份用副本。 

• 复制一个存在的项目以便修改后用于其它目的。 

用最快的方法生成一个副本，应选择“Save as”选项并且不重新安排对话框。从项目目录

向下的整个文件结构都不作任何检查地被复制并存于另外的名称之下。 

为了存储备份用副本数据载体上必须有足够的空间。不要试图将项目存于软盘上。因为通

常软盘上的空间往往不够。为了将项目数据转移到软盘上应使用“归档”功能。 

重新安排的保存会耗时较长，而且当对象不能被复制和保存时会显示出一条信息。引起的

原因可能是一个对象所需的选项软件包或数据不完全。 

 

归档 

你可以将项目或库以压缩的形式存入一个归档文件中。这种压缩存储过程可以在硬盘上进

行也可以在一种便携的数据载体上进行（例如，用软盘）。 

将项目转移到软盘只能用归档文件的形式。若一个项目过大，则在选用归档程序时注意其

应具有生成多张软盘上连续归档文件的功能。 

被以压缩形式存入一个归档文件的项目或库不能被编辑修改。若你希望对它们进行编辑，

就必须将数据解压缩，即恢复项目或库。 

 

 

24.2.2  对归档的要求 

为了将一个项目或一个库进行归档，必须满足以下要求：   

• 你必须在系统中安装归档程序。与STEP 7的连接在在线帮助中有说明，题目为“归档/

恢复的步骤”。 

• 所有与项目有关的数据无一例外地必须在项目目录之内或项目子目录之内。当使用C语

言开发环境时，有可能将数据存储在其它位置。这些数将不会被包括到归档文件中。 

• 如果你使用归档程序ARJ，PKZip版本2.04g或LHA，文件名称必须符合DOS文件名的规

定（8字符文件名加3字符扩展名），因为这些程序是DOS程序。若使用PKZip版本4.0，

JAR和WinZip则不必遵守上述对文件名的规定。 
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24.2.3  归档/恢复的步骤 

你可以对你的项目或库进行归档和恢复，使用的菜单命令为File＞Archive或File＞

Retrieve。 

注意 

被以压缩形式存入一个归档文件的项目或库不能被编辑修改。若你希望对它们进行编辑，

就必须将数据解压缩，即恢复项目或库。 

当进行恢复操作时，被恢复的项目或库会自动被包含到项目/库清单之中。 

 

设定目标子目录 

为了设定目标子目录，可在SIMATIC管理器使用菜单命令Options＞Customize。 

在这个对话框的“Archive”选项卡之下，你可以接通或关断选项“恢复时检查目录”。 

若该选项被关断，则在“项目存储位置”和“库存储位置”同一对话框中所设定的路径将

被用于恢复时的目标目录。 

 

将一个归档文件复制到软盘 

你可以将一个项目/库进行归档，然后将归档文件复制到软盘上。也可以“ Archive（归档）”

对话框中选择软盘驱动器作为目标目录。 

 

利用PKZIP2.04g的说明 

你使用归档程序PKZIP在软盘上生成一个归档文件时，若激活了选项“多软盘连续归档”，

则当你进行恢复时，程序会提示你插入后一张归档的软盘。PKUNZIP总是在DOS窗口内显

示下列信息： 

“Insert the LAST disk of the backup set - Press a key when ready.”（插入后一张备份

盘，如果准备好，按任意键）。 

当你激活了选项“多软盘连续归档”，即便整个归档文件全装在一张软盘上，上述信息，

也会显示。 

此时，可忽略它，并按任意键而确认对话框。 

 



使用M7可编程控制系统 

 25-1 

25  使用M7可编程控制系统 
 

25.1 M7系统程序 

具有标准PC机结构的M7-300/M7-400自动控制微机，在SIMATIC自动化平台上，使自由编

程功能得到扩展。你可以使用高级语言例如C语言或图形化编程语言CFC（连续功能图）

来编制SIMATIC M7的用户程序。 

为了生成程序，除STEP 7之外，你还需要用于M7-300/400的系统软件M7-SYSRT和用于

M7程序的开发环境（Pro C/C++或CFC）。 

 

基本程序 

当你要利用SIMATIC M7生成一个自动控制方案时，有一系列基本任务要完成。下表指出

了对于大多数项目都要执行的任务，将其定义为基本步骤。下表还给出了在本手册或其它

手册中可供参考的相关章节。 

 

步  骤 说  明 

设计自动控制方案 

M7专用； 

参考：  

M7-SYS RT编程手册 

启动STEP 7 同S7 

创建项目结构 

设置站 

建立硬件组态 

同S7 

建立通讯连接组态 同S7 

定义符号表 同S7 

生成C语言或CFC用户程序 
M7专用； 

参考：ProC/C++ 

配置操作系统 

在M7-300/M7-400中安装操作系统 

向M7下装硬件组态和用户程序 

M7专用； 

参考：  

M7-SYS RT用户手册 

检测并调试用户程序 ProC/C++ 

运行监控和M7诊断 同S7，但是没有用户自定义的诊断 

打印与归档 同S7 
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在M7中有什么不同？ 

对于M7-300/M7-400 STEP 7不支持如下功能： 

• 多重运算—若干个CPU的同步操作 

• 变量强置 

• 全局数据通讯 

• 用户自定义的诊断  

 

M7可编程控制系统的管理 

STEP 7为使用M7可编程控制系统提供如下特别的支持： 

• 在M7-300/M7-400中安装操作系统 

• 通过编辑系统文件对操作系统进行配置 

• 向M7-300/M7-400装载用户程序 

• 软件升级 

为了访问M7可编程控制系统的管理器，在包含有M7 CPU或FM模块工作站的项目中，选

中M7程序文件夹，选择菜单命令： 

PLC＞Manage M7 System 

在有关M7-SYSRT的用户手册和联机帮助中有详细的说明。 

 

 

25.2 用于M7编程的选装软件 

 

M7选装软件 

STEP 7为你提供了所需的如下基本功能： 

• 项目的生成与管理 

• 对硬件进行配置和参数设定 

• 配置网络和连接 

• 符号数据管理  

不论是使用SIMATIC S7还是SIMATIC M7这些功能都能具备为了实现M7有关的应用。除

了STEP 7之外，你还需要M7选装软件。 
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软件 内  容 

M7-SYS RT 

·M7 RMOS32操作系统 

·M7-API系统库 

·对MPI的支持 

用于S7和M7的CFC CFC（连续功能图）编程软件 

M7-ProC/C++ 

·用于在STEP 7中实现Borland开发环境的连接 

·符号的编辑与生成 

·xdb386高级语言调试工具的推理规则 

Borland C++ Borland C/C++开发环境 

 

与M7选装软件配合，STEP 7还可以支持下列附加功能：  

• 通过多点接口（MPI）向M7可编程控制系统下装数据 

• 查询有关M7可编程控制系统的信息 

• 在M7可编程控制系统上进行特别设定和对M7进行复位 

下图显示了M7编程对M7选装软件的依赖性。 

 
小结               

为生成…  所需的M7选装软件…  

C/C++程序 
1. M7-SYS RT 
2. M7-ProC/C++ 
3. Borland C++ 

CFC程序 
1. M7-SYS RT 
2. 用于S7和M7的CFC 

3. Borland C++ 
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何种软件提供何种支持 

为M7应用所持需的工具，一部集成于STEP 7之中，另一部分是M7的选装软件。 

下表指明了哪个软件包支持哪种功能： 

 

软件 提供的支持 

STEP 7 
 

·安装M7操作系统 

·管理M7可编程控制系统 

·下装，起动和删除M7程序 

·显示状态和诊断数据 

·CPU复位 

M7-SYS RT M7操作系统和M7系统软件应用帮助实现以下功能：  

·程序处理的控制 

·内存和资源的管理 

·对计算机和SIMATIC硬件的访问 

·处理中断 

·诊断 

·状态监控 

·通讯 

M7-ProC/C++ ·集成代码的生成(将Borland的开发环境集成于STEP 7 中 ) 

·将项目符号连接到源代码 

·集成的调试功能 

Borland C++ ·生成C和C++程序 

用于S7和M7的CFC 
·生成，检测和调试CFC程序 

·起动并运行CFC程序 
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25.3 M7-300/M7-400操作系统 

对于用高级语言C和C++生成的应用，操作系统的作用是非常重要的。对于这些应用，操

作系统要承担下列任务： 

• 访问硬件 

• 管理资源 

• 系统集成 

• 与系统中其它部件进行通讯 

为了完成自动控制任务，M7 RMOS32（实时多任务操作系统）实时操作系统与SIMATIC 

M7自动控制微机配合应用。M7 RMOS32经过扩展后包含了一个调用接口，M7 API（应

用程序接口）将其集成到SIMATIC系统之中。 

实时操作系统M7 RMOS32是用于实时和多任务方案的，在时间准则上使用32位处理。对

于M7模块它可以有如下列配置：  

• M7 RMOS32 

• M7 RMOS32带MS-DOS 

你选择的M7可编程控制系统的操作系统配置取决于你所用的M7模块： 

 

操作系统配置 模块/主内存 PROFIBUS-DP和TCP/IP有/无 大容量内存的安装 

M7 RMOS32 FM 356-4 / 4 MB   
FM 356-4 / 8 MB   
CPU 388-4 / 8 MB  
FM 456-4 / 16 MB  
CPU 488-3 / 16 MBCPU 
486-3 / 16 MB 

无 

有 

有 

有 

有 

有 

内存卡≥4MB或在硬
盘上 

M7 RMOS32带  
MS-DOS 

FM 356-4 / 8 MB   
CPU 388-4 / 8 MB  
FM 456-4 / 16 MB  
CPU 488-3 / 16 MBCPU 
486-3 / 16 MB 

无 

无 

有 

有 

有 

内存卡≥4MB或在硬
盘上 
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26   提示与技巧 
 

26.1 更换组态表中的模板 

如果你使用HW Config修正一个站的组态，并且你想更换一个模板，应如下进行： 

1.  使用拖放功能，将模板从Hardware Catalog（硬件目录）窗口中拖到旧模板上。 

2.  放下新模板。应尽可能地使新模板使用已插模板的参数。 

删除旧模板，插入新模板并赋值参数，比更换模板速度快。 

你可以使用菜单命令Options > Settings（“Enable Module Swapping（使能模板交换）”），

你可以在HW Config中关闭或打开该功能。 

 

26.2 具有大量网络站的项目 

如果你逐一组态所有站，并使用菜单命令Options > Configure Network调用NetPro，以

便组态连接，站将自动放置在网络视图中。该程序的缺点是你必须根据拓扑条件安排站和

子网。 

如果你的项目中包括大量的网络站，并且你想在这些站之间组态连接，你应在网络视图中

组态系统结构，并且开始保存概览。 

1.  在SIMATIC管理器中生成新项目（菜单命令File＞New）。 

2.  启动NetPro（菜单命令Options > Configure Network） 

3.  如下在NetPro中一个站一个站地生成： 

    - 使用拖放功能，从Catalog窗口中拖出站。 

    - 双击站，启动HW Config。 

    - 使用拖放功能，在 HW Config中放置具有通讯功能的模块（ CPU、CP、FM、IF模块）。 

- 如果你想网络连接这些模板，双击组态表中的相应行，生成新的子网，并网络连接 

  接口。 

    - 保存组态，并切换到NetPro。 

    -  在NetPro中，定位站和子网（使用鼠标移动对象，直至到达所需位置） 

4.  在NetPro中组态连接，根据需要校正网络连接。 
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26.3 再排列 

若在使用STEP 7过程中，出现一些无法解释的问题，对项目或库的数据进行重新安排，往

往会对克这些问题有利。 

选择菜单命令File＞Rearrange可进行重新安排。该功能可消除由于某些内容被删除后而

产生的数据存储不连续，即使得项目/库所需的存储器量减少。 

这个功能对项目或者库的数据存储进行优化，其方法类似硬盘碎片整理程序对硬盘的文件

存储进行优化。 

重新安排处理持续的长短取决于要移动的数据量，很可能要花些时间。因此该功能不能自

动实施（例如，当你关闭一个项目时），而应由用户在打算重新安排项目或库时进行调用。 

 

要求 

项目和库需要进行重新安排，必须保证其中不能有正在被其它用户编辑的对象，因为这时

的存取权会被封锁。 

 

26.4 如何在多个网络中编辑符号 

可以用LAD/STL/FBD程序编辑器查看和编辑多个网络中的符号。 

点击选择一个网络名(例如“Network 1”) 

按住CTRL键可同时选择其它网络 

右击调用文本菜单命令编辑符号 

可以使用快捷键CTRL+A选择一个程序块中的所有网络，然后选中网络名。 

 

26.5 用变量表进行测试 

监视和修改变量表中的变量时，请注意以下编辑技巧：  

• 可以在“符号”栏输入符号和地址，也可以在“地址”栏输入符号和地址。然后输入

便会自动地在正确的栏中写入。 

• 想显示修改值，你应将“Monitoring（监视）”触发点设在“Beginning of Scan Cycle

（扫描循环开始）”，将“Modifying（修改）”触发点设在“End of Scan Cycle（扫

描循环结束）”。 
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• 如果你把光标放在红色的行上，可以显示一个简短信息来说明错误的原因。按动F1键，

可获得消除这些错误的建议。 

• 你只能输入已在符号表中定义过的符号。符号必须准确地按照它在符号表中所定义的

行输入。有特殊字符的符号名必须用引号括起来（例如，“Motor.Off”，“Motor+Off”，

“Motor-Off”）。 

• 在“Online（在线）”选项卡（“Customize（自定义）”对话框）中可以关闭警告。 

• 使用事先断开连接，就可改变连接。 

• 监控变量时，可以定义监控触发器。 

• 通过选择行，并执行“Force（强制）”功能，可以修改所选变量。只有高亮显示的变

量才能修改。 

• 无确认退出：  

在“Monitoring（监视）”、“Modifying（修改）”、“Release PQ（释放PQ）”时，

如果你按动ESC键，将不会询问你是否想退出而中止“Monitoring（监视）”和“Modifying

（修改）”。 

• 输入一个“Contiguous Address Range（连续的地址范围）”：  

使用菜单命令Insert>Range of Variable。 

• 显示和隐藏栏：  

使用以下菜单命令可以显示和隐藏单个栏： 

符号：    View > Symbol  

符号注释：   View > Symbol Comment  

状态数值的输出格式： View > Display Format 

变量的状态值：  View > Status Value 

修改变量值：  View > Modify Value 

• 同时修改表中几行的显示格式： 

- 按住鼠标左键在所需表中拖动，选中那些要改变显示格式的区域。 

- 使用菜单命令View > Select Display Format，选择输出格式。只有那些表中允许 

改变格式的行才能改变格式。 

• 按动F1键，可以获得输入示例： 

   -  如果将光标放在地址栏，并且按动F1键，你可以获得地址输入的示例。 

   -  如果将光标放在修改值栏，并且按动F1键，你可以获得修改/强制值输入的示例。 

 



提示与技巧 

 

 26-4 

26.6 用程序编辑器修改变量 

在程序编辑器中，你可以将按钮设置为二进制输入和存储器位，这样可以通过点击鼠标快

速、方便地修改这些地址。 

 

需求 

• 在符号表中，已经通过菜单命令 Special Object Properties > Control at Contact对

所要修改的地址分配了属性。 

• 已经在LAD/STL/FBD程序编辑器的“General”表中选择了“Control at Contact”选项

(菜单命令Options > Customize)。 

• 已经选择了菜单命令Debug > Monitor。 

触发条件是“permanent/at the cycle start”只要按钮按下将一直保持修改。也可以通过多

重选择(CTRL键)修改多个地址。 

 

使用WinCC时的注意事项 

如果通过操作员控制在WinCC中启动程序编辑器并对一个变量进行监视，则只允许WinCC

的控制选项。 

 

26.7 虚拟工作存储器 

引起STEP 7出问题的另一个原因有可能是虚拟工作存储器不够。 

为了在Window 95/98/NT/XP/2000/Me 之下使用STEP 7，你应该调整虚拟存储器的设定。

调整的步骤如下： 

打开“控制面板”，利用命令Start > Settings > Control Panel。双击“System（系统）”

图标。对于XP，通过START > Desktop > Properties > Advanced > System Performance 

> Settings打开。 

在Windows95/98/NT下，选择“System Properties（系统性能）”对话框中的“Performance

（性能）”选项卡。在Windows2000/Me下，选择“Advanced”并点击“System Properties

（系统性能）”按钮。在Windows XP下，在“System Setting（系统设定）”对话框中选

择“Advanced”。 

点击“Virtual Memory（虚拟存储器）”（Windows 9x下）按钮或“Change（修改）”

（Windows NT/2000/Me下）按钮。 
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只适用于Windows 9x：在“虚拟存储器”对话框中，选中选项“用户自定义虚拟存储器” 

在“最小”处输入至少40MB，在“最大”处至少150MB 

只适用于Windows 9x：确保选项“禁止使用虚拟存储器”不能生效只适于NT：点击“Set

（设置）”按钮。 

 

注意 

对于在硬盘（默认为C：）上且为动态的虚拟存储器，你必须确保为子目录TMP或TEMP

提供足够的存储器量（大约20至30MB）  

• S7项目也在虚拟存储器设定的同一分区内，则应保证有大约两倍于S7项目大小的存储

器空间。 

• S7项目存于其它分区，此项要求无关。 
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